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Analyze 15.0 
User’s Guide

Analyze 15.0 is a robust research software for advanced biomedical imaging 

visualization, manipulation and measurement. It has been carefully designed to 

provide an intuitive and facile interface that allows full exploration of biomedical 

imaging data. The software features integrated modules that provide access to 

complementary tools for fully interactive multi-dimensional display, processing, 

segmentation, registration and measurement of biomedical imaging modalities 

including MRI, CT, PET, SPECT, ultrasound and digital microscopy. The applications 

of Analyze 15.0 are broad in scope, wide in scale and penetrating in impact.

Tutorial data

Example exercises are provided 

through out this user’s guide. To 

work through these exercises, 

download the example data from 

https://analyzedirect.com/data/. 
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The Analyze 15.0 workspace is the 

first operational window that appears 

when Analyze 15.0 is opened. The 

main window does not perform 

any imaging functions; rather, it 

coordinates all the modules within the 

Analyze 15.0 package and acts as a 

file manager for loaded data.

Once data is loaded into Analyze 

15.0, it will appear in the tabbed 

workspace (1) as a thumbnail (2) in 

the workspace and is available to 

all of the modules (3). To load data 

into a module, select the icon in the 

workspace (the thumbnail will appear 

framed in red when selected) and 

open the desired module from the 

Analyze 15.0 side menu.

ANALYZE 15.0 BASICS

Analyze 15.0 Basics
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Analyze 15.0 has been carefully 

designed to provide an intuitive 

and facile interface that significantly 

improves usability and performance. 

The software features integrated 

modules that provide access to 

complementary tools for fully 

interactive multi-dimensional display, 

processing, segmentation, registration 

and measurement of image data.

ANALYZE 15.0 BASICS

Analyze 15.0 Modules

Segment

Input/Output

Register

Display

Measure

Process

Transform

Provides direct loading 
and exporting of data for 

over 50 file formats

Provides sophisticated 
interactive tools for 
fast and precise region 
definition

Provides a powerful set 
of 2D and 3D image 

review and display tools

Facilitates image 
optimization, filtering and 

enhancement functions  

Allows spatial and 
intensity transformations, 
mathematical processing 

and data reorientation.

Provides multi-modality 
image fusion and image 
alignment of 2D, 3D and 
4D data

Allows in-depth analysis 
with a suite of robust 
image measurement tools
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ANALYZE 15.0 BASICS

The Analyze 15.0 workspace includes additional options which can be accessed by right-clicking within 

the workspace. The menu provides the following options:

Unload — Unload selected data from the workspace

Info — Display the header information for a selected data set

Rename — Change the name of a selected data set

Edit Header — Modify the header information of a selected data set (see Header Edit below)

Duplicate — Will duplicate the currently selected data set

Append — Append selected data

Un-append — Un-append 4D multi-volume data sets or RGB data sets

Select All — Select all data sets in the workspace

Invert Selected — Invert your selection of data in the workspace

Arrange — Arrange data sets by Name, Size or Modify Time 

Session Log — Store information that might be useful to the Analyze 15.0 support team and 

software developers, should a problem ever arise with one of the modules

Current Directory — View and modify the Current Directory location

License Manager — Open the Analyze 15.0 License Manager

Analyze 15.0 Update — Check to make sure the software is up to date; will also download and 

install any necessary updates

Options — Configure Analyze 15.0 features, Object Map loading, and Window management 

options (see Options below) 

Help — Open the Analyze 15.0 User’s Guide

Get Help — Open the AnalyzeDirect Support Page

About — View version, system and environment information

Right Mouse Button Menu



7ANALYZE 15.0

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

When Edit Header is selected from 

the right-mouse menu, the Header 

Edit window will open. Header Edit 

enables the modification of the 

selected data’s header information, 

including adding user defined fields 

or removing selected fields from the 

header. Header Edit is primarily used 

for adjusting dynamic range values, 

adding or correcting voxel dimension 

information, or modifying orientation 

(AVW image data only) for loaded 

volumes. 

Exercise caution when modifying 

header files, as inconsistent values 

may cause unpredictable results. 

If used on non-AVW image data, 

Header Edit may not work.

Header Edit

File - opens a File selection window enabling the selection 

of a header file (.hdr) to be examined and/or modified. 

DataType - Displays the data type of the selected file. 

Choose from the drop-down list to change the data type.

Width - Displays the image width value. 

Height - Displays the image height value. 

Depth - Displays the number of images in the volume

Num Vols - Displays the number of volumes contained in 

the file..

Depending on the type of file selected the following 

fields are available, but selection options may vary:

Save - Records all changes made to the header file. 

Calculate Max/Min – Calculates and reports the file’s 

maximum and minimum values.  The following options 

are available:

Ignore – Does not apply values to header.

Apply – Applies values to the header.

Done – Closes the Header Edit window. 
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When Options is selected from the 

right-mouse menu, the Options 

window will open. The Options 

window allow users to enable and 

disable Analyze and Module Options.

Analyze Options

Show Icon Message(s) – Enable or disable the 

display of pop-up messages returned when the 

mouse cursor is moved over a thumbnail in the 

workspace (1). 

Fixed Icon Font – Enable or disable a default 

fixed icon font for loaded image data (2). 

Auto Update – Enable or disable Analyze 15.0 

from automatically checking for updates when 

the software is opened (3). It is recommended 

that this option is enabled. 

Module Options

Auto Load Object Maps - Determines whether 

Object Maps are automatically loaded (Yes), not 

loaded (No), or the user is prompted (Prompt) to 

load an object map when a module is opened.

Options

Search Project Directory for Object Maps – Allows 

modules to search the current project directory for an 

object map when opened.

Search Home Directory for Object Maps - Allows 

modules to search the user’s Home directory for an 

object map when opened.

Manage Windows - When enabled, Analyze and all 

modules remember the positions and size of each 

window.  

Manage By Host – Stores separate window 

manOptionsagement information for each unique 

computer.  This may be necessary if a user runs on 

more than one system and each system has different 

configurations (number of displays, display orient, and 

screen resolution).

Reset Management - Deletes the position and 

size information for the system resetting window 

management information.
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ANALYZE 15.0 BASICS

Left click — Selects a file.

[Ctrl] + a — Selects all of the files in the workspace.

[Ctrl] + Left Mouse Click — Selects/deselects each file that has been clicked.

[Shift] + Left Mouse Click — Selects all files between first and last selections.

[Ctrl] + [Alt] + c  — Recalculates the data sets minimum and maximum information.

[Shift] + [Ctrl] + [Alt] + p — Forces a patch update.

[Ctrl] + x  — Duplicates selected file.

Double-clicking on a data set in the workspace restarts the last module used with that data. If there is not a module associated with the 

data, the Display module will open by default.

Main Analyze 15.0 Window Actions and Quick Keys 
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ANALYZE 15.0 BASICS

The main Analyze 15.0 Workspace 

can be partitioned into multiple 

workspaces using the tabs at the 

top of the main workspace, each of 

which can be given a name relevant 

to the task the workspace represents. 

To add a workspace, click New. To 

rename a tab, right-click the tab and 

select Rename.

This permits efficient organization of 

loaded data sets into task-specific 

groups. Icons representing the loaded 

data sets can be manually organized 

in each workspace panel by dragging 

the icons to the desired location. Data 

sets can further be moved between 

workspaces by dragging to the tab 

associated with the workspace. 

Workspace Tabs
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ANALYZE 15.0 BASICS

Workspaces can be organized into 

specific projects via the Current 

Project controls in the lower right of 

the Analyze 15.0 window. Analyze 

15.0 creates a default workspace/

project from the computer username.

Projects can be added to a user-

specific project list (click the 

workspace tool icon), with the 

workspace storage location for 

loaded images under the full control 

of the user. 

Projects
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Figure 1

To create a new project, click on the 

Project Configuration button (1).

Next, click New Project (2).

Name the project (3) and then use the 

Project Directory button (4) to specify 

the location where the project will 

reside on disk. Note that this is the 

location where all data loaded into 

the project will be stored so ensure 

that the location has enough free 

disk space to handle the data you 

plan to load for the project. Also, it 

is recommended that the project be 

stored on a local disk and not on a 

network drive.

Click Create (5). The Project file will 

be created and now be available in 

the Current Project drop-down. 

Creating a project
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Figure 1

Note, please exercise caution when 

deleting a project. 

To delete a project, click the Project 

Configuration button (1).

Select the Project you wish to delete 

(2) and then click delete (3).

A Delete Project file confirmation 

window will be returned. This 

window will ask you to confirm the 

deletion of the selected project file 

(Yes) or cancel the delete (No). Not 

that clicking Yes will only delete the 

project file of the selected project. 

This delete will not deleted the 

projects workspaces or loaded 

data.  Select Yes to proceed with the 

deletion of the project.

Deleting a project
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Next, another Delete Project window 

will be returned. This window will 

allow users to delete (Yes), not delete 

(No), or Cancel the deletion of the 

project directory and data. Note that 

selecting Yes to delete the Project 

Directory will delete all workspaces, 

data, and other files associated with 

the project saved under the project 

file location. Select Yes to continue 

with the delete.

The selected project and all 

workspaces and data will be deleted.
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Object Maps

Analyze 15.0 uses a file called an 

object map to partition image 

data into groups of voxels within a 

segmentation component map. After 

creation of the object map through 

segmentation, it can be used to drive 

visualization, registration, surface 

generation and statistical analysis.

The object map is an associated 

volume with the same dimensions 

as the image data. Each voxel of 

the object map contains an 8-bit 

value which encodes it as belonging 

to 1 of 256 total possible objects. 

Every voxel in the data set is initially 

assigned to the first object (Original), 

leaving 255 additional objects that 

can be used for 2D region or 3D 

volume of interest definition.

Object maps are loaded separately 

from the image data to which they 

are associated using the File > Load 

Object Map option in each functional

module. When the object map is loaded, the 

objects defined in it are overlaid on the image 

data. As can be seen in the above figures, 

grayscale segmentation destroys all voxels

that are not part of the object of interest, 

whereas object maps preserve the original 

data by assigning the segmented voxels to 

objects.

Original image

Grayscale segmentation Object map segmentation
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Analyze 15.0 provides common image display windows with interactive image controls across all modules. The following display options 

and controls are present in all sections of the software, but certain modules will contain additional functions. The implementation of the 

image display tools are similar for the Display, Transform, Segment, and Measure modules, implementation varies slightly for the Process 

and Register modules. For additional information on the Process and Register module display tools please refer to the Process and Register 

sections of this user’s guide.

IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

Introduction

Image Display Window

The image display window is divided 

into several areas: 

(1) Display controls

(2) Tools

(3) Axial slice display

(4) Coronal slice display

(5) Sagittal slice display

(6) Rendering window
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

The Display Controls allow users to 

control and customize the layout of 

the display window.

Toggle All Orientations: Allows 

users to switch between the display 

of all three orthogonal displays (the 

axial, coronal and sagittal) to a single 

orientation display.

Toggle Oblique: Allows users to 

switch the oblique display window on 

and off.

Toggle Rendering: Allows users to 

switch the Render window on and off.

Controls Layout: This option allows 

users to control the layout of the 

display window. Choose to set the 

Axial as Primary, Coronal as Primary, 

Sagittal as Primary, Render as Primary 

or specify No Primary image (default 

option).

Display Controls
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

The Tools options in the upper left-

hand corner of the Display Window, 

allow access to control tools for image 

navigation, display, and notation. 

Toggle Cursor Link: Allows enabling 

and disabling of the Cursor Link tool. 

The Cursor Link tool allows users to 

interactively navigate through the 

image data. Moving the Cursor Link 

in any of the displays will interactively 

update the other displays. See the 

Cursor Link tool in the Slice Display 

and Render Window sections for 

additional information.

Tools
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

Toggle Region Display: The Toggle 

Region Display option allows users to 

quickly switch between the display 

of the overlaying regions on the slice 

displays. The display options are; 

Filled Regions, Region Edges, Both, 

and Regions Off. Note the keyboard 

shortcut to toggle regions displays is 

the t key.

Set Note State: Enables the Notes 

tool. The Notes tool allows users 

to annotate the 2D slice data or 3D 

rendering. Notes are automatically 

associated with the data set and can 

be displayed in other modules. Notes 

can be hidden or deleted at any time.
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

The Axial Slice Display window, showing 1) Cursor Link, 2) Orientation labels, 3) Slice tool, 4) Zoom tool, and 5) Max/Min tool. 

The Slice Display windows displays 

the 2D slice data in each of the three 

orthogonal orientations. In the default 

display mode the upper left window 

displays the axial orientation, the 

lower left the coronal orientation, 

and the lower right the sagittal 

orientation.

The Slice Display window includes 

several tools for viewing and 

navigating through the image data, 

these include:

Cursor Link: allows users to 

interactively navigate through 

the image data. The tool can be 

controlled from any of the 2D 

orientations or from the 3D rendering. 

Moving the tool will interactively 

update the corresponding slice 

displays. The linked cursor can be 

enabled or disabled using the Toggle 

Cursor Link button.  

Slice Display

Arrow Keys: can also be used to move the 

linked cursor. The keys will move the linked 

cursor in the corresponding direction (up, 

down, left and right) for the active orientation.

Page Up and Down Keys: used to move 

through the slices in the active orientation. 

Orientation Labels: displays helpful 

orientation labels. The labels can be 

abbreviated by right-clicking on them.
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Slice Tool: Users can navigate 

through image slices using the slice 

tool. Click the yellow Slice text in the 

lower left-hand corner of the image 

pane. An up/down slice cursor will 

appear. Hold down the left mouse 

button, and slide the cursor upward 

to move to a higher slice number and 

downward to move to a lower slice. 

Users can quickly navigate to the 

First, Middle and Last slice by right-

clicking the yellow Slice text. A 

specific slice number can be chosen 

by double-clicking the yellow Slice 

text and typing in the desired slice 

number.
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Zoom Tool: Users can increase and 

decrease the display size of the data 

using the Zoom tool. Click on the yellow 

Zoom text in the bottom right corner of 

the image pane. A zoom cursor will be 

displayed. While clicking and holding 

the left mouse button, move the mouse 

upward to zoom in and downward to zoom 

out. Let go of the left mouse button when 

the desired zoom factor is reached.

Right-click on the Zoom tool to reveal 

additional options:

Zoom Presets — Right-click the yellow 

Zoom text and the following options will 

appear:

Zoom levels — 0.25x, 0.33x, 0.50x, 1.00x, 2.00x, 3.00x, 4.00x 

Fit Window — Uses a zoom factor that allows the data to fill the image pane.

Fit Width — Uses a zoom factor that allows the data to fit the width of the image pane. 

Fit Height — Uses a zoom factor that allows the data to fit the height of the image pane. 

Interpolation — Allows the interpolation method to be changed for the display of the data. The default is Bicubic (Input Driven). Users can 

switch to Linear (ID), Nearest Neighbor (Output Driven), Linear (OD), Bicubic and Windowed Sync.

Zoom Center - Uses the center of the image to set as the zoom point.
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Pan tool: The Pan tool is automatically enabled when the Zoom size of the image is larger than the current window. Clicking in the tool 

allows users to Pan the zoomed area over the current display. To enable the Pan tool without zooming right-click on Zoom and select 

Options and then check Show Pan.

Show Transforms: Transforms (Flips and Rotations) can be enabled for the display window, providing the user with the ability to flip and 

rotate the image display. To enable transforms right-click on the Zoom tool and then choose Options > Show Transforms, select Enabled 

and then select Flips and/or Rotates.

Max/Min tool: The Maximum and Minimum display intensities can be changed by clicking on the yellow Max/Min Tool at the bottom right 

corner of the image window. A cursor will return that allows the values to be manipulated. Hold down the left mouse button and move the 

mouse up/down or left/right. 

CT — Soft Tissue, Chest, Abdomen/Pelvis, Lung, Brain, Bone, Head/Neck

MR — Brain T1, Brain T2, Sag T2, Head/Neck, Spine, Abdomen/Pelvis T1, Abdomen/Pelvis T2 US — Low Contrast, Medium Contrast, High 

Contrast

Data — Volume Max/Min, Image Max/Min, Range Max/Min

User — Declare specific Max/Min values with a label. Once a label is saved, it can be accessed within the user menu.

To change only the Max value, hold the Shift key while using the Max/Min 

cursor. The Min values can also be edited independently by holding the Ctrl 

key while moving the Max/Min cursor. Note [Shift] + Right Mouse Button can 

be used to adjust Max/Min in any window  

without having to first select the Max/Min option.  

Right-click on the yellow Max/Min text to reveal 

the Preset Intensity options for the following  

list of modalities:
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Auto — Automatically calculates the Max/Min voxel intensity for each slice. Note that the Max/Min values change from slice to slice.

Invert — When selected, inverts the display intensities in a single orientation. To change the intensity display from Max/Min to Window/

Level right click on the Max/Min tool and choose Options > Intensity Display and choose between Max/Min or Window/Level. Note that 

selecting the Change option provides you with the ability to chance the apply these changes to All Modules (default), This Module, or This 

Display Window only.

Manual Intensity Input: Users can type in a Max/Min value by double clicking on the yellow Max/Min text. A box that contains editable 

fields will be returned. Input the desired values and press enter or click outside the box. 

Right Menu Options: Right-clicking in the Slice Display window reveals additional options.

Middle Button Action: Allows users to set the action of the middle mouse button. Choose from:

Change Slice (default) – Allows users to change the slice display by clicking the middle mouse button 

and moving the mouse forward, to move slice display forward, or backwards, to move the slice display 

backwards. 

Change Zoom – Allows users to change the zoom display by clicking the middle mouse button and 

moving the mouse forward, to zoom in, or backwards to zoom out. 

Change Intensity – allows max/min intensity values to be adjusted using the middle mouse button. 

Holding the middle mouse button and moving the mouse forward or backwards will adjust the maximum 

intensity value. Moving left and right will adjust the minimum intensity value.

Default – returns middle mouse button action back to the system default. 

Annotate Changes – Enables and disables the annotations associated with changing slices, zoom, or intensities.

Mouse Wheel Action: Allows users to set the action of the middle mouse wheel. Choose from:

Change Slice (default) – Allows users to change the slice display by scrolling the middle mouse button forwards, to move slice display 

forward, or backwards, to move the slice display backwards.
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Mouse Wheel Action (continued):

Change Zoom – Allows users to zoom display by scrolling the middle mouse button forwards, to zoom in, or 

backwards, to zoom out. 

Change Intensity Minimum – Allows users to adjust the minimum intensity value by scrolling the middle 

mouse wheel forwards or backwards.

Change Intensity Maximum - Allows users to adjust the maximum intensity value by scrolling the middle 

mouse wheel forwards or backwards.

Choose Middle Button Action – Allows users to scroll through the display tools (Slice, Zoom, or Intensity) for 

the Middle Button action. Selecting a tool will modify the action of the middle mouse button instantly. 

Default – returns middle mouse button action back to the system default. 

Annotate Changes – Enables and disables the annotations associated with changing slices, zoom, or 

intensities. 

Other Right Menu Options:

Copy to Clipboard – Copies the current slice display to memory. 

Isotropic – Active only for anisotropic data. Allows users to toggle between an isotropic or anisotropic display of the data. 

Show Enabled Object Only- Available when Region Display is set to Both - Filled Regions and Region Edges. Ignores object Display Off 

setting.

Color Only Enables Objects – Available when Region Display is set to Filled Regions. The option allows users to enable the display of the 

object color overlay in the current orientation even if the display of the object is switched off in the Object Control Window. Option updates 

to Traces or Objects depending on the Region Display setting selected. 

Trace Only Enabled Objects- Available in Segment only when Region Edges is enabled. See Segment for further information.
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

Other Right Menu Options (continued):

Set Object Opacity (50%)- Allows users to adjust the 

alpha blend of the object color overlay on the grayscale 

image data. When enabled an Opacity slider is enabled 

below the current image allowing for interactive 

adjustment.

Label Enabled Objects – Allows users to enable/

disable the display of object names on the slice display. 

Note, the keyboard short cut to enable/disable labels is 

Shift + l.

Cursor Link – Toggles the Cursor Link tool Off/On in 

the current display.

Axis Labels – Allows users to enable or disable the 

display of the axis labels on the perimeter of the slice 

display window.

Border Ruler – Enables/Disables the border ruler tool. 

Green hash marks represent 10mm increments, yellow 

represents 1mm increments, and blue represents 

0.1mm increments.

Print – Sends capture of current slice display to printer. 

Reset – Resets all options to default.
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IMAGE DISPLAY CONTROLS AND CUSTOMIZATION

The default upper right pane of 

the Image Display Window is the 

Rendering Window. This window 

displays a 3D rendering of the image 

volume

The Rendering Window includes 

several tools for viewing and 

navigating through the image data: 

(1) Cursor Link tool

(2) Navigation Icon tool

(3) Rotation tool

(4) Zoom tool

(5) Pan tool

(6) Max/Min tool

Cursor Link tool: As described in 

the Slice Display section above, the 

cursor link allows users to interactively 

navigate through the image data. 

The tool can be controlled from the 

3D rendering or from any of the 2D 

orientations. Moving the tool on the

Rendering Window and Tools

rendering will interactively update the 

orthogonal slice displays. The cursor link can 

be enabled or disabled using the Toggle 

Cursor Link button.

Navigation Icon tool — The Navigation Icon 

is a reference for the current orientation of the 

3D image data, and also allows users to rotate 

the data or specify a standard view: front, back,

top, bottom. To rotate the data, left-click on 

the Navigation Icon and hold the left mouse 

button down. The cursor will update to the 

Rotation tool enabling

interactive rotation of the 

rendering viewpoint. Releasing 

the left mouse button will 

dismiss the rotate cursor.
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Zoom tool: As with the Zoom tool for the 2D Slice Display, the Zoom tool in the Rendering Window allows users to increase and decrease 

the display size of the data. For more information refer to the Zoom tool description in the Slice Display section.

Pan tool: The Pan tool is automatically enabled when the Zoom size of the rendering is larger than the current window. Clicking in the 

tool allows users to Pan the zoomed area over the current display. To enable the Pan tool without zooming right-click on Zoom and select 

Options and then check Show Pan.’

Max/Min tool: The Maximum and Minimum display intensities for the rendering can be changed by clicking on the yellow Max/Min Tool at 

the bottom right corner of the window. A cursor will return that allows the values to be manipulated. Hold down the left mouse button and 

move the mouse up/down or left/right.

Right Menu Options: Right-clicking in the Rendering Window reveals additional options. Most of 

these options, if available, are described in the Slice Display section, however, there are few additional 

configuration options specific to the Rendering window. 

Middle Button Action: Allows users to set the action of the middle mouse button. See the Slice Display 

section for additional information.

Mouse Wheel Action: Allows users to set the action of the middle mouse wheel. See the Slice Display 

section for additional information.

Copy to Clipboard: Copies the current rendering display to memory.

Hide Colorbar: Toggles the Colorbar Off/On in the current display.

Disable Colormap: Disables/Enables the Colormap in the current display.

Interactive Render: Allows users to selects between Reduced Quality (useful for interactive rotation of 

extremely large image volumes) and Full Quality.

Cursor Link: Toggles the Cursor Link tool Off/On in the current display. 
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Render Options: Allows users to enable/disable the following rendering options:

Show Render Type: Allows users to view and change the rendering algorithm 

used to render the image data, choose from Depth Shading, Gradient Shading 

(default option), Volume Compositing, Maximum Intensity Projection, Summed 

Voxel Projection, Surface Projections, and Object Compositing. Double click 

on the Render Type option to cycle through the render types or right-click and 

choose a specific render type from the right mouse menu. For more information 

about render types and the render type specific options please refer to the 3D 

Rendering section of Display.

Show Rotation: Reports the current XYZ rotation angle coordinates. When 

selected, enables the rotate cursor. Right-click on the tool to choose from rotation 

default options; Front, Back, Left, Right, Top, and Bottom

Show Threshold: Displays the current Threshold maximum and minimum threshold values. Double clicking allows users to enter values. 

Right-click to specify Preset values or choose from Analyze Default, Calculated Max/Min, and DataType Max/Min.

Show Clip Plane: Enables the Clip Plane tool allowing users to specify the maximum and minimum depth along the ray path between which 

voxels are rendered. Clipping is particularly helpful when you need to observe the cross section of a 3D object. 

Show Clip Volume: Enables the Clip Volume tool, allowing users to clip the volume with six clip planes (X low, X high, Y low, Y high, Z low, 

and Z high). 

Show Render Size: Displays the current rendering size and allows the user to enter the rendering Width, Height, and Depth. Right click to 

choose from Default, Maximum Diagonal, Double Diagonal, Axial, Coronal, and Sagittal.
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Right Menu Options (Continued):

Transparency: The Transparency option turns transparent rendering on or off. The transparency 

rendering mode is useful for visualizing objects contained within objects or objects with views obscured 

by other objects. Object opacity levels can be set using the Opacity options in the Object Control 

window.

Background Opacity: The Background Opacity option is only available when Transparency rendering is 

enabled. The option allows users to specify the background opacity for the transparency rendering. 

Background Color: Allows users to set the color of the rendering background. The option opens a Color 

selection window enabling selection of desired color. 

Print: Sends capture of current slice display to printer. 

Reset: Resets all options to default. 
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The	Input/Output	module	centralizes	the	loading	and	saving	of	image	data	in	Analyze	15.0.	Input/Output	supports	the	loading	of	51	file	

formats	including	standard	Analyze	file	formats,	common	radiological	and	neurological	formats,	vender	specific	file	formats,	2D	desktop	

publishing	formats,	and	video	

formats	(see	table	on	next	page).

The Input/Output module has two 

modes;	Load	mode	and	Save	mode.	

Load mode is the default mode 

for	the	module	while	Save	mode	is	

enabled when a data set is selected 

in the workspace when Input/Output 

is	opened.

If a data set is selected in the 

workspace when Input/Output is 

opened	the	module	will	prompt	you	

to choose to start in Load mode or 

Save	mode.	Selecting	Yes,	will	start	

the	module	in	Save	mode	enabling	

the	saving	of	the	selected	image.

Introduction
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INPUT/OUTPUT > INTRODUCTION

The Input/Output windows consists of 

the following nine sections:

1. Mode tabs: Allows user to select 

the mode for the Input/Output 

module from the following:

Input: Sets Input/Output to Load 

mode	for	loading	data	into	Analyze.	

Process:	Provides	tools	for	processing	

of	image	data,	available	for	both	load	

and	save	modes.	

Output:	Sets	Input/Output	to	Save	

mode for exporting data from 

Analyze.

The Input/Output Window

2. Input Types:	Select	the	location	to	load	data	from	or	save	data	to.

Disk:	Allows	data	to	be	selected	and	loaded	from	the	system’s	local	disks	or	network	drives.

Workspace:	Allows	data	to	be	selected	and	loaded	from	a	workspace.

Database:	Allows	DICOM	data	to	be	imported	into	a	database,	selected	and	loaded	into	Analyze.	For	Save	mode	allows	DICOM	data	to	be	

stored	in	the	database	for	export	out	of	Analyze.	

PACS:	Allows	for	the	configuration	of	Query/Retrieve	(Q/R)	of	DICOM	image	data	from	PACS.
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INPUT/OUTPUT > INTRODUCTION

3. Directory selector:	Enables	users	to	navigate	to	the	location	of	the	data	to	be	
loaded.

4. File selection area:	Allows	users	to	select	the	desired	data	sets	for	loading.

5. Image display:	Provides	a	display	for	data	review	of	the	selected	image	file	prior	to	
loading.	

6. Info option:	When	checked	displays	the	header	information	for	the	selected	file.

7. Right-mouse options: 

Load/Save	Prompt:	Enable/Disable	Load/Save	Prompt	(Figure	3.2)

Formats:	Displays	list	of	supported	file	formats	and	associated	properties.

About	-	The	About	option	opens	the	Analyze	15.0	About	window.	The	About	window	

provides	detailed	information	about	the	system	and	the	Analyze	software.	Selecting	

Done	will	close	the	About	window.

User	Guide	-	The	User’s	Guide	option	opens	this	User	Guide.

Get	Help	-	Directs	you	to	the	AnalyzeDirect	website	support	pages.

8. Load Volume:	Loads	the	selected	file	into	the	current	workspace.	

9. Exit:	Closes	the	Input/Output	module.
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Input type: Disk

To	load	a	single	2D	image,	a	3D	

volume,	or	4D	multivolume	into	

Analyze:

Open	Input/Output.

Navigate	to	the	data	[1]	and	select	

the	data	set	you	want	to	load	[2].	See	

table at beginning of this chapter for 

supported	file	formats.

Note	that	the	data	will	be	displayed.	

[3]

Click	Load	Volume	[4]	to	load	the	

data.	The	selected	data	set	will	be	

loaded	into	Analyze	15.0.

Click	Exit	[5]	to	close	Input/Output.

Loading a Single File from Disk

Input: Loading Data
INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK



38

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

Input type: Disk

To	load	multiple	2D	DICOM	files	as	

a	single	3D	volume	from	a	folder	

on	your	system,	Analyze	provides	

an	InMemory	DICOM	Database	

function.	To	generate	the	information	

needed	to	provide	the	necessary	

patient/study/series	user	interface	for	

selecting	DICOM	volumes,	do	the	

following:

Open	Input/Output.

Navigate	to	the	directory	that	

contains	the	DICOM	image	folder.	[1]

Loading Multiple 2D DICOM Files as a 3D Volume from Disk

NOTE:	Do	NOT	navigate	into	a	folder	that	contains	the	DICOM	image	files	(.dcm	files).	In	the	example	figure	above,	the	directory	to	navigate	

to	is	named	“MicroCT”,	as	this	directory	contains	the	DICOM	image	folders.

Next,	perform	a	right-mouse	click	on	a	folder	containing	DICOM	files	(which	in	the	example	above	is	named	“St_20221122”)	and	select	“Open	

InMemory	DICOM	Database”.	This	quickly	creates	a	temporary	in-memory	DICOM	database	which	imports	all	the	DICOM	files	found	in	the	

folder	selected,	including	subfolders	within.

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK
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When	the	temporary	in-memory	

database	is	created,	the	input	type	is	

automatically	changed	from	Disk	to	

Database	[3].	

Once	the	process	is	complete,	the	

patient/study/series	user	interface	is	

displayed	[4].

Any	of	the	studies	can	be	selected,	

and the series contained within a 

study	will	be	displayed	in	the	series	

pane	[5].

Click	on	the	desired	volume	within	

the	series	pane	to	see	it	displayed	[6].

Click	Load	Volume	[7]	to	load	the	desired	series	into	Analyze	as	a	single	3D	volume.

Click	Exit		[8]		to	close	Input/Output.

NOTE: For importing and loading of 2D DICOM files using a persistent DICOM database (rather than the temporary in-memory 
database method shown here), please refer to page 44.

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK

Loading Multiple 2D DICOM Files as a 3D Volume from Disk (continued)
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Input type: Disk

Frequently,	scanner	vendors	do	not	

support exporting data in a single 3D 

format and choose instead to export 

data as a series of 2D images such as 

TIFF	or	BMP.	To	load	a	series	of	2D	

images	into	Analyze	as	a	single	3D	

volume:

Open	Input/Output.

Navigate	to	the	series	of	2D	image	

files.	[1]

To	select	a	range	of	Image	files,	first

choose	the	first	image	in	the	series,	then	press	the	Shift	key	and	finally	select	the	last	data	set	in	the	range	[2].	Alternatively,	select	ctrl	+	a	to	

select	all	files	in	the	directory.	

By	default,	all	selected	images	will	be	treated	as	a	single	volume	[3].	Other	load	options,	such	as	loading	a	series	of	2D	images	individually,	are	

available	from	Process	>	Organize. 

Click	Load	Volume	[4]	to	load	the	data	into	the	software	as	a	single	3D	volume.

Click	Exit		[5]		to	close	Input/Output.

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK

Loading Multiple 2D Non-DICOM Files as a 3D Volume from Disk
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Input type: Disk

To	load	multiple	3-D	volumes	into	the	

program	simultaneously: 

Open	Input/Output.	

Navigate	to	the	location	of	the	image	

data.	[1].	

To	select	multiple	data	sets,	hold	

down	the	Ctrl	key	and	select	each	

data	set	to	load.	[2].	

If the data select has different 

properties	(spatial	dimensions,	

volume	sizes,	data	types,	etc.)	the	

module will recognize this and 

treat the selected data sets as 

separate	volumes	[3].	Note	that	if	the	

properties of the selected data sets 

are the same the module will default 

to	load	as	a	single	multivolume.	

Click	Load	Volume	to	load	all	selected	

volumes.

Click	Exit	to	close	the	module	[4].

Loading Multiple 3D Volumes from Disk

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK
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Input type: Disk

Analyze	15.0	supports	4D	image	data	

sets	or	multivolumes.	Multivolumes	

are data sets that that consist of 

multiple	3D	volumes.	Multivolume	

loading	is	automatically	enabled	

when	loading	multiple	volumes	that	

have	the	same	Voxel	Dimensions	and	

Datatype.	To	load	a	series	of	volumes	

as	a	multivolume:

Open	Input/Output.	

Navigate	to	the	location	of	the	image	

data.	[1].	

To	select	multiple	data	sets,	hold	

down	the	Ctrl	key	and	select	each	

data	set	to	load.	[2].	

As	these	data	sets	have	the	same	

properties the module will default 

to loading the data as a single 

multivolume	[3].	

Click	Load	Volume	to	load	all	selected	

volumes	[4].

Click	Exit	to	close	the	module	[5].

Loading Multiple 3D Volumes as a 4D Volume from Disk

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM DISK
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Input Type: Workspace

Input/Output supports the loading 

of image data from one workspace 

to	another.	To	load	data	from	a	

workspace into the current workspace 

(the workspace selected when Input/

Output was opened): 

Open	Input/Output.	

Use the Workspace drop-down menu 

to	select	a	Workspace.	[1].	

Use the File drop-down menu to 

select	a	data	set	[2].	

The	selected	data	to	be	previewed	in	

the	Display	window	[3].	

Click	Load	Volume	to	load	the	

selected	file	to	the	current	workspace	

[4].

Click	Exit	to	close	the	module	[5].	

 

Loading Data From A Workspace

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A WORKSPACE
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Input Type: Database

The Database input option is for the 

import of DICOM image data into 

Analyze	15.0.	The	Database	option	

enables the indexing of collections 

of DICOM images through a local 

database	file.	To	create	a	database	

and for DICOM data import:

Open	Input/Output.

Set	Input	Type	to	Database	[1].	

The	first	time	the	Database	option	is	

selected,	a	window	will	be	displayed,	

asking: 

‘There is no input database 

connection.	What	would	you	like	to	

do?’

Select	Create	a	new	database.	[2].

Loading DICOM Data from a Database

Note:	If	you	have	used	previous	versions	of	Analyze	or	AnalyzePro	and	have	created	DICOM	databases	you	can	use	the	‘Browse	filesystem	for	an	

input	database’	to	navigate	to	and	select	a	.adb	file.	If	this	window	is	not	returned	or	if	this	is	not	the	first	time	you	have	opened	the	Database	

option,	select	Admin	button	[3]	to	open	the	Administer	Databases	window	and	create	a	new	database.	

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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The Administer Database(s) window 

will	open.

Name	the	database		[3] 	and	set	the	

location where the database will be 

saved.		[4].

Loading DICOM Data from a Database (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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Enabling DICOM Communications 
(optional)

A	DICOM	receiver	can	be	configured	

for	the	database.	The	receiver	will	

run	as	a	Windows	service	or	Unix	

daemon	and	will	actively	listen	on	

a	specified	port	for	DICOM	image	

data to be pushed to it from PACS or 

any	other	DICOM	node.	To	set	up	a	

DICOM	receiver:

Set the DICOM Communication to 

Enable.	[5].

Set	the	Port	number		[6]		and	

Application	Entity	Title	(AET)	Name.		

[7]	

Note	that	the	AET	Name	should	not	go	over	16	alphanumeric	characters.

Make	a	note	of	the	Port	number	and	AET	Name.	Your	PACS	administrator	will	need	this	information	along	with	the	systems	IP	address	to	

configure	DICOM	push	from	PACS.

Once	configured	on	PACS	you	will	be	able	to	push	DICOM	image	data	from	PACS	to	the	Analyze	15.0	database.	Note	that	if	DICOM	data	is	

not	being	received	after	pushing	from	PACS	you	may	need	to	open	the	port	number	for	the	Receiver	on	your	system’s	firewall.

Click	Create.	[8].

Loading DICOM Data from a Database (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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For Windows users an informational 

window will be returned informing 

your	that	a	system	prompt	will	follow	

to	install	services	for	the	database.	

Click	OK.	[9]

In the Windows User Account Control 

prompt	returned	click	Yes	[10]	to	allow	

the	program	to	install	the	receiver	

service.

Dismiss	the	service	installed	

confirmation	message	by	clicking	OK	

[11].

Details	about	the	receiver,	as	well	

as	the	associated	database	server,	

configured	for	the	database	are	

displayed	at	the	bottom	of	the	

Administer	Database(s)	window	[12].	

Close	the	window.

Loading DICOM Data from a Database (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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Importing Images

Once	the	Database	is	configured	you	

can now start importing DICOM image 

data.	

Click	the	Import	button	[13]	or	right-

click in the window and select Import 

DICOM	Images.	[14]

Use	the	Directory	Selector	to	navigate	

to the location of the DICOM images to 

import	and	click	OK.	[15]

A window will open stating Import 

all	DICOM	files	found	below	<the	

specified	folder>;	click	Yes.	[16]

Loading DICOM Data from a Database (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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Loading DICOM Images

Once	import	is	complete,	the	

image	data	will	be	available	in	the	

database.

To	load	a	DICOM	volume,	select	the	

desired	patient,	study	and	series	

volume	to	see	it	displayed.	

Click	Load	Volume	[17]	to	load	the	

desired	series	into	Analyze	15.0.

NOTE: To load multiple 2D DICOM 
images as a 3D volume without 
using a persistent DICOM database, 
please refer to page 39.

Loading DICOM Data from a Database (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A DATABASE
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Input Type: PACS

The	PACS	Input	Type	option	allows	

users	to	configure	Query	and	Retrieval	

of	DICOM	data	from	PACS.	To	set	up	

communications	to	allow	Query	and	

Retrieval	of	DICOM	data	from	PACS,	

first	create	a	database,	see	previous	

section:	Importing	DICOM	Data	>	

Creating	a	Database,	then:

Remote AET Configuration

Open	Input/Output.		

Set	Input	Type	to	PACS	[1].	Under	

Remote	AET,	click	Edit	[2].	In	the	

Input/Ouput Administer PACS (AET) 

list	window	that	opens,	click	New	[3]

The	window	will	update	showing	AET,	

System,	Port,	and	Description	fields.	

Enter the PACS information into these 

fields	[4]	and	click	Apply	[5].

Note	that	you	will	need	to	contact	

your	PACS	administrator	to	obtain	the	

relevant	PACS	information.

Loading DICOM Data from a PACS

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A PACS
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The window will update and the PACS 

information	will	be	available	in	the	main	

window.	[6].

Click	Save	to	close	the	window	[7].

Local Query/Retrieve AET Configuration

For	Analyze	15.0	to	successfully	query	and	

retrieve	DICOM	image	data	from	PACS	

a	local	MOVESCU	service	needs	to	be	

configured.	

Under	Query/Return	AET	click	the	

Propertied	button.	[8]

In	the	window	returned	enter	the	Q/R	AET.	

Note:	The	AET	should	not	be	over	16	

alphanumeric	characters.

Enter the Port number Q/R will use and 

then	click	Apply.	[10]

Make a note of the Q/R AET and Port 

number.	Your	PACS	administrator	will	need	

this	information	along	with	the	systems	IP	

address	to	configure	Q/R	on	PACS.

PACS	is	now	configured	on	Analyze	15.0.

Note:	There	may	be	additional	
configuration	required	on	the	

PACS	side	by	your	PACS	admin.	

Also,	your	systems	Firewall	may	

need	to	be	configured	to	allow	

Inbound and Outbound commu-

nication for the Remote AET port 

and	local	Query/Return	AET	port	

prior to successful Q/R of DICOM 

image	data	from	PACS.

Loading DICOM Data from a PACS (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A PACS
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Note: There	may	be	additional	configuration	required	on	the	PACS	side	by	your	PACS	admin.	Also,	your	systems	firewall	may	need	to	be	
configured	to	allow	Inbound	and	Outbound	communication	for	the	Remote	AET	port	and	local	Query/Return	AET	port	prior	to	successful	

Q/R	of	DICOM	image	data	from	PACS.

Querying and Retrieving DICOM data from PACS

To	Query	PACS,	choose	which	PACS	to	query	using	the	drop-down	menu	under	Remote	AET	[1].		Under	Query	enter	the	Patient	ID,	Patient	

Name	or	Study	Date		[2]		and	click	Find	[3].	The	relevant	patient	data	will	displayed	under	Patients.	[4].

Select	the	patient	and	click	Retrieve/Load	Volume(s)		[5]		to	load	the	selected	data	into	the	current	workspace.

Loading DICOM Data from a PACS (continued)

INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A PACS
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INPUT/OUTPUT > TRANSFORMING DATA

Spatial-	and	intensity-based	transformations	can	be	applied	to	the	data	while	loading	to	or	saving	from	Analyze	15.0.	These	

transformation	options	are	available	from	Input/Output	>	Process,	once	a	data	set	is	selected.	

Organize

MultiVolume Override

Sometimes	image	data	may	not	be	organized	as	expected.	For	example,	two	3D	data	sets	may	be	concatenated	into	a	single	3D	data	

set,	requiring	the	data	to	be	split	into	two	volumes.	Furthermore,	the	data	may	be	interleaved.	The	MultiVolume	Override	options	

provide	a	utility	to	efficiently	reorganize	such	problematic	data	while	loading.

Process: Transforming Data
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• Open	the	Input/Output	module.

• Navigate	to	the	data	and	select	

the	data	set	you	want	to	load	and	

transform.

• Note that the data will be 

displayed	[1].

• Select	the	Process	tab	[2].

• Under	Organize,	check	the	

MultiVolume	Override	option.	 [3]		

All possible data reorganization 

options	will	be	available	from	the	

drop-down	menu.

We know that in this example the 

54-slice	data	set	is	comprised	of	a	T1	

and	a	T2	data	set,	each	containing	27	

slices.	Select	the	appropriate	option	

from	the	drop-down	menu:	2	Volumes	

of	27	Slices	[4].

Download the Neuro_Interleaved_T1_2_MRI
data set to follow along
http://analyzedirect.com/data/

Organize (continued)
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• The data has now been changed 

from a single 3D data set 

containing 54 slices to a 4D 

multivolume	made	up	of	two	

3D	data	sets,	each	containing	

27	slices.	Hold	the	cursor	

over	the	image	and	use	the	

middle mouse wheel to scroll 

through	the	data.	Note	that	

in	this	example,	the	T1	and	T2	

image	data	is	interleaved	so	the	

current	volume	will	alternate	

between	T1	and	T2	slices.

• To	correct	for	the	interleaved	

image	data,	check	the	

Interleaved	option	[5].

• Scroll through the image data for 

volume	1.	This	will	now	display	

only	the	T1	image	data.	

• Use	the	Volume	option	[6]	to	

change	to	volume	2	and	scroll	

through	the	data.	Only	T2	image	

data	will	be	displayed.	

• Click	Load	Volume	[7]	to	load	

the	corrected	image	data.

Organize (continued)
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The	Intensities	option	allows	for	intensity	scaling	or	threshold-based	manipulations	to	be	applied	to	the	data.

Intensity Scaling

Intensity	scaling	allows	for	the	adjustment	of	the	voxel	value	information	in	the	data.	Image	data	can	be	scaled	by	adjusting	the	output	Data	

Type.	Values	can	also	be	linearly	scaled	using	the	Input	Maximum	and	Minimum	scale	options.

Modifying Image Data Type

Changing	the	image	data	type	can	reduce	the	size	of	the	data	on	disk.	In	this	example,	a	microCT	data	set	has	a	data	type	of	Float.	The	size	

of	the	image	data	when	loaded	into	AnalyzePro	is	92.71	MB.	Changing	the	data	type	to	Signed	16-bit	reduces	the	size	of	the	data	set	by	

about	50%	to	46.35	MB	when	loaded.

Intensities

Intensities
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• Open	Input/Output.

• Navigate	to	and	select	the 

data	set	you	wish	to	load 

and	transform.

• Select	Process	[1]	and	Intensities	

[2].

• Make a note of the Input 

Maximum	and	Minimum	values	

[3].

• Select	Load	Volume.	[4].		This	

will	load	the	volume	to	the	

workspace	as	a	Float	data	set.

Download the Bone_Sample_mCT
data set to follow along
http://analyzedirect.com/data/

Intensities (continued)
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• Set	the	Output	DataType	to	

Signed	16-bit	[5].

• Enter the Output Maximum and 

Minimum	values	[6]	by	copying	

the input maximum and minimum 

values	and	rounding	to	the	

nearest	whole	number.

• Select	Load	Volume	[7]	and	select	

Create	New	when	prompted.

• Exit	Input/Output	[8].

Intensities (continued)
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• Right-click	on	the	first	data	set	

and	select	Info	[9].	Repeat	for	the	

second	data	set.

• In the info panel beneath the 

data,	note	the	size	of	the	original	

and	scaled	data	set.

Intensities (continued)
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Threshold Scaling

Threshold scaling allows a range of 

voxels	from	the	input	volume	to	be	

loaded	as	a	binary	data	set.	All	voxels	

greater	than	or	equal	to	the	Input	

Minimum	and	less	than	or	equal	to	the	

Input	Maximum	are	set	to	1.	All	other	

voxels	are	set	to	0.

• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	to	which	you	want	to	apply	a	

threshold	scaling.

• Select	Process			[1]	and	

Intensities.	[2].

• Check	the	Threshold	option	[3].

• Use the Input sliders to set 

the threshold minimum and 

maximum	[4].

• Note	the	image	display	will	

update,	showing	a	binary	image	

for	the	selected	voxels	[5].

• Click	Load	Volume	[6]	to	load	the	

binary	volume.	

Download the EGV_Post_Op_CT
data set to follow along
http://analyzedirect.com/data/

Intensities (continued)
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Inverting Data

For	certain	applications,	such	as	the	

segmentation	of	the	thalamus,	it	is	

beneficial	to	view	an	inverted	copy	of	

the image data alongside the original 

grayscale	data	to	improve	visualization	

of	the	thalamus.	Reviewing	the	original	

and	inverted	image	data	aids	with	

manual	delineation	of	the	structure.

• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	you	want	to	invert.

• Select	Process	[1]	 and	Intensity	[2].

• Select	Load	Volume	[3]	to	load	the	

data	into	Analyze.

• Next,	check	the	Invert	option	[4].

Note	that	the	display	of	the	data	

will	update	[5].

• Click	Load	Volume	[3]	and	select	

Create	New.

A	grayscale	and	inverted	version	of	the	

data	are	now	available	for	use	within	the	

program.	These	two	data	sets	can	be	

simultaneously	loaded	into	Segment.

Download the EGV_Pre_Op_MRI
data set to follow along
http://analyzedirect.com/data/

Intensities (continued)
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Colormaps

When loading a data set that has an 

associated	colormap	[1],	 the	Colormap	

checkbox	will	be	selected	[2].

Download the Neuro_PET
data set to follow along
http://analyzedirect.com/data/

Intensities (continued)
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• To	load	the	grayscale	data	

without	the	associated	.lkup	

colormap	file,	uncheck	the	

Colormap	checkbox	[3]	

Note	that	the	image	display	will	

update	to	show	the	grayscale	data	[4].

• To	load	the	data,	click	Load	

Volume	[5].

Intensities (continued)
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Standard Uptake Value Conversion

The	Standard	Uptake	Value	(SUV)	

in	PET	data	is	defined	as	the	ratio	

of	activity	in	tissue	per	millimeter	to	

the	activity	in	the	injected	dose	per	

patient	body	weight.		When	PET	data	

is	loaded	into	Analyze	via	the	Input/

Output	Database	a	new	Intensity	

option	‘SUV	Conversion’	appears,	

[1]	the	scale	factors	present	in	the	

DICOM header information with the 

PET	data	are	used	to	automatically	

scale	the	data	into	units	of	activity	

per	millimeter.	[2]	Any	sampling	of	the	

PET	data	conducted	in	Analyze,	such	

as	ROI	analysis,	will	provide	values	in	

this	calibrated	range.

Intensities (continued)
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Data Flipping

It	may	be	necessary	to	flip	data	in	

order	to	orient	it	correctly.	The	Flip/

Shift	>	Flip	options	allow	users	to	

flip	data	along	any	single	axis	or	

combination	of	axes.

Once	a	flip	checkbox	is	selected,	the	

flip	will	be	applied	to	the	data	and	the	

display	panel	can	be	used	to	review.	

Unchecking the option will undo the 

flip.	Flipping	the	data	in	only	the	X	or	

Y	direction	will	create	a	mirror	image.	

If	this	is	not	the	desired	result,	the	

data	can	be	flipped	in	both	the	X	

and	Y	directions	at	once	to	prevent	a	

mirror	image	from	being	created.	To	

apply	a	flip:

• Open	Input/Output.

• Navigate	to	and	select	the	data	set	

to	be	flipped	and	loaded.

• Select	Process	[1]	and 

Flip/Shift	[2].

Flip/Shift

Axis OUTCOME

X Flips	data	horizontally,	rotating	about	the	vertical	(Y)	axis.

Y Flips	data	vertically,	rotating	about	the	horizontal	(X)	axis.

Z Changes	the	order	of	the	slice	data.

Download the EGV_Pre_Op_MRI
data set to follow along
http://analyzedirect.com/data/
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• Check	the	X	Flip	option	[3].

Note	the	update	to	the	data	[4].

Flip/Shift (continued)
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• Check	the	Y	Flip	option	[5].

Note	the	update	to	the	data	[6].

• To	load	the	data,	click	the	Load	

Volume	button	[7].

Flip/Shift (continued)
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Flip 2D 3D

No 

flip

X

Y

Z

Flip 2D 3D

XY

XZ

YZ

XYZ

Results of Flipping Data Along Any Combination of Axes
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Shifting Data

The shift option allows data to be 

shifted	horizontally	or	vertically.	Data	

shift	may	be	necessary	to	correct	for	

slice	wraparound.	In	this	example,	the	

front	slices	of	a	sagittally-acquired	

MRI	data	set	have	wrapped	around	to	

the	posterior	side	of	the	data	set	[1].	

and there are slices from the inferior 

side	of	the	volume	that	have	wrapped	

around to the superior side of the 

volume	[2].

Download the Neuro_MRI_Sagittal
data set to follow along
http://analyzedirect.com/data/

Flip/Shift (continued)
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• To correct for the horizontal 

shift	in	slices,	enter	-25	in	the	

Horizontal	Shift	field	[3].

Note that the data will be shifted 

back	25	slices.	The	last	25	slices	will	

automatically	wrap	around	from	the	

posterior side of the data set to the 

anterior	side	of	the	data	set	[4].

• To	correct	for	the	vertical	shift	

in	slices,	enter	6	in	the	Vertical	

Shift	field	[5].

Note that the data will be shifted up 

6	slices.	The	top	6	superior	slices	will	

automatically	wrap	around	to	the	

inferior	side	of	the	data	set,	since	the	

Wrap	checkbox	is	checked	[6].

Flip/Shift (continued)
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Shift Options Quick Reference

Shift Axial Coronal Sagittal

Horizontal	+ To left To left To anterior

Horizontal - To right To right To posterior 

Vertical	+ To anterior To superior To superior

Vertical	-	 To posterior To inferior To inferior
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• To	shift	data	interactively,	click	

on	the	image	data.	Note	that	the	

cursor will update; drag the data 

to	a	new	location	[7].

Flip/Shift (continued)
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• Unchecking the Wrap checkbox 

[8]	will	prevent	slices	from	being	

wrapped.	[9].

Flip/Shift (continued)
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Shear Factor Correction

Sometimes	CT	images	are	acquired	with	the	gantry	tilted	obliquely	(non-orthogonally)	relative	to	the	direction	of	the	table	movement.	If	the	

volume	is	constructed	by	stacking	the	image	slices,	the	volume	will	appear	sheared	or	skewed.	Analyze	will	automatically	detect	and	apply	

the	gantry	tilt	shear	correction	and	the	appropriate	shear	factor	values	will	be	populated	in	Shear	Factor	(per	slice)	fields.	If	desired,	the	

Shear	Factor	(per	slice)	values	can	be	manually	entered.

Flip/Shift (continued)
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Cropping Data

The	Subregion	tool	in	Input/Output	>	Process	can	be	used	to	reduce	the	size	of	a	data	set	without	the	need	to	interpolate	the	original	voxel	

data.	The	tool	can	also	be	used	to	crop	data	to	a	specific	region	of	interest.

Subregion
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• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	you	want	to	crop.

• Select	Process	[1]	and	Subregion	

[2].

• To	crop	the	data,	click	on	the	

green	box	[3]	in	the	display	

panel	and	adjust	to	the	desired	

position.

• To	define	the	crop	in	the	Z	

range,	click	on	the	Slice	option	

[4].	With	the	left	mouse	button	

held	down,	move	the	mouse	up	

or	down	to	navigate	through	the	

slice	data.	You	can	also	use	the	

scroll	wheel	to	move	through	the	

slice	data.	When	you	reach	the	

lower	limit	for	the	crop,	enter	the	

slice number in the Z Low box 

[5].	Enter	the	upper	limit	slice	

number	in	the	Z	High	box.	

• Click	Load	Volume	to	load	the	

cropped	data	[6].

Download the Neuro_ACPC_Aligned_MRI
data set to follow along
http://analyzedirect.com/data/

Subregion (continued)
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4D image data can also be cropped 

to	remove	time	points	from	the	data	

prior	to	loading.	When	a	4D	data	

set	is	selected,	a	fourth	dimension	V	

(volume)	will	be	enabled	[7].	To	crop	a	

4D data set:

• Select	the	Volume	option	[7]	

and	use	the	cursor	to	navigate	

through	the	volumes	in	the	data,	

just	like	you	would	use	the	Slice	

option	to	navigate	through	the	

slices	in	a	single	volume.

• Determine	the	volumes	you	want	

to	remove	from	the	multivolume	

and enter the corresponding 

lower	and	upper	volume	limits	in	

the	V	Low	and/or	V	High	boxes	

[8].

Cropping 4D Data

Download the 4D_Cardiac_CT
data set to follow along
http://analyzedirect.com/data/
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Resize can be used to resample 

image	data.	If	data	is	acquired	with	

anisotropic	(non-cubic)	voxels,	resize	

can be used to resample the data to 

create	an	isotropic	(cubic)	data	set.

Resampling Anisotropic Data

• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	to	be	resampled.

• Select	Process	[1]	and	Resize	[2].

• Click	Load	Volume	[3]	to	load	the	

data	set	without	resampling.

Resize

Download the Neuro_MRI_Sagittal
data set to follow along
http://analyzedirect.com/data/
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• Check the Force Cubic checkbox 

[4].

Note	the	input	and	output	voxel	

size and the input and output axis 

dimensions	[5].	The	data	has	been	

resampled at the highest spatial 

resolution	(0.98).	The	Z	dimension	

which	originally	had	a	voxel	size	of	

1.5	has	now	been	resliced	to	0.98.	To	

accommodate	this,	the	number	of	

slices in the Z dimension has increased 

from	123	to	188	(123*1.5/0.98	=	188).

• The interpolation option used to 

create the new slice data can be 

selected from the interpolation 

drop-down	menu	[6].

For	information	about	various	

interpolation	types,	see	Table	3.4	or	6.1.

• Click	Load	Volume	[7]	and	select	

Create	New.	Compare	both	the	

original and resampled data sets 

using	Display.	

Resize (continued)
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Interpolation Type Description

Nearest	Neighbor* selects	the	value	of	the	closest	voxel	to	which	the	interpolation	resampling	maps

Linear* applies	a	linear	interpolation	of	grayscale	intensity	based	on	the	distance	of	neighboring	voxels	from	the	

interpolated	voxel

Cubic	Spline** uses	a	cubic	spline	function	to	determine	interpolated	value

Windowed	Sinc** uses	windowed	sinc	function	sin(x)/x	to	determine	interpolated	value

Shape Based only	available	for	binary	data;	calculates	Euclidean	distance,	then	performs	linear	interpolation	between	

distance images

Each	interpolation	type	is	either	input	driven	(ID)	or	output	driven	(OD).

Input	driven	interpolation	algorithms	process	each	voxel	in	the	input	volume	and	map	each	input	voxel	into	the	output	space.	The	actual	

interpolation	takes	place	in	the	output	space,	given	the	projected	contributions	of	each	input	voxel	into	that	space.	Input	driven	algorithms	

will	always	use	every	voxel	in	the	input	volume	as	part	of	the	interpolation	process.

Output	driven	algorithms	step	through	each	voxel	in	the	output	data	set	and	find	the	corresponding	set	of	voxels	in	the	input	data	set	that	

map	into	the	output.	The	interpolation	of	voxels	takes	place	in	the	input	space,	depending	on	the	type	of	interpolation	selected.	Output	

driven	algorithms	are	more	common	in	image	processing	as	they	guarantee	that	every	voxel	in	the	output	data	set	will	be	filled	with	an	

interpolated	value.

Interpolation Types

*The	Nearest	Neighbor	and	Linear	interpolation	types	can	be	specified	as	ID	or	OD.

**The	Cubic	Spline	and	Windowed	Sinc	interpolation	types	are	both	OD.	Since	they	use	higher-order	functions,	they	account	for	more	neighboring	voxels	and	thus	may	provide	a	better	
estimate	for	the	interpolated	value.	These	algorithms	are	also	more	compute-intensive.

Resize (continued)
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Padding Data

The Pad/Orient option can be used 

to	pad	image	data.	This	may	be	

necessary	to	create	a	data	set	with	

certain dimensions or to make a data 

set	isovolumetric	(equal	number	of	

slices	in	each	orientation).

• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	to	be	padded.

• Select	Process	[1]	and	Pad/Orient	

[2]

• Note the slice dimensions for the 

data are reported in the Padded 

Volume	fields	[3].

Pad/Orient

Download the Neuro_MRI_Sagittal
data set to follow along
http://analyzedirect.com/data/
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• To make the data set 

isovolumetric,	update	the	

appropriate	Padded	Volume	field	

[4].	The	Pad	tool	will	try	to	apply	

an	equal	number	of	slices	to	pad	

the	data	in	the	pad	axis	[5].	

• Users can also choose to pad all 

slices to either the Low or High 

field	for	the	appropriate	axis.

• Click	Load	Volume	[6]	to	load 

the	data.

Pad/Orient (continued)
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Correcting an Orientation Flag

If a data set is loaded with an 

incorrect	orientation	flag,	it	will	not	

orient	correctly	in	other	AnalyzePro	

modules.	The	Orientation	option	can	

be	used	to	correct	this.

• Open	Input/Output.

• Navigate	to	and	select	the	data	

set	to	be	padded.

• Select	Process	[1]	and	Pad/

Orient	[2].

Note that the orientation of this 

sagittally-acquired	data	set	is	marked	

as	axial.	[3].

Download the Neuro_MRI_Incorrect_Orientation
data set to follow along
http://analyzedirect.com/data/

Pad/Orient (continued)
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• To	correct	this,	set	the	Orientation	

Input	option	to	Sagittal	[4].

• Note that the axis labels in the 

preview	are	corrected	[5].

• Click	Load	Volume	[6]	to	load	the	

data.

Pad/Orient (continued)
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Data	can	be	exported	from	Analyze	

15.0	as	easily	as	it	can	be	loaded	

into	the	program.	Input/Output	will	

open	in	Save	mode	when	a	data	set	is	

selected.

Opening Input/Output 
in Save Mode

• Select a data set and open Input/

Output.

• A	window	will	open,	prompting	

you	to	open	in	Load	or	Save	

mode.	Select	Save	mode.

Output: Saving Data
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• Input/Output	will	open	with	Output	selected	and	the	Output	Type	set	to	Disk	[1].

• Choose	to	save	the	data	as	a	3D	Volume	[2]	(default)	or	as	multiple	2D	images.	The	selection	will	determine	the	formats	you	can	select	

for	saving	the	data.

• Use	Directory	[3]	to	select	the	location	where	you	will	be	saving	the	data.

• Use	File	[4]	to	rename	the	data.

• Use	Format	[5]	to	specify	the	file	format	for	the	saved	data.

• Select	Save	Volume	to	save	the	data.

Saving a Data Set
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• Select	the	Database	option	[1].

• If	required,	select	a	database	from	the	drop-down	[2].

• Click	Store	Volume	[3].

Storing Data in a Database
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• The Edit/Add DICOM tags 

window	will	open.	Use	this	tool	

to	add	or	edit	any	DICOM	tag	

information.

• Click	Apply	Tags	and	Continue	[4].

• The data will be exported to and 

merged	into	the	database.

Storing Data in a Database (continued)
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• Right-click	on	the	data	to	send	to	PACS	[5].

• Select	Send	Patient	[6]	and	choose	the	PACS	AET	where	you	want	to	send	the	data	[7].

• To	configure	PACS,	see	Configuring	PACS	Communications.

Sending Data to PACS
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The	Display	module	allows	image	data	to	be	reviewed	interactively	in	2D	and	3D.	

The	2D	display	options	allow	for	the	display	of	the	image	data	in	any	or	all	orthogonal	planes	and	also	provides	the	ability	to	review	data	in	

any	oblique	plane.	

The	3D	tools	provide	a	variety	of	display	representations	for	three-dimensional	image	data	sets.	Display	uses	ray	casting	algorithms	to	

rapidly	generate	volume	rendered	displays	of	two	classes;	Transmission	displays	(Projections)	and	Reflections	displays	(Surface).		

Introduction



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

91DISPLAY > DISPLAY MODULE INTERFACE

The	Display	Module	interface	is	

divided	into	the	following	areas:	

[1] Menu, [2] Tools, [3] Display 

Configurations,	and	[4]	Display	Area.

Each	of	these	Display	Module	

Interface	areas	are	now	described:

Display Module Interface
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The	Menu	provides	access	to	the	File,	

Options,	and	Help	menus.	 

 

File 
 
The	File	menu	allows	users	to	load	

and	save	object	maps	for	the	loaded	

data	set.	The	File	options	include:

Input Output Ports:	Displays	a	
Volume	area	at	the	bottom	of	the	

Display	module	window.	This	area	

facilitates	the	dragging	and	dropping	

of	image	data	into	the	module.

Menu
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Load Object Map:	When	selected	
opens	a	Load	Object	Map	window	

allowing	users	to	navigate	to,	select	

and	load	an	object	map	file.	The	

following	options	are	available:

• Current	Directory:	Takes	user	to	

the	current	directory,	the	current	

directory	is	set	by	right-clicking	in	

the	main	Analyze	15.0	window	and	

then	choosing	Current	Directory	

from	the	menu.	See	section	1.	

Analyze	Basics	for	additional	

information.	

• Workspace	Directory:	Takes	

user	to	the	current	Workspace	

directory.

• Home	Directory:	Takes	user	to	the	

user’s	Home	directory.	

• Cancel	Load:	Cancels	the	load	of	

the	object	map.
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Save Object Map:	When	selected	
opens	a	Save	Object	Map	window	

allowing	users	to	navigate	to	name	

the	object	map	and	select	a	location	

to	save	the	object	map	file.

Save Object Map As:	Allows	users	
to	save	a	copy	of	the	current	object	

map	without	overwriting	the	original	

object	map	file.

Unload Object Map:	Unloads	the	
loaded	object	map

Exit:	Closes	the	module

Options 
 
When	selected	opens	the	Options	

menu	providing	access	to	Module	

configuration	options,	including:

Intensities Linked: Allows	users	to	enable	or	disable	linked	intensity	adjustment.	When	linked	any	adjustment	an	images	intensity	display	
will	be	applied	to	all	grayscale	slices	displayed.	When	disabled	image	intensities	can	be	adjusted	individually.	
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Zoom Linked: Allows	users	to	enable	
or	disable	linked	zooming.	When	

linked	any	zoom	in/out	on	an	image	is	

applied	to	all	images.	When	disabled	

images	can	be	displayed	at	different	

zoom	levels.

Fast Object Rendering:	Enables/
Disabled	Fast	Object	Rendering

Show Cursor Coordinates:	Allows	
users	to	Enable/Disable	the	display	

of	the	linked	cursor	coordinates	and	

voxel	grayscale	value	displayed	in	the	

lower	left-hand	corner	of	the	display	

window.
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Perspective Auto Zoom:	The	
Perspective	Auto	Zoom	function	is	

used	with	the	Perspective	tool.	When	

this	option	is	enabled	the	orthogonal	

view	will	automatically	zoom	out	so	

the	user	can	see	all	camera	control	

points.	

Auto Note Update:	Allows	the	Auto	
Note	Update	option	to	be	enabled	or	

disabled.

Auto Cursor Link:	Allows	the	Auto	
Cursor	Link	option	to	be	enabled	or	

disabled.

Remember Layout: When	enabled	the	module	will	remember	changes	made	to	the	layout	and	will	open	with	this	layout	in	the	future.	When	
disabled	the	module	will	open	with	the	default	layout.

Threads: Allows	users	to	specify	the	number	of	threads	used	in	a	multi-threaded	rendering	process.	By	default,	the	number	of	threads	is	set	
to	the	number	of	processors	on	the	system. 

 

Help 
 
The	Help	menu	provides	users	with	quick	access	to	help	resources	including:.

About:	View	version,	system	and	environment	information.

Users Guide:	Opens	the	Analyze	15.0	User’s	Guide.

Get Help:	Opens	the	AnalyzeDirect	Support	Page.
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Tools 

 

The	Tools	options	provide	access	to	the	Toggle	Cursor	Link,	Toggle	Region	Display	and	the	Set	Note	State	tools.	For	further	information	on	

these	tools	please	refer	to	section	2.	Image	Display,	Controls	and	Customization.	

Display Area 
 
The	Display	Area	provides	access	to	various	display	windows	and	tools,	a	description	of	these	tools	can	be	found	in	section	2.	Image	

Display,	Controls	and	Customization.	However,	the	Display	module	offers	additional	display	functionality	not	found	in	other	modules.	These	

tools	are	described	in	the	following	Display	Configurations	sections.	

Display Configurations 
 
The	Display	Configuration	area	allows	users	to	review	data	in	2D	or	3D	in	the	Display	Area.	The	default	setting	when	Display	is	first	opened	

is	for	the	Image(s)	check	box	to	be	checked	which	enables	the	data	to	be	displayed	in	an	array	of	2D	images.	When	the	3D	checkbox	

is	checked,	a	3D	display	window	is	added	to	the	current	display.	A	myriad	of	different	display	options	are	offered	through	Display	

Configurations	which	are	now	described: 
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Multiple Panels

When	Display	is	first	opened,	the	Image(s)	checkbox	is	selcted	by	default	and	the	data	set	will	be	

shown	as	a	panel	of	sections	from	a	single	orthogonal	orientation.	The	number	of	panels	shown	can	be	

controlled	using	the	Columns/Rows	button	and	using	the	Page	Down	and	Page	Up	buttons	to	change	

the	number	of	slices	shown.	In	the	lower	left-hand	corner	of	the	first	image	there	are	additional	display	

controls	tools.	These	are	Orient,	Increment,	and	Slice.

Orient: The	Orient	tool	allows	users	to	switch	to	switch	
between	any	of	the	three	orthogonal	orientations;	Axial,	

Coronal,	or	Sagittal.	Left	click	on	the	Orient	tool	to	cycle	

through	the	orthogonal	displays	or	right-click	and	choose	

the	desired	display	option	from	the	menu.

Increment:	The	Increment	tool	allows	users	to	specify	
the	interval	used	to	determine	the	next	image	to	be	

displayed.	Click	the	yellow	Increment	text,	the	cursor	will	

update	to	display	an	up/down	INCR	cursor.	Hold	down	

the	left	mouse	button	and	slide	the	cursor	upward	to	

increase	the	increment	value	and	downward	to	decrease	

the	increment	value.

Slice: Users	can	navigate	through	image	slices	using	the	slice	tool.	Click	the	yellow	Slice	text	in	the	lower	left-hand	corner	of	the	image	pane.	
An	up/down	slice	cursor	will	appear.	Hold	down	the	left	mouse	button,	and	slide	the	cursor	upward	to	move	to	a	higher	slice	number	and	

downward	to	move	to	a	lower	slice
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All Orientations

Images	can	be	shown	as	a	3-panel	display	depicting	all	orthogonal	orientations	using	the	All	Orientations	option.	In	this	view,	the	larger	

Primary	Panel	[1]		can	be	set	to	any	of	the	orthogonal	orientations	by	selecting	the	radio	buttons	under	Primary	Panel	options		[2]		or	by	

double-clicking	the	desired	image.

Thickness:	Note	that	in	the	lower	left-hand	corner	of	each	orthogonal	display	there	is	a	Thickness	option.	The	Thickness	tool	allows	users	to	
modify	the	orthogonal	display	from	one	to	many	slices,	displaying	a	slab	of	slices	in	which	the	average,	maximum	intensity	projection	(MIP),	

weighted	maximum	intensity	projection	(weighted	MIP),	minimum	intensity	projection	(MinIP)	or	weighted	minimum	intensity	projection	

(weighted	MinIP)	values	within	the	slab	thickness	(Thick	Type)	can	be	displayed.	These	types	of	images	can	improve	interpretation	accuracy	

and	decrease	review	time.

To	adjust	display	thickness,	click	the	yellow	Thickness	text,	the	cursor	will	update	to	display	an	up/down	THICK	cursor.	Hold	down	the	left	

mouse	button,	and	slide	the	cursor	upward	to	increase	the	thickness	value	and	downward	to	decrease	the	thickness	value.	Users	can	also	

right-click	and	select	thickness	options	calculated	based	on	the	data	sets	volume.	

Thick Type:	When	the	display	thickness	is	increased	the	Thick	Type	option	is	displayed	above	the	Thickness	option.	Left	click	on	the	Thick	
Type	text	to	toggle	through	the	Thick	Type	options	or	right-click	and	choose	the	desired	option	from	the	menu.	The	Thick	Type	options	are	

shown	on	the	following	table:
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Thick Type Description

Average Average	intensity	projection	displays	data	using	the	average	values	for	all	voxels	in	the	volume	and	the	thick	type	

value	for	slice	integration.	This	setting	can	be	useful	for	viewing	projections	of	noisy	images,	or	for	simulating	a	slice	

thickness	other	than	what	was	scanned.

MIP Maximum	intensity	projection	displays	data	using	only	the	highest	values	for	each	voxel	of	the	volume	and	the	thick	

type	value	for	slice	integration.

Weighted	MIP After	the	highest	values	of	each	voxel	has	been	determined	to	be	the	maximum	voxel	along	the	ray	path,	its	value	

is	weighted	by	the	percentage	of	its	distance	along	the	ray	path.

MinIP Minimum	intensity	projection	displays	data	using	only	the	lowest	values	for	each	voxel	of	the	volume	and	the	thick	

type	value	for	slice	integration.	This	slab	mode	is	particularly	useful	when	looking	at	air	or	fluid	in	smaller	slabs	of	

slices.

Weighted	MinIP After	the	minimum	values	of	each	voxel	have	been	determined	to	be	the	minimum	voxel	along	the	ray	path,	its	value	is	

weighted	by	the	percentage	of	its	distance	along	the	ray	path.
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Single Image

The	Single	Image	option	shows	an	image	from	a	single	orthogonal	orientation,	with	sequential	image	display	options	shown	as	buttons	in	

the	lower	left	of	the	image	display.	This	is	the	default	display	option	for	loaded	movie	files.	

In	addition	to	the	Thickness,	Orient,	and	Slice	display	options	(discussed	earlier)	there	are	video	controls	for	image	review,	these	include:	

Play Reversed:	Reverses	the	direction	of	the	display.	Clicking	on	the	tool	button	again	increases	the	display	speed.	

Display previous image:	When	selected	displays	to	previous	image.

Pause:	Pauses	the	display	of	the	images,	to	continue	click	on	the	pause	or	play	button.	

Display Next Image:	When	selected	displays	the	next	image.

Play:	Begins	the	display	of	the	images.	Clicking	on	the	tool	button	again	increases	the	display	speed.	

Right-clicking	on	the	controls	provides	access	to	additional	options	including	options	to	change	the	video	controls	button	size,	the	option	to	

add	a	delay	between	the	display	of	images,	and	an	option	to	automatically	reverse	display	of	images	at	the	end.
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Oblique

The	Oblique	option	is	only	available	

for	the	All	Orientations	and	Single	

Image	Image(s)	and	all	3-D	display	

configurations.	When	the	Oblique	

option	is	checked	[1]	it	enables	the	

display of a new Oblique window 

[2]	allowing	for	the	creation	of	any	

arbitrary	plane	using	the	Fly	tool	

controls	in	the	Oblique	window	[3]	

or	by	adjusting	the	blue	Oblique	

Reference	Lines	enabled	on	the	three	

orthogonal	displays	[4].	For	further	

information	on	using	the	Fly	tools	

or	the	Oblique	Reference	Lines	to	

create	oblique	images	please	refer	to	

section	6.	Transform.
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Additional	2D	image	display	

parameters	are	enabled	including:

Just Oblique:	When	selected	displays	
just	the	oblique	image.

Perpendiculars:	When	this	option	
is	checked	[1]	additional	oblique	

windows	are	displayed.	[2]	[3]	These	

oblique	displays	are	perpendicular	to	

the	first	oblique	image	and	allow	for	

additional	manipulations.
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Colormaps

The	Display	module	provides	users	

with	the	ability	to	create	or	load	a	

colormap	over	the	grayscale	image	

data.	Options	for	creating,	loading,	

saving,	editing,	hiding,	disabling,	and	

removing	colormaps	are	available	

from	the	right	mouse	menu	for	any	of	

the	2D	image	displays.	

Right-click	on	2D	slice	display	and	

choose	Colormap,	a	submenu	for	

Colormaps	will	be	displayed.

Create:	When	selected	opens	the	
Create	Colormap	window.

• Color	Cells:	allows	you	to	specify	

the	number	of	color	cells	to	be	

used	in	the	creation	of	the	color	

map.

• Type:	Allows	you	to	specify	the	

type	of	color	map	to	be	created,	

choosing	from	the	following:
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• Grayscale:	Creates	a	Grayscale	

colormap. 

 

 

 

 

 

• Rainbow:	Creates	a	Rainbow	

colormap. 

 

 

 

 

 

• Random:	Creates	a	Random	

colormap
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Create:	When	selected	creates	
colormap	from	specified	color	cells	

and	type.	The	colormap	is	applied	to	

the	displayed	image	data	(1),	a	color	

bar	is	displayed	(2),	and	the	Edit	Color	

Map	Window	(3)	is	returned.	When	

the	Edit	Colormap	window	opens	the	

following	options	are	available.	

Action

• Select	Cell:	Allows	users	to	modify	

the	color	of	a	specific	color	cell	in	

the	colormap.

• Use	the	Index	selection	arrow	

(1)	or	the	Index	field	(2)	to	

select	a	color	cell.

• Adjust	the	color	cell	color	

using	the	RGB	input	fields	(3),	

the	HSV	input	fields	(4),	or	the	

Color	Name	drop-down	(5).
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• Draw	Cells:	When	selected	allows	

users	to	draw	color	channels	on	

the	interface	(1).	Color	channels	

can	be	enabled/disabled	by	

clicking	on	the	color	buttons	at	

the	bottom	of	the	window	(2).

• Adjust	Bins:	Allows	users	to	

interactively	manipulate	bins	and	

the	color	ranges	of	bins.	Adjust	

Bins	is	the	default	selection.

• Bins	are	indicated	by	the	black	

vertical	lines	on	the	color	map	

plot.	To	adjust	a	bin	range,	

select	the	black	control	point	

at	the	top	of	the	vertical	black	

bin	line	(1)	and	move	the	line	

to	the	left	or	right	to	increase	

or	decrease	the	bin	range.

• The	Red,	Green,	and	Blue	

color	channels	can	be	adjusted	

for	each	bin.	Each	color	

channel	has	a	Start	point	and	

an	End	point.	To	adjust	select	

the	start	or	end	point	(2)	for	a	

color	channel	and	move	it	up	

or	down	to	adjust.

• Apply	Changes	to	Input	Data:	must	be	

selected	in	order	to	apply	the	colormap	

to	the	image	data.	If	not	selected	

before	closing	the	Edit	Colormap	

window	or	adjusting	the	slice	display	all	

work	on	the	colormap	will	be	lost.
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• Right	mouse	menu	options:	Right-clicking	in	the	colormap	plot	display	will	reveal	

additional	options	depending	on	the	current	Action	selected.	These	options	

include:	.

• Delete	Bin:	When	selected	deletes	the	current	Bin	(available	for	Adjust	Bin	

Action	only).

• Split	Bin:	When	selected	splits	the	current	Bin	into	two	bins	(available	for	Adjust	

Bin	Action	only).

• Set	Range:	Opens	the	Set	Color	Range	window	allowing	users	to	specify	the	

color	for	a	range	of	color	cells.

• Start	Cell:	Specify	the	starting	color	cell.

• End	Cell:	Specify	the	ending	color	cell.

• Set	Cell	Range	to:	

• Single	Color:	Select	a	single	color	for	the	color	cell	range.		

• Fade	Between	To	Colors:	Allows	users	to	specify	two	colors	to	fade	

between	for	the	specified	color	cell	range	

• Start	Color:	Specify	the	Starting	color.	When	Single	Color	is	selected	this	is	

the	only	option.	

• End	Color:	Specify	the	Ending	color.

• OK:	Closes	the	Set	Range	window.

• Apply:	Applies	the	edits	to	the	colormap.
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• Reset:	Resets	the	colormap.

• Hide	Colorbar:	Disables/Enables	the	colorbar	on	the	display	of	the	2D	image

• Display	Colorbar:	Disables	the	colormap	on	the	grayscale	image	data.	To	

enable	the	colormap	again	right-click	on	the	grayscale	data	and	choose	

Colormap	and	then	uncheck	Disable	Colormap.

• Remove:	Removes	colormap	from	the	image	data.

• Grayscale:	Sets	the	colormap	to	a	grayscale	colormap

• Rainbow:	Sets	the	colormap	to	a	Rainbow	colormap

• Random:	Sets	the	colormap	to	a	Random	colormap

• Load:	Load	an	existing	colormap	(.lkup)	file	(see	Load).

• Save:	Save	the	current	colormamp	(.lkup)	file.

Load:	Allows	users	to	navigate	to	and	load	an	existing	colormap	.lkup	file.	A	selection	of	predefined	colormaps	can	be	downloaded	from	
analyzedirect.com/data

Save:	Saves	the	current	colormap	.lkup	file.

Edit: Opens	the	Edit	Colormap	window.

Hide Colorbar:	Disables/Enables	the	colorbar	on	the	display	of	the	2D	image

Display Colorbar: Disables	the	colormap	on	the	grayscale	image	data.	To	enable	the	colormap	again	right-click	on	the	grayscale	data	
and	choose	Colormap	and	then	uncheck	Disable	Colormap.

Remove:	Removes	the	colormap	from	the	image	data.
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Primary Panel

The	primary	panel	option	allows	any	

of	the	display	images	to	be	set	as	the	

primary	image.

Axial: Makes	the	axial	image	the	
primary	image.	[1]

Coronal: Makes	the	coronal	image	
the	primary	image.

Sagittal: Makes	the	sagittal	image	
the	primary	image.

Oblique: Available	when	the	Oblique	
option	is	selected.	Makes	the	oblique	

image	the	primary	image.

3-D:	Makes	the	current	selected	3-D	
display	the	primary	image.
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The	3D	checkbox	adds	a	three	

dimensional	display	window	to	the	

current	collection	of	displays	and	

enables	the	selection	of	the	type	of	

3D	visualization	depicted	in	the	3D	

display	window.

3D Images
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The	Intersecting	Sections	option	

displays	a	3D	data	set	via	orthogonal	

section	displays.	Intersecting	

Sections	shows	three	slices	that	can	

be	controlled	using	the	X/Y/Z	values	

in	the	image	display	or	interactively	

selected	by	choosing	the	planes	in	

the	intersecting	sections	display.

In	the	lower	left-hand	corner	of	

the	Intersecting	Sections	display	

window	are	the	Intersecting	Sections	

navigation	controls.

Intersecting Sections

X:	Controls	the	Sagittal	(XZ)	slice	viewed	in	the	display.	Left	click	the	X	control	option	and	the	cursor	will	update.	Hold	down	the	left	mouse	

button	and	slide	the	cursor	up	to	increase	and	down	to	decrease	the	X	value.	Users	can	also	right-click	and	select	First,	Middle,	or	Last.

Y:	Controls	the	Coronal	(YZ)	slice	viewed	in	the	display.	Left	click	the	Y	control	option	and	the	cursor	will	update.	Hold	down	the	left	mouse	

button	and	slide	the	cursor	up	to	increase	and	down	to	decrease	the	Y	value.	Users	can	also	right-click	and	select	First,	Middle,	or	Last.	

Z:	Controls	the	Axial	(XY)	slice	viewed	in	the	display.	Left	click	the	Z	control	option	and	the	cursor	will	update.	Hold	down	the	left	mouse	

button	and	slide	the	cursor	up	to	increase	and	down	to	decrease	the	Z	value.	Users	can	also	right-click	and	select	First,	Middle,	or	Last.	
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X/Y/Z Right-click options: The	three	slice	display	
controls	also	provide	the	following	configuration	options	

by	right-clicking:

• Show (X, Y, or Z):	Allows	users	to	enable	and	disable	
the	current	slice	orientation	display.

• Color Edges:	Allows	users	to	enables	and	disable	the	
color	edges	around	the	slice	displays.

• Show Hidden Edges:	Only	available	when	Color	
Edges	is	enabled.	Allows	users	to	enable	and	disable	

hidden	edges	of	the	slice	displays.

Rot:	The	Rotation	tool,	reports	the	current	XYZ	rotation	
angle	coordinates.	When	selected,	enables	the	rotate	

cursor.	Right-click	on	the	tool	to	choose	from	rotation	

default	options;	Front,	Back,	Left,	Right,	Top,	Bottom	and	

Angled.

Right menu options:

• Copy to clipboard: Saves	the	current	Intersecting	
Section	image	to	memory.	This	can	be	pasted	(Ctrl	+	

v)	into	the	Analyze	15.0	workspace,	to	be	saved	out	of	

the	software,	or	pasted	into	any	other	application.	

• Save Intersecting Sections:	When	selected	saves	a	
recording	of	the	Intersecting	Section	display	to	the	

current	Analyze	15.0	workspace.	
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Cube	Sections	shows	images	on	the	face	of	a	

cube	representing	the	data	set,	with	controls	to	

select	the	slices	numerically	in	the	window	or	by	

interactively	grabbing	an	image	on	the	cube.	

The	following	navigation	controls	are	in	the	

lower	lefthand	corner	of	the	display	window:

X: Controls	the	Sagittal	(XZ)	slices	viewed	in	the	
display.	Left	click	on	the	X	control	to	update	the	

cursor.	Hold	down	the	left	mouse	button	and	

slide	the	cursor	up/down	to	increase/decrease	

the	minimum	X	value	and	left/right	to	increase/

Cube Sections

decrease	the	maximum	X	value.	Users	can	also	right-click	and	select	Full,	10	%,	25	%,	or	33	%.

Y: Controls	the	Coronal	(YZ)	slice	viewed	in	the	display.	Left	click	on	the	Y	control	to	update	the	cursor.	Hold	down	the	left	mouse	button	
and	slide	the	cursor	up/down	increase/decrease	the	minimum	Y	value	and	left/right	to	increase/decrease	the	maximum	Y	value.	Users	can	

also	right-click	and	select	Full,	10	%,	25	%,	or	33	%.	

Z: Controls	the	Axial	(XY)	slice	viewed	in	the	display.	Left	click	on	the	Z	control	to	update	the	cursor.	Hold	down	the	left	mouse	button	and	
slide	the	cursor	up/down	to	increase/decrease	the	minimum	Z	value	and	left/right	to	increase/decrease	the	maximum	Z	value.	Users	can	also	

right-click	and	select	Full,	10	%,	25%,	or	33%.	

X/Y/Z Right-click option:	Color	Edges	-	Allows	users	to	enables	and	disable	the	color	edges	around	the	Cube	Sections	display.

Rot:	The	Rotation	tool,	reports	the	current	XYZ	rotation	angle	coordinates.	When	selected,	enables	the	rotate	cursor.	Right-click	on	the	tool	
to	choose	from	rotation	default	options;	Front,	Back,	Left,	Right,	Top,	Bottom	and	Angled.

Right menu options: Copy to clipboard:	copies	the	current	Cube	Section	image.	Save Cube Sections:	saves	display	to	the	Workspace.
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Wire	Grid	generates	and	displays	a	plot	of	the	

current	slice	intensities.	Options	available	are:

Slice:	Allows	navigation	through	slices	data.

Orient:	Allows	change	of	display	orientation.

Spacing:	Allows	different	sampling	of	points	in	
the	slice	for	the	wire	grid	display.	Small	values	

result	in	fine	sampling	and	large	values	result	in	

coarse	sampling.	Values	in	the	range	of	5	-	10	

are	a	recommended	starting	point.

Wire Grid

Xspace: Adjusts	the	row	increment	determining	which	rows	of	the	slice	are	sampled	for	the	display	of	the	wire	grid.

Yspace: Adjusts	the	column	increment	determining	which	rows	of	the	column	are	sampled	for	the	display	of	the	wire	grid.	

Scale: Scale	allows	for	the	specification	of	the	display	size	of	the	wire	grid.	The	default	values	are	1.	for	X	and	Y	and	0.1	for	Z.

Xscale: Specifies	the	x	scale	used	to	determine	the	width	of	the	wire	grid.

Yscale: Specifies	the	y	scale	used	to	determine	the	width	of	the	wire	grid.

Zscale: Specifies	the	z	scale	used	to	determine	the	width	of	the	wire	grid.

Rot: The	Rotation	tool	allows	users	to	rotate	the	display	of	the	wire	grid.	

Right mouse menu options: Copy to clipboard: Saves	the	current	wire	grid	image	to	memory.	This	can	be	pasted	(Ctrl	+	v)	into	the	Analyze	
15.0	workspace,	to	be	saved	out	of	the	software,	or	pasted	into	any	other	application.	Save Wire Grid:	When	selected	saves	a	recording	of	

the	Wire	Grid	display	to	the	current	Analyze	15.0	workspace.
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The	Render	option	enables	a	3D	

volume	rendering	in	the	3D	display	

window.	Display	uses	ray	casting	

algorithms	to	rapidly	generate	volume	

rendered	displays	of	two	classes;	

Transmission	displays	(Projections)	

and	Reflections	displays	(Surface).		

Transmission displays (Projections): 
Models	the	image	voxels	as	light	

emitters	and	do	not	involve	explicit	

surface	detection.	A	display	pixel’s	

value	is	computed	as	a	function	of	

the	ray	passing	through	the	entire	

volume.

Render

Reflection displays (Surface):	Models	the	image	voxels	as	light	reflectors	and	require	the	detection	of	surfaces	within	the	volume.	The	basic	
reflection	algorithms	consider	the	first	voxel	encountered	by	the	ray	which	is	within	the	threshold	parameters	to	be	the	surface	voxels	to	be	

rendered.	The	algorithms	differ	in	how	the	detected	surface	voxels	are	rendered	on	the	screen.	

By	default,	a	voxel	gradient	shaded	rendering	is	shown,	with	controls	for	threshold	selection	and	rotation	angle.	Clicking	and	dragging	the	

rendering	with	the	middle	mouse	button	controls	the	rotation	angle.	
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While	the	tools	available	for	the	slice	and	render	display	windows	are	covered	in	section	2.	Image	Display,	Controls	and	Customization	of	

this	user’s	guide,	the	render	window	in	Display	has	some	additional	features	that	are	only	available	to	users	from	the	Display	module.	These	

features	will	be	reviewed	in	more	detail	in	this	section	of	the	guide.	

The	display	module	render	window	is	comprised	of	several	elements	and	tools:	1)	the	cursor	link	tool,	2)	the	navigation	tool,	3)	the	zoom	

tool,	4)	the	pan	tool,	5)	the	max/min	intensity	adjustment	tools,	6)	the	right	mouse	menu	options,	and	7)	additional	rendering	controls.

The Display Module Render Window
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The Cursor Link: The	cursor	link	allows	users	to	interactively	navigate	through	the	image	data.	The	tool	is	only	enabled	if	the	All	
Orientations,	Single	Image,	or	Oblique	Image	display	configurations	are	enabled,	otherwise	to	the	Cursor	Link	tool	is	disabled.	The	Cursor	

Link	tool	can	be	controlled	from	the	3D	rendering	or	from	any	of	the	2D	orientations.	Moving	the	tool	on	the	rendering	will	interactively	

update	the	orthogonal	slice	displays.	The	cursor	linked	can	be	enabled	or	disabled	using	the	Toggle	Cursor	Link	button.

The Navigation tool: The	Navigation	Icon	is	not	just	a	reference	for	the	current	orientation	of	the	3D	image	data,	the	tool	also	allows	
users	to	rotate	the	data	or	specify	a	standard	view;	front,	back,	left,	right,	top,	bottom.	To	rotate	the	data,	left-click	on	the	Navigation	Icon	

and	hold	the	left	mouse	button	down.	The	cursor	will	update	to	the	rotate	cursor	enabling	interactive	rotation	of	the	rendering	viewpoint.	

Releasing	the	left	mouse	button	will	dismiss	the	rotate	cursor.

The Zoom tool:	The	Zoom	tool	in	the	Rendering	Window	allows	users	to	increase	and	decrease	the	display	size	of	the	data.	For	more	
information	refer	to	the	Zoom	tool	description	in	section	2.	Image	Display,	Controls	and	Customization.

The Pan tool: The	Pan	tool	is	automatically	enabled	when	the	Zoom	size	of	the	image	is	larger	than	the	current	window.	Clicking	in	the	tool	
allows	users	to	Pan	the	zoomed	area	over	the	current	display.

The Max/Min Intensity Adjustment tool:	The	Maximum	and	Minimum	display	intensities	for	the	rendering	can	be	changed	by	clicking	on	
the	yellow	Max/Min	Tool	at	the	bottom	right	corner	of	the	window.	A	cursor	will	return	that	allows	the	values	to	be	manipulated.	Hold	down	

the	left	mouse	button	and	move	the	mouse	up/down	or	left/right.

Right Menu Options:	Right-clicking	in	the	Rendering	Window	reveals	additional	options.	Most	of	these	options,	if	available,	are	covered	in	
the	Slice	Display	section,	however,	there	are	few	additional	configuration	options	specific	to	the	Rendering	window.

• Middle	Button	Action:	Allows	action	setting	of	the	middle	mouse	button.	See	the	Slice	Display	section	for	additional	information.	

• Mouse	Wheel	Action:	Allows	action	setting	of	the	middle	mouse	wheel.	See	the	Slice	Display	section	for	additional	information.

The Display Module Render Window (continued)
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Right Menu Options (continued):

• Copy to Clipboard: Copies	the	current	rendering	display	to	
memory.

• Hide Colorbar:	Allows	users	to	hide	or	show	the	colorbar	when	
available.

• Disable Colormap: Allows	users	to	enable	or	disable	the	
colormap	when	available.

• Cursor Link: Toggles	the	Cursor	Link	tool	Off/On	in	the	current	
display.	

• Interactive Render: Allows	users	to	selects	between	Reduced	
Quality	(useful	for	interactive	rotation	of	extremely	large	image	

volumes)	and	Full	Quality.

• Object Movement:	Object	Movement	allows	users	to	
manipulate	the	location	of	disabled	objects.

• Disabled	–	disable	object	movements.

• Translation	–	allows	X,	Y,	and	Z	translations	to	be	applied	to	

the	selected	object.

• Rotation	-	allows	X,	Y,	and	Z	rotations	to	be	applied	to	the	

selected	object.

The Display Module Render Window (continued)
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Right Menu Options (continued):

• Reset	‘Object-x’	Movements	–	rests	all	translations	and	

rotations	for	the	current	object.

• Reset	All	Movements	–	rests	all	translations	and	rotations	for	

all	objects.

• Render Annotations

• Volume	Edges	–	when	selected	draws	the	volume	edges	on	

the	rendered	image.

• Clips	Edges	-	when	selected	draws	the	clip	edges	on	the	

rendered	image.

• Back	Drop	-	When	selected	displays	a	shaded	backdrop	in	

the	rendered	images.

• Color	–	Allows	users	to	change	the	color	of	the	Volume	

Edges,	Clip	Edges,	or	Background	Render	Annotations,	

when	enabled.

• Sequencer	–	allows	users	to	enable	the	Sequencer	tool	for	
movie	creation	(see	Sequencer	for	further	information.)

The Display Module Render Window (continued)
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Right Menu Options (continued):

• Parametric Mapping –	Allows	creation	of	renderings	with	related	parametric	maps.	When	
the	option	is	selected	the	Parametric	Mapping	window	opens.

• Workspace	-	allows	users	to	select	the	workspace	containing	the	related	volume	to	be	

used	for	parametric	mapping.

• File	-	allows	users	to	select	the	volume	to	be	used	for	parametric	mapping.

• Enable	Parametric	Mapping:	Toggles	On	and	Off	the	mapping	of	the	related	volume	on	

the	rendered	surface.

The Display Module Render Window (continued)

• Mapping	Factor:	Allows	users	to	adjust	the	contribution	of	the	related	volume	when	combining	the	rendering	of	the	input	volumes.	

Increasing	the	mapping	factor	provides	a	clearer	display	of	the	related	volume.	

• Map	Transparency	Value:	Allows	users	to	adjust	the	transparency	value	of	the	related	volume.
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Right Menu Options (continued):

• Specular Reflection: The	Specular	Reflection	rendering	option	is	available	for	the	
Gradient	Shading,	Transparency	and	Volume	Compositing	render	types.	When	the	

option	is	selected	the	Specular	Reflection	window	opens.

• Specular	Reflection	-	Choose	from	Off	or	On	to	determine	whether	Specular	

Reflection	is	used	to	render	the	volume.	Specular	Reflection	causes	the	

highlights	on	the	shiny	surface	(1).	

• Factor	-	Specifies	the	percentage	of	the	shading	that	is	done	in	Specular,	0.00	to	

1.00.	The	rest	of	the	shading	is	flat	shaded.	

The Display Module Render Window (continued)

• Exponent	-	Controls	the	falloff	rate	of	the	shading.	For	example,	a	shiny	surface	has	a	high	falloff	rate,	giving	a	small	bright	spot.	A	

more	diffuse	surface,	has	a	much	lower	falloff	rate,	and	thus	a	lower	exponent.
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Right Menu Options (continued):

• Lighting: The	Lighting	options	allows	users	to	specifying	the	location	of	the	light	
source	used	in	reflective	renderings.	This	option	is	available	for	the	Gradient	

Shading,	Transparency	and	Volume	Compositing	render	types.	When	selected	a	

Lighting	window	opens	providing	the	following	options:	

• Horizontal	-	Specifies	the	horizontal	angle	(azimuth)	of	the	light	source	(in	

degrees)	with	respect	to	the	viewpoint.	

• Vertical	-	Specifies	the	vertical	angle	(elevation)	of	the	light	source	(in	degrees)	

with	respect	to	the	viewpoint.		

The Display Module Render Window (continued)

• Brightness	-		–	Specifies	the	brightness	of	the	light	source	with	respect	to	the	viewpoint.

• Save Rendering	–	saves	the	current	rendering	to	the	Analyze	workspace.

• Render Options	–	Allows	users	to	enable/disable	additional	rendering	options,	these	include:

• Show	Render	Type	-	Allows	users	to	view	and	change	the	rendering	algorithm	used	to	render	the	image	data,	choose	from	Depth	

Shading,	Gradient	Shading	(default	option),	Volume	Compositing,	Maximum	Intensity	Projection,	Summed	Voxel	Projection,	Surface	

Projections,	and	Object	Compositing.	Double	click	on	the	Render	Type	option	to	cycle	through	the	render	types	or	right-click	and	

choose	a	specific	render	type	from	the	right	mouse	menu.	For	more	information	about	render	types	and	the	render	type	specific	

options	please	refer	to	the	3D	Rendering	section	of	Display.

• Show	Rotation	-	Reports	the	current	XYZ	rotation	angle	coordinates.	When	selected,	enables	the	rotate	cursor.	Right-click	on	the	tool	

to	choose	from	rotation	default	options;	Front,	Back,	Left,	Right,	Top,	and	Bottom.
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Right Menu Options (continued): 

• Show	Threshold:	Displays	the	current	Threshold	maximum	and	minimum	threshold	values.	Double	clicking	allows	users	to	enter	

values.	Right	click	to	specify	Preset	values	or	choose	from	Analyze	Default,	Calculated	Max/Min,	and	DataType	Max/Min.

• Show	Clip	Plane:	Enables	the	Clip	Plane	tool	allowing	users	to	specify	the	maximum	and	minimum	depth	along	the	ray	path	between	

which	voxels	are	rendered.	Clipping	is	particularly	helpful	when	you	need	to	observe	the	cross	section	of	a	3D	object.	

• Show	Clip	Volume:	Enables	the	Clip	Volume	tool,	allowing	users	to	clip	the	volume	with	six	clip	planes	(X	low,	X	high,	Y	low,	Y	high,	Z	

low,	and	Z	high).

• Show	Render	Size:	Displays	the	current	rendering	size	and	allows	the	user	to	enter	the	rendering	Width,	Height,	and	Depth.	Right	

click	to	choose	from	Default,	Maximum	Diagonal,	Double	Diagonal,	Axial,	Coronal,	and	Sagittal.

• Background Color	–	allows	users	to	set	the	color	of	the	rendering	background.	The	option	opens	a	Color	selection	window	enabling	
selection	of	desired	color.

• Transparency	-	The	Transparency	option	turns	transparent	rendering	on	or	off.	The	transparency	rendering	mode	is	useful	for	visualizing	
objects	contained	within	objects	or	objects	with	views	obscured	by	other	objects.	Object	opacity	levels	can	be	set	using	the	Opacity	

options	in	the	Object	Control	window.

• Background Opacity -	The	Background	Opacity	option	is	only	available	when	Transparency	rendering	is	enabled.	The	option	allows	
users	to	specify	the	background	opacity	for	the	transparency	rendering.	

• Print	-	Sends	capture	of	current	slice	display	to	printer.	

• Reset	-	Resets	all	options	to	default.

The Display Module Render Window (continued)
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The	additional	rendering	controls	provide	access	to	tools	and	rendering	options	only	accessible	from	the	Display	module:

Type:	Allows	users	to	select	which	type	of	rendering	algorithm	to	use	to	create	the	3D	rendering	of	the	image	data.	The	following	Render	
Type	options	are	available:	Depth	Shading,	Gradient	Shading,	Volume	Compositing,	Maximum	Intensity	Projection,	Summed	Voxel	

Projection,	Surface	Projection,	and	Object	Compositing.	Each	type	is	displayed	below	and	summarized	in	the	table	that	follows.

Additional Rendering Controls
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Render Type Description

Depth	Shading The	value	of	each	output	pixel	is	a	function	of	depth	only.	The	depth	of	the	first	renderable	voxel	found	along	the	ray	

path	is	used	to	determine	the	brightness	of	that	voxel.	Closer	voxels	will	appear	brighter	than	more	distant	voxels.

Gradient	Shading	

(Default)

The	grayscale	gradient	vector	is	computed	using	a	3D	neighborhood	about	the	surface	voxel.	The	value	projected	

at	each	output	location	is	the	dot	product	of	the	gradient	vector	and	an	independently	specified	light	source	

vector.	This	simulates	the	appearance	of	a	reflective	surface	under	uniform-field	illumination.

Volume	Compositing Volumetric	compositing	integrates	the	gradient-shaded	value	of	all	voxels	along	the	ray	path.	The	contribution	of	

each	gradient-shaded	voxel	value	is	weighted	by	color	and	opacity	values.	The	color	and	opacity	information	for	

each	intensity	is	specified	using	the	Alpha	map	window.

Maximum	Intensity	

Projection

The	maximum	voxel	intensity	along	the	ray	path	is	used.

Summed Voxel 

Projection

The	average	of	all	voxels	along	the	ray	path	is	used.

Surface	Projection The	algorithm	searches	down	the	ray	for	a	voxel	that	is	within	the	current	threshold	range.	Then,	it	skips	the	first	S	

voxels	along	the	ray,	where	S	is	specified	by	the	Surface	Skip	value.	Last,	it	returns	the	average	of	the	next	T	values,	

where	T	is	specified	by	the	Surface	Thickness.	The	surface	projection	rendering	can	be	limited	to	enabled	objects	

if	an	object	map	is	loaded.

Object	Compositing Available	only	when	an	object	map	is	loaded	with	the	data	set.	Produces	24-bit	color	renderings	where	the	voxel	

mapping	along	each	ray	path	is	controlled	by	the	Composite	Type	yellow	text.

Display Rendering Types
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Depth Shading

In	Depth	Shading	the	value	of	each	

output	pixel	is	a	function	of	depth	

only.	The	depth	of	the	first	renderable	

voxel	found	along	the	ray	path	is	

used	to	determine	the	brightness	of	

that	voxel.	Closer	voxels	will	appear	

brighter	than	more	distant	voxels.
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Gradient Shading

In	Gradient	Shading	the	grayscale	

gradient	vector	is	computed	using	

a	3D	neighborhood	about	the	

surface	voxel.	The	value	projected	

at	each	output	location	is	the	dot	

product	of	the	gradient	vector	and	an	

independently	specified	light	source	

vector.	This	simulates	the	appearance	

of	a	reflective	surface	under	uniform-

field	illumination.
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Volume Compositing

Volume	Compositing	(also	know	as	

Volumetric	Compositing)	integrates	

the	gradient-shaded	value	of	all	

voxels	along	the	ray	path.	The	

contribution	of	each	gradient-shaded	

voxel	value	is	weighted	by	color	and	

opacity	values.	The	color	and	opacity	

information	for	each	intensity	is	

specified	using	an	Alpha	map	created	

via	the	Tissue	Map	window.

• Tissue Map:	When	the	Volume	
Compositing	render	option	is	

selected	the	Tissue	Map	option	

is	automatically	displayed	above	

the	Type	option.	A	default	tissue	

map loaded is loaded and used 

to	render	the	image	data.	Tissue	

Map	Right	Click	options	are	as	

follows:
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Volume Compositing (continued)

Right Click Options

• Data	Tissue	Maps:	Allows	users	to	select	any	tissue	

maps	previously	created	and	saved	for	this	data	type.

• User	Tissue	Maps:	Allows	users	to	select	any	tissue	

maps	they	may	have	previously	created	and	saved.	

• System	Tissue	Maps:	Allows	users	to	select	any	system	

tissue	maps	created,	saved	and	shared	by	other	users.	

Also	allows	access	to	the	tissue	maps	distributed	with	

the	program.	

• Palette:	Opens	the	Tissue	Map	Palette.	This	window	

provides	a	preview	of	the	current	data	with	all	available	

Data,	User,	and	System	Tissue	Maps.	Double	click	on	

any	of	the	preview	icons	to	apply	that	tissue	map	to	the	

image	data.

• Browse:	Allows	users	to	browse	the	system	for	tissue	

maps.
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Volume Compositing (continued)

Right Click Options (continued)

• Edit:	Opens	the	Tissue	Map	tool.	Double-clicking	on	the	Tissue	Map	text	will	also	open	this	tool.	

The Tissue Map tool	-	provides	an	interface	to	allow	users	to	create	or	edit	tissue	maps	by	choosing	color	and	opacity	(alpha)	values	for	
tissue	maps.	The	tool	consists	of:	1)	The	parameters	area,	2)	the	colorbar,	3)	the	parameter	display,	4)	the	tissue	list,	and	5)	the	image	map.
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Volume Compositing (continued)

The Tissue Map tool (continued)

(1)	The	Parameters	Area:	The	parameters	area	allows	users	to	assign	color	

and	opacity	values	to	ranges	of	voxels	based	on	intensity.	

• To	set	a	range	of	voxels	for	the	tissue	map	use	the	Start/End	and	Min/

Max	controls.

• To	assign	a	color	to	each	parameter	use	the	color	assignment	drop-

down	menu	or	click	on	the	color	selector	next	to	the	drop-down	

menu.

• To	adjust	the	selected	tissue	opacity	level	use	the	opacity	drop-down	

menu.

(2)	The	Colorbar:	Displays	the	tissue	maps	color	bar.

(3)	The	Parameter	Display:	Displays	an	interactive	graphical	representation	

of	the	tissue	map	parameters	over	a	plot	of	the	image	histogram.

(4)	The	Tissue	List:	Displays	the	current	tissues	within	the	tissue	map.	•	

To	add	a	tissue,	click	the	‘+’	key.	To	remove	a	tissue,	select	a	tissue	and	

then	click	the	‘-‘	key.

(5)	The	Image	Map:	The	image	map	area	previews	the	tissue	map	

parameters	on	the	current	2D	image.	
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Maximum Intensity Projection

In	Maximum	Intenstiy	Projection	the	

maximum	voxel	intensity	along	the	

ray	path	is	used.	

Weighting:	On/Off	-	MIP	Weighting	
enables	the	specification	of	

performance	of	weighting.

• Off:	This	is	the	default	state;	no	

weighting	is	applied.	

• On:	When	selected	weighting	is	

applied.	Before	the	value	of	the	

voxel	is	compared	to	see	if	it	is	

the	maximum	voxel,	its	value	is	

weighted	by	the	percentage	of	its	

distance	along	the	ray	path.
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Summed Voxel Projection

In	Summed	Voxel	Projection	the	

average	of	all	voxels	along	the	ray	

path	is	used.
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Surface Projection

In	Surface	Projection	the	algorithm	

searches	down	the	ray	for	a	voxel	that	

is	within	the	current	threshold	range.	

Then,	it	skips	the	first	S	voxels	along	

the	ray,	where	S	is	specified	by	the	

Surface	Skip	value.	Last,	it	returns	the	

average	of	the	next	T	values,	where	T	

is	specified	by	the	Surface	Thickness.	

The	surface	projection	rendering	can	

be	limited	to	enabled	objects	if	an	

object	map	is	loaded.

• Surface Skip:	Indicates	the	
number	of	voxels	to	skip	once	

a	renderable	voxel	has	been	

detected,	before	summing	of	the	

thickness	begins.

• Surface Thickness:	Specifies	
the	maximum	thickness	for	the	

rendered	surface.
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Object Compositing

Object	Compositing	is	available	only	

when	an	object	map	is	loaded	with	

the	data	set.	This	rendering	option	

produces	24-bit	color	renderings	

where	the	voxel	mapping	along	

each	ray	path	is	controlled	by	the	

Composite	Type	yellow	text.

Composite Type: The following 

composite	type	options	are	available.

• Transparency	-	Opacity,	Thickness	

and	Color	parameters	for	each	

object	are	used	to	determine	the	

contribution	of	each	visible	object	

voxel	along	the	ray	path.

Display Rendering Types

• Summed	Object	-	The	object	color	contributions	for	each	visible	voxel	along	the	ray	path	are	summed	and	then	divided	by	the	total.

• Maximum	Object	-	The	object	which	contributes	the	maximum	number	of	voxels	along	each	ray	path	is	rendered.

• Maximum	Contiguous	Object	-	The	object	which	contributes	the	longest	contiguous	span	of	voxels	along	each	ray	path	is	rendered.
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Object Compositing (continued)

Object Compositing Options:	Surface	Shading,	Size	Scaling,	and	Position	Scaling	options	are	available	for	certain	composite	types.	These	
options	are	not	available	for	Transparency.	Size	and	Position	Scaling	are	available	for	Maximum	Contiguous	Object	methods.

• Surface	Shading:	Adds	gradient-based	surface	shading	to	the	output	rendering	when	this	option	is	enabled.

• Size	Scaling:	The	count	of	voxels	belonging	to	the	rendered	objects	is	used	to	weight	the	rendered	contribution	of	that	object	along	

the	ray.		Larger	counts	will	be	brighter,	fewer	will	be	darker.		This	provides	further	visual	information	in	the	rendering	with	respect	to	the	

relative	size	of	the	object	along	the	ray.	

• Position	Scaling:	The	output	rendering	weighted	by	the	relative	position	of	the	first	voxel	rendered	for	the	object	along	the	ray	path.		

This	provides	visual	cues	to	show	relative	object	position,	with	closer	objects	being	brighter	than	those	occuring	later	down	the	ray	path.
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Object Compositing (continued)

Rot:	Reports	the	current	XYZ	rotation	angle	coordinates.	When	selected,	enables	the	rotate	cursor.	Right-click	on	the	tool	to	choose	from	
rotation	default	options;	Front,	Back,	Left,	Right,	Top,	Bottom	and	Angled.	

Thresh:	The	Threshold	option	displays	the	current	Threshold	maximum	and	minimum	values.	Editing	the	threshold	values	can	be	useful	to	
eliminate	noise,	airspace,	or	tissue	when	an	object	map	has	not	been	loaded.

• Clicking	the	yellow	Thresh	text	will	update	the	cursor	to	an	up/down/left/right	Threshold	(TRESH)	cursor.	Hold	down	the	left	mouse	

button	and	slide	the	cursor	forward	to	increase	the	minimum	threshold	value	and	backwards	to	decrease	it.	Slide	the	cursor	right	to	

increase	the	maximum	threshold	value	and	left	to	decrease	the	maximum	threshold	value.	

• Double	clicking	the	yellow	Thresh	text	allows	users	to	enter	minimum	and	maximum	threshold	values.	

• Right-click	to	specify	Preset	values	or	choose	from	Analyze	Default,	Calculated	Max/Min,	and	DataType	Max/Min.	
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Object Compositing (continued)

Render Size:	The	Render	Size	option	allows	users	to	specify	various	rendering	size	attributes.	The	options	include:	

• Width:	Specifies	the	display	width	for	the	rendered	image.

• Height:	Specifies	the	display	height	for	the	rendered	image.	

• Depth:	Specifies	the	depth	for	the	rendered	image.

Right click options:

• Default:	Sets	the	width	and	height	to	the	largest	input	volume	axis.	Depth	is	set	to	the	maximum	diagonal	(Square	Root	of	the	sum	of	the	

squares	of	each	input	axis).	

• Maximum	Diagonal:	Sets	the	width,	height	and	depth	to	the	maximum	diagonal.	

• Double	Diagonal:	Sets	the	width,	height	and	depth	to	double	the	diagonal	size.	

• Axial:	Sets	the	width	and	height	to	the	volume’s	width	and	height.	The	depth	is	set	to	the	maximum	width-depth	or	height-depth	

diagonal.	

• Coronal:	Sets	the	width	and	height	to	the	volume’s	width	and	depth.	The	depth	is	set	to	the	maximum	width-height	or	height-depth	

diagonal.	

• Sagittal:	Sets	the	width	and	height	to	the	volume’s	height	and	depth.	The	depth	is	set	to	the	maximum	width-height	or	width-depth	

diagonal.
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Stereo:	The	Stereo	option	allows	users	
to	generate	stereo	pairs	of	the	current	

rendered	image.	To	enable	stereo	

pairs	renderings,	click	on	the	yellow	

Stereo	text	or	right	click	and	check	the	

Stereo	option.	The	following	right-click	

options	are	available:

• Red-Blue:	Generates	a	rendering	

for	use	with	“Red-Blue”	glasses.	

• Red-Green:	Generates	a	rendering	

for	use	with	“Red-Green”	glasses.	

• Red-Blue:	Generates	a	rendering	

for	use	with	“Red-Blue”	glasses.
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Object Compositing (continued)

Scale: Enables	the	specification	of	scaling	factors	to	be	applied	to	the	inputs	during	the	rendering	process	specifying	the	size	of	the	
rendered	space.	The	following	options	are	available:

• X:	Specifies	the	X	scale	factor	used	to	render	the	X	axis,	defining	the	render	width.

• Y:	Specifies	the	Y	scale	factor	used	to	render	the	Y	axis,	defining	the	render	depth.

• Z:	Specifies	the	Z	scale	factor	used	to	render	the	Z	axis,	defining	the	render	height.
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Object Compositing (continued)

Stereo (continued)

• Red-Green:	Generates	a	rendering	for	use	with	“Red-Green”	glasses.	

• Cross	Fusion:	Generates	a	rendering	for	use	without	glasses.	The	viewer	uses	a	technique	of	crossing	their	eyes,	looking	at	the	left	image	

with	the	right	eye	and	vice-versa.	

• Interlaced:	Generates	a	rendering	where	every	other	line	comes	from	each	view	point.	Viewing	of	this	type	usually	requires	an	interlaced	

monitor	and	special	glasses	which	trigger	on	each	frames	display.

• Disparity:	Specifies	the	angle	between	the	viewpoints.	Half	for	each	view	point.

• Reverse	Left/Right:	When	selected,	swaps	the	viewpoints.

• Separation:	Available	only	for	Cross	Fusion,	this	value	specifies	the	number	of	voxels	which	separate	the	two	centers	of	the	two	

renderings.

Perspective: The	Perspective	rendering	tool	allows	users	to	create	perspective	renderings	of	the	image	data	based	on	eye/camera	and	look	
at	viewpoints.	The	tool	can	also	be	used	in	conjunction	with	the	Sequence	tool	to	create	fly-thru	movies.	Clicking	on	the	yellow	Perspective	

text	enables	Perspective	rendering.	See	the	Perspective	tool	for	further	information	on	perspective	rendering	and	movie	generation.

• Right	Click	Options

• Perspective:	Enable	or	disable	perspective	rendering.

• Perspective	Ray	Type:	Allows	users	to	choose	between	a	floating	point	or	integer	ray	type	for	perspective	rendering.	See	Ray	Type	

for	further	information.
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Object Compositing (Continued)

Perspective (continued)

• Field Of View:	The	Field	Of	View	(FOV)	
option	allows	users	to	specify	the	FOV	for	

generating	perspective	renderings.	Click	

the	yellow	Field	Of	View	text	and	move	the	

cursor	right	to	increase	the	FOV,	making	

the	rendering	appear	smaller.	Move	the	

cursor	left	to	decrease	the	FOV	and	the	

rendering	appear	larger.		Double-clicking	

the	yellow	Field	Of	View	text	allows	users	

to	manually	enter	FOV	parameters.	Right-

clicking	on	the	Field	Of	View	text	provides	

access	to	the	following	options:

Display Rendering Types

• Maintain	Aspect:	The	Maintain	Aspect	option	allows	users	to	disable	and	enable	aspect	maintenance.	Disabling	the	Maintain	Aspect	

option	allows	users	to	specify	different	X	and	Y	FOV	parameters,	allowing	for	the	creation	of	a	non-proportional	rendering.

• Default:	Sets	the	FOV	to	the	default	value,	approximately	a	XY	FOV	value	of	25.

• Zoom	In:	When	selected	decreases	FOV,	approximately	a	XY	FOV	value	of	12.5.

• Zoom	Out:	When	selected	increases	the	FOV,	approximately	a	XY	FOV	value	of	50.

• Zoom	Way	Out:	When	selected	increases	the	FOV,	approximately	a	XY	FOV	value	of	70.	
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Object Compositing (Continued)

Ray Type:	The	Ray	Type	option	allows	
users	to	switch	the	ray	indexing	type	

from	Integer	to	Float.	Switching	to	

float	will	improve	rendering,	however,	

the	best	results	will	typically	be	seen	

with	anisotropic	data.

Clip Plane:	The	Clip	Plane	tool	
allows	users	to	specify	the	maximum	

and	minimum	depth	along	the	ray	

between	which	voxels	are	processed	

for	inclusion	in	the	rendered	image.	

Voxels	outside	the	depth	range	are	

ignored.	

Display Rendering Types

Clicking	on	the	yellow	Clip	Plane	text	will	update	the	cursor	to	display	a	CLIP	cursor.	Hold	down	the	left	mouse	button	and	slide	the	cursor	

upwards	to	increase	the	Minimum	clip	value,	backwards	to	decrease	the	value.	Slide	the	cursor	left	to	decrease	the	Maximum	clip	value	and	

right	to	increase	the	Maximum	clip	value.	Double	click	on	the	Clip	Plane	text	to	manually	enter	the	minimum	and	maximum	clip	values

Right click options:

• Half	way:	When	selected	sets	the	minimum	clip	value	to	halfway	through	the	data	set.	

• Reset:	Resets	the	minimum	and	maximum	clip	values.
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Object Compositing (Continued)

Clip Plane Right Click Options (cont):	Clip	Shading:	The	Clip	Shading	option	specifies	the	type	of	shading	used,	choose	from:

• Depth:	Specifies	that	a	value	based	only	on	depth	is	used	to	create	the	shaded	pixel.

• Actual:	Specifies	that	the	gray	scale	value	of	the	intersected	voxel	is	used.

• Gradients:	Specifies	that	the	voxel	along	the	ray	path,	just	before	the	intersected	voxel,	is	temporarily	set	to	the	input	volume	minimum	

intensity	value	and	the	gradient	shading	is	calculated.
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Object Compositing (Continued)

Clip Vol:	The	Clip	Volume	tool	allows	
users	to	specify	a	sub-volume	of	the	

data	to	be	rendered	based	on	the	

X,	Y,	Z	coordinates	of	the	volume.	

Clicking	on	the	yellow	Clip	Vol	text	

will	update	the	cursor	to	display	a	

CLIP	cursor	and	volume	edges	will	

appear	around	the	rendered	image.	

Click	on	the	volume	edges	to	toggle	

through	the	planes	to	clip,	choosing	

from	Low	X,	High	X,	Low	Y,	High	Y,	

Low	Z	and	High	Z.

Display Rendering Types

Hold	down	the	left	mouse	button	and	slide	the	cursor	upwards	to	increase	the	plane	value,	backwards	to	decrease	the	value.

Double	click	the	text	to	manually	enter	the	volume	sub-volume	parameters:

• LX:	Low	X,	specifies	the	low	X	value.

• HX:	High	X,	specifies	the	high	X	value.

• LY:	Lox	Y,	specifies	the	low	Y	value.
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Object Compositing (Continued)

Clip Vol (continued): 

• HY:	High	Y,	specifies	the	high	Y	

value.

• LZ:	Low	Z,	specifies	the	low	Z	

value.

• HZ:	High	Z,	specifies	the	high	Z	

value.

Clip Vol Right Click Options:

• Reset:	Resets	the	minimum	and	

maximum	clip	values.

Display Rendering Types

• Clip	Shading:	The	Clip	Shading	option	specifies	the	type	of	shading	used.	Choose	from	the	following	options:

• Depth:	Specifies	that	a	value	based	only	on	depth	is	used	to	create	the	shaded	pixel.

• Actual:	Specifies	that	the	gray	scale	value	of	the	intersected	voxel	is	used.

• Gradients:	Specifies	that	the	voxel	along	the	ray	path,	just	before	the	intersected	voxel,	is	temporarily	set	to	the	input	volume	

minimum	intensity	value	and	the	gradient	shading	is	calculated.
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The	Parametric	Mapping	functionality	

provides	users	with	the	ability	to	

blend	the	rendering	of	two	image	

data	sets.	This	is	useful	for	displaying	

renderings	of	functional	data	with	

structural	data.	A	related	data	set	is	

loaded	via	the	Parametric	Mapping	

window	available	from	the	right	

mouse	menu	in	the	Render	window.	

The	related	image	must	be	registered	

with	the	base	data	set	beforehand	in	

order	for	it	to	be	used	as	a	parametric	

input	volume.

Download	the	MRI_Brain.avw	and	the	

PET_Brain.avw	to	follow	along	from

Parametric Mapping

https://analyzedirect.com/data.	Use	the	Input/Output	module	to	load	both	the	MRI_Brain.avw	and	the	PET_Brain.avw	data	sets.	Select	the	

MRI_Brain	data	set	and	then	open	Display.	In	Display	set	the	Display	Configuration	to	3-D	and	choose	the	Render	option	(1).	Uncheck	the	

Image(s)	option.	

Change	the	orientation	of	the	brain	to	right	using	the	Navigation	icon	(2).	Right-click	in	the	Render	window	and	choose	Parametric	Mapping	

from	the	menu	options	(3).

In	the	Parametric	Mapping	window	choose	the	PET_Brain	data	set	from	the	File	drop	down	(4).	If	the	data	resides	in	another	Workspace	

select	that	workspace	using	the	Workspace	drop	down.	Alternatively,	drag-and-drop	the	related	image	from	the	workspace	onto	the	

Parametric	Mapping	window.
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The	Parametric	rendering	will	be	

displayed.

Adjust	the	Mapping	Factor	and	

observe	the	effect	on	the	rendering.

Parametric Mapping (Continued)
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Creating a Basic Movie

The	Sequence	tool	provides	users	

with	an	intuitive	interface	to	quickly	

create	impressive	movies	of	the	

rendered	image	data.	

Download	the	Mouse_Lungs.avw	

data	set	to	follow	along,	from	https://

analyzedirect.com/data.•

Use	the	Input/Output	module	to	load	

the	Mouse_Lungs.avw.

Select	the	Mouse_Lungs	data	set	and	

then	open	Display.

Sequence Tool

In	Display	set	the	Display	Configuration	to	3-D	and	choose	the	Render	option.	Uncheck	the	Image(s)	option.	(1)

Right-click	in	the	Render	window	and	select	Sequencer	from	the	menu	(2).	The	Sequencer	tool	will	be	displayed	below	the	rendering.	(3)

Click	the	Add	Key	Frame	button	(4)	to	add	a	starting	key	frame	to	the	sequencer	(5).
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Double-click	the	Yellow	Thresh	text	

in	the	lower	left-hand	corner	of	the	

Render	window	and	change	the	

minimum	value	to	2200	(6).	Note	the	

updated	rendering.	(7).

Click	the	Add	Key	Frame	button	

(8)	to	add	a	new	key	frame	to	the	

sequencer	(9).

Left	click	the	Transition	button	(10)	

between	the	key	frames	to	open	the	

Transition	parameters	window	(11),	

here	set	the	number	of	Frame(s)	to	30	

(12).

Sequence Tool (continued)

Click	the	Preview	Sequence	button	(13)	to	preview	the	movie.

To	save	the	movie	to	the	Analyze	workspace	select	Generate	and	Save.	(14).

In	the	Window	returned	name	the	movie	(15)	and	then	select	Render	Sequence	

(16).	The	movie	file	will	be	saved	to	the	workspace.	Use	the	Input/Output	

module	to	save	the	movie	out	of	the	software	as	an	.AVI,	QuickTime,	or	

Animated	GIF.
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Creating a Rotational Movie

Download	the	Mouse_Lungs.avw	and	

the	Mouse_Lungs.obj	files	to	follow	

along,	from	https://analyzedirect.com/

data

Use	the	Input/Output	module	to	load	

the	Mouse_Lungs.avw.

Select	the	Mouse_Lungs	data	set	and	

then	open	Display.

Select	File	>	Load	Object	Map	and	

load	the	Mouse_Lungs.obj.

In	Display	set	the	Display	

Configuration	to	3-D	and	choose

Sequence Tool (continued)

the	Render	option	(1).	Uncheck	the	Image(s)	option.

Right-click	on	the	Rendering	and	then	choose	Transparency	from	the	menu.

After	Transparency	has	been	applied	right	click	again	and	select	the	Sequencer	option	(2).

The	Sequencer	tool	will	be	displayed	below	the	rendering	(3)
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To	create	a	simple	rotational	movie,	click	the	Add	Key	Frame	button	(4)	twice	to	add	two	

key	frames	to	the	sequencer	(5).

Left	click	the	Transition	button	between	the	key	frames	(6)	to	open	the	Transition	

parameters	window	(7).

In	the	Transition	window	set	the	number	of	Frames	to	20	(8),	next	check	the	360	Rotation	

option	(9)	and	then	select	Screen	Y	(10).

Select	the	Preview	Sequence	button	to	review	the	movie	(11).

To	save	the	movie	to	the	Analyze	workspace	select	Generate	and	Save.	(12)

In	the	Window	returned,	name	the	movie	and	then	select	Render	Sequence.	The	movie	

file	will	be	saved	to	the	workspace.	Use	the	Input/Output	module	to	save	the	movie	out	

of	the	software	as	an	.AVI,	QuickTime,	or	Animated	GIF.

Sequence Tool (continued)
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Enhanced Movie Making: Object 
Movement and Rotation

Download	the	Mouse_Lungs.avw	and	

the	Mouse_Lungs_2.obj	files	to	follow	

along,	from	https://analyzedirect.com/

data

Use	the	Input/Output	module	to	load	

the	Mouse_Lungs.avw.

Select	the	Mouse_Lungs	data	set	and	

then	open	Display.

Select	File	>	Load	Object	Map	and	

load	the	Mouse_Lungs_2.obj.

Sequence Tool (continued)

In	Display	set	the	Display	Configuration	to	3-D	and	choose	the	Render	option	(1).	Uncheck	the	Image(s)	option.	

Right	click	in	the	Render	window	and	select	the	Sequencer	option.

The	Sequencer	tool	will	be	displayed	below	the	rendering,	click	the	Add	Key	Frame	button	(2)	to	add	a	starting	key	frame	to	the	sequencer.

Next,	right-click	on	the	in	the	Render	window	and	choose	Object	Movement	>	Translation	(3).
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Click	on	the	left	lung	object	to	select	it	and	then	

drag	it	to	the	right	(4).	When	complete	click	Add	

Key	Frame	(5).

Click	Transition	button	between	the	two	key	

frames	to	open	the	Transition	parameters	window	

(6),	set	the	Frame(s)	to	20.

Click	Preview	Sequence	to	preview	the	movie	so	

far.	

Next,	press	the	Shift	key	and	then	select	the	left	

lung,	the	Object	Transformation	will	be	changed	

from	a	translation	to	a	rotation,	rotate	the	left	lung	

(8).

When	complete	click	Add	Key	Frame,	note	that	

the	transition	is	automatically	set	to	20	frames	(9).

Click	Preview	Sequence	to	preview	the	movie	so	

far.

Sequence Tool (continued)
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Next,	let’s	perform	the	translation	and	rotation	on	

the	right	lung	in	one	key	frame.	Click	on	the	right	

lung	object	to	select	it	and	then	drag	it	to	the	left.	

(10)	Press	the	Shift	key	and	select	the	right	lung	

again,	rotate	the	right	lung	(11).

When	complete	click	Add	Key	Frame,	again	the	

transition	is	automatically	set	to	20	frames	(12).

Click	Preview	Sequence	to	preview	the	movie	

so	far.	The	movie	will	show	the	left	lung	moving	

out	the	right	side	followed	by	a	rotation,	next	

the	left	lung	will	move	out	to	the	left	side	while	

performing	a	rotation.	

Now	let’s	add	a	rotation.	Click	the	Add	Key	Frame	

button	again	to	add	a	new	key	frame,	click	on	

the	Transition	button	added	before	the	last	key	

frame	(13).	In	the	Transition	window	check	the	360	

Rotation	option	and	choose	Screen	Y	(14).

Sequence Tool (continued)
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To	end	the	movie,	let’s	have	all	

objects	move	back	to	their	original	

positions.	You	could	achieve	this	by	

right-clicking	on	the	Render	window	

and	choosing	Object	Movement	>	

Reset	All	Movements.	However,	in	

this	case	we	will	copy	the	first	key	

frame	and	paste	it	to	the	end	of	the	

sequence	we	have	generated.	

Right-click	on	the	first	key	frame	and	

choose	Copy	from	the	menu	(15).

Right-click	at	the	end	of	the	sequence	

and	choose	Paste	(16)	to	paste	a	copy	

of	the	first	key	frame	and	the	end	(17).

Sequence Tool (continued)

This	provides	a	nice	movie	that	starts	and	ends	with	the	all	objects	in	the	same	position,	important	for	when	looping	the	movie	for	a	

presentation.

Preview	the	movie	and	then	use	the	Generate	and	Save	option	to	save	a	copy	to	the	workspace.	

Explore	the	other	rendering	options	to	help	enhance	your	movies,	for	example	use	the	Scale	option	to	give	the	effect	of	zooming	in	or	out	

of	your	rendered	image	and	use	the	Clip	Plane	or	Clip	Volume	options	to	clip	into	the	data.
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Enhanced Movie Making: Zooming 
and Clipping

Download	the	Mouse_Lungs.avw	and	

the	Mouse_Lungs_2.obj	files	to	follow	

along,	from	https://analyzedirect.com/

data

Use	the	Input/Output	module	to	load	

the	Mouse_Lungs.avw.

Select	the	Mouse_Lungs	data	set	and	

then	open	Display.

Select	File	>	Load	Object	Map	and	

load	the	Mouse_Lungs_2.obj.

Sequence Tool (continued)

In	Display	set	the	Display	Configuration	to	3-D	and	choose	the	Render	option	(1).	Uncheck	the	Image(s)	option.	

Right	click	in	the	Render	window	and	select	the	Sequencer	option.

The	Sequencer	tool	will	be	displayed	below	the	rendering,	click	the	Add	Key	Frame	button	(2)	to	add	a	starting	key	frame	to	the	sequencer.

If	the	additional	rendering	options	are	not	visible	in	the	lower	left	hand	corner	of	the	Render	window	(3)	enable	the	options	by	right-clicking	

in	the	Render	window	and	then	choosing	Render	Options	from	the	menu,	check	the	Show	Scale	and	Show	Clip	Plane	options,	but	feel	free	

to	enable	all	options	(4).
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Double	click	the	yellow	Scale	text	and	change	the	

X,	Y,	and	Z	Scale	values	to	2.2	(5).	Note	that	the	

rending	display	size	will	increase.	

Click	Add	Key	Frame	(6)	to	add	a	new	key	frame	to	

the	sequence.

Click	the	Transition	button	(7),	in	the	Transition	

parameters	window	(8)	set	Frame(s)	to	25	(9).

Double	click	the	yellow	Clip	Plane	text	and	change	

the	Min	value	to	642.	(10)	Note	that	the	rendering	

display	will	be	clipped.

Click	Add	Key	Frame	(11)	to	add	a	new	key	frame	

to	the	sequence.

Click	the	Transition	button	and	increase	the	

number	of	Frame(s)	to	50	(12).

Sequence Tool (continued)
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Double	click	the	yellow	Clip	Plane	text	and	change	

the	Min	value	back	to	1.	(13)	Note	that	the	rending	

display	will	update.

Click	Add	Key	Frame	(14)	to	add	the	new	key	

frame	to	the	sequence.

Double	click	the	yellow	Scale	text	and	change	the	

X,	Y,	and	Z	Scale	values	back	to	1.	(14)	Note	that	

the	rending	display	size	will	decrease.	

Click	Add	Key	Frame	(15)	to	add	the	new	key	

frame	to	the	sequence.

Click	Preview	Sequence	(16)	to	preview	the	movie.

Click	Generate	and	Save	(17)	to	save	the	movie	to	

the	workspace.

Sequence Tool (continued)
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The	Perspective	Tool	provides	

users	with	another	option	to	create	

powerful	and	interesting	movies	from	

their	rendered	image	data.	

Download	the	EGV_CT.avw	data	

set	to	follow	along,	from	https://

analyzedirect.com/data.

Use	the	Input/Output	module	to	load	

the	EGV_CT.avw.

Select	the	EGV_CT	data	set	and	then	

open	Display.

In	Display	check	both	the	Image(s)	

and	3-D	Display	Configuration

Perspective Tool

options.	Make	sure	to	choose	All	Orientations	and	Render.

From	the	Render	options	in	the	lower	left-hand	corner	double	click	on	the	yellow	Thresh	text	and	change	the	Min	value	to	430.	(2)	Note	if	

the	Render	options	are	not	available	right	click	in	the	Render	window	and	choose	Render	Options,	enable	all	the	options.

Right	click	on	Type	and	select	Volume	Compositing.	(3)	Then	right	click	on	Tissue	Map	and	choose	System	Tissue	Maps	>	CT	2	(4).

Enable	the	Perspective	tool	by	clicking	on	the	Perspective	option	changing	it	from	disabled	to	enabled.	(5)	Note	that	the	three	orthogonal	

views	will	update	to	display	interactive	camera	and	look	at	points.	Right	click	in	the	Render	window	and	choose	Sequencer	(6)	to	enable	to	

sequencer	below	the	Render	window.	Click	Add	Key	Frame	to	add	a	starting	key	frame	to	the	sequencer	(7).
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In	the	Sagittal	orientation	click	on	the	perspective	camera	point	(round	icon)	(8)	and	move	it	to	the	left	(9).

Perspective Tool (continued)

Note	the	update	to	the	rendering	

(10).

Click	the	Add	Key	Frame	button	

(11)	to	add	the	new	key	frame	to	the	

sequence.	Click	the	Transition	button	

(12)	and	set	the	Frame(s)	to	25	(13).
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In	the	Axial	orientation,	zoom	in	to	view	the	display	clearer.	(14).	Select	the	perspective	Camera	point	(15)	and	move	it	clockwise	(16).	

Perspective Tool (continued)

Note	the	update	to	the	rendering	

(17).

Click	the	Add	Key	Frame	button	

(18)	to	add	the	new	key	frame	to	the	

sequence.	



163

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

DISPLAY > 3D IMAGES

In	the	Coronal	orientation	click	on	the	perspective	camera	point	(19)	and	move	it	left,	closer	to	the	image	data	(20).

Perspective Tool (continued)

Note	the	update	to	the	rendering	(21).	

Click	the	Add	Key	Frame	button	(22)	to	

add	the	new	key	frame	to	the	sequence.	

Right	click	on	the	first	frame	and	choose	

Copy	(23).	At	the	end	of	the	sequence	

right	click	and	choose	Paste.	(25)	The	

movie	will	now	start	and	end	at	the	same	

point.

Preview	the	movie	(26).	If	you	wish	

to	save	the	movie	sequence	to	apply	

to	another	data	set,	right-click	in	the	

Sequencer	and	choose	Save	Sequence.	

(27).	To	save	the	movie	to	the	workspace	

select	Generate	and	Save	(28).
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Introduction
The Process module provides 

access to image enhancement 

tools that allow data to be 

refined, such that image 

features can be seen easier 

or detection of regions is 

improved during segmentation. 

There are three main process 

functions [1] available: 

Spatial Filters - for the filtering 

of image data to reduce image 

noise or increase contrast 

between structures of interest. 

Morphology - mathematical 

segmentation operations for 

the pre-processing of image 

data for segmentation.
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Histogram - for the modification of the image histogram to enhance image quality or enhance features.

All of these functions are used to prepare data for further segmentation and analysis.



Spatial Filters

Filter Type Description Method

Low Pass dampens noise, smoothes volume replaces the value of each voxel with the average value of the 

neighborhood*

Unsharp eliminates  homogeneous regions, 

highlights edges and noise

subtracts a low pass filtered volume from the original volume

Unsharp Enhance combines unsharp with original volume adds an unsharp filtered volume to the original volume

Sobel highlights edges performs a classic edge detection filter

Sobel Enhance combines Sobel with original volume adds a Sobel filtered volume to the original volume

Median dampens noise, smoothes volume replaces the value of each voxel with the average value of the 

neighborhood*

Rank generic rank filter orders all the values of voxels in the neighborhood* and returns the value 

corresponding to the rank in the ordered list†

Sigma smoothes noise while preserving edges 

and thin lines

replaces the value x of each voxel with the average value of voxels in the 

neighborhood* having values of x ± 2σ ‡

VSF Mean smoothes noise while preserving edges 

and thin lines

replaces the value x of each voxel with the average value of voxels in the 

neighborhood§ having values of x ± σ

Gradient highlights edges replaces the value of each voxel with the maximum absolute difference 

between its value and that of its orthogonal neighbors

There are 19 different spatial filters that can be applied to a data set. These are described in the table below. A filter can be applied to the 

entire volume or to selected objects if an object map is loaded.
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Filter Type Description Method

AHE enhances contrast for viewing (not for 

measurement)

adjusts voxel values based on histogram of a localized region¶

Anisotropic reduces noise while preserving edges performs 2D affine, unbiased or biased anisotropic diffusion for the 

number of iterations and time per iteration|| specified

Convolution smoothes noise, resulting in a blurry 

image

performs spatial convolution of volume with user-supplied point spread 

function

Inhomogeneity 

Correction

corrects low-frequency grayscale 

gradients

replaces voxel intensity with Ii * global mean / local mean, where Ii is the 

input voxel intensity

Sticks suppresses noise while enhancing thin 

edges

applies directional masks and determines output based on Type 

parameter

Chamfer Distance 

Map

creates a map that may be used for 

shape recognition

calculates Chamfer distance of each voxel to nearest nonzero voxel

Euclidean Distance 

Transform

creates a map that may be used for 

shape recognition

calculates Euclidean distance of each voxel to nearest nonzero voxel

Adaptive Restoration reduces noise  using an adaptive 

method

degrades image by constant-power additive noise, then applies a low 

pass filter

Curvature creates a map of instantaneous local 

surface curvature

sums binary voxel values in the 26-connected neighborhood of each voxel 

to give a curvature value from 0-26
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*The neighborhood around each voxel is defined by the kernel dimensions selected in the Kernel Size options.

†The kernel size determines the number of voxels whose values are ranked, e.g. a 3 X 3 X 3 kernel has 27 voxels, a 5 X 5 X 5 kernel has 125 voxels and a 7 X 7 X 7 kernel has 343 voxels. 
The larger the kernel size, the more computationally intensive this filter becomes. It is recommended to use a smaller kernel size such as 3 X 3 X 3. In a 3 X 3 X 3 kernel, a rank of 1 would 
return the minimum value, a rank of 14 would return the median value and a rank of 27 would return the maximum value.

‡If fewer than 9% of the voxels in the kernel fall within the x ± 2σ range, the voxel in question will not be changed. Sigma (σ) is defined using the text box or slider bar.

§The circular neighborhood around each voxel is specified by the Ring parameter.

¶Clip Fraction — Specifies the limit of contribution of any given grayscale value, reducing the enhancement of noise in the resulting image or volume. This method is particularly 
effective for images which have subtle detail in both very bright and very dim regions of the image. It may also be used to expand the dynamic range of grayscale in a region which has 
subtle but significant changes. 

||A value of 0.25 is recommended for general use and will be used as the default if the supplied value is zero or negative. However, a value of 0.10 or less is required to guarantee stable 
behavior. The lower value will require more iterations but should be used if absolutely correct results are essential. This option is only available when Type is set to Affine.
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No Filter Low Pass

Sigma

Inhomogeneity 
Correction

Unsharp Unsharp Enhance

VSF Mean

Sticks

Sobel

Gradient

Chamfer Distance Map

Sobel Enhance

AHE

Euclidean Distance Map

Median

Anisotropic

Adaptive Restoration

Rank

Convolution

Curvature
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Download the microCT_Bone.avw 

data set to follow along, from 

https://analyzedirect.com/data.

This exercise will show how to apply 

a median filter to a microCT bone 

data set.

Use the Input/Output module to load 

the microCT_Bone.avw data set into 

the software.

Select the data set [1]  and open 

Process [2].

Applying a Filter to a Data Set
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Choose Spatial Filter as the Process 

Type [3].

Choose a Filter Type [4]. Low Pass and 

Median filters are commonly used to 

smooth noisy data.

Set the Kernel Size in the X, Y and 

Z dimensions [5]. A kernel size of 7 

X 7 X 7 is often used for microCT 

data acquired using a PerkinElmer 

scanner.

Click Process Volume [6].

Once the processing is complete, 

the Save Volume button will become 

available. Click Save Volume [7].
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Applying a Filter to a Data Set (continued)
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In the Save Volume window, choose 

to replace the input data set with the 

processed data set, or to create a new 

data set [8].

The new data set can be saved in 

any workspace in the current project 

and renamed in the File checkbox. 

Check the Replace Input Volume with 

Processed Volume box if you want to 

further process the processed volume 

[9].

Click Save Volume [10].
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Applying a Filter to a Data Set (continued)
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A number of morphologic operations 

are available [1], and these are 

described in the table on the next 

page. 

These operations can be performed 

on the entire volume or on selected 

objects if an object map is loaded.

Morphology



Morphologic Operation Description Method

Threshold isolates structures defined by a difference in 

intensity

sets voxels between and equal to the specified maximum and minimum to 1 and all 

other voxels to 0

Erode peels a layer from the outer edge of large 

objects and deletes small objects

retains voxels in inner areas of the object, as determined by the structuring element 

dimensions and shape

Dilate expands small objects in a binary volume adds voxels to outer areas of the object, as determined by the structuring element 

dimensions and shape

Open removes small objects and breaks isthmuses erosion followed by dilation

Close fills thin gulfs and small holes dilation followed by erosion

Maximum emphasizes high-intensity regions grayscale equivalent of binary dilation

Minimum emphasizes low-intensity regions grayscale equivalent of binary erosion

Ultimate Erosion shows the last voxels remaining of disconnected 

components

performs successive erosions on the object until the last erosion before the 

components would disappear

Thinning thins an object in binary or grayscale thins the object based on the number of iterations specified, using template matching

Homotopic Thickening thickens an object in binary or grayscale thickens the object based on the number of iterations specified

Fill Holes fills holes in a volume fills holes in 2D or 3D, based on the connectivity value chosen

Connected Components finds connected regions in a volume performs a 2D or 3D connected component analysis

Complement generates inverse of an image generates the binary or grayscale complement of the image

Umbra darkens the image decreases the intensity value of all voxels by the specified intensity cutoff value

Nonmax Suppression shows voxels of highest intensity sets voxels which are not at a local maximum to zero

Watershed performs classic watershed operation thresholds a binary volume, performs repeated erosions, sets voxels to erosion level 

and connects components
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Available Morphological Operations
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Download the Mouse_Lungs.avw 

data set to follow along, from 

https://analyzedirect.com/data.

This exercise will show how to apply 

a series of morphological operations 

to a data set to isolate an object 

of Interest while removing as much 

unwanted tissue as possible. This 

will prepare the data for further 

analysis. In this example we will 

isolate the lungs from a preclinical 

micro-CT data set by using various 

morphological operations including 

thresholding, eroding, and opens.

Use the Input/Output module to load 

the Mouse_Lungs.avw data set into 

the software.

Select the data set [1] and open 

Process [2].

Applying Morphological Operators to Data



The first step in this process is 

to eliminate the background 

noise.

Choose Morphology as the 

Process Type [3].

Choose the Threshold option as 

the Morphological Operation 

[4].

Set the Minimum Threshold 

level to 1105 [5]. Note that this 

will eliminate the background 

single.

Set the Output Type to 

Grayscale [6].

Next, click Process Volume [7].
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When processing is complete click Save Volume [8].

In the Save Volume window ensure the ‘Create a new workspace volume containing the processed data.’ option is selected [9].

Also, ensure the ‘Replace Input Volume with Processed Volume’ option is checked [10].

Click Save Volume [11]. The processed data will be saved as a new volume in the workspace and will also be set as the Input Volume for 

Process.

Applying Morphological Operators to Data (continued)



The next step is to remove a 

layer of voxels from the outer 

surface of the body. This 

step is completed in order 

to prevent these voxels from 

being included when we use 

thresholding in the next step to 

isolate the lungs. 

Select the Erode option from 

the Morphological Operations 

menu [12].

Set the Element Size to 9 by 9 

by 9 [13]. The voxels that will be 

eroded from the data can be 

seen in the Compare column 

[14].
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Next, click Process Volume [15] and when processing is complete click Save Volume [16].

This time in the Save Volume window check the ‘Replace contents of ‘Mouse_Lung_Thr’ with processed data.’ option [17]. This will overwrite 

the volume and prevent an additional volume being written to the workspace. 

Click Save Volume [18]. The processed data will be saved over the input volume and also be set as the Input volume.

Applying Morphological Operators to Data (continued)



Now we will use Thresholding 

to isolate the lung parenchyma. 

Choose the Threshold option 

from the Morphological 

Operation menu [19].

Set the Minimum Threshold 

level to 1 and the Maximum 

Threshold level to 1639 [20].

Note that this threshold range 

will isolate the lungs [21].

Next, click Process Volume and 

when processing is complete 

click Save Volume.

In the Save Volume window 

leave the option set to
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‘Replace contents of ‘Mouse_Lung_Thr’ with processed data.’

Click Save Volume [22]. The processed data will be saved over the input volume and be set as the Input.

Applying Morphological Operators to Data (continued)



The final step to process 

this data set is to conduct a 

morphological Open operation  

on the image data. An Open 

operation is an erode followed 

by a dilation. The erode will 

take away layers, removing 

areas of noise. The dilate 

operation will then add back 

layers of voxels removed from 

the lung.

Set the Morphological 

Operation to Open [23].

Set the Element Size to 7 by 7 

by 7 [24].

Ensure the Element Shape is
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set to Rectilinear [25]. Note the preview of the final isolated lung data set [26].

Next, click Process Volume and when processing is complete click Save Volume.

In the Save Volume window leave the option set to ‘Replace contents of ‘Mouse_Lung_Thr’ with processed data.’

Click Save Volume [27]. The processed data will be saved over the input volume and be set as the Input.

Close the Process module.

Applying Morphological Operators to Data (continued)



Select the processed image 

data ‘Mouse_Lung_Thr’ from 

the workspace and view it using 

the Display module [28].

In four easy steps we have 

isolated the lungs with a 

minimal amount of surrounding 

noise. This data is ready 

for visualization, volume 

measurement, or further 

segmentation.
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Applying Morphological Operators to Data (continued)
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The histogram of an image is a 

function that relates the number of 

pixels in the image to the range of 

brightness values of those pixels. This 

can be expressed in a 2-D graph, 

plotting brightness vs. number of 

pixels.

The Histogram Process Type [1] allows 

users to perform the manipulations 

to alter the shape of the gray level 

histogram of an image to reduce 

noise, enhance contrast, or detect 

edges.

The Histogram Operations [2] 

available are:

• Flatten (also known as 

equalization)

• Preserve

• Normalize

• Match

Histogram
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The available histogram operations are Flatten, Preserve, Normalize and Match. These operations can be performed on the entire volume or 

on selected objects if an object map is loaded.

Histogram 
Operation

Description Method

Flatten maximizes contrast evenly distributes voxels across the specified intensity output range

Preserve brightens image while preserving 

contrast

maps the input intensity range onto a narrower output range in a 

statistically optimal manner

Normalize allows comparison of data sets forces the mean or mode of the histogram to specified values

Match allows comparison of data sets matches the intensity distribution to a loaded histogram file or the 

histogram of another volume

Histogram Operations
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The histogram flattening function 

allows users to attempt to produce 

an even distribution of voxels across 

the gray scale range specified by 

the Output Range minimum and 

maximum. A volume which has 

roughly equal numbers of voxels 

at every gray scale value will tend 

to exhibit maximal contrast across 

the entire gray scale range. Original 

grayscale values may be brightened, 

darkened, and or binned together to 

affect the flattening procedure.

In this exercise we will apply the 

histogram flattening function to 

Cubic_CT_Head data set and 

observe the effects.

Histogram Flatten

Download the Cubic_CT_Head.avw data set to follow along from http://analyzedirect.com/data

Load the Cubic_CT_Head.avw into Analyze using the Input/Output module.

Select the Cubic_CT_Head data set from the workspace [1] and open Process [2].
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Select the Process Type Histogram 

[3].

Set the Histogram Operation to 

Flatten [4].

Leave the Output Range Minimum 

set to 0 and Maximum set to 255 [5].

Note the input histogram [6] and 

the flattened output histogram [7]. 

The histogram flattening function 

has evenly distributed the range of 

voxels from the input volume across 

the grayscale range of the output 

volume.

Histogram Flatten (continued)

Review the enhanced processed data set [8]. Additional structure in the brain can be seen in the processed image that is not visible with 

the current Max/Min levels set for the input volume.

Click Save Volume [9] to save the processed image data to the workspace.
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The histogram preserve function 

provides a utility for feature 

enhancement with in the input data 

set. The function works by mapping 

a broad grayscale range into a 

narrow range in a statistically optimal 

manner. For example, this function 

may be used to map 16384 gray 

level bins of a 16-bit image into 256 

bins of an 8-bit image. The ideal 

distribution would place 1/256 of the 

total pixels in each of the 256 bins.

In the exercise we will demonstrate 

how to use the histogram preserve 

function to map the histogram of a 

16-bit CT cardiac data set to an 8-bit 

data set and review the resulting 

Histogram Preserve

Download the CT_Heart.avw  data set to follow along from http://analyzedirect.com/data

Load the CT_Heart.avw  into Analyze using the Input/Output module.

Select the CT_Heart.avw data set from the workspace [1] and open Process [2].
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Select the Process Type Histogram 

[1].

Set the Histogram Operation to 

Preserve [2].

Set the Output Range Minimum to 0 

and the Maximum to 255 [3].

Note the input histogram [4] and 

the processed output histogram [5]. 

The histogram preserve function 

has mapped the entire range of the 

signed 16-bit input data set (-1024 

to 3072) to the range of an unsigned 

8-bit data set (0-255).

Review the enhanced processed data 

set [6].

Click Save Volume [7] to save 

the processed image data to the 

workspace.

Histogram Preserve (continued)
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Histogram Normalization forces 

the Gaussian parameters of the 

image histogram (mean or mode) to 

specified values.

This exercise will show how to 

normalize the histogram of two 

functional data sets to the same 

median value so that they can be 

compared to each other.

Download the two data sets 

SISCOM_Ictal_SPECT.avw and 

SISCOM_Interictal_SPECT.avw from 

http://analyzedirect.com/data and 

load both datasets into the Analyze 

workspace using Input/Output.

Histogram Normalization

Select the SISCOM_Ictal_SPECT.avw data set from the workspace and open Process.

Set the process type to Histogram [1] and choose Normalize  [2] as the histogram operation.

Set the parameters to use the histogram median and a target value of 150 [3]. Note the update to the processed histogram [4] and 

processed data set [5]. Setting the target value of each data set to the same value will allow comparison between the two.

Click Save Volume [6].
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In the Save Volume window, choose to replace the input volume 

with the process volume [17] or create a new workspace volume 

[7].

Name the file, if creating a new workspace volume [8].

If you want to process the volume further, choose to replace the 

input volume with the process volume [9].

Click Save Volume to apply the changes [10].

Repeat these steps for the second data set, SISCOM_Interictal_

SPECT.avw.

Histogram Normalization (continued)

The two new volumes you have created have been normalized to the same value, 

so equivalent numbers in the images now indicate levels of metabolic activity. The data sets can be subtracted to create a difference map or 

otherwise quantitatively compared.
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Histogram matching matches the 

intensity distribution of a volume 

to a histogram. The function forces 

the histogram of the input volume 

to match the grayscale distribution 

of the specified histogram file 

from another data set. Volumes of 

the same subject should have the 

same general distribution of gray 

levels, even though the parameters 

of a particular volume (exposure, 

brightness, contrast) may vary widely. 

Histogram matching may be used 

to normalize the absolute grayscale 

values of a set of volumes to a 

selected optimal example.

Histogram Match

The goal of this exercise is to match the histograms of two data sets acquired for the same subject. Download the EGV_CT.avw and EGV_MRI.

avw datasets from http://analyzedirect.com/data to follow along.

Load the two data sets into Analyze using the Input/Output module. Select the EGV_CT data set and open Process.

Set the Process Type to Histogram [1]  and select the Match Histogram Operations option [2].

Right-click on the Input histogram and choose Save Histogram [3]. Save the histogram file to the Desktop. Close the Process module.
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Select the EGV_MRI data set and 

open Process.

Set the Process Type to Histogram 

and select the Match Histogram 

Operations option.

Click the File button under Histogram 

File [4] and then navigate to and 

select the .nhisto file saved for the 

EGV_CT data set and then click open.

The histogram will be applied to 

the data set. Note the change in 

the processed histogram [5] and the 

processed MRI data [6].

Click Save Volume to saved the 

processed data to the workspace.

Histogram Match (continued)
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There are several types of transformations that can be applied to data: spatial transformations such as cropping, resizing or flipping; 

intensity transformations such as thresholding, intensity scaling and inversion; and custom transformations using mathematical 

operators with image calculator/image algebra and image repair. All of this functionality is housed in the Transform module under five 

transformation tabs: [1]

1. Spatial Transforms

2. Intensity Transforms

3. Image Calculator

4. Image Algebra

5. Image Repair

Introduction
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The Spatial Transforms tab [1]

provides access to all the spatial 

transformation tools within Analyze 

including:

• Pad

• Subregion

• Resize

• Shift

• Flip

• Apply Matrix

• Follow Path

Many of the functions available in 

this section are also available in 

Input/Output under the Process 

tab, however, the implementation 

of these transformation tools within 

Transform take advantage of the 

new intuitive interface making data 

manipulation easier and quicker.

Spatial Transforms
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The Pad tool can be used to add blank slices around the original data set. This may be necessary to create a data set with certain 

dimensions or with the same number of slices in each dimension. The options for this tool are as follows:

Pad: The padding options allow users to pad a data set. Padding places the Input volume in a larger output volume at the position specified 

by the padding values. The pad values specify the X, Y, and Z input volume starting and ending position in the output volume. The following 

padding options are available:

 · X Low: The X Low field allows users to apply padding to the starting X position for the data set. 

 · X High: The X high field allows users to apply padding to the ending X position for the data set. 

 · Y Low: The Y Low field allows users to apply padding to the starting Y position for the data set. 

 · Y High: field allows users to apply padding to the ending Y position for the data set. 

 · Z Low: field allows users to apply padding to the starting Z position for the data set. 

 · Z High: field allows users to apply padding to the ending Z position for the data set. 

Equal Padding: When the Equal Padding option is enabled a pad value entered in any of the pad fields will be applied to all fields, applying 

the same number of slices to each side of the volume.

Pad Value: The Pad Value option allows users to assign a specific grayscale value to be assigned to the padded regions in the output 

volume.

Padded Volume: The Padded Volume option allows users to specify the output dimensions of the volume. 

Pad Volume: Pads the input data based on the Pad parameters specified by the user. 

Pad
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Here we use the Pad tool to add 

blank slices around the original data 

set.

To follow along, download the data 

set VHF_Legs from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to pad and 

open Transform. Navigate to 

Spatial Transforms [1] and select 

the Pad tool [2].

• To add a given number of slices 

to the low or high end of the data 

set in any dimension, type the 

number of slices to be added in 

the appropriate boxes [3] and the 

padded volume dimensions will 

be updated.

Using the Pad Tool

• To change the intensity value of the added slices, change the Pad Value [4]. 

• To set the padded volume dimensions, change the numbers in the appropriate boxes [5] and the low and high number of slices in each 

dimension will update automatically.
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• Once the dimensions have 

been changed from the original 

dimensions, the Pad Volume 

button will update.

• Click Pad Volume to apply the 

changes [6].

• Click the Save Volume button to 

save the padded volume to the 

workspace. To retain the original 

volume, choose to create a new 

workspace volume [7] and click 

Save Volume [8].

• Close Transform.

Using the Pad Tool (continued)
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The Subregion tool can be used to reduce the size of a data set without interpolating within the original data, or to crop to a specific region of 

interest. Available options are as follows:

Subregion: The subregion matrix provides users with an interface to specify the starting (Low) and ending (High) crop points in each 

orientation (X, Y, Z, and V). Users can also specify increment (Inc) and Number (Num) of slices to crop. The subregion matrix will update 

when subregions are defined using the interactive cropping tool from the slice display. 

• X: The X row allows users to specify column attributes for cropping data. Column attributes are automatically updated to reflect 

changes when modified.

 · Low: Low allows users to specify the first column of pixels to be loaded. 

 · Inc: The increment options allows users to specify increments between the first column of pixels from each image to be loaded. 

 · High: High allows users to specify the last column of pixels to be loaded. 

 · Num: Number allows users to enter the number of columns for each image to be loaded.

 · Max: The Max field reports the maximum number of columns to be loaded. Note that this field is not editable. 

• Y: The Y row allows users to specify the row attributes for cropping data. Row attributes are automatically updated to reflect changes 

when modified.

 · Low: Low allows users to specify the first row of pixels to be loaded. 

 · Inc: The increment options allows users to specify increments between the first row of pixels from each image to be loaded. 

 · High: High allows users to specify the last row of pixels to be loaded. 

 · Num: Number allows users to enter the number of rows for each image to be loaded.

 · Max: The Max field reports the maximum number of rows to be loaded. Note that this field is not editable. 

• Z: The Z row allows users to specify the slice attributes for cropping data. Slice attributes are automatically updated to reflect changes 

when modified.

 · Low: Low allows users to specify the first slice to be loaded. 

 · Inc: The increment options allows users to specify increments between slices. 

 · High: High allows users to specify the last slice to be loaded.

Subregion
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Subregion > Z (Continued):
 · Num: Number allows users to enter the number of slices to be loaded.

 · Max: The Max field reports the maximum number of slices to be loaded. Note that this field is not editable.

• Z: Only enabled when a multivolume is selected. The V row allows users to specify the volume attributes for cropping data. Volume 

attributes are automatically updated to reflect changes when modified.

 · Low: Low allows users to specify the first volume to be loaded. 

 · Inc: The increment options allows users to specify increments between volumes. 

 · High: High allows users to specify the last volume to be loaded. 

 · Num: Number allows users to enter the number of volumes to be loaded.

 · Max: The Max field reports the maximum number of volumes to be loaded. Note that this field is not editable.

Auto Crop: The Auto Crop tool will automatically calculate the minimum enclosing area to crop image data in the selected orientation. Auto 

crop will remove empty space around data. This is a useful utility for removing black background slices or automatically cropping binary 

data. The following options are available: 

• Orientation: Allows users to select the orientation to be used to calculate the minimum enclosing area. Choose from; Axial, Coronal, or 

Sagittal.

• Slice(s): Allows users to auto crop the current slice or all slices in the current orientation.

• Crop: Initiates the auto crop process.

Extract Sub Volume: Extracts the sub volume utilizing the parameters specified in the subregion matrix. 

Subregion Options (continued)
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Here we will use the Subregion tool 

can be used to crop a data set to a 

specific region of interest.

To follow along, download the data 

set VHF_Legs from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to crop and 

open Transform. Navigate to 

Spatial Transforms [1] and select 

the Subregion tool [2].

• Use the control points to set 

the cropped region in the axial 

[3], coronal [4] and sagittal [5] 

orientations. Scroll through the 

slices to ensure the region is correct 

throughout the data set.

• To set the cropped region to 

specific slice numbers, use the 

input boxes [6].

• Click Extract Sub Volume to 

perform the crop [7].

Using the Subregion Tool
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• Click Save Volume [8] to save the 

cropped data set.

• To retain the original volume, 

choose to create a new workspace 

volume [9] and rename [10].

• Click Save Volume [11].

• Close Transform.

Using the Subregion Tool (continued)
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The Resize tool can be used to resample image data. If data is acquired with anisotropic (non-cubic) voxels, the Resize tool can be used 

to resample the data to create an isotropic (cubic) data set. Occasionally data with a relatively large voxel size can be segmented more 

smoothly if resampled to a smaller voxel size. This will not change the resolution of the data but allows for a smoother definition of 

regions during segmentation.

Resize

Resampled Voxel SizeOriginal Voxel Size
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Resize: The resize tool allows users to perform tri-linear interpolation or voxel replication/sampling to resize a volume to a specific size. 

The interpolation parameters indicate the type of resize operation to perform. The following options are available:

Input: Displays the volume and voxel parameters of the input volume. 

Axis Dim: Reports the voxel dimensions of the input volume:

 · X, Y, Z: Displays the X, Y or Z dimension of the input volume.

Memory: Displays the size (memory usage) of the input volume. 

Voxel Size: Reports the voxel size of the input volume. Note that the input X, Y, and Z values can be adjusted to accurately report the 

voxel size for the input volume.

 · X, Y, Z: Displays the voxel width, height or distance between the slices of the input volume. 

Output: 

Voxel Size: Allows users to adjust the voxel size for the output volume. Note, when Force Cubic is selected, the individual X, Y, and Z 

fields are disabled leaving one value specifying the voxel size for X, Y, and Z in the output volume. When a voxel size is changed, the axis 

dimensions and memory usage are automatically calculated and updated to reflect the change. 

 · X, Y, Z: Allows users to specify the voxel width, height or distance between the slices for the output volume. 

Memory: Reports the size (memory usage) for the output volume. 

Axis Dim: The output axis dimensions display the voxel dimensions for the output volume. When a value is changed, the voxel size and 

memory usage are automatically calculated and updated to reflect the change. 

 · X, Y, Z: Specifies the X, Y or Z dimension of the output slice. 

Force Cubic: When enabled, forces the output volumes voxel size to be cubic. This is useful when resizing anisotropic data to be 

isotropic.  

Interpolate: Choose from Nearest Neighbor (ID), Linear (ID), Nearest Neighbor (OD), Linear (OD), Cubic Spline, Windowed Sinc or 

Shape Based to specify the interpolation method to use. See Table 6.1 for a full description of Interpolation Types.

Resize Options
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To follow along, download the data 

set VHF_Legs from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to resize and 

open Transform. Navigate to 

Spatial Transforms [1] and select 

the Resize tool [2].

• Check the Force Cubic 

checkbox to interpolate 

between anisotropic voxels [3], 

set the new voxel size [4] and 

choose an interpolation type [5].

See the table on the following page 

for different interpolation types.

• Click Resize Volume [6] to 

resample the data set.

Using the Resize Tool
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Interpolation Type Description

Nearest Neighbor* selects the value of the closest voxel to which the interpolation resampling maps

Linear* applies a linear interpolation of grayscale intensity based on the distance of neighboring voxels from the 

interpolated voxel

Cubic Spline** uses a cubic spline function to determine interpolated value

Windowed Sinc** uses windowed sinc function sin(x)/x to determine interpolated value

Shape Based only available for binary data; calculates Euclidean distance, then performs linear interpolation between 

distance images

Each interpolation type is either input driven (ID) or output driven (OD).

Input driven interpolation algorithms process each voxel in the input volume and map each input voxel into the output space. The actual 

interpolation takes place in the output space, given the projected contributions of each input voxel into that space. Input driven algorithms 

will always use every voxel in the input volume as part of the interpolation process.

Output driven algorithms step through each voxel in the output data set and find the corresponding set of voxels in the input data set that 

map into the output. The interpolation of voxels takes place in the input space, depending on the type of interpolation selected. Output 

driven algorithms are more common in image processing as they guarantee that every voxel in the output data set will be filled with an 

interpolated value.

Interpolation Types

*The Nearest Neighbor and Linear interpolation types can be specified as ID or OD.

**The Cubic Spline and Windowed Sinc interpolation types are both OD. Since they use higher-order functions, they account for more neighboring voxels and thus may provide a better 
estimate for the interpolated value. These algorithms are also more compute-intensive.

Using the Resize Tool (continued)
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• Click Save Volume [7] to save the 

resampled data set.

• To retain the original volume, 

choose to create a new workspace 

volume [8], rename [9] then click 

Save Volume [10].

• Close Transform.

Using the Resize Tool (continued)
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The Shift tool can be used to shift data horizontally or vertically. This may be necessary to correct wraparound artifacts. Available options are 

as follows:

Shift: Allows users to enter the number of voxels to shift data in the X, Y, or Z:

 · X: Entering a number will apply a positive x shift (shift to the left). Entering a negative number will apply a negative x shift (shift to the 

right). 

 · Y: Entering a number will apply a positive y shift (shift forward). Entering a negative number will apply a negative y shift (shift 

backward). 

 · Z: Entering a number will apply a positive z shift (shift up). Entering a negative number will apply a negative y shift (shift down). 

 · Wrap: Allows users to specify if shifted voxels will wrap around when shifting.

Shift Volume: Applies the specified shift.

Shear: The Shear option allows users to apply horizontal and vertical shear correction in the Axial, Coronal, or Sagittal orientation. Note that 

Analyze automatically identifies and corrects for shear when loading data (see Shear Factor Correction in the Input/Output section of this 

manual).

 · Orient: Choose from Axial, Coronal, or Sagittal.

 · Horizontal: Allows users to specify the horizontal correction value for the selected orientation. 

 · Vertical: Allows users to specify the vertical correction value for the selected orientation.

Shear Volume: Applies the specified shear correction parameters.

Shift
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Correcting Wraparound Using the 
Shift Tool

The Shift tool can be used to shift 

data horizontally or vertically. 

This may be necessary to correct 

wraparound artifacts. 

To follow along, download the data 

set MRI_Head.avw from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to shift and 

open Transform. Navigate to 

Spatial Transforms [1] and select 

the Shift tool [2].

• This data set has a wraparound 

artifact which is visible in the 

sagittal view.

• Set sagittal as the primary 

view by double-clicking on 

the sagittal image or using the 

primary view menu [3].

Using the Shift Tool
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• Use the linked cursor to 

determine the shift parameter 

value [4].

• In this data set, when the cursor 

is lined up with an appropriate 

break point in the sagittal view, 

the corresponding coronal slice 

number is 25 [5].

Refer to the table below to determine 

the correct sign and direction of the 

desired shift.

Axial Coronal Sagittal

Parameter + - + - + -

X right left right left

Y up down right left

Z up down up down

Shift Parameters

Using the Shift Tool (continued)
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• Since we want to shift the sagittal 

image to the left, we will use a Y 

parameter of -25.

• Type this parameter value into 

the input box [6].

• Select the Wrap checkbox [7].

• Click Shift Volume to complete 

the shift [8].

• The data set will shift to the left 

by 25 slices and wrap those slices 

back around to connect with the 

rest of the head. 

• Click Save Volume to save the 

shifted data set [9].

• In the Save Transformed 

window, choose to create a new 

workspace volume [10].

• Rename [11] and click Save 

Volume [12].

• Close Transform.

Using the Shift Tool (continued)
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In some cases, it may be necessary to flip data in order to orient 

it correctly. The Flip tool allows users to flip data along any 

single axis or combination of axes, according to the following 

parameters.

Flip Parameters

Flipping the data in only the X or Y direction will create a 

mirror image. If this is not the desired result, the data can be 

flipped in both the X and Y directions at once to prevent a 

mirror image from being created.

Flipping Data

To follow along, download the data set VHF_Legs from analyzedirect.com/data and load into Analyze using Input/Output.

• Select the data set to flip and open Transform. Navigate to Spatial Transforms [1] and select the Flip tool [2].

• Select the checkboxes for the directions you wish to flip the data [3]. We will flip this data in the X and Y directions to avoid creating a 

mirror image.

• Click Flip Volume [4] to apply the flip.

Flip

Axis Outcome

X flips data horizontally about the vertical (Y) axis

Y flips data vertically about the horizontal (X) axis

Z reverses the order of the slices
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• Here, the data set before and after 

the X-Y flip is shown. Once the 

data is flipped, click Save Volume 

to save the flipped data set [5].

• In the Save Transformed 

window, choose to create a new 

workspace volume [6].

• Rename [7] and click Save 

Volume [8].

• Close Transform.

Flip (continued)
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The Apply Matrix tool [1] when used 

in conjunction with the Oblique tool 

[2], can spatially transform a data 

set in many different ways, including 

rotation, translation and scaling 

(stretching or compressing) along any 

axis, and inversion. In addition, any 

4x4 matrix can be loaded into the 

tool to apply the same transformation 

to many data sets. 

Another prominent feature of this 

tool is the ability to output oblique 

data sets, such as AC-PC aligned 

brain data. The AC-PC line (anterior 

commissure - posterior commissure 

line) also known as the bicommissural 

line, has been adopted as a standard 

by the neuroimaging community, and 

in most instances is the reference 

plane for axial imaging in everyday 

scanning.

Apply Matrix
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Matrix: The matrix tool enables specification, application, loading, and saving of transformation matrices. The matrix displays a 4 x 4 the 

identity matrix for the data and will update to a transformation matrix when manipulations are made to the matrix. Adjustments can be made 

directly in any of the matrix fields; however, this is not recommended, instead use the manipulate matrix tools or the Obliques Window to 

adjust. 

• View Transposed: When selected, inverts the transformation matrix.  

Manipulate Matrix: Allows users to manipulate the transformation matrix. The following options are available:  

• Rotate: Rotates the transformation matrix. Users can select to rotate the X, Y, and Z degree of rotation. The rotation is applied to the X 

axis first, then the Y axis, and finally the z axis. 

 · X, Y, Z: Specifies that the transformation matrix will be rotated about the X, Y or Z axes.

 · Degrees: Specifies the degree of rotation.

Translate: Allows users to apply translations. Translations are applied to the X, Y, and Z.

 · X, Y, Z: Specifies that the transformation matrix will be translated in X, Y or Z.

 · Voxels: Specifies the number of voxels to translate. 

Scale: Modifies the transformation matrix by a specified scale factor.

 · X, Y, Z: Specifies that the transformation matrix will be scaled in X, Y or Z.

 · Factor: Specifies the scale factor. 

Identity: Sets the transformation matrix to the identity matrix.

Invert: Inverts the transformation matrix.

Apply: When selected, applies the specified manipulations options to the transformation matrix.

Apply Matrix Options
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Reset Matrix: Resets the Matrix.

Load Matrix: Allows users to load previously saved matrix files.

Save Matrix: Allows users to save the current matrix file. 

Isotropic Scaling: When anisotropic (non-cubic) data is loaded into Transform it is automatically scaled to isotropic (cubic) voxels. The 

Isotropic Scaling option will be enabled and set to Yes.

• Yes: This is the default option. Anisotropic data is automatically resampled to be isotropic. This enables the application of any 

transformation, as detailed above, and allows for the generation of a transformed volume in the isotropic space. The saved volume will 

have spatially correct, transformed voxels.

• No: Disables anisotropic resampling, please note that this is not recommended. Users should only select this option if they wish to save 

out anisotropic data, however, the transformed spatial voxel size will not be known and users will be prompted to remove the voxel 

spatial information from the header or copy the original isotropic voxel size from the input volume when saving the data. 

Transformed Volume Size: Allows users to choose between Best Fit or Maintained to specify if the saved volume should be resize to best 

fit the data (recommended) or if it should maintain the original volume dimensions.

Interpolation Type: Allows users to specify the interpolation type to be used when transforming the data. Choose from Nearest Neighbor, 

Linear, Cubic Spline, or Windowed Sinc.

Transform Min: Allows users to select the grayscale value of additional/new background voxels. Choose between; Data Type, Data 

Minimum, or User Specified.

Apply Matrix: When selected, applies the specified transformation matrix to the image data.

Apply Matrix Options (continue)
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AC-PC Alignment of Brain Data

In this exercise we will use the tools 

available in the Transform module to 

align an MRI scan of the brain along 

the AC-PC axis.

To follow along, download the data 

set MRI_Head.avw from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to align 

along the and open Transform.

• Navigate to Spatial Transforms [1]

• Select the Apply Matrix tool [2].

Using the Apply Matrix Tool
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The optimal display settings for 

AC-PC alignment or any other 

manipulation of an oblique plane are 

as follows:

• Switch off the rendering [3] 

(unless an object map is loaded, 

which might help visualize 

the oblique). Now the three 

orthogonal views are shown.

• Switch on the oblique [4].  Now, 

the oblique and the three 

orthogonal views are shown.

Using the Apply Matrix Tool (continued)
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• Toggle the orthogonal 

orientations to a single image [5].

• Set this image to the sagittal view 

by clicking twice on the Orient 

parameter [6].

• Now the sagittal orientation and 

the oblique image are shown.

• Switch on the perpendicular 

images [7].

Using the Apply Matrix Tool (continued)
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• The AC-PC line will be defined 

on the sagittal view, so double-

click the sagittal image or select 

Image as Primary in the drop-

down menu [8].

• Right-click on the sagittal image 

and select Perpendicular Axis 

[9] to turn on the perpendicular 

axis tool.

Using the Apply Matrix Tool (continued)



219

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

TRANSFORM > SPATIAL TRANSFORMS

• Navigate to the mid-sagittal 

slice, which for this data set is 

slice 90 [10].

• Drag the left endpoint of 

the perpendicular axis to the 

posterior commissure [11].

• Drag the right endpoint of the 

perpendicular axis to the anterior 

commissure [12].

• To set the oblique plane 

to be parallel, rather than 

perpendicular, to the AC-PC 

plane, right-click on one of the 

perpendicular axis endpoints 

and set the Matrix to Create to 

Parallel [13].

Using the Apply Matrix Tool (continued)
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• Now the main oblique image (the 

leftmost of the three) is an AC-PC 

aligned axial image [14].

• Double-click this image to make 

it the primary image.

Using the Apply Matrix Tool (continued)
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• The AC [15] and PC [16] can 

both be seen on the same 

oblique slice, indicating good 

AC-PC alignment.

• To adjust vertical alignment of the 

data set, right-click Yaw and set 

the Rotation Increment to 1 [17].

• Use the left and right Yaw 

buttons to align the data set 

vertically [18]. The increment can 

be made even smaller to make 

smaller adjustments as needed.

Using the Apply Matrix Tool (continued)
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• The last adjustment to be made 

to the oblique plane will be 

done using the Roll function. 

Right-click on Roll and change 

the Rotation Increment to 1 [19].

• Click on the left and right roll 

buttons [20] to adjust the data 

set until the anatomical structures 

appear symmetrical [21].

Using the Apply Matrix Tool (continued)
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• Click Apply Matrix [22] to apply 

the transformation.

Using the Apply Matrix Tool (continued)
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• Click Save Volume [23] to save 

the transformed data set.

• In the Save Transformed 

window, choose to create a new 

workspace volume [24].

• Rename [25] and click Save 

Volume [26].

• Close Transform.

Using the Apply Matrix Tool (continued)
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Data Reorientation

The Apply Matrix option can be used 

to reorient data. An example of this 

can be found when using the Analyze 

Bone Microarchitecture Analysis 

(BMA) Add-On, which requires 

that the input bone specimens are 

orientated into a specific orientation 

[1] as a prerequisite for bone tissue 

classification and measurement. 

The Oblique reorientation tools and 

Apply Matrix option in Transform 

provide the tools necessary to 

successfully re-orientate the image 

data for analysis.

 

In this exercise we will use the tools available in the Transform module to correctly orient a micro-CT bone data set for processing in the 

BMA add-on module. 

To follow along, download the data set BMA_PE_micro_CT.avw from analyzedirect.com/data

Load the data into Analyze using Input/Output.

Select the data set from the Analyze workspace and open Transform.

Using the Apply Matrix Tool (continued)
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In Transform select the Spatial 

Transforms tab [2] and then choose 

the Apply Matrix option [3]. Click the 

Toggle Oblique button [4] to enable 

to Oblique window [5].

Note, if your display does not look 

like that shown in the screenshot, 

right-click on the Controls Layout 

icon and choose Default Display 

Layout, this will return you to the 

standard 4 window display showing 

the axial, coronal, sagittal, and 

render displays. Now click the 

Toggle Oblique button. Right-click 

in the coronal window and select the 

Perpendicular Axis tool (6). 

Use the Perpendicular Axis tool (red and black dashed 

line) [7] to define a line down the center of the bone 

to be analyzed. Do this by repositioning the ends of 

the line. In this example this is done on the coronal 

window. An oblique plane (shown by the blue and 

black dashed line) [8] will be defined perpendicular to 

the red and black line. 

Using the Apply Matrix Tool (continued)
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To apply the transformation to 

the data set click the Apply Matrix 

button. [12] 

Once the transformation is complete 

the data can be saved to the 

workspace by clicking the Save 

Volume button. [13]

In the Save Tranformed window 

returned choose the ‘Create a new 

workspace volume’ option and then 

append ‘_reformatted’ to the original 

file name. Finally click Save Volume. 

The reformatted data set will be 

saved to the workspace.

The plane will need to be adjusted in the sagittal view [9].

To do this, use the Pitch buttons in the oblique window [10] 

to manipulate the blue line until it is perpendicular to the 

long axis of the bone in the sagittal window. [11]. Note that 

in this example the axis (shown in blue and black on the 

sagittal image) should be pitched slightly upwards. This is 

achieved using the Pitch Up button. 

Using the Apply Matrix Tool (continued)
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The Follow Path tool is useful for reslicing a data set along the centerline of a vessel or airway. A series of points is chosen along a path in 

the data set, and the data is resliced perpendicular to the line created by these points. Available options include the following.

Path coordinates: Users can interactively define path coordinates by clicking on and of the orthogonal display images. 

 · Load: Allows users to load a previously defined set of path coordinates.

 · Save: Allows users to save the current path coordinates.

 · Reset: Resets the current path coordinates.

Intermediate Point(s): Allows users to enable or disable the automatic intermediate points are created between users defined points:

 · None: No intermediate points will be created.

 · Linear: Intermediate points will be created by linear interpolation between user defined points.

 · Spine: Intermediate points will be created by spline interpolation between user defined points.

Image Width: Allows users to define the width of the generated path images.

Image Height: Allows users to define the height of the generated path images.

Interpolation Type: Allows users to specify the interpolation type to be used when creating the path images. Choose from Nearest 

Neighbor, Bilinear, Cubic Spline, or Windowed Sinc.

Workspace: The workspace drop down allows users to specify which workspace the path image sequence will be saved to. 

File: File allows users to specify the name of the path sequence.

Preview Images: Will display a preview of the path sequence.

Generate Images: Will save the path sequence to the selected workspace with the specified file name.

Follow Path
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Reslicing Data Along the Trachea

A good example for the use of the 

Follow Path tools involves reslicing 

data along the centerline of the 

trachea, using lung data from CT.

To follow along, download the 

CT_Lungs data set from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set to reslice 

along a path of points and open 

Transform. Navigate to Spatial 

Transforms [1] and select the 

Follow Path tool [2].

• Choose a method of connecting 

the points: none, linear, or spline 

[3]. Spline creates the smoothest 

transition between slices, so that 

will be selected here.

• The image width and height [4] determine the dimensions of the output. If you are interested only in measuring the cross-sectional area of 

the structure on each slice, the image dimensions can be reduced from their original size.

Using the Follow Path Tool
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• The interpolation type [5] can be 

set to nearest neighbor, bilinear, 

cubic spline or windowed sinc. For 

more information on interpolation 

types, see the table shown earlier 

in the Resize section.

• Choose a workspace [6] and 

output file name [7] for the 

resliced data set.

• Now it is time to choose the 

points. A previously saved set 

of points can be imported using 

the Load button [8]. Points can 

also be chosen by selecting them 

directly on the data set. Points 

can be chosen in any orthogonal 

image but must be chosen in 

order along a path.

Using the Follow Path Tool (continued)
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• Click in the trachea to set the first 

point [9].

• Scroll through the slices and 

continue to set points along the 

path [10] until reaching the last 

point of the desired path [11].

Using the Follow Path Tool (continued)
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• Click Generate Images [12} to 

create the resliced data set 

and save it to the specified 

workspace.

• Close Transform.

Using the Follow Path Tool (continued)
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The Intensity Transforms tab allows 

access to tools that enable image 

intensity values to be adjusted. 

These would be used, for example, 

to make an image easier to process 

or to highlight certain objects within 

the image. The Intensity Transforms 

available in Analyze include:

• Threshold

• Intensity Scaling

• Inversion

• RGB channel manipulation

Many of the functions available in this 

section are also available in Input/

Output under the Process>Intensities 

tab.

Intensity Transforms
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Threshold scaling allows a range 

of voxels from the input volume to 

be saved as a binary data set. All 

voxels greater than or equal to the 

threshold minimum and less than or 

equal to the threshold maximum are 

set to 1 and all other voxels are set 

to 0. Available options include the 

following: 

Threshold slider: The Threshold 

double-ended slider bar allows users

Threshold

to specify a range of threshold values using the minimum and maximum ends of the threshold slider. Selecting the minimum end of the 

slider and moving it to the right will increase the minimum threshold value, moving it to the left will decrease the minimum value.

Threshold Render: Enables and disables the 3D threshold preview. It is recommended to disable this option for large data sets.

Threshold Volume: Threshold the volume data based on the minimum and maximum threshold range set using the threshold slider.

Creating a Binary Data Set with Thresholding

To follow along, download the 

VHF_Legs data set from  

analyzedirect.com/data and load into Analyze using Input/Output.

Select the data set to threshold and open Transform. Navigate to Intensity Transforms [1] and select the Threshold tool [2].
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• Use the sliders to set the 

threshold minimum and 

maximum, or type the values into 

the input boxes [3].

• While the slider is held down, 

the voxels defined by the given 

threshold range are highlighted in 

red in the orthogonal views [4].

• The rendering that will result 

from that threshold range is 

shown [5].

• Click Threshold Volume [6]  to 

apply the global threshold.

Using the Threshold Tool (continued)
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• The result is a binary data set. 

Click Save Volume [7] to save this 

data set.

• In the Save Transformed 

window, choose to create a new 

workspace volume [9].

• Rename [10] and click Save 

Volume [11].

• Close Transform.

Using the Threshold Tool (continued)
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Intensity scaling allows for the adjustment of the voxel value information in the data. Image data can be scaled by adjusting the output data type.

Available options include the following:

Input: Reports the input data type and minimum and maximum intensity values.

• DataType: Display the input data’s data type.

• Maximum: Displays the input data’s maximum intensity value. Note, this value can be adjusted to accurately report the maximum value in 

the input volume.

• Minimum: Displays the input data’s minimum intensity value. Note, this value can be adjusted to accurately report the minimum value in the 

input volume.

Output: Allows users to adjust the output data type and minimum and maximum intensity values. The following options are available:

• DataType: The DataType drop down menu allows users to select from the available data types, including; unsigned 8-bit, signed 8-bit, 

unsigned 16-bit, signed 16-bit, unsigned 32-bit, signed 32-bit, Float, RGB, and Double.

• Maximum: Displays the output data’s maximum intensity value. This value can be adjusted.

• Minimum: Displays the output data’s minimum intensity value. This value can be adjusted.

Intensity Scale Volume: Scales the data based on the intensity scaling parameters set. 

Intensity Scale
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Modifying Image Data Type

Changing the data type can reduce 

the size of the data on disk. In this 

example, a microCT data set has a 

data type of Float and the size of the 

image data is 92.71 MB. Changing the 

data type to signed 16-bit reduces the 

size of the data set by about 50% to 

46.35 MB without having a significant 

effect on the voxel intensities.

To follow along, download the 

Bone_Sample_mCT data set from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

Using the Intensity Scale Tool

• Select the data set to scale and open Transform.

• Navigate to Intensity Transforms [1].

• Select the Intensity Scale tool [2].

• Select the Signed 16-bit data type from the Output drop-down menu [3].

The maximum and minimum values will be set to the default values for the signed 16-bit data type.

• Change these values to match the maximum and minimum input values, rounding to the nearest whole number [4].

• Click Intensity Scale Volume [5] to apply the changes.
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• Click Save Volume [6] to save the 

scaled data set.

• In the Save Transformed 

window, choose to create a new 

workspace volume [7].

• Rename the file [8].

• Click Save Volume [9].

• Close Transform.

Using the Intensity Scale Tool (continued)
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For certain segmentation and 

visualization applications, it is 

beneficial to view an inverted copy of 

the image data alongside the original 

grayscale data. Available Options are 

as follows:

Maximum: Allows users to specify 

the maximum intensity value for the 

inverted data set.

Minimum: Allows users to specify 

the minimum intensity value for the 

inverted data set.

Invert: When selected inverts the 

image data.

Invert

Inverting Data

To follow along, download the MRI_3D_Head data set from analyzedirect.com/data and load into Analyze using Input/Output.

• Select the data set to invert and open Transform.

• Navigate to Intensity Transforms [1].

• Select the Invert tool [2].

• Click Invert Volume [3] to apply the inversion.
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• Click Save Volume [4] to save the 

inverted data set.

• In the Save Transformed window, 

choose to create a new workspace 

volume [5].

• Rename [6] and click Save Volume 

[7].

• Close Transform.

Using the Invert Tool (continued)



242

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

TRANSFORM > INTENSITY TRANSFORMS

• The inverse version of the input 

data can be useful for delineation 

of objects during segmentation. 

As the Segment module supports 

dual inputs, select the original 

MRI_3D_Head data set from the 

workspace and with the Ctrl key 

selected click on the inverted 

version just created, MRI_3D_

Head_Inverted, and open 

Segment. 

• Either input can be used for 

the segmentation of brain 

structures.

Using the Invert Tool (continued)
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options are available: 

Conversions from 24-bit Options

RGB Channel Manipulation

TRANSFORM > INTENSITY TRANSFORMS

Option Description

Grayscale Formula Converts the RGB values to an 8-bit grayscale image using the following formula: 

gray_voxel = red_voxel*.3+green_voxel*.59+blue_voxel*.11

Dithering Converts the RGB values to 8-bit with a colormap. The number of color cells used is specified by the Number Of Colors value.

Data w/Colormap Converts the RGB values to data with a colormap using the colors in the input data

Red Channel Specifies that only the 8-bit red channel is used for conversion

Green Channel Specifies that only the 8-bit green channel is used for conversion

Blue Channel Specifies that only the 8-bit blue channel is used for conversion

Conversions to 24-bit Options

Option Description

Data w/Colormap Converts a data set with a colormap loaded into a 24-bit color image

Object Colored Uses a data set and an object map to make a 24-bit data set where all the voxels have been colored using colors and definitions in 

the object map. Uses the following options: Object Color: Creates a color image displaying object color overlaid on voxels that are 

part of the selected objects in the object map. All other non-object voxels are removed from the image; Enhanced Object Color: 

This option is the same as the Object Color option but with enhanced (brighter) object color; Object Color Only: Creates a colored 

image representation of the grayscale image data with solid colored objects overlaid; Object with Edges: Creates a colored image 

of the grayscale data overlaid with object boundaries; Object Edges Only: Creates a colored image of object boundaries only; • 

Show All Objects: Uses all objects for the colored image; Enabled Objects Only: Uses only enabled objects for the colored 

image; Color Enabled Only: Uses only color enabled objects for the colored image.

Combine Channel(s) Combines the red, green and blue channels into a 24-bit color image

Convert Image Initiates the conversion process using the parameters set.
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Creating an RGB Data Set

Creating an RGB dataset by fusing 

a grayscale input volume with its 

associated object map can provide a 

useful reference image.

To follow along, download the 

MRI_3D_Head.avw and MRI_3D_

Head.obj data sets from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the MRI-3D_Head data set 

and open Transform.

• In Transform select File > Load 

Object Map and load the 

MRI_3D_Head.obj. The object 

map will be overlaid on the 

grayscale image data [1].

RGB Channel Manipulation (continued)

• In the Object control window switch Off the display of the skin object and then switch On the display of the Lenticular and Caudate objects 

[2].

• Select the Intensity Transformation tab [3] and then select the RGB Channel Manipulation option [4].

• Under the To 24-bit Conversion select the Object Colored option [5].

• The Object Color Options will be displayed below. Select Object With Edges [6] and then select Enabled Objects Only [7]

• Click Convert Volume [8].
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• Once the transformation is 

complete save the new RGB data 

set to the workspace using the 

Save Volume button [9].

• The image data can be saved out 

of Analyze using the Input/Output 

module.

RGB Channel Manipulation (continued)



246

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

TRANSFORM > IMAGE CALCULATOR

The Image Calculator tool allows 

many mathematical functions to 

be applied to volumes, matrices 

and constant numerical values, 

including basic arithmetic operations, 

trigonometric functions and logic 

operators.

The Image Calculator interface 

provides a keypad [1] allowing users 

to input functions to the calculator’s 

scrollable canvas [2]. The canvas 

displaying input data, applied 

functions, and results. Users can also 

right click on the canvas to access 

the Buttons Tool to add additional 

functions to the keypad [3]. Image 

Calculator also provides the standard 

image display area [4] for data review.

Image Calculator
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By default, the keypad provides access to the following functions: 

*The modulo operation finds the remainder after division of one number by another.

There are also two drop-down menus available above the keys; Deg and Auto.

Deg: Sets the trigonometric input to Degrees, Radians, or Gradians.

Auto: The Auto drop-down menu specifies how volume data will be handled during operations that may cause data overflow, for example 

the multiplication of two signed 16-bit data sets. The default setting, Auto, ensures that the volume data will be automatically promoted 

up to the next appropriate data type. In the case of the multiplication of two signed 16-bit data sets the resulting data set would have a 

data type of signed 32-bit. All other options will fix the calculator to work only in that data type. This means that overflow and wrapping 

may occur. In some instances, the data type of the volume generated may not be the type selected due to the operation and may require a 

specific output datatype, for example the extraction of a red channel from an RGB data set. The following data types options are available:

   Unsigned 8-bit   Signed 8-bit    Unsigned 16-bit

   Signed 16-bit.   Unsigned 32-bit.  Signed 32-bit. 

   Float     RGB    Complex

Calculator Keypad
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TRANSFORM > IMAGE CALCULATOR

Calculator Canvas

Data is loaded into the Image 

Calculator interface if a data set is 

selected when Transform is opened. 

Image Calculator also accepts image 

data via drag-and-drop from the 

workspace onto the calculator canvas 

[1], onto the Volume input port [2] 

when File > Input/Output Ports is 

enabled, or onto any of the display 

windows [3].

The calculator canvas also accepts 

matrix files loaded from disk and 

functions from the keypad [4].
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Additional functions can be added to the calculator 

keypad. To add more functions to the keypad right 

click in the calculator canvas and select Buttons to 

open the Button Tool [1].

To add a function drag the function button from 

the Palette to the Key Pad [2]. The function will be 

automatically added to the calculator keypad [3].

The following additional functions are available:

Button Tool

 

** Convert rectangular coordinates (x,y) to polar (r,0), computes magnitude r

*** Convert rectangular coordinates (x,y) to polar (r,0), computes phase 0
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TRANSFORM > IMAGE CALCULATOR

A good example of Image Calculator use is in the creation 

of a difference map between ictal and interictal SPECT data 

sets, typically acquired in the study of epileptic seizures. These 

difference maps can be used to study regions of hypo- and 

hyperperfusion.

To follow along, download the SISCOM_Ictal_SPECT_Nrm and 

SISCOM_Interictal_SPECT_Coregistered_Nrm data sets from  

analyzedirect.com/data and load into Analyze using Input/

Output.

The SPECT data inputs for this exercise have already been 

registered and normalized so that they can be compared.

• Open Transform and navigate to Image Calculator [1]. 

• Drag and drop the ictal data set into the calculator window 

[2].

Creating a Difference Map
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TRANSFORM > IMAGE CALCULATOR

• Press the minus key [3].

• Drag and drop the interictal data 

set into the calculator window [4].

• Press the equals key [5] to 

complete the subtraction.

Creating a Difference Map (continued)



252

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

TRANSFORM > IMAGE CALCULATOR

• Click Save Volume [6] to save the 

difference map.

• In the Save Transformed 

window, choose to create a 

new workspace volume [7] and 

rename [8].

• Click Save Volume [9].

• Close Transform.

The difference map is now 

saved to the Analyze Workspace 

and is available for use in other 

modules.

Creating a Difference Map (continued)
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Image Algebra performs mathematical operations on volumes and constant numerical values by means of an algebraic formula parser. There 

are several useful formulas preloaded, as detailed in the table below.

The Image Algebra interface provides access to a Formula parser [1], variable tabs [2], and the standard display area [3].

Image Algebra
TRANSFORM > IMAGE ALGEBRA
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The Formula field allows users to enter a formula to process image data, alternatively users can choose from a list of predefined formulas.

A formula may be as simple as Output=Input, which copies a file, or as complex as to contain up to 1000 variables and 1000 constants. 

When entering complex formulas parenthesis should be used literally to group mathematical operations.

The following operators are supported; +, -, *, /, ( ), <, >, <= ,>= , ==, !=

TRANSFORM > IMAGE ALGEBRA

Symbol Name Meaning/Definition Example

= Equals sign Equality; is equal to, equals Output = Input --- Copies a file

!= Equality operator: 

Inequality

Not equal to operator; is not equal 

to, does not equal. Returns true if 

the operands to not have the same 

value; otherwise, it returns false.

Output = (Input!=145)*Input 

Removes voxels equal to 145 from the image. ‘(Input!=145)’ assigns all voxels not equal to 145 to 1 and 

all voxels equal to 145 to 0. ‘*Input’ then multiples the resulting binary image with the original grayscale 

image, all voxels assigned to 1 are kept while all voxels assigned to 0 are removed from the final image.

== Equality operator: 

Equality

Equal to operator returns true (1) 

if both operands have the same 

value; otherwise it returns false (0).

Output = (Mask==0)*Volume  

Inverts the binary mask input image so all voxels set to 1 are removed from the final image while all voxels 

set to 0 are kept. Normally when multiplying a grayscale and binary the voxels set to 1 in the binary mask 

are kept while the voxels set to 0 are removed.  ‘Mask==0’ keeps all the voxels in the binary image with 

a value of 0. ‘*Volume’ multiples the (inverted) binary image with the grayscale images, the resulting 

grayscale image contains the voxels that were set to 0 in the binary image.

< Strict inequality Less than Output = (Input<155)*128 

In this formula if the voxel intensity value is less than 155, TRUE(1) is returned and these voxels are 

assigned an intensity value of 128, else False(0) is returned and the result is 0 and the original grayscale 

value is preserved. ‘(Input<155)’ assigns all voxels less than 145 to 1 and all other voxels to 0. ‘*128’ then 

assigns all voxels with a value of TRUE(1) an intensity value of 128. 

Formula Parser
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Symbol Name Meaning/Definition Example

> Strict inequality Greater than Output = (Input>45)*Input 

Keeps all voxels greater than 145 (146 and higher) in the image and removes all other 

voxels. ‘(Input>145)’ assigns all voxels greater than 145 to 1 and all other voxels to 0. 

‘*Input’ then multiples the resulting binary image with the original grayscale image, all 

voxels assigned to 1 are kept while all voxels assigned to 0 are removed from the final 

image.

<= Inequality Less than or equal to Output = (Input<=145)*Input 

Keeps all voxels equal to and less than 145 in the image and removes all other voxels. 

>= Inequality Greater than or equal to Output = (Input>=145)*Input 

Keeps all voxels equal to and greater than 145 in the image and removes all other voxels.

+ Plus sign Addition Output = File1 + File2 

Adds two files. Summing data is for useful for averaging data for noise reduction.

- Minus sign Subtraction Output = File1 – File2 

Subtracts File2 from File1. Subtraction is useful for creating a difference image or 

removing background noise.

* Asterisk Multiplication Output = Binary*Grayscale 

Multiplies two data sets, in this example the binary image is multiplied by a greyscale 

image. All voxels in the binary mask equal to 1 will be kept in the resulting greyscale 

image while all voxels with a value of 0 will be removed. Useful for masking data.

/ Division slash Division Output = (File1+File2)/2 

Averages 2 data sets. Useful for averaging images to reduce noise.

( ) Parentheses Calculate expression inside first Output = (Input-intercept)/slope 

Scales image data based on the slope and intercept values from a linear regression line. 

Useful for rescaling CT data to HU’s or BMD units. ‘(Input-intercept)’ minuses the intercept 

value from the input value prior to dividing by the slope ‘/slope’.

Formula Parser (continued)
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Application examples:

Data Normalization: Output=(input-(min(input)))/(max(input))-(min(input))

Scaling data to a phantom: Output = (Input-#intercept#)/#slope#

Masking data and setting the excluded voxels to a specific intensity value: Output=(Mask==0)*Volume+(Mask==1)*#value#

The following functions are supported:

Function Notes

sqrt(equation) Equation can be a variable or a constant. 

log(equation) Equation can be a variable or a constant. 

exp(equation) Equation can be a variable or a constant. 

count() Returns the output slice number. 

max(variable) Returns the maximum value. 

min(variable) Returns the minimum value. 

avg(variable) Returns the average value. 

abs(variable) Returns absolute value. 

int(variable) Converts to integer, truncating floating point values. 

float(variable) Converts to floating point values. 

xpos() Returns the x position in the input image. 

ypos() Returns the y position in the input image. 

ADDTOT(num_add, inc) Returns the sum of the added images as a floating point image.

ADDAVG(num_add, inc) Returns the result of the added and averaged images.

RED(variable) Returns the red portion of the RGB image if the variable specifies an RGB image or an image with a colormap.

GREEN(variable) Returns the green portion of the RGB image if the variable specifies an RGB image or an image with a colormap.

BLUE(variable) Returns the blue portion of the RGB image if the variable specifies an RGB image or an image with a colormap.

TRANSFORM > IMAGE ALGEBRA

Formula Parser (continued)

Note: ADDTOT() and ADDAVG() are 

specialized functions that allow large 

groups of images to be summed or 

averaged. Unlike other functions which use 

a single image as input, these functions 

allow for multiple image inputs, with 

a single output image generated. The 

options in the variables menu all users 

to specify which input image is passed 

to a function. With these functions, the 

values specified in the variables menu 

specify only the starting slice for a group 

of images. num_add specifies the total 

number of images to add together, and 

inc specifies the increment between 

these images. Special status messages 

are generated when these functions are 

executed. Review these messages carefully 

if you experience problems accomplishing 

the desired total and averaging 

functions.
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Additional information when defining formulas:

• Surrounding variables with #’s, will cause prompting for the information that is to be put in the formula in place of the variables. 

• Variable names must begin with an alpha character and have no more than 15 alphanumeric characters. 

• <,>,<=,>=,==,!= are boolean operators that can be used in user specified formulas. The following is an example showing the use of 

boolean operators: 

There are several useful formulas preloaded, as detailed in the table below.

TRANSFORM > IMAGE ALGEBRA

Formula Output=

Copy a File Input

Average Two Files (File1+File2)/2

Binary times Grayscale (Bin!=0)*Gray

Grayscale Thresholding (a>=#in_min#)*(a<=#in_max#)*a+(a<#in_min#)*#out_min#+(a>#in_max#)*#out_max#

Create 24-bit RED(r)+GREEN(g)+BLUE(b)

Extract the Red Channel RED(Input)

Use Total of 3 slices ADDTOT(3,1)

Use Average of 5 slices ADDAVG(5,1)

Pseudo Transparency ((xpos(a)+ypos(a))%2)*a+((xpos(a)+ypos(a)+1)%2)*b

Row Interlace (ypos()%2)*a+((ypos()+1)%2)*b

Intensity Clipping ((a<#min#)*#min#)+(((a>#max#)*#max#)+((a>=#min#)*(a<=#max#))*a)

Formula Parser (continued)
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Adding Formulas 
To add your own formula to the list of formulas 

available from the formula drop down menu, 

do the following. 

• Right click in the Formula field [1].

• In the Edit Formula List window returned 

enter a description for your formula [2].

• Next, enter the formula [3]. Remember to 

surround variables with #’s to make them 

imputable. 

• Uncheck the Default option [4], unless you 

wish your formula to be the default formula 

that appears in the formula bar when 

Image Algebra is selected. 

• Click Add [5].

• The formula will be added to the list [6] and 

will be selectable from the formula drop 

down menu [7].

• Apply Formula: Applies the formula to the 

image data.

• Save Volume: Opens the Save Transform 

window

TRANSFORM > IMAGE ALGEBRA

Formula Parser (continued)
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Variables are dynamically generated when a formula is created or selected. The entries allow for 

the specification and/or modification of data values and parameters. Should a parameter fail to be 

provided and a default value cannot be determined, the formula parser will prompt the user for the 

value. The following options are available (depending on the current formula):

Output: allows for the specification of the output image attributes. The following options are available: 

• Volume: The volume field enables specification of the volume attributes for the output file

 · Start: Specifies the starting volume number for the output file.

 · Increment: Specifies the increment used between volumes for the output file.

TRANSFORM > IMAGE ALGEBRA

Variables

• Slice: The slice field enables specification of the slice attributes for the output file. 

 · Start: Specifies the starting slice number in the output volume for each volume processed. 

 · Increment: Specifies the increment between slices for the output volume. 

 · Slice(s) Per Volume: Specifies the number of slices in each output volume. Options are: Same: When selected, indicates that the 

number of slices in the first input file is used as the number of slices in the output file; Specified: When selected, enables the 

specification of the number of slices in the output file. 

• DataType: Specifies the data type of the output file. Users can choose from a list of available data types, including; unsigned 8-bit, 

signed 8-bit, unsigned 16-bit, signed 16-bit, unsigned 32-bit, signed 32-bit, float, RGB, and double.

 · Rounding: When enabled, floating values are converted to integers by rounding to the nearest integer, otherwise the number will be 

truncation at the decimal point. This option has no effect if the calculated value is an integer or the Output Datatype is float.

• Max/Min: Specifies the method used to set the maximum and minimum values for the output file. The following options are available: 

 · Copy: Specifies that the maximum and minimum values are copied from the input file. 

 · Calculate: Specifies that the maximum and minimum values are calculated for every slice processed. 

 · Full Range: Specifies that the maximum and minimum are set to the full range possible for the current data type.
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Variable: The variable parameters, named assigned from the variable defined 

in the formula, allows for the specification of the variable (e.g. Input) volume 

attributes. The following options are available:

• Volume: The Volume field enables specification of the volume attributes for 

the variable volume. 

 · Start: Specifies the starting volume number for the variable volume. 

 · Increment: Specifies the increment used between volumes for the 

variable volume. 

 · Number: Choose from the following to specify the number of volumes to 

be processed: 

All: Specifies that all volumes in the variable volume will be processed; 

Specified: Indicates the number of volumes in the variable volume to be 

processed. 

• Slice: The slice field enables specification of the slice attributes for the 

variable volume. 

 · Start: Specifies the starting slice number in the variable volume for each 

volume processed. 

 · Increment: Specifies the increment between slices for the variable 

volume. 

 · Number: Choose from the following to specify the number of slices 

to be processed: All: Specifies that all slices in the variable volume will 

be processed; Specified: Indicates the number of slices in the variable 

volume to be processed.

TRANSFORM > IMAGE ALGEBRA

Variables (continued)
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A good example of Image Algebra 

use involves multiplying a grayscale 

data set with a binary data set. The 

binary brain will act as a mask; all 

voxels in the grayscale data set 

that fall within the binary mask will 

be kept, while the voxels that fall 

outside will be removed.

To follow along, download the 

MRI_3D_Head and  

MRI_3D_Head_Bin data sets from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Open Transform and navigate to 

Image Algebra [1].

• From the formula drop-down, 

select the third option down: 

(Bin!=0)*Gray [2].

TRANSFORM > IMAGE ALGEBRA

Applying a Binary Mask to a Grayscale Volume
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• The input variables will appear 

as tabs labeled with the variable 

names.

• Drag and drop the binary data 

set into the designated space on 

the Bin tab [3].

• Do the same with the grayscale 

data set on the Gray tab.

• Once both data sets are loaded 

into Image Algebra, click the 

Apply Formula button [4]

TRANSFORM > IMAGE ALGEBRA

Applying a Binary Mask to a Grayscale Volume (continued)
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• The result is shown to the right.

• Click Save Volume [5] to save the 

masked data set.

• In the Save Transformed 

window, choose to create a 

new workspace volume [6] and 

rename [7].

• Click Save Volume [8].

• Close Transform.

TRANSFORM > IMAGE ALGEBRA

Applying a Binary Mask to a Grayscale Volume (continued)
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The Image Repair tool includes the 

ability to designate bad slices or 

subregions that can be repaired by 

copying voxels from neighboring 

slices, interpolating across 

neighboring slices, copying from 

a related volume or removing bad 

regions from the volume. Subregion 

repair includes the ability to blend 

voxels at the edge of the region. 

Available options are as follows:

Bad Slice(s): This option allows users 

to specify a range of bad slices or an 

area of corrupt data.

Image Repair
TRANSFORM > IMAGE REPAIR

Axial, Coronal, Sagittal: Allows a range of slices to be selected in the Axial, Coronal or Sagittal orientations.

Slider: The Bad Slices(s) double-ended slider allows users to specify a range of bad slices in the selected orientation.

Bad Region: Enables the specification of a region in the image data to repair.  The region is defined by the following options:

 · LX: Specifies the lowest X coordinate of the bad region.

 · HX: Specifies the highest X coordinate of the bad region.

 · LY: Specifies the lowest Y coordinate of the bad region.

 · HY: Specifies the highest Y coordinate of the bad region.

Alternately, users can use the green selection area shown on the Repair Region image to define the region to repair [1].
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Bad Region (continued)

 · Show Border: Displays a rectangular box around the region defined by the Bad Region X and Y parameters.

 · Blend Border: The blend border options allows for the specification of a region around the bad region where the corrected image 

information is slowly blended with the current image intensities. Move the slider button to adjust the Blend border size. Set this value 

to zero if no transition area is desired. 

Correction Method: Allows users to select an appropriate correction methodology. Select from the following options:

 · None: No correction will occur. 

 · Copy the Closest Good Slice: Copies all the pixel values from the closet non-bad image.

 · Interpolate Between the First Good Slice: Use Linear interpolation to calculate a replacement slice for each bad slice. The value of 

each voxel is computed using information for each of the good slices on each side of the bad slices. The percentage of each image 

uses is calculated based on the distance from the bad slice to each good slice.

 · Copy from Related Volume: Only available if a related volume is loaded. This option copies all pixel values from the related volume. 

Commonly used with a mirrored and registered copy of the input volume to symmetric features in regions.

 · Remove the Bad slices: The slices are removed and the slices after the last bad slice are shifted to the area removed. This option leave 

blanks in the last few images for the selected orientation.

 · Erase the Bad Slices: The selected range of bad slices are just set to the minimum data type value. 

Correct What: The correct what options allows user to correct the original image data (Volume), a loaded object map (Object Map), or both 

the original image data and object map (Both). 

Repair Slices: Applies the selected correction method to range of the bad slices, or regions within those slices.

Image Repair Options

TRANSFORM > IMAGE REPAIR
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Here we will repair an image that has 

a series of corrupt slices.

Repairing an Image

To follow along, download the 

VH_Abdomen data set from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Open Transform and navigate to 

Image Repair [1].

• Navigate to the first corrupt slice 

in the data set, which for this 

example is slice 276 [2].

• Move the lower limit of the bad 

slices slider bar to 276 [3].

Repairing an Image

TRANSFORM > IMAGE REPAIR
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TRANSFORM > IMAGE REPAIR

• Navigate to the last corrupt slice 

in the data set, which for this 

example is slice 279 [4].

• Move the upper limit of the bad 

slices slider bar to 279 [5].

• Set the correction method to 

Interpolate Between the First 

Good Slices [6].

• Click Repair Slices [7] to apply the 

correction.

Repairing an Image (continued)
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TRANSFORM > IMAGE REPAIR

Note that the repaired version 

now appears on the left side of the 

window [8]

• Click Save Volume [9] to save the 

corrected data set.

• In the Save Transformed 

window, choose to create a 

new workspace volume [10] and 

rename [11]

• Click Save Volume [12].

• Close Transform.

Repairing an Image (continued)
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272SEGMENT

The goal of segmentation is to partition an image into regions, or objects, that are homogeneous with respect to one or more 

characteristics or features. Segmentation is a critically important tool for the processing of image data and is often the precursor to other 

applications such as measurement, visualization, surface-based registration and surface extraction.

Introduction
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SEGMENT > OBJECT MAPS

Analyze uses a file called an object map 

to partition image data into groups of 

voxels within a segmentation component 

map. After creation of the object map 

through segmentation, it can be used to 

drive visualization, registration, surface 

generation and statistical analysis.

The object map is an associated volume 

with the same dimensions as the image 

data. Each voxel of the object map 

contains an 8-bit value which encodes it 

as belonging to 1 of 256 total possible 

objects. Every voxel in the data set 

is initially assigned to the first object 

(Original), leaving 255 additional objects 

that can be used for 2D region or 3D 

volume of interest definition.

Object maps are loaded separately 

from the image data to which they are 

associated using the File > Load Object 

Map option in each functional module. 

When the object map is loaded, the 

objects defined in it are overlaid on the 

image data.

Object Map Segmentation vs. Grayscale Segmentation

Grayscale segmentation destroys all voxels that are not part of 
the object of interest.

Object maps preserve the original data by assigning the 
segmented voxels to objects.

Object Maps
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SEGMENT > SEGMENT MODULE INTERFACE

The Segment Module interface is 

divided into the following areas: 

[1] Menu, [2] Segmentation Options, 

[3] Display Controls, [4] Tools, 

[5] Object Control Window, [6] 

Orthogonal Image Display, and [7] 

Rendering Window.

Each of the Segment Module 

Interface areas are now described:

Segment Module Interface
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SEGMENT > SEGMENT MODULE INTERFACE

The Menu provides access to the File, Options and Help menus.

File

The File menu allows users to load and save object maps for the loaded data set. The File options include:

Input/Output Ports: Displays a Volume area at the bottom of the Segment module window. This area facilitates the dragging and dropping of 

image data into the module and the loading of a related image data set, see Dual Input Segmentation for additional information.

Load Object Map: When selected opens a Load Object Map window allowing users to navigate to, select and load an object map file. The 

following options are available:

• Current Directory: Takes user to the current directory, the current directory is set by right-clicking in the main Analyze 15.0 window and 

then choosing Current Directory from the menu. See section 1. Analyze Basics for additional information. 

• Workspace Directory: Takes user to the current Workspace directory.

• Home Directory: Takes user to the user’s Home directory. 

• Cancel Load: Cancels the load of the object map.

Menu
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Save Object Map: When selected opens 

a Save Object Map window allowing users 

to navigate to name the object map and 

select a location to save the object map 

file.

Save Object Map As: Allows users to 

save a copy of the current object map 

without overwriting the original object 

map file.

Reset Object Map: Resets the current 

loaded object map, deleting all defined 

objects. When this option is selected a 

prompt will be returned asking you to 

confirm the reset. Select ‘Yes’ to continue 

or ‘No’ to cancel.

If the object map has not been saved or 

changes to an object map have not been 

saved when the Rest Object Map option is 

selected an Object Map Changed prompt 

will be returned providing the opportunity 

to save the object map.

Exit: Closes the module

Menu (continued)
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Other

The other menu provides access to additional module options and configuration of the tools area. 

Options: When selected opens the Options menu providing access to Module configuration options, including:

• Intensities Linked: Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity display 

will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually.  

• Fast Object Rendering: Enables/Disabled Fast Object Rendering.

• Show Cursor Coordinates: Allows users to Enable/Disable the display of the linked cursor coordinates and voxel grayscale value displayed 

in the lower left-hand corner of the display window.

• Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

• Auto Cursor Link: Allows the Auto Cursor Link option to be enabled or disabled. 

• Remember Layout: When enabled the module will remember changes made to the layout and will open with this layout in the future. When 

disabled the module will open with the default layout. 

• Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is set 

to the number of processors on the system.

Menu (continued)
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Powerbar Editor

When selected opens the PowerBar editor 

allowing users to add additional shortcut 

buttons to the tools area of the Segment 

window. Add or remove the following 

shortcut buttons form the tools area: 1) 

Exit, 2) Options, 3) Input/Output, 4) Load 

Object Map, 5) PowerBar Editor, 6) Reset 

Object Map, 7) Save Object Map As, 8) 

Save Object Map, 9) Set Note Stat, 10) 

Toggle Cursor Link, 11) Toggle Region 

Display.

Help

The Help menu provides users with quick 

access to help resources including:

• About: View version, system and 

environment information.

• Users Guide: Opens the Analyze 15.0 

User’s Guide.

• Get Help: Opens the AnalyzeDirect 

Support Page.

Menu (continued)



279

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > SEGMENT MODULE INTERFACE

The Display Control tools allow users 

to control and customize the layout 

of the Segment display area. Some of 

these control options are unique to 

Segment.

Control Layout

This option allows users to control the 

layout of the display. Choose from 

Axial as Primary, Coronal as Primary, 

Sagittal as Primary, Render as Primary 

or No Primary image.

No Primary Image: This is the default 

selection. 

This option displays the rendering 

and three orthogonal views in four 

equally sized windows.

Control Layout

Toggle Rendering

Toggle Oblique

Toggle All Orientations

Display Controls
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Axial as Primary: Focuses the 

display on the axial image. The 

coronal, sagittal and rendering 

windows are displayed below the 

axial window.

Coronal as Primary: Focuses the 

display on the coronal image. The 

axial, sagittal and rendering windows 

are displayed below the coronal 

window.

Display Controls (continued)
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Sagittal as Primary: Focuses the 

display on the sagittal image. The axial, 

coronal and rendering windows are 

displayed below the sagittal window.

Render as Primary: Focuses the 

display on the rendering. The axial, 

coronal and sagittal windows are 

displayed below the rendering. 

Display Controls (continued)
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Toggle Rendering

The Toggle Rendering options allows 

users to switch the Render window on 

[1] and off [2].

Display Controls (continued)
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Toggle Oblique

The Toggle Oblique option allows 

users to switch the oblique display 

window [1] on and off.

The oblique window provides users 

with the ability to create any arbitrary 

oblique plane on the fly, using the 

control tools [2] in the oblique window.

Display Controls (continued)
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The oblique image can also be 

generated using the blue oblique 

reference line that appears in all of the 

other enabled windows [3].

When the oblique image is enabled, 

an additional option becomes 

available: Toggle Perpendicular [4].

Display Controls (continued)
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Toggle Perpendicular

The Toggle Perpendicular window 

provides an oblique control window 

for each orientation [1].

The control tools [2] can be used 

to manipulate each orientation to 

aid users with the generation of the 

desired oblique plane.

Display Controls (continued)
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When enabled, the perpendicular 

displays can be viewed with the 

Rendering toggled on [3]. While 

this option is up to the user, some 

users find the oblique reference 

lines displayed on the 3D rendering 

helpful when manipulating the 

oblique plane in 2D.

Users may also find it useful to switch 

off the linked cursor tool [4] when using 

the oblique reference lines.

For more information about creating 

oblique planes, refer to the Apply 

Matrix exercise in the Transform 

section.

Display Controls (continued)
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Toggle All Orientations

The Toggle All Orientations option 

allows users to switch between the 

display of the axial, coronal and 

sagittal [1] windows to a single image 

window [2]. 

Display Controls (continued)
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When the rendering is enabled, the 3D 

rendering will also be displayed [3].

When display is toggled to single 

display mode, additional display 

options are enabled [4].

SEGMENT > SEGMENT MODULE INTERFACE

Display Controls (continued)
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The additional options allow users to 

display the image before [5] and after 

[6] the current slice. To display another 

orientation, click on the Orient text 

[7] to cycle through the orthogonal 

orientation displays. 

Display Controls (continued)
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The Tools options in the top right 

hand corner of the Segment Module 

Interface, provide access to the 

Cursor Link, Toggle Region Display 

and the Set Note State tools.

Cursor Link

The cursor link allows users to 

interactively navigate through the 

image data. The tool can be controlled 

from any of the 2D orientations or 

from the 3D rendering. Moving the 

tool will interactively update the 

corresponding slice displays.

The linked cursor can be enabled 

or disabled using the Toggle Cursor 

Link button.

Tools

Cursor Link

Toggle Region Display

Set Note State
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Toggle Region Display

Users have the option to change 

the display of objects on the 2D 

slices. Users can cycle through the 

various object display options using 

the Toggle Region Display button 

or using the t key.

Tools (continued)
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Filled Regions with Edges

Filled Regions Edges

Off

There are four object display options:

Tools (continued)
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2D Object Opacity Display: It is 

possible to change object color 

alpha blend for the display of objects 

on the 2D slice data for the filled 

regions and filled regions with edges 

object display options. Adjusting the 

alpha blend allows users to visualize 

underlaying grayscale data while still 

seeing which voxels are assigned to 

objects. 

To adjust the alpha blend right-click 

on any of the 2D slices displays and 

then choose the Set Object Opacity 

[1] option to enable it.

An Opacity slide will appear below 

the slice display window [2] allowing 

users to adjust the alpha blend of 

the objects on the image data. The 

default opacity value is 50%. 

Use the slider to reduce the object 

opacity value [3] and review the effect 

[4].

Tools (continued)
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Notes

The Notes tool in Analyze allows 

users to annotate image data in 2D 

or 3D. Notes will be associated with 

the data set and can be loaded into 

other modules. Notes can be hidden 

or deleted at any time.

Shows notes (default).

Allows users to make and edit notes.

Hides notes.

To annotate a data set using notes 

click on the Notes button in the 

toolbar (note that the Edit mode will 

be activated.) Click on any 2D slice or 

the 3D rendering to create a note. 

Tools (continued)
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The Object Controls window allows users to 

add objects to the current object map. It also 

allows users to edit object properties. The 

Object Controls window provides users with the 

following object control options, functions, and 

productivity tools:

Add Object

The Add Object button [1] allows users to add 

new objects to the object map. Objects are 

show in the object list [2].

Name

The Name field [3] in the object attributes 

area allows users to modify the assigned 

object name to something applicable for the 

segmented object.

Object Controls Window

Color

Object color can be updated by entering the color name (e.g. Gray) or the hex color code (e.g. #808080) in the Color field. [4] 

Object colors can also be interactively selected using an object color palette. To open the Color palette, click on the palette icon [5] next to 

the Color field or the colored square next to the object name in the object list.
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The Color selection palette [6] will open, select 

a basic color or use the color selector to choose 

a color. Color HSL and RGB values can also be 

input.

Display

The Display attribute for an object controls 

if the object is visible or not on the 2D slice 

displays and 3D rendering. To disable and 

enable the display of an object use the Display 

checkbox [7] in the object attribute are or click 

the screen icon next [8] to the object in the 

object list. 

Object Lock

Object locking provides the ability to lock 

objects preventing the voxels assigned to the 

locked object from being edited. This is a

Object Controls Window (continued)

powerful tool to aide segmentation, as locking an object protects objects from being written over. When an object is locked, the boundary 

of the object acts as a limit. This can be leveraged to help with the segmentation of objects that are spatially connected. However, some 

semi-automatic tools do not observe locked objects. Before such a tool is used, a dialog box will appear notifying the user of this.

Objects can be locked and unlocked by checking the Locked checkbox [9] in the object attribute area or by clicking the lock icon [10] for the 

object in the object list. 
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Opacity

The Opacity option [11] is only available 

when the Transparency option is enabled. 

To enable the option right-click on the 

rendering and choosing Transparency 

form the menu. Adjusting object opacity 

levels allows users to enhance the 

rendered display of objects. Object 

opacity can be manipulated by using the 

opacity slider or by entering a value in 

the text field.

Delete

The delete button [12] allows users to 

remove objects form the object map. 

Voxels assigned to an object that is 

deleted are reassigned back to the 

Original object and the object is removed 

from the object list. 

Object Controls Window (continued)

Right Mouse Menus

There are several right mouse menu options in the object controls window, and these menus are accessible by right-clicking in the object list 

[13], the object attribute area [14], and the area around the Add Object button. [15] 
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Object List Right Mouse Menu

Right click in the object list area to access 

additional object functionality from the 

right mouse context menu. These options 

include:

Control By: The Control By option 

allows users to set the control of object 

attributes by objects or by attribute. 

When set to Object users can modify 

all object attributes for a single object. 

When set to Attribute users can modify 

the selected attribute for all objects: 

• Objects: Objects is the default control 

by option, displaying a list of objects. 

Attributes for each object can be 

edited in the object attribute area for 

each object.

Object Controls Window (continued)

• Attributes: When the Attributes option is selected the object list area updates providing an attribute drop down menu [16]. Users can 

select any of the object attributes to enable or disable for all the objects in the object map [17]. The attribute options include; Display, 

Lock, Name, Color, Shades, Neighbors Used, and Opacity. Controlling by Attribute is extremely useful when you need to modify 

attribute values for many objects. Right-clicking in the object area provides access to additional selection options to enable or disable 

attributes including All, None, and Invert.
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Remove Unused: allows users to quickly 

delete any object in the object list that 

doesn’t have a voxel assigned to it. A 

helpful option for object map clean-up.

Reorder Objects: allows users to reorder 

objects in the object list. When selected 

a Reorder Objects window opens [18]. 

Objects can be moved up or down in 

the object list using the arrow keys next 

to the object [19]. Right-clicking on an 

object allows you to move the object to 

the top or bottom of the object list [20]. 

To apply changes in object order click the 

Re-order button [21].

Reassign Objects: Selecting the 

reassign object option will open the 

Reassign Object(s) window enabling the 

reassignment of one or many objects to 

another. Select the object to reassign 

from the ‘Reassign From’ list [23] then set

Object Controls Window (continued)

the object to reassign to from the ‘To’ drop down list. [24] Check or uncheck the Remove Object After Reassignment check box [25] and 

then click Apply. [26] All voxels assigned to the objects selected in the ‘Reassign From’ list will be assigned to the object in the ‘To’ list.

Recalc Objects: When this option is selected the module calculates and sets the minimum enclosing 3-D region for each object.
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Load Objects: allows users to load objects from another object map into the current 

object map. For example, electrodes segmented from a CT data set could be loaded 

onto a brain object in a co-registered MRI data set. To use, right-click on the object list 

area and then choose Load Objects from the menu. In the window returned navigate 

to and select the object map that contains the object(s) you wish to load. Once select a 

Load Object(s) window [27] will open. Check the objects you wish to load [28] and then 

click Load Selected [29].

Please note, loaded objects will overwrite voxels assigned to other objects so consider 

the order that objects are loaded. For example, loading a hippocampus object into 

an object map that contains the whole brain would work fine, however, loading the 

whole brain into an object map that contains the hippocampus would not work, as the 

hippocampus object would be overwrote by the brain object. 

Object Controls Window (continued)

Load Binary: allows users to create objects using a binary image. For example, electrodes segmented from a CT 

data set saved to the workspace as a binary image could be loaded onto a brain object in a co-registered MRI 

data set. The following options are available:

o Workspace: Select the workspace that contains the binary image to load. 

o File: Select the binary image file. 

o Object: Choose the object to create from the binary image input.

To use, right-click on the object list area and then choose Load Binary from the menu. In the Load Binary window 

returned use the Workspace menu option to select the workspace that contains the binary image. Next use the 

File option to select the binary image from the workspace. Finally, use the Object drop-down menu to set the 

object the binary image will create, by default the option is set to ***New***, however, any object in the object 

map can be selected. Finally, click Load Binary.
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Object Controls Window (continued)

Save Binary: allows users to save any object in 

the object map out to the selected workspace 

as a binary image, the voxels part of the object 

will be saved as 1’s while every other voxel will 

be saved as a zero. The following options are 

available:

o Object: Chose the object to save. 

o Workspace: Select the workspace to save 

the binary image to. 

o File: Name the file. 

o Save Binary: Initiates the save process.

Save Greyscale: allows users to save any object 

in the object map out to the selected workspace 

as a grayscale image, with all voxels not part of 

the object removed from the image (set to the 

background). The following options are available:

o Object: Chose the object to save. 

o Workspace: Select the workspace to save 

the greyscale image to. 

o File: Name the file. 

o Save Greyscale: Initiates the save process.



302

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > SEGMENT MODULE INTERFACE

Apply Edits: allows users to change the voxel grayscale values in the image for any object in the 

object list, including the original object. To use, right-click on the object list area and then choose 

Apply Edits from the menu. In the Apply Object Edits to Volume window returned [30] select the 

object(s) to edit [31] and then use the drop-down menu to choose the type of edit to apply. The 

following options are available:

• Set to Value: Allows users to select a single greyscale value that all voxels represented by the 

object will be assigned to. 

• Intensity Scale Values: Provides users with the ability to the range of the grayscale values by 

adjusting the minimum and maximum values.  

• Random Value: Assigns voxel values to a random value. The Random value maximum and 

minimum range defaults to volumes maximum and minimum, but these values can be edited by 

the user.

• Gaussian Value: Assigns voxel values within the object to be assigned to a Gaussian Value. Mu 

and Sigma values are calculated automatically, but can be updated by the user. 

Assign the desired value(s). Choose to Apply the edits to the Loaded Volume or a Copy of the 

Loaded Volume (recommended) and then click the Apply Edits to Volume button [32] to update 

the data set.

Load Surface: Allows users to load related .stl or .pogo surface files for the data set.

Extract Surface: The Extract Surface option allows users to generate and save surface files from 

objects. For instructions on how to use this option please refer to the Generating Surface Files 

from Objects section of this guide. 

Object Controls Window (continued)
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The Object Attribute Area Right Mouse Menu

Right click in the object attribute area to access additional object functionality from the right 

mouse context menu. These options include:

Object Controls Window (continued)

Control By: The Control By option allows users to set the control of object attributes by objects or by attribute. For a full description please 

see the Control By section in the Object List Right Mouse Menu Options section above.

Neighbors: The Neighbors option allows users to specify which voxels are used to calculate the gradient for image rendering. Changing the 

neighbors option can help improve the display of rendered objects especially with anisotropic data sets or with objects loaded from related 

data sets. The following options define the neighbors used:

• All: Specifies that all voxels, no matter which object they belong to are used.

• Object w/Gradient: The object with gradient specifies that only the grayscale values of neighboring voxels which belong to the same 

objects are used.

• Object wo/Gradient: The object without gradient specifies that only neighboring voxels which belong to the same object are used. The 

grayscale value of the voxels are ignored, with gradient computations applied to the object map itself (binary surface rendering).

• Object Smoothed: This option is similar to object without gradient option, however, instead of using only the neighboring voxels 

belonging to the same object to calculate the shading, the neighboring voxels within a5x5x5 region around the voxels of interest are 

used. A weighting factor is applied so that the closest neighbors have twice the contribution as those twice as far away.

Shades: The Shades options allows users to set the number of shades used for the object. Users can choose from; 1, 16, 32, 50, 64, and 256.
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The Add Object Area Right Mouse Menu

Right click in the Add Object area provides access to the Templates option. The Templates option allows users to create object templates 

for object maps, this option is especially useful when users create the same object maps containing the same objects for multiple volumes. 

It is also helpful for object maps that contain may objects. To use this option, create a list of objects specifying object names, colors, and 

any other attributes and then right-click and choose Templates > Save Templates. Choose to save for the Current User or All Users and then 

name the template. Click Save. 

Object Controls Window (continued)

To	load	an	object	template	right	click	in	the	Add	Object	area	and	then	select	the	template.	User	specific	templates	(Current	User)	are	shown	

at	the	top	of	the	window	while	system	templates	(All	Users)	are	shown	in	the	middle.	Once	the	template	is	selected	the	objects	specified	in	

the	template	will	be	loaded	to	the	object	list.	Note	that	these	are	just	empty	objects,	templates	will	not	save	any	kind	of	segmented	object	

region.
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The orthogonal slice display windows provide an interactive 2D review tool of the slice data in the axial, coronal and sagittal planes. For 

more information about the slice display windows, refer to the Display section of The Analyze User’s Guide.

Orthogonal Image Display
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The Rendering Window provides an interactive 3D display of the segmented image data. For more information about the render window, 

refer to the Display section of The Analyze User’s Guide.

Renedering Window
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The segmentation options are provided in five tabs:

• Edge Strength

• Walls

• Subregion

• Semi-Automatic

• Manual

These five tabs provide access to all the segmentation tools in Segment. The segmentation tools within each tab will now be described.

Segmentation Tools
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The Edge Strength option allows users 

to mask the input data with a set of 

enhanced gradients that act as limits 

aiding in the segmentation of structures. 

Edge strength works by applying a 3 

X 3 X 3 Sobel filter to the image data, 

which can be interactively adjusted using 

the Edge Strength Threshold slider. All 

voxels with gradient values less than or 

equal to the selected threshold value are 

displayed with a definable edge color 

and form boundaries around structures. 

The boundaries act as limits, restricting 

semi-automatic segmentation operations. 

The following controls are available:

Edge Strength

Use Edge Strength to Enhance Segmentation: When this option is checked the Edge Strength option is enabled for the image data, a 3 

by 3 by 3 Sobel filter is applied to the volume and the Edge Strength Threshold slider and additional options are enabled.

Edge Strength Threshold: This slicer defines the upper threshold value for the Sobel filtered gradient volume. When the left mouse button 

is used to drag the slider, all of the voxels with gradient values less than or equal to the threshold value are highlighted. Semi-automated 

segmentation algorithms are applied to the voxels within the threshold range. 

Edge Color and Edge Opacity: Allows users to specify the color and adjust the opacity display of the edge overlay on the image data.

Show Edges on All Tabs (when active): maintains the display of the edges on the image data when moving to different segment tabs. 
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First we will attempt to segment the 

heart from this CT data set without 

using edge strength.

To follow along, download the data 

set CT_Heart from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1], and 

choose Region Grow [2].

• Click on the image data to set a 

seed point [3 ]. The seed point 

should be in the object you 

would like to isolate.

• Set the threshold Min/Max values 

to define the object  [4]  and click 

Connect Object [5].

Using Edge Strength
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• The results of the region grow 

are shown below.

• The segmented object is shown 

overlaid on the 2D slice data 

[6] and a 3D representation [7] 

is displayed.

Note that both the heart and the spine 

have been assigned to Object_2 [8].

• Click Undo.

Using Edge Strength (continued)
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Now we will repeat this segmentation 

using edge strength to separate the 

heart from the rest of the data set.

• Select Edge Strength [9] and 

check Use Edge Strength to 

Enhance Segmentation [10].

• Set the Edge Strength Threshold 

to 90. Note that this value will 

be different for each data set. In 

general, adjust the edge strength 

using the slider [11] until you 

find a suitable value. The edges 

will interactively update on the 

data set. Use the edge display 

to determine the suitable edge 

strength value.

• Optionally, change the color of 

the edge by entering the desired 

color in the text field or by using 

the color selector [12].

• When performing the 

segmentation, leave the Show 

Edges checkbox [13] selected. 

If required, reduce the Edge 

Opacity using the slider [14].

Using Edge Strength (continued)
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The edges detected on this data set using the Edge Strength algorithm with an edge strength threshold of 90 are shown overlaid on 

the data below.

Using Edge Strength (continued)



313

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > EDGE STRENGTH

• Repeat the segmentation. Select 

Semi-Automatic, then choose 

Region Grow.

• Click on the image data to set 

a seed point. The seed point 

should be in the object you 

would like to isolate.

• The Threshold Min/Max values 

should still be set to the previous 

values. If not, reset them to 

define the object and then click 

Connect Object [15].

Using Edge Strength (continued)
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Note that this time, only the heart was segmented. The Edge Strength technique prevented the region grow algorithm from including the 

spine in the object. Further segmentation can now be achieved with or without Edge Strength enabled. Select File > Save Object Map to 

save your work.

Using Edge Strength (continued)
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SEGMENT > WALLS

Segmenting structures of interest that are connected to surrounding anatomy with similar grayscale values can be challenging. The 

Walls option provides tools to create adaptable 3D limits to help make this process easier for the user. The Walls tool is useful for many 

segmentation applications, particularly isolating the cerebellum from the rest of the brain parenchyma or limiting the boundaries of a region 

grow operation to isolate blood pools from cardiac data.

Walls

The Walls option allows users to 

define traces which are used to limit 

the extent of an object. Separate 

walls can be created in each 

orientation, the wall defined in one 

orientation is not reflected in the 

other orientations. Traces defined 

on slices are linearly interpolated 

within each orientation reducing 

user interaction time, so that a trace 

defined on slice 10 and a trace 

defined on slice 50 are automatically 

interpolated between so the user 

doesn’t have to define the wall on 

each slice between.  The interpolated 

traces are designated by a dashed 

green line, while the user defined 

traces appear as a dashed red line.

Walls are used with the Threshold Volume, Region Grow, Connected Components, Object Extractor and Object Separator Semi-Automatic 

tools. Walls can also be used in conjunction with the Edge Strength and Subregion tools.
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The Walls tab provide the following 

option:

Define Walls to Limit Semi-
Automated Operations: When 

checked enables wall definition 

options allowing users to define walls 

on the image data. 

Wall Type: Allows users to select 

the wall definition mode, the options 

include: 

• Line: The line option allows users 

to define a straight-line wall on 

the image data.

• Trace: Allows user to define a 

freehand wall on the image data

• Spline: The Spline option allows 

users to define a curved wall. 

Splines are flexible curve traces 

with movable control points that 

are useful for creating smooth 

walls.

SEGMENT > WALLS

Walls Tab Options
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• Smart Edge: The smart edge 

option detects regions of high 

rate of change of voxel intensity 

(gradient) that represent edges, 

smart edge snaps to the edges of 

these regions. 

• Sensitivity: The sensitivity of 

the smart edge can be adjusted 

using the slider or the mouse 

scroll wheel. The lower the value 

the less sensitive the tool is, 

the higher the value the more 

sensitive the tool is.

Extend Wall(s): Specifies if the wall 

is extended beyond the first and last 

user defined wall in each orientation. 

Reset Wall(s): Allows the user to 

reset the defined walls in any or all 

orientations.

SEGMENT > WALLS

Walls Tab Options (continued)
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Here we will use the Walls 

functionality to segment the 

cerebellum from the rest of the brain 

parenchyma in a head MRI dataset.

To follow along, download the data 

set EGV_MRI from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Walls [1] and check Define 

Walls to Limit Semi-Automated 

Operations [2].

• Set the Wall Type to Spline 

[3].

• Set the primary display to 

Sagittal [4].

SEGMENT > WALLS

Using Walls
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• Navigate through the sagittal 

slices to find the first slice that 

includes tissue belonging to 

the cerebellum. Draw a wall 

separating the cerebellum from 

the cerebrum on this slice. 

• To draw a wall using the spline 

tool, left-click to set spline 

points which will connect into a 

smooth line. Double-click when 

defining the last spline point to 

set the spline [5].

• The spline points can be adjusted 

by left-clicking and dragging. 

Right-clicking on a spline point 

allows you to delete it or make 

other changes to the spline such as 

closing the spline or deleting the 

entire spline.

• Move forward through the 

sagittal slices and adjust the wall 

as required [6].

• The Wall can also be redrawn if 

necessary.

SEGMENT > WALLS

Using Walls (continued)
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• Once the cerebellum is no 

longer well defined by the wall, 

redefine the wall on that slice. 

The wall will be interpolated 

between all slices on which it is 

defined. When finished, scroll 

through the slices to ensure that 

the cerebellum is well defined 

by the wall.

Note that walls can be set in multiple 

orientations. This is helpful when 

trying to isolate structures connected 

to several surrounding structures in all 

orientations. For example, it can be 

used when isolating the heart from 

the lungs, spine, sternum, etc. It can 

also be useful to define walls in the 

sagittal and coronal orientations to 

better segment the cerebellum.

• Continue to define walls around 

the cerebellum in the sagittal 

orientation [7], [8]. 

SEGMENT > WALLS

Using Walls (continued)
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SEGMENT > WALLS

• Once the cerebellum boundary 

is defined in three dimensions 

by the wall, select the Semi-

Automatic tab  [9]  and choose 

Object Extractor [10].

• Click in the cerebellum on a 

sagittal slice to set a seed point 

[11]. 

• Adjust the maximum and 

minimum threshold values [12] 

until the auto trace defines the 

object [13]. 

Note that while the entire brain will 

be defined, the walls will prevent the 

whole brain from being segmented 

and will confine the segmentation to 

the cerebellum.

• Click Extract Object [14]. 

Using Walls (continued)
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SEGMENT > WALLS

• The cerebellum will be isolated and displayed in 3D.

• Once segmentation is complete, the structure will be rendered [15] and overlaid on the slice data [16].

• Save your work by selecting File > Save Object Map.

Using Walls (continued)
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SEGMENT > SUBREGION

Subregion allows users to limit segmentation to a specific user-defined region. This tool is particularly useful when segmenting a structure of 

interest, such as the hippocampus, without having to crop the original image data.

Subregion
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Subregion can be used with the 

Threshold Volume, Region Grow, 

Connected Components, Object 

Extractor and Object Separator 

Semi-Automatic tools. Subregion can 

also be used in conjunction with the 

Edge Strength and Wall tools.

Restrict Segmentation with a 
Subregion: When checked enables 

subregion restriction of semi-

automatic and manual segmentation 

tools. The following options are 

available:

• Segment Inside the Specified 

Subregion: Allows users to 

segment within the specified 

subregion.

• Segment Outside the Specified 

Subregion: Allows users to 

segment outside the specified 

subregion.

SEGMENT > SUBREGION

Subregion Options
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• X Slider: Allows users to define the extent 

of the subregion in the X orientation.

• Y Slider: Allows users to define the extent 

of the subregion in the Y orientation.

• Z Slider: Allows users to define the extent 

of the subregion in the Z orientation.

• Shade Restricted Area: Allows users to 

switch on shading [1] for the restricted area 

or switch off shading [2] for the restricted 

area.

• Shade Color: Allows users to change the 

color of the restricted area [3] by typing a 

color in the color field area or by selecting 

a color using the color section option.

• Segment Outside the Specified Subregion: 

Allows users to segment outside the 

specified subregion.

• Shade Color: Allows users to change the 

color of the restricted area [3] by typing a 

color in the color field area or by selecting 

a color using the color section option.

SEGMENT > SUBREGION

Subregion Options (continued)
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SEGMENT > SUBREGION

Here we will set a Subregion to 

protect and limit the region when 

segmenting with other tools.

To follow along, download the data 

set EGV_MRI from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Subregion [1], and check 

the Restrict Segmentation with a 

Subregion checkbox [2].

• Choose to Segment Inside 

(default) or Outside the 

Subregion [3]

• Use the X, Y, Z sliders [4] or 

the yellow control points [5] 

to specify the Subregion in all 

orientations. 

• The area in red will be protected 

as you move to the Semi-

Automatic or Manual tools to 

segment regions of interest. 

Setting a Subregion
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SEGMENT > SEMI-AUTOMATIC TOOLS

The Semi-Automatic tab provides access to many useful tools for interactive, efficient segmentation of objects. These tools include simple 

segmentation options, such as threshold, to more advanced, semi-automated techniques like object extraction and object separation. The 

segmentation tools available also include those that use 3D spatial connectivity and include region growing and connected components.

Semi-Automatic Tools
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SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold segmentation allows a range of voxels from the input volume to be assigned to an object. All voxels greater than or equal to the 

threshold minimum and less than or equal to the threshold maximum are assigned to the object.

Threshold Volume



329

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

Threshold Slider: The Threshold double-ended slider bar allows users to 

specify a range of threshold values using the minimum and maximum ends 

of the threshold slider. Selecting the minimum end of the slider [1] and 

moving it to the right will increase the minimum threshold value, moving it 

to the left will decrease the minimum value. Selecting the maximum side of 

the slider [2] and moving it to the left will decrease the maximum threshold 

value, moving the slider to the right will increase the maximum value. Voxel 

with values outside the range are ignored and not include as part of the 

current object.

SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold Volume Options

When adjusting the minimum or 

maximum threshold range [3] an 

interactive preview showing the 

range of selected voxels will be 

displayed overlaid on the grayscale 

data [4], a 3D display of the voxels 

will also be displayed in the render 

window. [5] The color of the 

previewed voxels will match the color 

of the object you currently have 

selected. [6]
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Holding the Alt key while dragging either the minimum or maximum end of the slider 

allows for smaller adjustment of the value allowing users to fine tune selections. Clicking in 

the trough to either side of the minimum or maximum end of the slider [7] will advance the 

value by 1. Shift-click will decrease the value by 1.

Min and Max: The minimum and maximum input field allows users to manually enter the 

minimum or maximum threshold value. There are also arrow up and down buttons the 

right of the input field to increase or decrease the currently value by 1.

Threshold Rendering: This option allows users to disable and enable to 3D preview of 

the selected voxel range. It is recommended to disable this option by unchecking the 

checkbox when working with large data sets.

Threshold Object: Assigns the voxels in the selected range to the current object.

SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold Volume Options (continued)

Right click options: Right clicking on the Threshold 

slider provides users with access to the following 

options:

Presets: The Presets option allows users to define 

threshold values for specific structures or objects of 

interest. This is particularly useful for those users who 

routinely segment the same structures from their 

image data.



331

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

have been defined. The first three presets are for a dental segmentation application. The second three presets are for a muscle 

segmentation application. As the first three presets Depend Type is set to Any, these presets will be available for any data set loaded 

into the Segment module. However, the latter three presets have a Depend Type set to Volume Dimension and the Dependency set 

to a volume size of 450 by 450 by 224, these presets will only be available for data sets loaded into Segment of this size. The following 

Depend Types are available:

Module: Defaults can be set for specific modules, for example presets to segment image data can be set to only appear when the data 

is opened with Segment, presets for rendering set to appear only when data is opened with Display. 

Volume Name: The preset will only display if the volume name meets dependency criteria.  

Volume Data Type: The preset will only display if the volume data type meets the dependency criteria. 

Volume Dimensions: The preset will only display if the volume data type meets the dependency criteria. 

Any: Default option. The preset will be displayed.

SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold Volume Options (continued)

Right click options (continued) 
Presets (continued): When the Edit Presets Thresholds 

window opens, the following options are available:

• Name: Allows users to enter the name for preset

• Min: Enter the minimum threshold value for the preset

• Max: Enter the maximum threshold value for the preset

• Depend Type: Allows users to set dependencies for 

presets. This option allows users to set multiple presets 

but only the presets that meet the dependencies 

requirements are displayed for the current data. In the 

example screenshot two sets of segmentation presets
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SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold Volume Options (continued)

Right click options (continued) 
Presets (continued):

• Dependencies: Allows users to specify the dependency criteria for the 

selected Depend Type.

• Action: Allows users to Add or Remove presets.

• Order: Allows users to change the order in which the presets are listed. As a 

general rule of thumb presets should be listed in the order they are used for 

segmentation.

To define a set of presets do the following:

Right-click on the Threshold slider and choose 

Presets.

In the Presets window set the preset name, next 

enter the min and max threshold values, finally set 

a Depend Type and Dependency if desired. Click 

Add and either enter the next Preset or choose 

Save. 

Once Presets are established, they can be accessed 

by simply right-clicking on the Threshold slider and 

choosing Presets and then the Preset name.
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SEGMENT > SEMI-AUTOMATIC TOOLS

Threshold Volume Options (continued)

Right click options (continued)

Auto Thresholds: The	auto	thresholds	option	
allows	users	to	compute	up	to	6	automatically	

computed	threshold	to	specify	the	number	of	

automatic	thresholds	computed.		Selecting	a	

threshold	value	will	set	the	minimum	threshold	to	

that	value.

Show/Hide Histogram: When	selected,	calculates	
and	displays	the	volume	histogram	below	the	

Threshold	Volume	options.

When the threshold minimum and maximum values 

are adjusted the voxels within the selected range 

display as green on the histogram while the voxels 

out of range are displayed in red. Adjusting the 

scale bar to the left side of the histogram display 

will increase or decrease the scale the histogram. 

Right clicking on the histogram allows users to auto 

compute up to 8 threshold values for the image 

data. The thresholds are displayed as triangular 

buttons at the bottom of the histogram display, 

selecting a triangle will set the minimum threshold 

value.
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SEGMENT > SEMI-AUTOMATIC TOOLS

Here we will use Threshold Volume 

to create a new object in a dataset.

To follow along, download the data 

set CT_Liver from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Threshold Volume.  [2].

• Use the Threshold slider [3] to 

adjust the voxel intensity range, 

so that the soft tissue is displayed 

in the binary mask preview. This 

data set is scaled to Hounsfield 

Units (HU), so the grayscale 

intensities represent HU. This 

may be used to isolate tissue with 

a known HU range [4].

• Click Threshold Object [5] to 

assign all selected voxels to the 

current object.

Threshold Volume Segmentation
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SEGMENT > SEMI-AUTOMATIC TOOLS

• Rename the object, [6] then change the color [7].

• Right-click on the rendering and select Transparency [8].

Threshold Volume Segmentation (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

• Add a new object [9].

• Update the name [10] and color 

[11].

• Adjust the threshold range [12] 

so that the bone is displayed in 

the binary preview, then click 

Threshold Object [13].

• Note that the rendering [14] will 

update to display both objects. 

The bone is now fixed to visible, 

as the rendering transparency is 

enabled [8].

• Select File > Save Object Map to 

save your work.

Threshold Volume Segmentation (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

Whereas threshold-based segmentation applies globally to all voxels in the volume, region growing can be used to limit the segmentation to 

voxels that are connected to a user-defined seed point which fall within a specified threshold range.

To enable the Region Grow options, first a seed point must be set on the structure you wish to isolate [1]. Note, multiple seeds can be 

selected to facilitate the simultaneous segmentation of multiple objects as long as the objects have the same threshold properties, for 

example multiple disconnected bones.

Region Grow
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SEGMENT > SEMI-AUTOMATIC TOOLS

When the seed is set the following options become available: 

Threshold slider: The Threshold double-ended slider bar allows users to specify a range 

of threshold values using the minimum and maximum ends of the threshold slider. For a full 

description of the threshold slider please refer to the Threshold Volume section.

Min and Max: The minimum and maximum input field allows users to manually enter the 

minimum or maximum threshold value. There are also arrow up and down buttons the right of 

the input fields to increase or decrease the currently value by 1.

Threshold Rendering: Allows users to disable and enable to 3D preview of the selected voxel 

range. Disable this option by unchecking the checkbox when working with large data sets.

Connect Type: Determines if the connection type will be 3D or 2D.

3-D: Region grow will be applied to the (3D) volume.

2-D: Region grow will be limited to the current (2D) slice.

Neighbors: Allows users to select the number of neighboring voxels during the connection 

process. The options available depend on the connect type. For 3D, users can choose 

6-connected or 26-connected. For 2D, 4-connected or 8-connected can be selected.

• 3D Neighbor options: 
6-connected: Specifies that only 3-D neighbors are checked for connectivity during the 

region growing process. [1] 

26-connected: Specifies that the entire 26-voxel neighborhood is checked for connectivity 

during the region growing process. [2]

Region Grow Options
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SEGMENT > SEMI-AUTOMATIC TOOLS

• 2D Neighbor options: 
4-connected: Specifies that only 2-D neighbors are checked for connectivity during the 

region growing process. [3] 

8-connected: Specifies that the entire 8-voxel neighborhood is checked for connectivity 

during the region growing process. [4]

Reset Seeds: Resets the user defined seed(s). Seeds can also be deleted by right clicking on 

the seed and then selecting delete.

Connect Object: Initiates the connection process.

Threshold Slider right click options: Right clicking on the Threshold slider provides 

users with access to the following additional options; Presets, Auto Threshold, Show/Hide 

Histogram. For more information please refer to the Threshold Slider right click options in the 

Threshold Volume section.

Seed point right click options: Right clicking on a seed point provides the following options:

• Style: The style options allows users to change the of the seed point. Select from Dot, 

Crosshair (default), Arrow, and Diamond. 

• Label: The label options allows user to enable and disable labels for seed points. Select 

from None (default), Number (useful when setting multiple seeds), and Tag. 

• Shadow: Allows users to enable (default) or disable the shadow effect for the seed. 

• Delete: Deletes selected seed point.  

Region Grow Options (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

Here we will use Region Grow to 

segment a new object in a dataset.

To follow along, download the data 

set CT_Heart from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic  [1] and 

choose Region Grow [2].

• Click on the image data to set 

a seed point in the object you 

would like to isolate [3]

• Set the Threshold Min/Max values 

to define the object [4]

• Click Connect Object [5].

3D Segmentation with Region Grow
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SEGMENT > SEMI-AUTOMATIC TOOLS

• The voxels fulfilling the seed 

point and threshold criteria for 

the region grow will be assigned 

to a new object.

• The segmented object is shown 

overlaid on the 2D slice data [6] 

and a 3D rendering [7] is 

displayed.

3D Segmentation with Region Grow (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

It may be necessary to adjust the 

number of neighbors used in order 

to limit the region grow. This will help 

prevent unwanted objects from being 

segmented with the target object.

To follow along, download the data 

set VH_Abdomen from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Region Grow [2].

• Click on the image data to set a 

seed point in the structure you 

would like to isolate [3].

• Set the Threshold Min/Max values 

to define the object [4] and click 

Connect Object [5]. 

3D Segmentation with Region Grow (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

Note that the segmentation of the 

abdominal aorta in the example, 

using the default 26-connected 

neighbors, also assigns part of the left 

lung into the object [6].

• Click Undo [7]

• Set the seed point,  [8]  set 

Neighbors to 6-connected, [9] 

and click Connect Object [10].

Note the segmentation result for 

the abdominal aorta [11] no longer 

contains part of the left lung. 

3D Segmentation with Region Grow (continued)
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SEGMENT > SEMI-AUTOMATIC TOOLS

Region grow also provides the ability 

to limit the region to a single slice via 

the 2D Connect Type option.

To follow along, download the data 

set CT_Heart from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select a data set and open 

Segment.

• Select Semi-Automatic,  [1]  

choose Region Grow  [2   and set 

the Connect Type to 2D. [3].

• Click on the image data to set a 

seed point.  [4]  The seed point 

should be in the 2D structure you 

would like to isolate.

• Set the Threshold Min/Max 

values to define the object  [5]  

and click Connect Object. [6].

• The region will be isolated on the 

single slice [7].

2D Segmentation with Region Grow
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SEGMENT > SEMI-AUTOMATIC TOOLS

• To segment multiple 2D regions, 

click Undo [8].

• Click on the image data to set 

multiple seed points on the 

regions you want to segment [9].

• Set the Threshold Min/Max 

values to define the object [10] 

and click Connect Object [11].

• All of the regions falling within 

the threshold criteria will be 

isolated in 2D [12].

2D Segmentation with Region Grow (continued)



346

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > SEMI-AUTOMATIC TOOLS

The connected components tool allows users to identify groups of objects based on spatial connectivity and intensity range. This 

segmentation method finds groups of voxels within a user-specified intensity range and assigns spatially disconnected groups to 

independent objects. The number of objects identified is specified by the user, and objects are created in order of largest to smallest based 

on the number of connected voxels in each object.

Connected Components
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SEGMENT > SEMI-AUTOMATIC TOOLS

The following Connected Components options are available: 

Threshold slider: The Threshold double-ended slider bar allows users to specify a range 

of threshold values using the minimum and maximum ends of the threshold slider. For a full 

description of the threshold slider please refer to the Threshold Volume section.

Min and Max: The minimum and maximum input field allows users to manually enter the 

minimum or maximum threshold value. There are also arrow up and down buttons the right of 

the input fields to increase or decrease the currently value by 1.

Threshold Rendering: Allows users to disable and enable to 3D preview of the selected voxel 

range. Disable this option by unchecking the checkbox when working with large data sets.

Connect Type: Determines if the connection type will be 3D or 2D.

3-D: Region grow will be applied to the (3D) volume.

2-D: Region grow will be limited to the current (2D) slice.

Neighbors: Allows users to select the number of neighboring voxels during the connection 

process. The options available depend on the connect type. For 3D, users can choose 

6-connected or 26-connected. For 2D, 4-connected or 8-connected can be selected. For a 

full description of the neighbor options refer to the Region Grow section.

Connected Components Options
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SEGMENT > SEMI-AUTOMATIC TOOLS

Restrict Components: When enabled displays a set of criteria that can be used to restrict 

the object segmentation resulting from the connected component analysis. Components 

with less than or more that the values entered in the x and y parameters will be ignored 

in the connected components analysis. These options specify that All Components must 

have:

• At least ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have 

at least the minimum number of voxels in its structure as specified by ‘x’ and no more 

than the maximum number of voxels in its structure as specified by ‘y’. 

Connected Components Options (continued)

• A Width of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a width of at least the minimum number of 

voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

• At Height of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a height of at least the minimum number of 

voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

• At Depth of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a depth of at least the minimum number of 

voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

Keep Largest X Component(s): Allows users to set the maximum number of objects to be kept in the connected component process.

Each Resulting Component becomes a New Object: When selected determines that each segmented component is assigned to its own 

object in the object map.

Each Resulting Component defined as Current Object: When selected determines that each segmented component is assigned to the 

current object selected in the object map.

Find Components: Initiates the connected components segmentation.  
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SEGMENT > SEMI-AUTOMATIC TOOLS

Here we will use Connected 

Components to segment several 

objects in a dataset.

To follow along, download the data 

set CT_Liver from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• In the Object Control window 

click Add Object, name the 

object Bone and then make sure 

the object is selected [1].

• Select Semi-Automatic [2] and 

choose Connected Components 

[3].

Segmenting Multiple Objects Using Connected Components

• Set the threshold range [4] to isolate the spine and ribs. A minimum threshold value of 295 and a maximum of 1464 works well for this 

dataset.

• Set the number of components to keep to 14 [5]

• This time select the Each	Resulting	Component	defined	as	Current	Object option [6]. Now all 14 isolated components will be set to a 

single object.

• Click Find Components [7].

• The data will be thresholded and the largest groups of voxels specified will be identified and rendered as a single object [8].
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The Object Extractor tool enables the user to define and extract objects from image data using a combination of thresholding, region 

growing and morphological operations.

First, a seed point is manually set on a structure of interest. Next, a threshold range is established by the user to define the structure. The 

region defined by a given threshold range is shown on the 2D slice containing the seed point using a 2D auto trace mechanism. This region 

updates interactively as the threshold range is adjusted, allowing the user to determine the threshold range that properly defines the region 

of interest. The Object Extractor segmentation routine is ready to be started once the seed point and threshold range define the structure 

on the initial slice.

The algorithm first applies a global threshold to the data set, using the minimum and maximum values specified by the user. Next a 3D 

binary erosion is performed on the binary result of the global threshold. The erosion attempts to break connections between the target 

structure and neighboring regions which have similar 

Object Extractor

intensity values. The erosion is followed by a 3D 

6-neighbor region grow, which uses the initial seed 

point. The processed target slice on which the initial 

seed point was set is compared to the initial auto trace 

from the user-defined seed point and threshold range. 

The erosion and region growing steps are repeated 

until the set of voxels on the processed target slice are 

a subset of the initial auto trace. Next, the processed 

data is conditionally dilated until 99% of the voxels 

in the auto traced region on the processed target 

slice are recovered. Once the extraction process 

is complete, the resulting object is rendered and 

displayed over the 2D slice data.
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As with the Region Grow tool, a seed 

point must be set on the structure 

you wish to segment [1] before 

the Object Extractor options are 

enabled. Note, multiple seeds can 

be selected for the simultaneous 

segmentation of multiple structures 

with the same threshold parameters, 

for example the segmentation of 

both the left and right lungs. When 

the seed is set the following options 

become available:

Threshold slider: The Threshold 

double-ended slider bar allows 

users to specify a range of threshold 

values using the minimum and

Object Extractor Options

maximum ends of the threshold slider. For a full description of the threshold slider including right click options, please refer to the Threshold 

Volume section. 

 

Min and Max: The minimum and maximum input field allows users to manually enter the minimum or maximum threshold value. There are 

also arrow up and down buttons the right of the input fields to increase or decrease the currently value by 1. 

 

Threshold Rendering: This option allows users to disable and enable to 3D preview of the selected voxel range. It is recommended to 

disable this option by unchecking the checkbox when working with large data sets.
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Show Thresholding: When the minimum and maximum threshold values are selected the adjustment 

is previewed on the 2D slice data. By default, the Show Thresholding option is set to Max Adjust. 

Adjusting the minimum threshold value will display as a update of the outer boundaries of the object 

only {x} while adjusting the maximum will display as a filled preview. To enable the filled preview the 

following options are available.

Object Extractor Options (continued)

Select Seed: Switches to seed selection mode.

Draw Limit: Switches to limit definition mode. Allowing users to define limits on the image data to prevent the defined region from leaking 

into surrounding structures.

Reset Seeds: Resets the user defined seed(s). Note, you can delete a seed point by right-click on the seed and choosing Delete. Seeds can 

also by moved by left-clicking on the seed and then dragging to a new location.

Reset Limit: Resets all user defined limits.

Extract Object: Initiates the Object Extraction segmentation 

process.

Max Adjust: Only adjusting the maximum threshold level will preview with the filled region. 

Min Adjust: Selecting Min Adjust will reverse the default preview display so that adjusting the 

minimum threshold value will show a filled region while adjusting the maximum threshold values will 

display the outer boundaries of the object only. 

Any Adjust: Will set the filled preview display when adjusting either the minimum or maximum 

threshold value. 

Never: Disables the filled preview display. Both minimum and maximum threshold adjustment will 

display the outer boundaries of the object only.
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Here we will use Object Extrator to 

segment a single object in a dataset.

To follow along, download the data 

set EGV_MRI from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] 

and choose Object Extractor 

[2].

• Click on the image data to set 

a seed point in the object you 

would like to isolate [3].

• Adjust the minimum threshold 

value [4] until the auto trace 

defines the object [5].

Segmentation of a Single Object Using Object Extractor



354

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > SEMI-AUTOMATIC TOOLS

• Adjust the maximum threshold 

level and note that the red binary 

mask will interactively update.

• Lower the maximum threshold 

value until holes start to appear 

in the red binary mask in the 

structures surrounding the brain, 

but not in the brain [6].

• Click Extract Object [7].

• Once segmentation is complete, 

the object map will be rendered 

[8] and overlaid on the slice data 

[9].

• Save your work by selecting File 

> Save Object Map.

Segmentation of a Single Object Using Object Extractor (continued)
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Here we will use Object Extrator 

to segment multiple objects in a 

dataset.

To follow along, download the data 

set CT_Lungs from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1]   and 

choose Object Extractor 

[2}.

• Click on the image data to set 

a seed point in the object you 

would like to isolate. [3].

• Adjust the minimum and 

maximum threshold values  [4   

until the auto trace defines the 

object. [5]. 

• Select Extract Object. [6]

Segmentation of Multiple Objects Using Object Extractor
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• Once the segmentation process 

is complete, the object will be 

rendered [7].

• Rename the object [8]. Add 

a new object [9] and rename 

[10].

• Set a seed point in the next 

object [11] and select Extract 

Object [12].

• Once the segmentation process 

is complete, the object will be 

rendered [13].

• Save your work by selecting File 

> Save Object Map.

Segmentation of Multiple Objects Using Object Extractor (continued)



357

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > SEMI-AUTOMATIC TOOLS

The Object Separator tool uses morphologic erosion to break connections between objects based on user-defined seed points to 

specify objects to separate. The purpose of the tool is to break objects into two or more objects. The tool requires a minimum of two 

seed points to be set.

Object Separator
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The	following	Object	Separator	Options	are	available:

Seed #1 – Define As: This option is enabled when the first seed point location is set. By default this 

option is set to Current Object, that is the object currently selected in the object control window. 

Selecting the drop-down menu allows users to choose from; Current Object, Not Changed (the object 

that the seed voxel is already assigned to), New, and then any objects in the object list.

Seed #2 – Define As: This option is enabled when the second seed point location is set. By default this 

option is set to Not Changes, that is the object the seed point voxel is currently assigned to. Selecting 

the drop-down menu allows users to choose from; Current Object, Not Changed, New, and then any 

objects in the object list.

Reset Seeds: Deletes all defined seed points.

Object Separator Options

Separate Objects: Begins the Object Separator process.

Seed point right click options: Right clicking on a seed point provides the following options:

Style: The style options allows users to change the of the seed point. Select from Dot, Crosshair (default), Arrow, and Diamond. 

• Label: The label options allows user to enable and disable labels for seed points. Select from None (default), Number (extremely useful 

when setting multiple seeds), and Tag. 

• Shadow: Allows users to enable (default) or disable the shadow effect for the seed. 

Delete: Deletes selected seed point.
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Here we will use Object Separator to 

disconnect objects in a dataset.

To follow along, download the data 

set CT_Heart from  

analyzedirect.com/data and load into 

Analyze using Input/Output. 

• Select the data set and open 

Segment.

• Select Semi-Automatic and 

choose Region Grow.

• Click on the image data to set 

a seed point. The seed point 

should be in the object you 

would like to isolate.

SEGMENT > SEMI-AUTOMATIC TOOLS

Separating Objects

• Set the Threshold Min/Max values to define the object and then click Connect Object.

• The structure will be isolated.

• Rotate the rendering to view the objects to disconnect. 

• Select Object Separator [1] and click Add Object [2].

• Set a seed point on the first structure [3] and add a seed point to the second structure [4]. 

Object separator usually works best when the seed points are set in the orthogonal images.

• Click Separate Objects [5].
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• The structures will be 

disconnected and assigned to 

different objects [6].

• Save your work by selecting File > 

Save Object Map.

Separating Objects (continued)
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The Oblique Cutting tool enables the specification and display of an oblique cut plane in the volume image.  The selected object can 

be split at the cut plane, with the smaller region after the split assigned to a different object as specified in the object control window. 

This tool is particular useful for splitting and reassigning vessels to new objects.

When the Oblique Cutting tool is selected the user must click on the image in the approximate location were the cut is to be placed, 

this can be done by clicking on the rendering or any of the orthogonal views. Once selected the Obliques window will open [1] and the 

oblique cut plane will be displayed on the rendering [2] and as a blue dashed line on the orthogonal displays. [3] The following Oblique 

Cutting options [4] will be made available: 

Oblique Cutting
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The	following	Oblique	Cutting	Options	are	available:

Cut: When the Cut option is clicked the selected object is split 

at the location of the oblique cut plane, the smaller object after 

the split is assigned to the object currently selected in the object 

window [5]. If the same object is selected a message will be 

returned stating ‘Attempting to assign cut vein to itself’. [6] Click OK 

to dismiss the warning and then select or add a new object in the 

object control window.

Cancel: Selecting cancels will cancel the Oblique Cut, the Oblique 

Cut options will no longer be available and then Oblique Cut Plane 

will be removed from the orthogonal slice displays.

Find Best: The Find Best option searches for the oblique image 

which contains the most circular representation of the selected 

object.

Recenter: Recenters the oblique plane. The center of the selected 

object on the oblique plane is computed. The oblique plane is then 

adjusted so that this computed center is displayed as the center in 

the oblique window.

Additional Options: The oblique cut plane can be adjusted by 

dragging an edge of the plane on the rendered image or by 

dragging the endpoints or center of the cut plane lines displayed on 

the orthogonal images. 

Oblique Cutting Options
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Here we will use Oblique Cutting to 

specify and display an oblique cut 

plane in a dataset.

To follow along, download the data 

set Cardiac_CT from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Region Grow [2].

• Set a seed point in the middle of 

the left atrium [3].

• Define a threshold range to 

describe the blood pool [4] and 

click Connect Object [5].

Oblique Cutting of Objects
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• Add a new object and name it RCA (right coronary artery) [6].

• Select Oblique Cutting [7].

• Rotate the rendering of the heart so the RCA is visible [8].

• Move your cursor to the base of the RCA and click to set a seed point on the RCA [9].

Oblique Cutting of Objects (continued)
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• The Segment interface will update while the Oblique Cutting algorithm finds the best plane to cut the RCA from the main heart object.

• If the computed cut plane is not ideal you can adjust the plane interactively on the rendering [10] or on any of the slice displays [11].

• The navigation tools can also be used on the oblique image [12].

• Select Cut [13] to cut the data.

Oblique Cutting of Objects (continued)
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• The RCA will be separated from 

the main object and assigned to 

the RCA object [14].

• To return to the regular display, 

click on the Toggle Obliques 

button to switch off the display of 

the oblique image.

• Select File > Save Object Map to 

save your work.

Oblique Cutting of Objects (continued)
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The Fill Holes function performs a flood-fill operation on the 

selected object. The operation reassigns voxels belonging to 

other objects to the selected object. The fill operation stops 

when it reaches the boundary of the object.

Fill Type: The fill type option allows users to select from the 

following fill type operations:

• 3-D: Fills three dimensional holes in the volume. This 

option is useful for filling small holes in the image data.

• 3-Pass: This option fills holes by process the volume, 

image by image in all three orthogonal directions.

• 2-D All Images: Conducts a 2D region fill on all 2D slices 

in the selected orientation.

• 2-D Current Image: Conducts a 2D region fill on the 

current 2D slice.

Set Current Object to Selection: Allows users to enable 

(default) or disable setting the filled region to the same object 

as being filled. Keep this option enabled if you wish to fill 

holes in an object and have them assigned to the same object 

[1], uncheck and disable this option if you wish to have the 

voxels that fill the holes in the object assigned to a different 

object, an object that is selected from the object list [2].

Fill Holes
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After the initial segmentation, an 

object may contain holes, which are 

voxels belonging to the Original 

object. To obtain an accurate volume 

measurement and to ensure the object 

is whole, it may be necessary to apply 

a fill holes operation on the object.

To follow along, download the data 

set EGV_MRI from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Object Extractor [2].

• Click on the image data to set a 

seed point.

• Adjust the minimum and 

maximum threshold values [3] to 

define the structure and select 

Extract Object [4].

SEGMENT > SEMI-AUTOMATIC TOOLS

Filling Holes in Objects
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• To remove small holes in the 

object [5] which are a result of the 

segmentation parameters, select 

Fill Holes [6].

• With the Fill Type set to 3D, [7] click 

on the object to fill smaller holes in 

the object [8]

• To fill larger holes, such as the 

ventricular CSF, use the 3-Pass Fill 

Type [9] and click on the brain [10]. 

All larger holes will be filled and 

assigned to the object.

• Select File > Save Object Map to 

save your work.

Filling Holes in Objects (continued)
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The fill holes option can also be used 

as a strategy to segment multiple 

objects. In this example we isolate the 

adipose tissue via threshold-based 

segmentation from a water-suppressed 

MRI data set. We will then use fill holes 

to create the muscle object and the 

intramuscular adipose tissue object.

To follow along, download the data set 

Thigh_MRI from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic  [1] and 

choose Threshold Volume [2].

• Set a threshold range [3] to globally 

segment the adipose tissue and 

click Threshold Object [4].

• The adipose tissue will be 

segmented [5].

• Rename the object [6], add a new 

object [7] and name it Muscle.

Using Fill Holes for Segmentation
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• Select Fill Holes [8] and set the Fill 

Type to 3-Pass [9].

• Uncheck the Set Current Object to 

Selection [10] checkbox.

• Ensure that the Muscle object 

is selected [11] and click on the 

Adipose Tissue object [12]. The 

voxels inside the Adipose Tissue 

object currently assigned to the 

Original object will be reassigned to 

the Muscle object [13].

• To assign the voxels labeled as 

Adipose Tissue within the Muscle 

object to Intramuscular Adipose 

Tissue (IMAT).

• Add a new object [14] and name it 

IMAT.

• Click on the Muscle object to fill it 

[15]. The voxels inside the Muscle 

object currently assigned to the 

Adipose Tissue object will be filled 

and assigned to the IMAT object 

[16].

• Select File > Save Object Map to 

save your work.

Using Fill Holes for Segmentation (continued)
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The Morph Objects option allows users to apply rudimentary morphological operations to objects. The operations available are dilate, 

erode, open and close. Additional morphological operations are accessible from the Morphology tool in Process. The following Morph 

Objects options are available:

Morph Objects

Operation: The operation drop-down menu allows users to 

select the morphological operation to perform. Choose from:

• Dilate: Adds a layer of voxels to an object, increasing the 

size of the object by increasing the objects boundaries 

while reducing the size of holes in the object [1].

• Erode: Removes a layer of voxels from an object, decreasing 

the size of the object by eroding the objects boundaries 

and increasing the size of holes in the object [2].

• Open: Performs an erode followed by a dilate [3]. In 

general, an open is less destructive than an erosion. The 

effect of the operation is to preserve voxels that have a 

similar shape to the structuring element, while removing 

other regions from the object. The effect on the image can 

be subtle as indicated in the image below.

• Close: Performs an dilate followed by a erode [4]. The close 

operation is similar to the dilate operation in that it tends to 

increase the object boundaries and shrink holes within the 

object. However, the close operation is less destructive of 

the original object boundary.
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• Box: A rectilinear structuring element is a solid rectangle (or cube) of the given size in X, Y, and Z. For example, a 3x3x3 rectilinear 

structuring element is a 27-voxel cube - one center voxel surrounded by 26 orthogonal and diagonal voxels [2].

Element Size: The element size, sometimes referred to as kernel size, allows users to set the X, Y, and Z dimensions of the selected element 

shape that will be used in the chosen morphological operation.

• X: The X option allows users to specify the width of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the 

text entry field. 

• Y: The Y option allows users to specify the height of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the 

text entry field. 

• Z: The Z option allows users to specify the depth of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the 

text entry field.

Note, to specify a 2D element set any of the dimensions to 1. A 3x3x3 jack-shaped structuring element will erode away or dilate (add) a 

single layer of voxels on the structure, a 5x5x5 structuring element will generally take away or add two voxels, etc.

Morph Objects (continued)

Element Shape: Allows users to choose between a jack [1] or box [2] shaped 

element.

• Jack: A jack-shaped structuring element includes only the orthogonal 

elements to the center voxel of the structuring element. In a 3x3x3 

jack-shaped structuring element, there are 7 voxels - one center voxel 

surrounded by the 6 orthogonal neighbors. The diagonal voxels are not 

part of this structuring element [1].
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Use Conditional Volume: The use conditional volume option is only available for the dilate operation. When selected the option allows a 

user to limit the dilation of the current object, conditioning the results with a volume selected from the workspace. The voxels that exist in 

the conditional volume define a ‘mask’ for voxels to be processed in the current volume. When selected the following options are available 

to choose the conditioning volume:

• Workspace: Allows the user to select the workspace that contains the conditional volume. 

• Name: Allows user to select the volume to use as the conditional volume. Note volumes can be binary or grayscale.

• Drag and drop here: Allows users to select the conditional volume via drag-and-drop from the workspace.

Set Current Object to Selection: The 

Set Current Object to Selection option 

is only available for the dilate and close 

operations. The option allows users to 

enable (default) or disable setting the 

current object as the selected object for 

the output of the morphological operation, 

that is the voxels that will be added to the 

object once the dilate or close operation 

is complete. Keep this option enabled if 

you wish to assign the additional voxels to 

the same object [5], uncheck and disable 

this option if you wish to have assign the 

additional voxels to a different object, an 

object selected from the object list. [6] 

Morph Objects (continued)
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• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Object Extractor.

• Click on the image data to set a 

seed point.

• Adjust the minimum and 

maximum threshold values to 

define the structure and select 

Extract Object.

• Once the object is segmented, 

rename and update the color.

• Choose Morph Object [2] and 

set Operation to Erode [3].

• Leave the element size set to 3 

X 3 X 3.

• Set the target object to Original 

[4]. This will specify that any 

eroded voxels will be reassigned 

to the Original object. 

• Now click on the brain [5] to 

initiate the erosion.

Using Morph Objects to Improve Segmentation

Here we will improve the segmentation of an object by applying rudimentary morphological operations to the object.

To follow along, download the data set MRI_3D_Head from analyzedirect.com/data and load into Analyze using Input/Output.
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• Select Filter Objects [6] and 

apply a 3 X 3 X 3 Mode filter 

to the brain by clicking Filter 

Objects [7].

• Select Morph Objects [8] and set 

the Operation to Dilate [9].

• Select the Brain object [10] and 

click on the brain [11].

Using Morph Objects to Improve Segmentation (continued)
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Note the difference between the pre 

[12] and post [13] processed brain 

objects. 

Using Morph Objects to Improve Segmentation (continued)
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Filter Objects

Filtering objects is a simple and 

intuitive way to reduce noise, fill 

small holes, and smooth object 

edges. Filtering objects reduces 

the amount of variation between 

the pixels (2D) or voxels (3D) that 

make up the object. The filtering 

process simply replaces each pixel or 

voxel with a function of itself and its 

neighbors, defined by the element 

size selected.

The filter is only applied to 

segmented objects and does not 

change the original data. If after 

attempting to segment a structure 

from a data set you decide that 

filtering the grayscale image data 

would improve the segmentation 

result refer to the Process module 

> Spatial Filters processing type to 

access all of the software’s filtering 

options.
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Filter Objects Options

Operation: Three filtering operations are available:

• Mode: The mode filter replaces the target voxel with the mode of the neighborhood of voxels 

specified by the element size. The value repeated most often is the mode.

• Median: Like the mode filter the median filter considers each voxel in the neighborhood 

specified by the element size to replace the target, however, instead of simply replacing the 

voxel with the mode of the neighboring voxel values, it replaces is with the median of those 

values. The median is calculated by first sorting all the voxel values into numerical order and 

then replacing the target voxel with the middle voxel value. 

• Rank: Like the median filter the rank filter first sorts the values with in the neighborhood 

specified by the element size, numerically. However, the value used to replace the target voxel 

is dependent upon the rank value selected by the user using the Rank Slider.

 · Rank Slider: The slider allows users to specify of rank value used. The range of rank values 

is dependent on the neighborhood of voxels used for the filter, which is controlled by the 

element size. For example, in a 3x3x1 region the minimum rank value would be 1 while the 

maximum rank value would be 9. If the rank value was set to 6, the corresponding voxel value 

for that ranked voxel would by used to replace the target voxel.

Element Size: Allows users to set the X, Y, and Z dimensions of the rectilinear element to be used in the selected filtering operation.

• X: allows users to specify the width of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field. 

• Y: allows users to specify the height of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field. 

• Z: allows users to specify the depth of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field.

Filter Objects: Initiates object filtering. Note that object filtering does not 

honor object locking, and locked objects will be filtered. If any objects in the 

object list are locked a message will be returned stating that locked objects 

have been detected and object filtering does not honor locks. The option to 

cancel (No) or to continue (Yes) with the filtering operation will be given.
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Here we will improve the 

segmentation of an object by using 

Filter Objects.

To follow along, download the data 

set Mouse_Lungs from analyzedirect.

com/data and load into Analyze 

using Input/Output.

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Region Grow [2].

• Set a seed point on the object 

you want to isolate [3] and set a 

threshold range [4] that describes 

the object.

• Click Connect Object [5].

Using Filter Objects to Improve Segmentation
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• Select Filter Objects. [6].

• Set the Operation to Mode. 

[7]

• Set the Element Size to 5 X 5 X 

5  [8]  and select Filter Objects 

[9]. 

Note the difference in the 2D and 

3D regions between the unfiltered 

[10] and filtered [11] segmentation 

results. Filtering has filled small holes, 

removed noise around the surface of 

the lung parenchyma and smoothed 

the contours of the segmentation.

Using Filter Objects to Improve Segmentation (continued)
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Propagate Objects

The Propagate Objects tool uses shape-based 

interpolation to extend the definition of a 

region to slices of the volume on which it was 

not defined. For example, if the user defines 

a region on every fifth slice, this tool could 

be used to fill in the region on the skipped 

slices. The user must specify the direction in 

which objects are propagated by choosing 

the orthogonal orientation in which they were 

defined. A smoothing option is available which 

filters the objects to produce a smoother 

segmentation result.

The following options are available:

Propagation Type: choose between propagating the current object (default) selected 

from the object list or all objects in the object list.

Axial: Select axial if the regions to propagate were defined in this orientation.

Coronal: Select coronal if the regions to propagate were defined in this orientation.

Sagittal: Select sagittal if the regions to propagate were defined in this orientation.

Smoothing: Enables a smoothing operation to be applied to the object(s) after 

propagation is completed.

Propagate Object: Initiates the region propagation process.
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Using Propagate Objects

Here we will extend the definition of 

a region using Propagate Objects.

To follow along, download the data 

set CT_Liver from analyzedirect.com/

data and load into Analyze using 

Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Spline [2].

• Set the primary display to Coronal  

[3] and double-click on Slice [4] to 

move to coronal slice 100.

• Adjust the display intensity, [5] if 

desired.

• Trace a spline around the liver [6] 

and select Apply [7].
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• Move to coronal slice 125 and 

trace the liver [8].

• Repeat on coronal slices 150 [9] 

and 175 [10].

• Select Semi-Automatic [11] and 

Propagate Objects [12].

• Set the propagation orientation 

to Coronal [13] and click 

Propagate Object [14].

• After the object propagation 

process is complete, the liver 

object will be defined from slice 

100 to slice 175. The object can 

be reviewed in each orientation 

and the 3D rendering.

Using Propagate Objects (continued)
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The Manual tab provides users with access to interactive segmentation tools for manual 2D slice-based segmentation. These tools allow 

users to define regions with precision while reducing the time required to perform manual segmentation.

The Manual Tools that will described in this section include the following:

• Freehand Draw

• Manual Trace

• Auto Trace

• Polygon Trace

• Spline Trace

• Smart Trace

• Reassign Object

• Nudge Edit

• Divide Regions

• Adjust Regions

• Fabricate Shape(s)

Manual Tools
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The Freehand Draw tool lets the user draw regions of interest directly onto the image data. The 

following options are available.

Pen Shape: The pen shape option [1] allows users to specify the shape of the pen for region 

definition, choose from Round, Square, or Diamond.

Pen Size: The pen size slider [2] provides users with the ability to adjust the size of the pen used 

for region definition. The pen size ranges from 1 to 100 pixels. Note that the real-world size of the 

pen is reported below the pen size slider [3].

Current Pen: The current pen icon [4] is a quick reference tool for users, displaying the selected 

pen shape, pen size, and object color of the selected object from the object list.

Draw Many: The draw many option allows users to enable (default) or disable the draw many 

option. Enable this option is you wish to draw a continuous region, [5] disable the option is you 

wish to draw a single region as defined by the pen shape, pen size, and selected object [6].

Freehand Draw
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Thick Edit:	The	thick	edit	option	allows	users	to	apply	edits	(region	definitions)	defined	on	
the	current	slice	to	other	slices	in	the	volume.	When	thick	is	enabled	the	following	options	are	

available:

• Slices(s)	Before:	Specifies	the	number	of	slices	before	the	current	slice	in	which	to	apply	the	

edits.

• And	After:	Specifies	the	number	of	slices	after	the	current	slice	in	which	to	apply	the	edits.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined 

by the auto advance options, once the current edit is defined. Note the auto advance will occur 

after the user releases the left mouse button and the edit is applied to the current slice. The auto 

advance option is a productivity tool allowing users to move through the image data without 

having to move the cursor from the current orientation window that regions are being defined on. 

The following options are available.

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled. 

• Forward: Specifies that auto advance will move forward through the image data (slice number 

increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice 

number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.

Freehand Draw (continued)
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Freehand Draw allows easy definition 

of 2D regions.

To follow along, download the data 

set EGV_MRI from analyzedirect.

com/data and load into Analyze 

using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Freehand Draw [2].

• Use the Pen Size slider to change 

the Pen Size to 20 [3].

• The Current Pen [4] will update to 

the color of the currently selected 

object [5]. 

Using Freehand Draw to Define a 2D Region
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• Left-click on the image and drag 

the cursor to trace a region [6].

• Releasing the left mouse button 

will end the trace [7].

• Continue to define the brain 

using the pen tool [8].

Using Freehand Draw to Define a 2D Region (continued)
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The Freehand Draw tool allows users 

to define a single circle, square, or 

diamond.

To follow along, download the data 

set EGV_MRI from analyzedirect.

com/data and load into Analyze 

using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Freehand Draw [2].

• Set the Pen Shape to Square [3] 

and change the Pen Size to 25 [4]. 

• Uncheck the Draw Many option 

[5]. 

• Click on the image to define a 

square.  [6]

• Additional squares can be defined 

by clicking on the slice again.

Using Freehand Draw to Define a Single Shape on a 2D Slice
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The Freehand Draw tool allows users 

to define a single shape (circle, square, 

or diamond) over many slices. This can 

be helpful when defining regions that 

are constant through the 3D volume.

To follow along, download the 

data set CLS_Bone_Phantom from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual  [1]  and choose 

Freehand Draw.  [2]

• Change the Pen Size to 50  [3]  and 

uncheck the Draw Many option [4]. 

Using Freehand Draw to Define a Single Shape in 3D

• Check the Thick Edit option [5].

• To define the phantom insert on multiple slices, use the Slice(s) Before and After options [6] to specify the extent of propagation of the 

2D region through the data set. In this example, set both parameters to 180.

• Click on an insert [7] to define a region, and note that you can move the 2D region around. The region will not be defined until the left 

mouse button is released. 
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Once the left mouse button is released the regions will be applied to the specified slices. Note the update in the coronal [8] and Sagittal [9] 

orientations and the 3D rendering [10].

Using Freehand Draw to Define a Single Shape in 3D (continued)
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The Freehand Draw tool is particularly 

useful for manually defining or filling 

regions between locked objects, 

specifically when the region of 

interest is not easily segmentable but 

the surrounding tissue is.

To follow along, download the 

data set VH_Abdomen.avw from 

analyzedirect.com/data and load into 

Analyze using Input/Output. 

• Select the data set and open 

Segment.

• Select Semi-Automatic [1] and 

choose Threshold Volume [2].

Using Freehand Draw to Paint Regions of Interest

• Change the name of the current object to Other, then add two new objects: VAT (visceral adipose tissue) and SAT (subcutaneous adipose 

tissue) [3].Select the Other object and use global thresholding to assign voxels having intensity values of 0 to 81 and 91 to 247 to the 

Other object. This will assign all of the non-adipose tissue voxels to the Other object.

• Lock the Other object [4].

For more information on threshold-based segmentation, refer to Threshold Volume. 
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• Select Manual [5] and choose 

Freehand Draw [6].

• Set the Pen Shape to Diamond 

[7] and change the Pen Size to 

20 [8].

• Select the VAT object [9] and 

note that the Current Pen [10] will 

update to the color of the VAT 

object. 

• Use the pen tool to draw over 

the VAT regions [11].

Using Freehand Draw to Paint Regions of Interest (continued)
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• Once the VAT region is defined, 

lock the VAT object  [1  and 

select the SAT object.  [1

• Increase the Pen Size to 30 [14  

and draw over the SAT regions 

[15].

• When finished, [16] use File > Save 

Object Map to save your work.

Using Freehand Draw to Paint Regions of Interest (continued)
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Manual Trace

Like the Freehand Draw tool, the 

Manual Trace tool allows the user to 

draw regions of interest directly onto 

the image data. Manual tracing allows 

contours to be drawn around the 

edges of a region of interest.

When the Manual Trace tool is 

selected the following options are 

available:

Thick Edit: The thick edit option 

allows users to apply edits (region 

definitions) defined on the current 

slice to other slices in the volume. 

When thick is enabled the following 

options are available:
• Slices(s) Before: Specifies the number of slices before the current slice in which to apply the edits.

• And After: Specifies the number of slices after the current slice in which to apply the edits.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current 

edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. 

The auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the 

current orientation window that regions are being defined on. The following options are available.

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled.
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Manual Trace Options (continued)

Auto Advance (continued):

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on a trace when Auto Trace is selected will provide access to the following additional editing options:

• Edit Type: Allows users to switch between the modify trace and split trace edit modes.

 · Modify Trace: The modify trace option is the default mode for manual trace editing. If the cursor is held over the boundary of an 

object when tracing begins the edit will apply to that object whose boundary is being modified, regardless of the object selected 

from the object list. If you wish to have edits applied to the object selected in the object list uncheck the Auto Set Object option. For 

more information on how to edit a trace refer to Manual Contour Tracing and Editing.

 · Split Trace: Split trace mode allows the 

current object to be edited [1] and split into 

two objects with the smaller section of the 

trace being assigned to the object selected 

in the object list. If the object selected is the 

same as the object being split the smaller 

section will be automatically assigned to a 

new object [2].
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Manual Trace Options (continued)

Right click options (continued):

• Adjust Line Thickness: The adjust line thickness options allows users to switch the thickness display of the traced boundaries of objects. 

When enabled (default) traces appear thicker, [3] when disabled traces appear thinner. [4]

• Delete: Deletes selected region.

• Delete All: Deletes all regions on the slice.

• Auto Set Object: When enabled (default) edits made to object boundaries in Modify Trace mode are assigned to the object being 

edited. Unchecking the option will ensure boundary edits are assigned to the object selected in the object list.
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Manual Contour Tracing and Editing

To perform contour tracing and 

editing using Manual Trace, use the 

following steps.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Manual Trace [2].

• Left-click on a slice to begin 

tracing and move the cursor 

around the region you want to 

define [3].

• Release the left mouse button to 

complete the trace [4].

• To edit the trace and add pixels 

that may be missing [5], click on 

the trace [6].
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• After clicking on the trace, draw 

in the missing region [7].

• To edit the trace and remove 

additional pixels [8], hover near 

the edge of the contour until the 

cursor changes to a + sign, then 

drag the cursor into the trace [9].

• Adjust the trace to remove the 

undesired pixels [10]. 

Manual Contour Tracing and Editing (continued)
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Manual Trace and Auto Advance

Here we will use the Auto Advance 

function of Manual Trace to 

automatically move forwards and 

backwards through image data as the  

region of interest is defined.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Manual Trace [2].

• Set Auto Advance to Forward [3].

• Add an object and name it Right 

Ventricle [4].

• Move to Axial slice 133 [5].

• Left click on the border of the 

right ventricle and trace the 

structure [6]. When complete 

release the left mouse button. 

The trace will be applied to this 

slice, and the next slice forward, 

slice 134, will appear.
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Manual Trace and Auto Advance (continued)

• Continue tracing the right 

ventricle in this manner until slice 

139 is reached. 

• At slice 139 add a new object and 

name it Left Ventricle [7]. Make 

sure the new object is selected.

• Change the Auto Advance option 

to Backward [8]

• Left click on the border of the left 

ventricle and trace the structure 

[9]. When complete release the 

left mouse button. The trace will 

be applied to slice 139 and slice 

138 will appear. Continue tracing 

the left ventricle until slice 133 is 

reached.

Tip: Object regions can be deleted by holding the cursor over the 

object and then pressing the delete key on your keyboard. Note 

that the first time you delete an object in this way for the current 

segmentation session you will be prompted on which action to take; 

don’t delete (No), delete (Yes), delete and don’t prompt this message 

in the future (Yes, always), don’t delete and don’t prompt this 

message in the future.
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Auto Trace

The Auto Trace tool enables the user to 

define and extract regions of interest from 

the image data using 2D seeded region 

growing. Region definition begins with a 

seed pixel, manually set by the user, on a 

structure of interest. Next, a threshold range 

is established by the user to define the 

boundary of the structure. The 2D region 

is defined by all the pixels in the threshold 

range that are connected to the seed pixel.

The following options are available:

Select Seed: The select seed mode is the 

default mode the Auto Trace tool will open 

in. Select seed allows users to set a seed 

point on the image data [1] to enable the 

Auto Trace tool options.

Draw Limit: The draw limit mode allows 

users to manually define limits on the image 

data to limit the auto trace region [2].
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Auto Trace Options (continued)

Object Restrict: The Object Restrict options 

allows users to restricts the definition of the 

current object with the boundaries of any 

established objects. When disabled traces 

are not limited by object boundaries [1].

However, when the option is enabled traces 

are restricted [2].

Threshold slider: The Threshold double-

ended slider bar allows users to specify a 

range of threshold values using the minimum 

and maximum ends of the threshold slider. 

Minimum and Maximum values can be 

entered in the text entry fields while the 

arrow up and down keys to the right of the 

minimum and left of the maximum text entry 

fields can be used to increase or decrease 

values 1 point at a time. Click left and right of 

the text entry boxes  

Tip: Clicking in the trough to either side of 

the minimum or maximum end of the slider 

will advance the value by 1. Shift-click will 

decrease the value by 1.
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Auto Trace Options (continued)

Right clicking options: Right clicking on 

the threshold slider will provide access to 

threshold presents. The Presets option allows 

users to select predefined thresholds or 

define new threshold values for specific areas 

of interest. For more information on Presets, 

including how to configure presents refer to 

the Threshold Volume.

Border: The Border options allows users to 

specify how the border of the trace will be 

displayed on the image, choose from: 

• On Edge: The auto trace will be 

positioned exactly on the edge of the 

thresholded region (top image).

• Off Edge: The auto trace will be 

positioned one pixel off the edge of the 

thresholded region (middle image).

• Fill: The auto trace will display On Edge 

with a filled interior (bottom image).
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Auto Trace Options (continued)

Exterior Only: The Exterior Only 

option allows users to enable (default) 

or disable the display of the exterior 

border only. Enable the option if you 

only wish to see the exterior borders 

of the trace, uncheck and disable the 

option if you wish to view the exterior 

and interior borders. The option is 

compatible for all Border displays.

• Top image: Exterior Only disabled 

with On Edge selected

• Middle Image: Exterior Only 

disabled with Off Edge selected

• Bottom image: Exterior Only 

disabled with On Fill selected
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Auto Trace Options (continued)

Auto Limit: The Auto Limit option 

applies a post processing step to 

the auto trace to eliminate thin 

portions of the auto trace. This option 

performs a morphologic open using 

the Gap Size value, defined by the 

user, to define the number of layers to 

be removed from the trace and then 

added back. 

To use the option, after setting a 

seed point and appropriate threshold 

criteria to define a region [1], click the 

Auto Limit check box [2], then set the 

Gap Size using the slider, [3] review 

the impact on the defined region. 

[4] Note that the Gap Size of 0 is the 

same as having no Auto Limit set. 

This option helps eliminate the need 

for manually defining limits in some 

situations.
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Auto Trace Options (continued)

Seeds share parameters: The Seeds share parameters option allows users to enable or disable (default) seeds from sharing the same 

auto trace options including threshold range, border settings, auto limit, and object information. Enable this option if you wish to define 

multiple separate regions with the same parameters, keep this option disabled if you wish to define multiple separate regions with different 

parameters.

Reset Seed(s) after Apply: After applying the trace all seeds will be reset (deleted).

Reset Limit(s) after Apply: After applying the trace all limits will be reset (deleted).

Apply: Applies the trace to the slice. 

Cancel: Cancels the Auto Trace, resets all defined seed points and limits.

Reset Seeds: Resets all seeds.

Reset Limits: Resets all limits.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current 

edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. 

The auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the 

current orientation window that regions are being defined on. The following options are available.   

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled. 

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.
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To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Auto Trace [2].

• Set the primary display to Axial 

[3] and double-click Slice [4] to 

move to axial slice 122.

• Set a seed pixel in the white 

matter [5].

• Rename Object_2 to Brain [6] 

and then adjust the minimum and 

maximum threshold values [7] to 

define the brain.

• Click Apply [8] to trace the brain 

on this slice.

• Scroll forward to slice 123. The 

+ key can also be used instead if 

your mouse has no scroll wheel.

• As the seed point and threshold 

range are carried forward, the 

brain will be redefined on this slice. 

Using Auto Trace to Define a 2D Region of Interest
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• Set the Auto Advance option to 

Forward [8] and click Apply [9]. The 

brain will be traced on this slice and 

the display will automatically move 

forward to slice 124.

• Continue to apply the auto trace 

to the brain up to slice 133. If the 

initial seed point is copied to a 

slice where it does not fall within 

the brain, reset the seed point and 

threshold range and click Apply to 

set a new auto trace on that slice.

• Click in the ventricular CSF to set a 

seed point [10].

• Add a new Object and rename it 

vCSF [11]. Note that the second 

seed point will change color 

to match the color of the new 

object. Adjust the threshold 

range to define the vCSF object 

[12].

• Set a second seed point to define 

the remaining vCSF [14] and click 

Apply [15].

Using Auto Trace to Define a 2D Region of Interest (continued)
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• Continue clicking Apply to trace 

the Brain and vCSF objects. If a 

seed point is copied to a location 

where it is no longer on the target 

object [16], move the seed point 

back onto the object [17] and 

continue to apply the auto trace.

• Stop defining objects at slice 137.

• Select File > Save Object Map to 

save your work.

Using Auto Trace to Define a 2D Region of Interest (continued)
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The Polygon Trace tool enables the definition of a closed polygon region. 

The following options are available:

Reset Polygon Trace after Apply: Resets (deletes) the polygon trace after the region is defined. Polygon traced regions are defined after the 

user double-clicks or presses the escape (Esc) key to close the trace ending the tracing process, the trace is applied when the Apply button is 

clicked, the ‘A’ key on your keyboard is pressed, the user right-clicks on the spline trace and selects Apply from the menu or the Auto Apply 

option is enabled.

Auto Apply: When selected the polygon trace is automatically applied once the user double-clicks or presses the escape key to close the 

trace.

Polygon Trace
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Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current 

edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The 

auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current 

orientation window that regions are being defined on. The following options are available. 

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled. 

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Polygon trace provides users with the following options:

• Apply: Applies the trace.

• Cancel: Cancels the trace, deleting the trace and controls points. 

• Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Polygon trace or trace 
converted to a Polygon. When selected any edits made to the Polygon will be automatically applied when a control point is moved. 

• Delete Control Point: Deletes the control point the cursor if currently over.

• Delete Spline: Deletes the trace and controls points.

Polygon Trace Options

Note: Clicking on an object border [1] 

when the Polygon Trace is selected 

will convert the object region into a 

polygon [2] with adaptable control 

points [3].
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Here we will use the Polygon Trace 

tool to define a region of interest 

and then how to divide a region into 

subregions.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Polygon Trace [2].

• To define a Polygon trace around 

the brain in the axial image, left 

click on the image to set the first 

control point [3] and then move 

the cursor and left click again to 

set a second control point [4].

• Continue in defining the border 

or the brain in this manner until 

complete [5]. Double-click or press 

the Esc key to end tracing and 

then process Apply [6] to define 

the region. 

Region Definition and Region Modification with Polygon Trace
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• Select File > Reset Object 

Map to delete the trace, select 

‘Continue without Saving’ when 

prompted.

• Next, segment the brain in 3D 

using the Object Extractor. Select 

the Semi-Automatic tab [7] and 

then choose Object Extractor [8].

• Click Add Object [9] to add an 

object to the object list and then 

click in the white matter on axial 

slice 123 to set a seed point [10].

• In the Threshold option set the 

minimum threshold value to 49 

and the maximum to 140 [11] and 

then click Extract Object [12].

Region Definition and Region Modification with Polygon Trace (continued)
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• To subsegment a 2D region 

do the following. Select the 

Manual tab [13] and then choose 

the Polygon tool [14]. Lock the 

Original object and then add a 

new object to the object list [15].

• Switch off the Linked Cursor [16] 

and then use the Polygon tool to 

define the left hemisphere of the 

brain on axial slice 123, [17] and 

then click Apply [18].

Region Definition and Region Modification with Polygon Trace (continued)
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• The brain on slice 123 has been 

split into two objects representing 

the left and right hemisphere [18].

• The Polygon trace tool can also 

be used to edit 3D objects. To 

subsegment a 3D region define 

a Polygon trace over the left 

hemisphere of the brain in the 

Rendering window [19] and then 

click Apply [20].

• All voxels not assigned to a 

locked object within the trace 

(and all voxels along the ray path) 

have be assigned to the selected 

object [21].

Region Definition and Region Modification with Polygon Trace (continued)
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The Spline Trace tool allows users 

to define curved regions of interest. 

Splines are flexible curve traces with 

movable control points that are useful 

for creating smooth edge traces.

The available options are as follows:

Reset Spline Trace after Apply: 
Resets (deletes) the spline trace after 

the region is defined. Spline traced 

regions are defined after the user 

double-clicks or presses the escape 

(Esc) key to close the trace ending the 

tracing process, the trace is applied 

when the Apply button is clicked, the 

‘A’ key on your keyboard is pressed, 

the user right-clicks on the spline 

trace and selects Apply from the 

menu or the Auto Apply option is 

enabled.

Auto Apply: When selected the 

spline trace is automatically applied 

once the user double-clicks or presses 

the escape key to close the trace.

Spline Trace
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Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current 

edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The 

auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current 

orientation window that regions are being defined on. The following options are available. 

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled. 

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Spline trace provides users with the following options:

• Apply: Applies the trace.

• Cancel: Cancels the trace, deleting the trace and controls points. 

• Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Spline Trace or trace 
converted to a Spline Trace. When selected any edits made to the trace will be automatically applied when a control point is moved. 

• Delete Control Point: Deletes the control point the cursor if currently over.

• Delete Spline: Deletes the trace and

Spline Trace Options

 controls points.

Note: Clicking on an object border 

when the Spline Trace is selected 

will convert the object region into a 

spline with adaptable control points.
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• Select a data set and open 

Segment.

• Select Manual  [1]  and choose 

Spline Trace. [2]

• Set the primary display to Coronal  

[3]   and double-click Slice  [4]  to 

move to coronal slice 100.

• To begin drawing a spline, 

position the cursor on the image 

and left-click [5]. Reposition the 

cursor and left-click to continue 

drawing the spline around the 

object of interest [6.]

• Double-click to end and close 

the spline.

• Note that control points can be 

moved. Click a control point, 

drag to a new location and the 

Spline will update.

• Select Apply [7] to apply the 

spline trace.

• Use File > Save Object Map to 

save your work.

Using Spline Trace to Define a Region of Interest
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The Smart Trace tool detects regions 

of high rate of change of voxel 

intensity (gradient) representing 

edges. The tool snaps to the edges 

of these regions. The sensitivity of the 

smart edge can be adjusted using the 

slider or the mouse scroll wheel.

The following options are available:

Sensitivity: The sensitivity of the 

smart edge can be adjusted using the 

slider or the mouse scroll wheel. The 

lower the value the less sensitive the 

tool is, the higher the value the more 

sensitive the tool is.  

Reset Smart Trace after Apply: 
Resets (deletes) the smart trace after 

the region is defined. Smart trace 

regions are defined after the user 

double-clicks to close and end the 

tracing process and then pressing the 

Apply button, selecting the ‘A’ key 

on your keyboard, or having the Auto 

Apply option selected.

Smart Trace
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Auto Apply:	When	selected	automatically	applies	the	Smart	Trace	region.

Lock Control Points:	Allows	users	to	lock	or	unlock	(default)	the	smart	trace	controls	points.	Unlocking	the	control	points	allows	users	to	move	
the	control	points.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current 

edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The 

auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current 

orientation window that regions are being defined on. The following options are available. 

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled. 

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Smart Trace provides users with the following options:

• Apply: Applies the trace.

• Cancel: Cancels the trace, deleting the trace and controls points. 

• Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Smart Trace or trace 
converted to a Smart Trace. When selected any edits made to the Smart Trace will be automatically applied when a control point is 
moved. 

• Delete Control Point: Deletes the control point the cursor if currently over.

• Delete Spline: Deletes the trace and controls points.

Note: Clicking on an object border when the Smart Trace is selected will convert the object region into a Smart trace with adaptable control 
points. 

Smart Trace Options
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To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select Manual [1] and choose 

Smart Trace. [2].

• Left-click in the image to set the 

first control point [3].

• Move the cursor along the edge 

of the object and click to set 

additional control points [4]. To 

adjust the sensitivity of the smart 

edge, use the mouse scroll wheel. 

Scrolling up will increase the 

sensitivity and scrolling down will 

decrease sensitivity.

Smart Trace Region Definition
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• When the trace is complete, 

double-click to close the spline [5].

• If needed, control points can 

be moved. Uncheck the Lock 

Control Points option, click on 

a control point and drag it to a 

new location. The Smart Trace 

will update.

• Control points can be deleted. 

Select a control point, right-click 

and select Delete Control Point.

• Select Apply or use the A key to 

apply the trace.

• Use File > Save Object Map to 

save your work.

Smart Trace Region Definition (continued)
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The Reassign Object tool allows users to interactively reassign the voxels of one object to another object. First, select the object to which 

the voxels will be reassigned from the object control window. Then, select a reassignment type. Finally, to establish a seed pixel, click on the 

object to be reassigned. Object reassignment occurs immediately. Reassignment options are described in the table below:

Reassign Object

Reassignment Type Action

All All voxels in the selected object are reassigned to the current object 

3D All voxels in the selected object that are connected in 3D to the seed pixel are reassigned to the current object

2D All voxels in the selected object that are connected in 2D to the seed pixel are reassigned to the current object

Unconnected 3D All voxels in the selected object that are not connected in 3D to the seed pixel are reassigned to the current object

Reassignment Types
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Here we will reassign the voxels of 

one object to another object.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Use File > Load Object Map to load 

the corresponding object map.

• Select Manual [1] and choose 

Reassign Object [2].

• Set the primary display to axial [3] 

and move to axial slice 130.

• Switch the display of the Skin 

object off and switch on the 

display of the Lenticular and 

Caudate objects. Select the Brain 

object and change the Opacity 

level of the Brain to 2 [4].

• Set the reassignment type to 

All [5] and click on the yellow 

Lenticular object [6].

Reassigning Objects
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• Note that all the voxels of the 

Lenticular object have been 

reassigned to the Brain object [7].

• Set the reassignment type to 

3D [8] and click on the brown 

Caudate object on the right side 

of the brain [9].

Reassigning Objects (continued)
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• Note that the all the voxels of the 

Caudate object connected to the 

seed pixel have been reassigned 

to the Brain object [10]. As the left 

caudate nucleus is not connected 

to the right caudate nucleus, that 

part of the object remains [11].

• Click Undo [12] and set 

the reassignment type to 

Unconnected 3D [13].

• Click on the brown Caudate 

object on the right side of the 

brain [14].

Reassigning Objects (continued)
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• Note that this time, all the voxels 

assigned to the Caudate object 

connected to the seed pixel 

have been kept [15] while those 

unconnected voxels representing 

the left caudate nucleus have been 

reassigned to the Brain object [16].

• Note that for the All, 3D and 

Unconnected 3D reassignment 

types, seed points can be set on 

the 3D rendering. 

• Set the reassignment type to 

2D [17] and click on the anterior 

section of the green Ventricle 

object [18].

Reassigning Objects (continued)
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The voxels assigned to the Ventricle object, which are connected to the seed pixel only on this 2D slice have been reassigned to the 

Brain object [19].

Reassigning Objects (continued)
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Nudge Edit enables users to manually 

edit borders of defined regions. The 

tool allows object borders to be 

pushed inwards or outwards using an 

adjustable circular cursor. The size of 

the cursor can be adjusted using the 

middle mouse button. When Nudge 

Edit is selected the cursor mode will 

update to the Nudge Edit tool when 

an image is clicked on. Available 

options include:

Auto Advance: This option 

automatically moves users to a new 

slice as defined by the auto advance 

options, once the current edit is

Nudge Edit

defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The auto 

advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current 

orientation window that regions are being defined on. The following options are available.

• Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

• Forward: Specifies that auto advance will move forward through the image data (slice number increases).

• Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

• Increment: Specifies the number of slices the auto advance will move forward or backwards.
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data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select File > Load Object Maps 

and load MRI_3D_Head.obj.

• Select Manual, [1] then choose 

Nudge Edit [2].

• Set the primary display to Axial [3] 

and move to Axial slice 132 [4].

• To edit the border of the Brain 

and Ventricle objects click in the 

brain. The circular nudge tool 

cursor will appear [5].

Note the color of the cursor will match 

the object being nudged.

• Move the cursor to edit the 

border [6].

• The borders of the Brain and 

Ventricle objects will be updated 

as the cursor moves through [7].

Editing Object Borders using Nudge Edit

SEGMENT > MANUAL TOOLS
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• Click Undo.

• Using the middle mouse button, 

change the size of the cursor 

to 5, then click in the Ventricle 

object [8]. Push the border of the 

Ventricle object out to edit the 

object boundary [9].

• The borders of the Brain and 

Ventricle objects will be updated 

as the cursor moves through [10].

Editing Object Borders using Nudge Edit (continued)
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The Nudge Edit Tool can also be used 

in conjunction with locked objects. 

When measuring the intracranial area 

on a certain slice, after reassigning 

the Ventricle object on this slice 

to the Brain object using Reassign 

Object, the Skin object can be locked 

and the brain object pushed out 

using the Nudge tool to the border of 

the skin object. 

• Use Reassign Object to reassign 

the Ventricle object on Axial slice 

132 to the Brain object.

• Lock the Skin object.

• Select the Nudge Edit tool.

• Click in the Brain [1] and move 

the Nudge Edit tool into the 

intracranial space [2] between the 

Brain and Skin objects.

• Note that the Brain object will 

be pushed into the intracranial 

space but not into the locked 

skin object [3].

• Continue moving the Nudge tool 

through the intracranial space [4].

Using the Nudge Edit Tool with Locked Objects
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• Note that if the cursor moves past 

the Skin object into the Original 

object, voxels in the Original 

object can still be added to the 

Brain object using the Nudge 

Edit tool. To prevent this, lock the 

Original object as well.

• Continue moving through the 

intracranial space [5] to complete 

the edit [6].

Using the Nudge Edit Tool with Locked Objects (continued)
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The Divide Regions tool allows users to divide objects into subdivisions based upon the division type selected. Users can choose between 

Grid, Radial or Between Borders. 

Divide Regions

Divide Type Function Example
Grid Divides selected object into rectangles. 

Specify: Controls how the object will be divided by specifying between Rows and Columns or Region Size. 

Rows & Columns: specifies the number of rows and columns the object will be divided into. 

Region Size: specifies the size (in pixels) of the rectangle that will be used to divide the object.

Radial Radially divides selected object, splitting the object into pie wedges. 

Divisions: specifies the number of divisions the structure will be split into. 

Start Angle: specifies the starting angle of the first division. 

End Angle: disabled by default., but when enabled, specifies the ending angle for the radial division. 

Between Borders Divides object into concentric shapes. 

Divisions: specifies the number of concentric divisions the structure will be split into between borders. Enter 

the number into the text entry box or use the arrow up/down keys to set number.
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Grid division can be useful for 

subdividing structures into various 

anatomical substructures. Here we will 

perform a grid division of the corpus 

callosum (CC) on the mid-sagittal slice 

into its substructures.

To follow along, download 

MRI_3D_Head from  

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the dataset and open 

Segment.

• Set the primary display to Sagittal, 

[1] move to the mid-sagittal slice 

[2] and Zoom to the CC [3].

• Select Manual and use either 

Smart Trace or Auto Trace to 

define the CC on the mid-sagittal 

slice [4].

• Select Divide Regions [5]. Set the 

Divide Type to Grid [6].

• Set the Number of Rows to 1 and 

Columns to 6 [7].

• Click in the CC [8].

Grid Division of an Object
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• The CC will be divided into 6 

Subregions [9].

• Note that the Rostrum [10] will 

need to be assigned to a separate 

object. This can be achieved 

using the 2D reassignment option 

in the Reassign Object tool. 

Objects can be given the correct 

structural names (Splenium, 

Isthmus, Posterior Midbody, 

Anterior Midbody, Rostral Body, 

Genu and Rostrum) using the 

Object Control window.

• Use File > Save Object Map to 

save your work.

Grid Division of an Object (continued)
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Radial Division of an Object

Like grid division, radial division of 

objects can be useful for subdividing 

structures into various substructures.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select MRI_3D_Head and open 

Segment.

• Select Manual [1] and choose 

Auto Trace [2].

• Set the primary display to Axial 

[3] and use Slice [4] to move to 

axial slice 130.

• Set a seed pixel in the white 

matter [5] and adjust the minimum 

and maximum threshold values [6] 

to define the brain. A min value 

of 45 and max value of 125 works 

well for this data set.

• Click Apply [7] to define the 

brain.
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• Select the Divide Regions tool [8] and set the Divide Type to Radial [9].

• With Division set to 8, click anywhere in the brain to divide the object into 8 radial divisions [10].

Radial Division of an Object (continued)
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The Divide Regions Between Borders 

division type allows users to create 

a concentric set of objects. The tool 

will divide the area between an inner 

and outer border into the number of 

regions specified by the user, which 

is acheived by interpolating new 

borders between the inner and outer 

border.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the dataset and open 

Segment.

Dividing Regions Between Borders – Interpolating Between Objects

• Set the primary display to Sagittal [1] and use Slice [2] to move to sagittal slice 96.

• Select Manual [3], and choose Spline [4].

• Use the Spline tool to define a region of interest around the brain [5].

• Add a new object and define a region of interest around the ventricles [6].

• Select the Divide Regions tool [7] and set the Divide Type to Between Borders [8].

• Set the Divisions to 2 [9].

• Click anywhere in the brain between the red brain border and the green ventricle border [10].
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• 2 new regions will be interpolated 

between the brain and ventricles 

[11].

Dividing Regions Between Borders – Interpolating Between Objects (continued)
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Dividing Regions Between Borders – Interpolating Within an Object

If there is no inner border defined 

when using the Divide Objects 

Between Border division type, the 

tool will calculate the center of the 

object and use this as an interpolation 

point, creating new interior object 

borders from the outer border.

• Select MRI_3D_Head and open 

Segment.

• Set the primary display to 

Sagittal [1] and use Slice [2] to 

move to sagittal slice 96.

• Select Manual [3] and choose 

Spline [4].

• Use the Spline tool to define a 

region of interest around the 

brain [5].

• Select the Divide regions tool 

[6] and set the Divide Type to 

Between Borders [7].

• Set the Divisions to 2 [8]. Click 

anywhere in the brain [9].
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• The tool will detect that there 

is no interior border and return 

a Border Divide Error. Click OK  

[10] to enable the tool to use the 

center of the outside border as an 

interpolation point to substitute 

the interior border.

• The object will be subdivided 

into regions interpolated from the 

outer border and the new regions 

will look like smaller versions of 

the outer border [11].

Dividing Regions Between Borders – Interpolating Within an Object (continued)
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The Adjust Regions tool allows users to interactively manipulate regions. Users can rotate, translate, scale and deform objects. The adjust 

option provides users with the following region adjustment options:

Adjust Regions

Adjust Regions Methods and Functions

Method Function
Rotate The Rotate option allows users to rotate a region. To rotate a region, left click on the region to select it, the region will be outlined with a dashed 

yellow and red line. With the left mouse button still pressed move the mouse up to rotate the region clockwise and down to rotate counterclockwise.

Translate The Translate option allows users to translate a region left, right, up, or down. To translate a region, left click on the region to select it, the region will 

be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up, down, left, or right to move the region. 

The following options are also available for translate:  

With mouse movement: This is the default option and will allow the user to translate the selected region. 

A copy of the region: Allows users to translate a copy of the selected region. Choose from the following Copied Object options 

Same: Copied object is assigned to the same object as the selected object.  

Current: Copied object is assigned to the currently selected object from the object list.  

New: Copied object is assigned to a new object. 

Region so that its centered on brightest point: This option will shift the selected region so that the brightest pixel in the object is used as the new 

center point for the object.

Scale The Scale option allows users to adjust the regions scale by increasing and decreasing it both horizontally and vertically. To scale a region, left click on 

the region to select it, the region will be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up and 

down to adjust the scale vertically or move the mouse left or right to adjust the scale horizontally. 

Deform The Deform option allows users to interactively deform regions. To apply a free transform deformation on a region, left click on the region to select it, 

the region will be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up or down and left or right to 

deform. 
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Here we will rotate, translate, scale 

and deform objects using the Adjust 

Regions tool.

To follow along, download the 

data set MRI_3D_Head from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the dataset and open 

Segment.

• Select File > Load Object Maps 

and load MRI_3D_Head.obj.

• Set the primary display to Axial [1] 

and move to Axial slice 136 [2].

• Select Manual [3] and choose 

Adjust Regions [4].

• Set the Adjust Method to Rotate 

[5].

• Click in an object to select it and 

move the mouse up or down to 

rotate the object [6].

• Release the mouse button to 

end the rotation and commit the 

rotation to the object [7].

Using the Adjust Regions tool



447

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > MANUAL TOOLS

• Click Undo [8] and set the Adjust 

Method to Translate [9].

• With the Translate option set to 

with mouse movement [10], click 

in an object and drag to a new 

location [11].

• Release the mouse button to end 

the translation. The object will be 

moved to the new location [12].

Using the Adjust Regions tool (continued)
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• Setting the Translate option to ‘a 

copy of the region’ will allow you to 

make a copy of the selected object 

and move to a new location.

• Setting Copied Object to Same 

assigns voxels in the new region 

to the same object as the parent 

region [13].

• Setting Copied Object to Current 

assigns voxels in the new region 

to the object currently selected 

in the Object Control window 

[14].

Using the Adjust Regions tool (continued)
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• Setting Copied Object to New 

assigns voxels in the new region 

to a new object [15].

The Translate Adjust Method also 

allows users to Translate the region 

so that it is centered on the brightest 

point. With this option, the tool 

calculates the brightest pixel in the 

object and sets that as the the center 

of the object, translating the object 

appropriately.

• Set the Translate method to the 

region so that it is centered on 

the brightest point [16].

• Click in an object [17].

Using the Adjust Regions tool (continued)
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• The region will instantly be 

recentered around the brightest 

point in the object [18].

• Click Undo.

• Set the Adjust Method to Scale 

[19].

• Click in an object and move your 

mouse to increase the scale of 

the selected object [21].

• Moving the mouse up and down 

adjusts the scale in the vertical 

direction. Moving the mouse 

left and right adjusts the scale in 

the horizontal direction. Moving 

the mouse diagonally adjusts 

the scale of the object while 

preserving the shape. Release 

the button to commit the scale 

manipulation to the object.

• Click in an object and then move 

your mouse to decrease the scale 

of the selected object [21].

• Release the button to commit the 

scale manipulation to the object.

Using the Adjust Regions tool (continued)
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• Undo the previous manipulations. 

• Set the Adjust Method to 

Deform [22].

• Click in an object and move 

your mouse to experiment with 

the deformations available [23]. 

In this example the user is 

deforming the border of the 

brain object.

• Releasing the mouse button 

will apply the deformation to 

the object.

Using the Adjust Regions tool (continued)
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Fabricate Shape(s)

The Fabricate Shape(s) tool allows 

users to create 2D and 3D objects 

in the object map or input grayscale 

data. The tool provides options for 

users to create shapes interactively 

or by loading a list of coordinates 

defined in a text file.

The Object to Create option allow 

users to specify a set of parameters to 

create 2D or 3D objects within a data 

set.

Dimension: Allows users to choose to 

create a 2D or 3D object.

2-D: The following Shape options are

available for 2D object creation:  

Dot: The Dot option allows user to create a 1-pixel dot on any of the 2D images. 

Square: The Square option allows users to create a 2D square on any of the 2D images. 

Rectangle: The Rectangle option allows users to create a 2D rectangle on any of the 2D images. 

Line: The Line option allows users to create a 2D line on any of the 2D images. 

Circle: The Circle option allows users to create a 2D circle on any of the 2D images. 

Oval: The Oval option allows users to create a 2D oval on any of the 2D images.

Note the Filled option allows users to enable (default) or disable the application of a fill to the preview of the 2D region, the fill color will 

correspond to the color of the selected object. Fill is not available for Dot or Line shape options.
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Fabricate Shape(s) Options

Draw Slice: The Draw Slice options provide the ability to specify the orientation and slice the shape will be created on. Alternatively, the 

slice and orientation can be set by clicking on the desired slice in the desired orientation

 · 2-D Orient: Choose from Axial, Coronal, or Sagittal.

 · 2-D Slice: Use the slice slider or manually enter the slice number to create the object on for the selected orientation.

Location and Size: Provides the ability to specify the location and size of the shape being created. For any of the 2D shapes chosen (Dot, 

Square, Rectangle, Line, Circle, or Oval), the following shape dependent sub-options are enabled:

Dot Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	dot	object.		Press	Alt	to	choose;	pixels	(default),	real	world	distances,	or	

X,Y	coordinates	(X,Y).		

 · X:	Set	the	X	location	for	the	dot.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Y:	Set	the	Y	location	for	the	dot.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

Square Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	square	object.	Press	Alt	to	choose;	pixels	(default),	real	world	distances,	

manually	setting	the	X,	Y	coordinates	for	the	lower	left	corner,	using	sliders	to	set	the	X,	Y	coordinates	for	the	lower	left	corner,	or	

manually	setting	the	X,	Y	coordinates	of	the	center	of	the	square.

 · Center	X:	Set	the	X	center	location	for	the	square.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	square.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Size:	Set	the	size	in	pixels	for	the	square.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	Alternatively,	click	

on	the	square	on	the	image	and	drag	it	to	the	desired	size.
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Fabricate Shape(s) Options (continued)

Object to Create > 2D > Location and Size (continued):

Rectangle Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	rectangle	object.	Press	Alt	to	choose;	pixels	(default),	real	world	

distances,	manually	setting	the	lower	left	(X1,	Y1)	and	upper	right	(X2,	Y2)	coordinates,	using	sliders	to	set	X1,	Y1,	X2,	and	Y2,	double-

ended	slides	to	specify	the	both	the	X	and	Y	low	and	high	values,	or	manually	entering	the	lower	left	rectangle	X	and	Y	coordinates	

and	the	rectangle	Width	and	Height	values.

 · Center	X:	Set	the	X	center	location	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Width:	Set	the	width	in	pixels	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	Alternatively,	

select	either	vertical	side	of	the	rectangle	on	the	image	and	drag	it	to	the	desired	size.

 · Height:	Set	the	height	in	pixels	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

Alternatively,	select	either	horizontal	side	of	the	rectangle	on	the	image	and	drag	it	to	the	desired	size.

Line Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	line	object.	Press	Alt	to	choose;	setting	start	X,	Y	and	end	X,	Y	points	

using	sliders	(default),	double-ended	sliders	with	pixel	values,	double-ended	sliders	with	real	world	distances,	or	entering	coordinates	

manually.

 · Start	X:	Set	the	X	start	location	for	the	line.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Start	Y:	Set	the	Y	start	location	for	the	line.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · End	X:	Set	the	X	end	location	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · End	Y:	Set	the	Y	end	location	for	the	rectangle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Note,	users	can	also	manually	adjust	the	end	points	of	the	line	and	drag	to	the	desired	location.
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Fabricate Shape(s) Options (continued)

Object to Create > 2D > Location and Size (continued): 
Circle Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	circle	object.	Press	Alt	to	choose;	pixels	(default),	real	world	distances,	

or	manually	entering	the	center	X,	Y	coordinates	and	circle	radius.

 · Center	X:	Set	the	X	center	location	for	the	circle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	circle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Radius:	Set	the	radius	of	the	pixels	for	the	circle.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

Oval Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	oval	object.	Press	Alt	to	choose;	pixels	(default),	real	world	distances,	

manually	entering	the	center	X1,	Y1	and	X2,	Y2	coordinates,	using	sliders	to	set	the	X1,	Y1	and	X2,	Y2	coordinates,	double-ended	

sliders	to	set	both	X/Y	high/low	values,	or	manually	entering	the	lower	left	X	and	Y	coordinates	and	the	oval	Width	and	Height

 · Center	X:	Set	the	X	center	location	for	the	oval.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	oval.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Width:	Set	the	width	in	pixels	for	the	oval.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Height:	Set	the	height	in	pixels	for	the	oval.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 ·

3-D: The following Shape options are available for 3D object creation: 

Dot: The Dot option allows user to create a 1-pixel dot within the volume data. 

Cube: The	Cube	option	allows	users	to	create	a	3D	cube	within	the	volume	data. 
Box: The Box option allows users to create a 3D box within the volume data. 

Line: The Line option allows users to create a 3D line within the volume data. 

Sphere: The Sphere option allows users to create a sphere within the volume data. 

Ellipsoid: The Ellipsoid option allows users to create an ellipsoid within the volume data. 

Cylinder: The Cylinder option allows users to create a cylinder within the volume data.
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Fabricate Shape(s) Options (continued)

Object to Create > 3D (continued): 
Note	the	Filled	option	allows	users	to	enable	(default)	or	disable	the	application	of	a	fill	to	the	preview	of	the	3D	region,	the	fill	color	will	

correspond	to	the	color	of	the	selected	object.	Fill	is	not	available	for	the	Dot	or	Line	shape	options.

Location and Size: Provides	the	ability	to	specify	the	location	and	size	of	the	shape	being	created.	For	any	of	the	3D	shapes	chosen	(Dot,	
Cube,	Box,	Line,	Sphere,	or	Ellipsoid),	the	following	shape	dependent	sub-options	are	enabled:

Dot Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	dot	object.	Press	Alt	to	choose;	pixels	(default),	real	world	distances,	

text	file	input	(see	Creating	Objects	from	a	Text	File	for	further	information),	or	manually	entering	the	X,Y,	Z	coordinates	(X,	Y,	Z).

 · X:	Set	the	X	location	for	the	dot.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Y:	Set	the	Y	location	for	the	dot.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Z:	Set	the	Z	location	for	the	dot.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Note,	users	can	click	on	any	of	the	2D	images	or	the	rendering	to	set	the	X,	Y,	Z	coordinates	for	the	dot.

Cube Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	cube	object.	Press	Alt	to	choose;	manually	entering	X,	Y,	Z	center	

voxel	coordinates	and	cube	size	(default),	sliders	to	define	the	X,	Y,	Z,	and	size	parameters	of	the	cube,	sliders	with	corresponding	

real	world	distances,	text	file	input,	or	manually	setting	the	X,	Y,	Z	coordinates	for	the	lower	left	front	corner	coordinate	and	cube	size	

value.

 · Center	(X,	Y,	Z):	Set	the	cube	center	voxel	by	entering	the	X,	Y,	Z	coordinates	of	the	center	location	for	the	cube.	Alternatively,	click	and	

drag	the	2D	display	of	the	cube	in	any	orthogonal	orientations	to	reposition.	

 · Size:	Set	the	size	in	voxels	for	the	square.	Users	can	also	click	on	the	2D	display	of	the	cube	in	any	orientation	and	interactively	increase	

or	decrease	the	size	of	the	cube	in	3D.



457

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

SEGMENT > MANUAL TOOLS

Fabricate Shape(s) Options (continued)

Object to Create > 3D > Location and Size (continued):

Box Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	box	object.	Press	Alt	to	choose;	to	use	slides	to	enter	X,	Y,	Z	and	Width,	

Height	and	Depth	values	in	voxels	for	the	box	(default),	manually	entering	X,	Y,	Z	center	and	the	box	Width,	Height	and	Depth	values,	

using	sliders	to	specify	the	X,	Y,	Z	center	values	and	Width,	Height,	and	Depth	values	in	real	world	coordinates,	use	a	text	file	to	specify	

the	box	parameters,	manually	specify	the	X1,	Y1,	Z1	and	X2,	Y2,	and	Z2	values	to	define	the	box,	use	sliders	to	determine	the	X1,	Y1,	Z1	

and	X2,	Y2,	and	Z2	values,	use	double-ended	sliders	the	X,	Y,	and	Z	upper	and	lower	parameters,	or	manually	enter	coordinates	for	LX,	

LY,	LZ	and	With,	Height,	and	Depth	values	to	define	the	box.

 · Left	(X):	Set	the	X	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Lower	(Y):	Set	the	Y	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Front	(Z):	Set	the	Z	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Width:	Set	the	width	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Height:	Set	the	height	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Depth:	Set	the	depth	value	for	the	box.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

Line Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	line	object.	Press	Alt	to	choose;	setting	start	X,	Y,	Z	points	for	the	

line	end	points	using	double-ended	slider	bars,	using	double-ended	slider	bars	mapped	to	real	work	distances,	manually	entering	

the	XYZ	coordinates	for	both	end	points,	or	using	single	sliders	to	specify	the	Start	X,	Start	Y,	Start	Z,	End	X,	End	Y,	and	End	Z	

coordinates.

 · X,	Y,	Z	Sliders:	Use	the	double-ended	slider	bar	to	set	the	X,	Y	and	Z	values	for	each	end	point	of	the	3D	line.	Adjusting	the	lower	end	

of	the	slider	will	adjust	the	X,	Y	or	Z	point	location	for	the	first	end	point	of	the	line	while	adjusting	the	upper	end	of	the	slider	will	

adjust	the	X,	Y	or	Z	point	location	for	the	second	end	point	of	the	line.	

 · Note,	line	end	point	for	the	3D	line	can	be	adjusted	by	selecting	and	moving	the	end	points	on	any	of	the	orthogonal	images.
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Fabricate Shape(s) Options (continued)

Object to Create > 3D > Location and Size (continued):

Sphere Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	sphere	object.	Press	Alt	to	choose;	to	set	sphere	parameters	in	voxels	

using	an	X,	Y,	Z	and	Radius	slider	(default),	to	set	sphere	parameters	in	real	world	distances	using	an	X,	Y,	Z	and	Radius	slider	(default),	

a	text	file	to	define	a	sphere(s),	or	manually	enter	the	X,	Y,	Z	and	Radius	parameters	in	voxels	manually.

 · Center	X:	Set	the	X	center	location	for	the	sphere.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	sphere.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Radius:	Set	the	radius	of	the	pixels	for	the	sphere.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

Ellipsoid Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	ellipsoid	object.	Press	Alt	to	choose;	to	set	ellipsoid	parameters	in	

voxels	(default),	real	world	distances,	using	a	text	file,	manually	entering	the	center	X1,	Y1,	Z1	and	X2,	Y2,	Z2	coordinates,	using	sliders	

to	set	the	X1,	Y1,	Z1	and	X2,	Y2,	Z2	coordinates,	double-ended	sliders	to	set	both	X,	Y,	and	Z	upper	and	lower	values,	or	manually	

entering	the	lower	left	X,	Y,	Z	coordinates	and	the	ellipsoid	Width,	Height,	and	Depth	values,	use	sliders	to	enter	the	X,	Y,	Z	position	

information	and	Width,	Height,	and	Depth	values,	or	coordinates	to	specify	the	center	X,	Y,	Z	and	values	for	ellipse	Width,	Height,	and	

Depth.

 · Center	X:	Set	the	X	center	location	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Z:	Set	the	Z	center	location	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Width:	Set	the	width	in	pixels	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Height:	Set	the	height	in	pixels	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Depth:	Set	the	depth	in	pixels	for	the	ellipsoid.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.
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Fabricate Shape(s) Options (continued)

Object to Create > 3D > Location and Size (continued): 
Cylinder Location and Size Options:

 · Alt:	Set	the	preferred	way	to	define	the	size	and	location	of	the	cylinder	object.	Press	Alt	to	choose;	to	set	cylinder	parameters	in	

voxels	(default),	use	real	world	distances,	to	use	a	text	file,	to	manually	entering	the	center	X,	Y,	Z	coordinates	and	input	the	radius	and	

length	values,	or	use	sliders	to	input	the	Center	X,	Y,	Z,	Radius,	and	Length	values.

 · Center	X:	Set	the	X	center	location	for	the	cylinder.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Y:	Set	the	Y	center	location	for	the	cylinder.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Center	Z:	Set	the	Z	center	location	for	the	cylinder.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.

 · Radius:	Set	the	radius	in	pixels	for	the	cylinder.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Length:	Set	the	length	in	pixels	for	the	cylinder.	Use	the	slider	to	set	the	value	or	manually	enter	the	in	the	text	entry	box.	

 · Axis:	Choose	which	axis;	X,	Y,	or	Z	(default)	to	orientate	the	length	of	the	cylinder.

Apply changes to:	Allows	users	to	select	the	image	volume,	the	object	map,	or	both	to	defined	the	fabricated	shape(s).	

Volume: Applies	the	fabricated	object	to	the	grayscale	image	data.

• Set Volume Voxels to:	Choose	to	assign	greyscale	voxel	values	as	user	defined	Specified	value,	a	Random	Value,	or	a	Gaussian	Value.	

 · Specified value: Allows users to select a greyscale value that all voxels within the fabricated shape will be assigned to.

 · Random Value: Assigns voxel values within the fabricated shape to editable random values from 1 to 255.

 · Gaussian Value: Assigns voxel values within the fabricated shape to a Gaussian Value. Default Mu and Sigma values are assigned at 

128.0 and 25.6 respectively but can be updated by the user. 

• Object Map: Allows	users	to	assign	the	fabricated	shape	to	the	selected	object	in	the	object	list.

• Both:	Applies	fabricated	shape	to	both	the	Volume	and	Object	Map	(see	above).

Create Shape:	Initiates	the	Fabrication	process.
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Using Fabricate Shape(s)

Here we will use the Fabricate 

Shape(s) tool to create a 3D shape in 

a volume.

To follow along, download the data 

set CT_Foot from analyzedirect.com/

data and load into Analyze using 

Input/Output.

• Select the data set and open 

Segment.

• Select File > Load Object Maps 

and load CT_Foot.obj.

• Select Manual [1] and choose 

Fabricate Shape(s) [2].

• Set the Dimension to 3D [3] and 

set the Shape to Sphere [4].

• Use the linked cursor to navigate 

to the location where you would 

like to create the new shape [5].
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• Add a new object, name it and 

assign a color [6].

• Change the Radius of the sphere  

[7] and drag the 2D shape 

template in any of the images to 

the location you where you want 

to create the shape [8].

• Select Create Shape [9].

• The shape will be created and 

added to the object map. Right-

click on the rendering and select 

Transparency for a clearer view of 

the object in 3D [10].

Using Fabricate Shape(s) (continued)
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Here we will show how Fabricate 

Shape(s) can create objects defined in 

a text file.

To follow along, download the 

data set Trans_Pre_OP_MRI from 

analyzedirect.com/data and load into 

Analyze using Input/Output.

• Select the data set and open 

Segment.

• Select File > Load Object Maps 

and load Trans_Pre_OP_MRI_

brain.obj.

• Select Manual [1] and choose 

Fabricate Shape(s) [2].

• Set the Dimension to 3D [3] and 

set the Shape to Sphere [4].

• Add a new object, name it 

Electrodes and assign a color to 

the object [5].

• Click on the Alt button [6] and 

select File. 

Creating Objects from a Text File using Fabricate Shape(s)
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• In the window returned set Files 

of type to Text File (*.txt) [7].

• Select Electrodes text file [8] and 

click Open [9].

• Set the Radius to 6 [10] and click 

Create Shape [11].

• Once created, the new shapes 

will be added to the object map 

and can be viewed overlaid on 

the 2D images and in the 3D 

rendering [12].

• Right-click on the rendering and 

select Transparency for a clearer 

view of the objects in 3D.

• Select File > Save Object Map 

and save your object map as 

Trans_Pre_OP_MRI_brain_and_

electrodes.obj.

Creating Objects from a Text File using Fabricate Shape(s) (continued)
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Manual Tools for 3D Editing
Some of the manual tools have the 

capability to be used to edit objects 

in 3D. This is achieved by drawing 

directly on the 3D rendering.

To follow along, download the data 

set CT_Foot from analyzedirect.com/

data and load into Analyze using 

Input/Output.

• Select the data set and open 

Segment.

• Set the primary display to 

Render [1].

• Select Semi-Automatic [2] and 

choose Threshold Volume [3].

• Set a Threshold range [4] to 

isolate the bones of both feet 

and click Threshold Object [5].
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• Select Manual [6] and choose 

Manual Trace [7].

• Add a new object [8].

• Move the cursor to the Rendering 

and trace around the right foot 

[9].

• Complete the trace and release 

the left mouse button. All voxels 

not assigned to the Original 

object within the trace will be 

assigned to the selected object 

[9].

Manual Tools for 3D Editing (continued)
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Manual Tools for 3D Editing (continued)

• Add a new object.

• Select the Freehand Draw trace 

and trace over one of the bones 

in the right foot [11].

• Everything under the region 

will be assigned to the selected 

object [12].
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Dual Input Segmentation
Segment allows users to load two 

registered input data sets. The 

ability to load related volumes is 

powerful and allows users to segment 

structures from either data set.

• Load registered pre-operative 

MRI and post-operative CT.

• Segment the brain from the MRI 

and electrodes from the CT.
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• Load registered structural 

MRI and functional PET data. 

Structural regions can be 

delineated on the MRI and 

viewed on the PET, while regions 

of activity or uptake can be 

viewed on the functional data 

and displayed on the MRI.

• Loading two copies of the same 

input data set allows users to 

adjust or invert intensity display 

values on the related volume. This 

can be leveraged to assist with the 

segmentation of brain structures 

such as the thalamus. 

Dual Input Segmentation (continued)
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4D Segmentation
Segment supports 4D multivolumes. Users can use all of the segmentation tools to derive 2D, 3D, or 4D regions of interest. Segmentation 

using many of the Semi-Automatic tools can be configured to automatically propagate to the next 3D volume in the 4D multivolume as soon 

as the first segmentation is complete. To follow along, download the multivolume data set 4D_Cardiac_CT.avw from analyzedirect.com/

data and load into Analyze using Input/Output.

• Select the multivolume data set and open 

Segment.

• A Volume control window will be available 

above the object control window [1].

• The slider [2] allows users to navigate 

through the 3D volumes in the multivolume.

• The window also provides the user with 

options to create a 3D or 4D object map 

[3] and to enable or disable the currently 

selected semi-automatic segmentation 

tool to be applied to all volumes in the 

multivolume [4].

• Select Semi-Automatic [5] and choose 

Region Grow [6].

• Set a seed point in a blood pool [7] and set 

a threshold range to isolate the object of 

interest [8].

• Confirm mode is set to 4D and the Grow 

All Volumes option is checked [9]. Click 

Connect Object [10].
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Segment will isolate the object from 

the first volume of the multivolume. 

After segmentation is complete, the 

parameters used to isolate the object 

from the first volume will be copied to 

the next volume and the blood pool 

will be segmented on the second 

volume. This will continue until all 

volumes have been processed. Use 

the volume slider to navigate through 

the multivolume to review the 

segmentation results. 

4D Segmentation (continued)
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Surface generation offers users 

the ability to create and export 

surface files for 3D printing, additive 

manufacturing, and CAD applications. 

There is a fundamental transformation 

that needs to take place between the 

voxel-based volume image world and 

an explicit surface description file, 

for which Analyze provides several 

helpful algorithms.

Analyze provides the ability to 

efficiently and accurately extract and 

represent a surface from a specific 

object of interest, exporting this 

surface in several common surface 

description formats including STL (see 

table for a list of supported surface 

formats).

Generating Surface Files from Objects

Format Extension

Alias Wavefront .obj

Autocad .dxf

Compressed IGES .iges

IGES .iges

Inventor .iv

Patran .out

Ply .ply

Poly .poly

3D Systems .stl

Binary 3D Systems (default) .stl

VRML .wrl

The key to surface generation is to use Analyze to accomplish a segmentation of the particular structure of interest from the volume image 

data, using any of the available tools provided with Segment, and then use the segmented object to drive the surface extraction process for 

the optimal definition and output of the surface data.
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The Segment module provides the mechanism to extract a surface description of segmented 

objects from volume image data via two unique Analyze-specific algorithms; Adapt Deform or 

Marching Cubes. Both Adapt Deform and Marching Cubes extract an optimal description of 

the surface with as few polygons as possible. Once extracted, the surface can be saved in many 

common surface description formats and imported into third party 3D printing program, CAD 

software, or rapid prototyping equipment.

Extract Surface: The Extract Surface window provides users with the interface to generate 

surface files. To access the window right click in the Object List and choose Extract Surface [1]. 

The following options are available:

Surface Generation Options

• Object: The Object selection area allows users to select objects to generate surfaces 

for [2]. Note that multiple objects can be selected, each object will be exported to its 

own surface file. If users wish to combine objects in a single surface file objects either 

need to be combined prior to surface extraction using the Reassign Object function 

or combination needs to be conducted after export using a third-party application. 

• Filename: Surface file names are specified in the Filename field. [3] This field 

becomes available once an object is selected.

• Options: The Options area allows users to specify the surface extraction method 

for surface generation. When a method is selected method specific options become 

available. User can choose between Adapt Deform and Marching Cubes:

 · Adapt Deform: The Adapt Deform algorithm (enabled by default) [4] specifies 

that the adaptive deformation algorithm will be used to generate the tiled 

surface.
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• Options (continued)

 · Adapt Deform (continued): This algorithm is based on an adaptive mesh model; a discrete dynamic system constructed from a set 

of nodal masses that are interconnected by adjustable springs. This system is governed by a set of ordinary differential equations of 

motion (discrete Lagrange equations) that allow the system to evolve to equilibrium. 

 

In the mass-spring model, the set of coupled equations are solved iteratively in time to update the position of the nodal masses until 

the masses reach an equilibrium position. For the purposes of surface reconstruction, the equilibrium positions of the nodal masses 

will approximate the surface of the object. The initial positions of the nodal masses are determined by creating a rough approximation 

of the surface using a surface tracking technique. A cubic grouping element is used to create a lower resolution version of the data 

set, which is then systematically triangulated to form the initial approximation of the surface. The following options are available: 

 · Specify Budget: Allows users to specify the maximum number of polygons in the final surface.

Surface Generation Options (continued)

 · Iterations: Iterations allows the user to specify the number of iterations of the 

deformation process. While there are a maximum number of iterations beyond 

which there will be little or no improvement in the quality of the final surface, that 

point is highly dependent on the data. 

 · Cube Edge Size: The Cube Edge Size option allows users to adjust the length (in 

voxels) of a side the initial cubic grouping element. This grouping element is used 

to form the initial surface approximation. If the polygonal budget is set to 0, then 

smaller cubes will result in higher resolution surfaces, otherwise cube size should 

be inversely related to the polygonal budget in order to reduce the number of 

iterations required to reach equilibrium (small polygonal budgets require large 

cube sizes).
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• Options (continued)

 · Adapt Deform (continued): 
The effects of changing the 

cube edge size on the resulting 

surface can be seen in this 

image. The larger the cube 

edge size the smoother the 

generated surface is. Note, 

increasing the resolution 

(reducing cube edge size) 

increases the processing time 

and this is demonstrated by 

setting the ‘Cube Edge Size’ to 

‘1’.

Surface Generation Options (continued)

 · In cases where a high resolution (Cube Edge Size of 1) is required, it is 

recommended that users use the Marching Cubes algorithm.  

 · Marching Cubes: The Marching Cubes option [5] specifies that the marching 

cubes algorithm will be used to generate the tiled surface. The algorithm 

processes the data in scan line order and calculates the polygonal vertices using 

linear interpolation.
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• Options (continued)

 · Marching Cubes (continued): As	
discussed	in	Adapt	Deform	if	a	surface	

file	of	the	exact	segmented	object	

(a	cube	edge	size	of	1)	is	required,	

then	Marching	Cubes	should	be	

used.	This	will	provide	an	accurate	

surface	description,	in	a	smaller	file,	

in	a	fraction	of	the	time	of	Adapt	

Deform.

 · Use Gradient: The	Use	Gradient	
option	is	enabled	(checked)	by	

default.

Surface Generation Options (continued)

 · Checked:	When	enabled	the	algorithm	will	use	the	gradient	information	present	in	the	voxel	data	to	estimate	surface	position.	This	

results	in	a	smooth	surface	that	may	have	a	higher	error	estimate	than	the	equivalent	binary	surface	extraction.

 · Unchecked:	When	enabled	the	algorithm	will	ignore	gradient	information	and	generate	a	surface	based	on	binary	thresholding.	This	

will	produce	a	“voxelated”	surface	that	minimizes	the	error	between	voxel	surface	and	the	reconstructed	polygonal	surface.	

 · Output Scaled Data:	When	selected	will	scale	the	surface	file	into	real	world	coordinates.	When	the	surface	coordinates	will	be	scaled	
from	voxel	dimensions	in	the	header	information	of	the	data	to	real	world	dimensions.	This	requires	the	VoxelWidth,	VoxelHeight,	and	

VoxelDepth	parameters	be	set	correctly	in	the	volume’s	header	information.

 · Output Directory:	Allows	users	to	specify	the	location	where	the	generated	surface	files	will	be	saved	to.	
 · Output Format:	Allows	users	to	specify	the	format	the	generated	surface	files	will	be	saved	in	(see	previous	table	for	formats)
 · Right-handed:	For	both	the	Adapt	Deform	and	Marching	Cubes	extraction	processes	the	surface	files	created	will	have	a	3D	left-
handed	coordinate	system.	Checking	the	right-handed	option	will	flip	the	surface	file	to	a	right-handed	coordinate	system.	

 · Extract Surface(s):	Initiates	the	surface	generation	and	export	routine.	When	completed	a	dialog	box	will	be	returned.	
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Here we will generate several surface files at once from objects we have previously segmented 

and which are contained in an object map.

To follow along, download the data set MRI_3D_Head from analyzedirect.com/data and load 

into Analyze using Input/Output.

• Select the data set and open Segment.

• Select File > Load Object Maps and load MRI_3D_Head.obj.

• Right click on the object list [1] and select Extract Surface [2].

• Select the objects that you will use to generate a surface file [3].

• The output surface name will be the same as the object name. If desired, rename the output 

surface file name [4].

• Select the surface generation method [5].

• Set the Output Directory [6].

• Choose the ouput format [7].

• Click Extract Surface(s) [8].

• When surface generation is complete a notification will be returned confirming that the 

selected surfaces have been generated and saved. Click OK [9] to close the window.

The generated surfaces can now be retrieved from the output directory and used in other third 

party applications such as 3D printing, additive manufacturing, or computer aided design.

Generating Surface Files from a Selection of Objects
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Image Registration

The goal of image registration is to determine a spatial transformation that will bring into alignment separately acquired images of the same 

object. When accurately registered, each separate image will have the same coordinate system and same voxel size, a voxel in one image 

will represent the same physical location as the corresponding voxel in the other image. The registration process interpolates the registered 

images as they are resampled and/or reformatted during the registration process. For example, registration of an axial PET data set to a 

sagittal MRI data set results in the PET data being transformed (resampled and reformatted) into the sagittal MRI space.

Registration is a prerequisite for several applications including; the display, segmentation, and analysis of structural and functional data, 

algebraic manipulation of image data (image addition, subtraction, multiplication, and division), the analysis of dynamic image data, and the 

fusion of data from multiple images.

Introduction
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Image Fusion

Image fusion is the process of combining, into one image, the information from multiple registered images. For example, the registration of 

an axial PET to a sagittal MRI allows for the transformed PET image data to be superimposed upon the sagittal MRI and output as a single 

fused volume illustrating both structure and function.

Transformation

Transformation is the process of changing a match data set to align with the base data set using the parameters calculated during 

registration, these parameters include; translation, rotation, scaling, and shear. 

Translation: A translation moves data to a different position. A 2D image can be moved left, right, up or down. A 3D volume can be moved 

left, right, up, down, backwards or forwards. 

Rotation: Rotation rotates the data at a particular angle from its origin. 

Scaling: Scaling changes the size of a data set. Scaling either expands or compresses the dimensions of the image data. 

Shear: Shearing, sometimes referred to as skewing, is a transformation that slants the shape of the data.

Introduction (continued)
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The register module is divided 

into several areas: 1) the menu, 2) 

tools, 3) the display area, and 4) the 

registration controls.

Menu

File: The File menu allows users to 

load the base and match data, load 

and save transformed object maps, 

and save transformed match data. 

The File options include:

• Input/Output: Displays a 

Volume area at the bottom of 

the Register module window. 

This area facilitates the dragging 

and dropping of image data into 

the module and the reversing of 

inputs via the Swap Inputs button.

Register Module Interface
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File >Input/Output (continued): 
Tip: Swapping inputs is useful when you register a match 

data set to a base data but need the base data set 

transformed into the space of the match data set. This 

situation can arise when you are unable to register image 

A to image B, but are able to register image B to image A.

• Load Object Map: Allows users to load an object map 

for the Base and/or Match volume. When selected a 

window will be returned prompting the user to specify 

which volume the object map should be loaded for. 

There is also the option to cancel the object map load. 

Once Base or Match is selected a Load Object Map 

window will open allowing users to navigate to, select, 

and load an object map file. The following options are 

available:

 · Current Directory: Takes user to the current 

directory, the current directory is set by right-

clicking in the main Analyze 15.0 window and then 

choosing Current Directory from the menu. 

 · Workspace Directory: Takes user to the current 

Workspace directory.

 · Home Directory: Takes user to the user’s Home 

directory. 

 · Cancel Load: Cancels load of the object map.

Menu (Continued)
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File (continued):

• Unload Object Map: Allows users to unload the Base, Match, or both 

object maps. Users also have the option to cancel the object map 

unloading process.

• Save Registered: The Save Registered option allows users to save the 

transformed match data set, the fused image data, or the transformed 

match object map – only available if a match object map was loaded.

When the Save Object Map option is selected users will be prompted 

to save the object map or cancel the save. When Save Object Map is 

selected a new window will open providing users with the option to 

overwrite the loaded object map (Yes) or to save as a new object map 

(No, I want to specify a name and location).

• Exit: Closes the module

Other: The other menu provides access to the Options and Powerbar 

editor menus.

Menu (Continued)

Other > Options: When selected opens the Options menu providing access to Module configuration options, including:

• Intensities Linked:  Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity 

display will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually.

• Linked Pan: Allows users to enable (default) or disable linked image panning. Note that linked panning only applies to the current row of 

images. Disabling linked pan allows you to pan a single image at a time.
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Other > Options (continued):

• Linked Zoom: Allows users to enable or disable linked zooming. The following options are available:

 · Both: Both is the default option, when selected any zoom in/out on an image is applied to all images for both input data sets.

 · Row: Allows zooming to be applied to the current row of images.

 · Column: Allows zooming to be applied to the current column of images.

Menu (Continued)

• Linked Blend: The linked blend option allows for the enabling (default) and disabling of the same blend type to be applied to all fused 

images in the center column. Keep enabled if you wish to apply the same blend option to all fused images, disable if you wish to apply 

different blend options to the fused images. 

• Adjust Scale: Allows users to enable or disable (default) the scale tool for the match data allowing for interactive image scaling.

• Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

• Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is 

set to the number of processors on the system.

Other > Powerbar Editor: Provides access to the Powerbar Editor allowing users to add and remove tools from the tools area. See the 

Powerbar Editor description in the Segment section for further information. 

Help: The Help menu provides users with quick access to help resources including:

• About: View version, system and environment information.

• Users Guide: Opens the Analyze 15.0 User’s Guide.

• Get Help: Opens the AnalyzeDirect Support Page.
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The Tools options provide access to the Toggle Cursor Link, Toggle Region Display and the Set Note State tools. For further information on 

these tools please refer to section 2. Image Display, Controls and Customization.

• Reset Matrix: The reset matrix tool is unique to Register and allows users to reset the match data sets matrix at any time. To reset the 

match registration matrix simply click the Reset Matrix button. 

Tools

Display Area

The Register display area consists 

of; 1) the base image display, 2) the 

match image display, 3) the fused 

image display, 4) the linked cursor 

tool, 5) linked cursor coordinates, 6) 

slice display tool, 7) image display 

controls, 8) blend type options, and 9) 

manual registration tools.
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Display Area: The Register module display area is a nine-panel display divided into three columns and three rows; each column displays a 

different data set while each row displays a different orientation.  The first column [1] displays the base data set, the third column [2] displays 

the match dataset, while the middle column [3] displays a fused image - a blended combination of the base and match data. The top row 

displays all three image data sets (base, fused, and match) in the axial orientation, the middle row displays all three data sets in the coronal 

orientation, and the bottom row displays all three data sets in the sagittal orientation. 

The Cursor Link: The cursor link [4] allows users to interactively navigate through the input image data. The cursor linked tool can by 

adjusted in any of the nine display panels interactively updating all nine simultaneously. The linked cursor coordinates as well as the voxel 

intensity value for both the base and match volumes are displayed in the lower left-hand corner. [5] The cursor link can be enabled or 

disabled using the Toggle Cursor Link button.

The Slice Tool: Users can navigate through image slices using the slice tool. Click the yellow Slice text in the lower left-hand corner of the 

base axial, [6] coronal, or sagittal image display. An up/down slice cursor will appear. Hold down the left mouse button and slide the cursor 

upward to move to a higher slice number and downward to move to a lower slice. 

Display Area (Continued)

Users can quickly navigate to the First, Middle and Last slice by right-clicking the 

yellow Slice text. A specific slice number can be chosen by double-clicking the 

yellow Slice text and typing in the desired slice number.

Image Display Controls: Register provides users with access to the Zoom, Pan, and 

Max/Min tools [7].

• Zoom Tool: Users can increase and decrease the display size of the data using 

the Zoom tool. Click on the yellow Zoom text in the bottom right corner of the
image pane. A zoom cursor will be displayed. While clicking and holding the left mouse button, move the mouse upward to zoom in and 

downward to zoom out. Let go of the left mouse button when the desired zoom factor is reached. For a full description of the Zoom tool 

including right mouse menu options please refer to the Zoom tool in Section 2. Image Display, Controls and Customization.
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Image Display Controls > Zoom Tools (Continued):  Note: Linked Zooming can be disabled, enabled, or enabled for just columns or rows. 

See the Other > Options menu description above for additional information.

• The Pan tool: The Pan tool is automatically enabled in Register. Click on the yellow Pan text in the bottom right corner of the axial, 

sagittal, or coronal base images. A pan cursor will be displayed. While clicking and holding the move the cursor to pan the image. 

Panning is linked for the selected row, to pan the current image only disable Linked Pan in the Other > Options menu for additional 

information see the Other > Options menu description above.

Display Area (Continued)

• Max/Min tool: The Max and Min display intensities of the base data set can be 

changed by clicking on the yellow Max/Min Tool at the bottom right corner of 

the axial base image window. A cursor will return that allows the values to be 

manipulated. Hold down the left mouse button and move the mouse up/down or 

left/right to adjust the display. To change the intensity display of the match data, 

click on the yellow Max/Min Tool at the bottom right corner of the match image 

window. For a complete description on how to how values are changed with the 

Max/Min tool please Section 2. Image Display, Controls and Customization. 

Blend Type Options: The blend type in 

the lower left-hand corner of the fused 

axial image [8] can be used to adjust the 

blended composition of the fused image. 

To adjust the blend type, left click on the 

yellow Blend Type text to toggle through 

the blend type options, alternately, right 

click on the yellow Blend Type text and 

choose a blend type from the menu [9].
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• Average (Ignore 0’s): Like the Average blend option the Average (Ignore 0’s) option linearly interpolates the base and match images to 

form the fused image, however, voxels with a value of 0 in the base image are not included when creating the fused image. 

Display Area (Continued)

• Average: The Average blend option linearly interpolates the base and match 

images to form the fused image.

 · Blend Percent: The blend percent option is available when the Average blend 

type option is selected. The blend percent allows users to adjust the percent 

of the Base image used in the interpolation to form the fused image. The 

default blend percent is 50, lowering the percentage will lower the amount the 

base image displayed in the fused image, higher the percentage will increase 

the amount of the base image displayed in the fused image. Double-click 

on the yellow Blend Percent text to enter a percent value or right-click and 

choose a value from the menu. 

Blend Type Options (continued): 

Blend type adjustment is helpful for the visual 

assessment and verifications of registration, especially 

when the base and match images are both grayscale 

[10].

The following blend types are available:



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

488REGISTER > REGISTER MODULE INTERFACE

Display Area (Continued)

 · Blend Percent: The blend percent option for the Average (Ignore 0’s) blend options works and functions the same as the blend 

percent option for the Average blend option.

• Checkerboard: This function depicts the base and match volumes in a checkerboard pattern. The following options are available:

 · Grid Size: Allows users to specify the size of squares used to create the checkerboard grid. 

 · Toggle Grid: Switches the base and match volume inputs for the checkerboard squares [13].

Blend Type Options > Average (Ignore 0’s) (continued): 

In the example here, a rectangular region has been removed from the base image and the voxel values set to 0 [11]. Instead of a black 

rectangle appearing in the fused image, these voxels are ignored and the voxels from the match image are displayed [12].
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Display Area (Continued)

Blend Type Options (continued): 

• Difference: The difference option 

subtracts the base volume from 

the match, directly showing the 

difference between volumes [14]. 

 

• Red-Green: The red-green blend 

option applies a red color overlay 

to the base volume and green 

color overlay to the match volume.  

Color blending is useful when the 

two volumes are both grayscale or 

from the same modality. 

• Green-Red: The green-red blend 

option applies a green color 

overlay to the base volume and 

red color overlay to the match 

volume.



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

490REGISTER > REGISTER MODULE INTERFACE

Display Area (Continued)

Blend Type Options (continued): 

• Yellow-Cyan: The yellow-cyan 

blend option applies a yellow 

color overlay to the base volume 

and cyan color overlay to the 

match volume.   

 

• Cyan-Yellow: The cyan-yellow 

blend option applies a cyan color 

overlay to the base volume and 

yellow color overlay to the match 

volume. 

Manual Registration Tools: The 

manual registration tools [15] allow 

users to adjust the position of 

the match data set by translating 

or rotating the data in the axial, 

coronal, and sagittal orientations. 

When enabled users are also able to 

scale the match data manually in all 

orientations. 
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Display Area (Continued)

Manual Registration Tools (continued): 

• Rotate: The rotate buttons allow 

users to incrementally rotate 

the image data clockwise or 

counterclockwise relative to the 

selected orientation. Left click either 

rotate button to rotate the data in 

that direction. 

 · Rotate increment: The default 

number of pixels rotated at a 

time is 10, to adjust the number 

of degrees for each rotation left 

click on the yellow Rotate text and 

then choose Rotation Increment 

and then select for the options 

available [16].

 · Rotating with the mouse: Left 

click on the yellow Rotate text and 

a Rotate cursor will be displayed. 

While clicking and holding the 

left mouse button, move the 

mouse upward to rotate clockwise 

[17] and downward to rotate 

counterclockwise [18].
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Display Area (Continued)

Manual Registration Tools (continued): 

• Translate: The translate buttons allow users to incrementally translate 

the image data up or down or to the left or right, relative to the selected 

orientation. Left click any of the four translate buttons to translate the data in 

that direction.

 · Translate increment: The default number of pixels translated at a time is 1. 

To adjust the number of pixels for each translation left click on the yellow 

Translate text and then choose Translation Increment and then select for 

the options available [19].

 · Translating with the mouse: Left click on the image or click on the yellow 

Translate text and a Translate cursor will be displayed. Translation will mimic 

the movement of the mouse: while clicking and holding the left mouse 

button, move the mouse forward to translate the image up, backwards to 

translate the image down, right to move the translate the image right, and 

left to translate the image left [20]. Note, translation from the left mouse 

button is enabled by default, allowing translation of the match image data 

by clicking on it and moving the cursor. To disable this option right click in 

any of the Match display windows and uncheck the Left Drag to Translate 

option.

• Scale: The scale tools are not enabled by default; they can be enabled from 

the Other > Options menu. The scale buttons [21] allow users to incrementally 

translate the image data up or down or to the left or right, relative to the 

selected orientation. Left click any of the four translate buttons to translate the 

data in that direction.
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Display Area (Continued)

Manual Registration Tools > Scale 
(continued): 

 · Scale increment: To adjust the 

scale increment left click on 

the yellow Scale text and then 

choose Scale Increment (only 

available when scale is enabled) 

and then select for the options 

available [22].

 · Scaling data with the mouse: 
To scale using your mouse, left 

click on yellow Scale text and a 

Scale cursor will be displayed 

[23]. While clicking and holding 

the left mouse button, move 

the mouse forward to increase 

the vertical scale [24], move the 

mouse backwards to decrease 

the vertical scale [25]. 

 

Move the cursor to the right 

to increase the horizontal 

scale [26], left to decrease the 

horizontal scale [27].
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Display Area (Continued)

Manual Registration Tools Right Click Options: Right clicking on the manual 

registration tools provides access to the Rotation, Translation, and Scale Increment 

adjustment options. The right menu also provides access to an Interpolation option 

allowing users to select the following interpolation options for manual manipulation of 

the data; Nearest Neighbor, Linear, Bicubic (default), and Windowed Sync.

Display Area Right Mouse Options:  The following additional options are available 

from the right mouse menu in the Register display area. Note that the options available 

depend on the column selected (Base, Fused, Match). The options include:

 · Middle Button Action: Sets the action of the middle mouse button.

 · Rotate @ Point: Only available in the Register module, this option allows users to 

select a specific point to use to rotate the match input around. 

 · Mouse While Action: Sets the action of the middle mouse wheel.

 · Copy to Clipboard: Copies the current slice display to memory.

 · Isotropic: Active only for anisotropic data. Allows users to toggle between an 

isotropic or anisotropic display of the data.

 · Rotation Increment: Allows users to adjust the rotation increment (see Rotate Increment).

 · Translate Increment: Allows users to adjust the translation increment (see Translate Increment).

 · Scale Increment: Available when Scale is enabled. Allows users to adjust the scale increment (see Scale Increment).

 · Matrix: The matrix option allows users to: Load a matrix file (*.mat file) for the match data set; Save the current matrix file; or Reset: the 

matrix file, selecting from Axial, Coronal, or Sagittal. 

 · Alignment Grid: When selected a grid displays over the current image providing a reference aid for match data realignment [28].

 · Left Drag to Translate: Translation from the left mouse button is enabled by default, allowing users to translate the match image data 

by clicking on it and moving the cursor. To disable uncheck the option.

 · Reset: Resets all options to default. This option does not reset the matrix.
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Registration Controls

The Registration Controls are found in the left hand column of the Register Module Interface.

Register Type

Register Type indicates the current dimensionality mode; 2-D, 3-D, or 4-D. This is set automatically by Register 

and is dependent upon the data selected. Choosing two single 2D slices or a single 3D volume will open the 

Register in 2-D mode, selecting two 3D volumes will open Register in 3-D mode. Note, if multivolumes are 

selected, additional volume controls became available under 3-D mode. See Volumes for additional information. 

The Register algorithm is selectable and users can choose between Surface Alignment or Mutual Information.

Surface Alignment

Surface alignment, also referred to as surface matching, is a geometry-based registration method. Surface 

alignment is fast and robust, even in the presence of image noise and incomplete overlap of the input image 

volumes.

Surface alignment tries to maximize the overlap between 

corresponding surfaces extracted from two image inputs. 

To use surface alignment both input volumes must contain 

common objects which need be explicitly segmented from the 

grayscale image data, for example the brain from an MRI data 

set saved as either a grayscale or binary image prior to use in 

Register.

Alternatively, if the object is segmentable via thresholding 

(e.g. the brain from a SPECT image,) a surface can be defined 

interactively within Register using the threshold controls.



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

496REGISTER > REGISTER MODULE INTERFACE

Registration Controls (continued)

A surface is extracted from both the base object 

(base image) and the match object (match image). 

The base object is used to create a chamfer distance 

volume. This is a volume in which each voxel has 

a value equal to the number of single-voxel steps 

from that coordinate to the nearest point on the 

base surface. Surface points are defined as any 

non-zero-valued voxel with at least one zero-valued 

orthogonal neighbor in 3-D space.

For the match object surface points are defined as 

any non-zero-valued pixel with at least one

zero-valued orthogonal neighbor within the same slice. To evaluate the error at any orientation, the coordinates of the selected ‘match 

surface’ points are transformed into the space of the base image, and the chamfer volume voxel values at those coordinates are summed. If 

all the match surface coordinates land on the base surface, the sum is zero. The minima search algorithm is a variant of simulated annealing 

which searches for minima at randomly determined multiple starting orientations, researching promising minima at successively higher 

resolution until a best minima is found.
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Mutual information registration is proven to be effective for 

registering image data from different modalities. Mutual information 

seeks to align voxels whose values have common probabilities of 

being present in their respective image sets. 

There are two components of the registration paradigm in Analyze:

1. The cost function used as the metric to judge when the volumes 

are in register.

2. The multiresolution search strategy used to find the global 

optimum of the cost function. 

The mutual Information cost function is based on the individual 

and joint entropy measured from the voxel values in the base and 

match volumes. There needs to be enough overlap and mutually 

shared signal from common structures for a relationship to be found 

between the two volumes and for them to be successfully co-

registered.

The mutual information algorithm determines the geometric 

transformation parameters used to spatially register the input data. 

The transformation parameters include both translation and rotation 

and scaling and shearing if enabled. The parameters are output in 

a homogeneous 4x4 matrix file. Image registration is achieved by 

transforming a volume using the transformation matrix.

Registration Controls (continued)
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2D registration determines the geometric transformation parameters to be used to align 2D images, slice-by-slice or matching a series of 

slices to a single base slice.

The following options are enabled/available with 2D registration:

2-D: The 2-D dimension mode is enabled when two 2D slices or a single 3D volume are loaded into Register.

Surface Alignment: Enables surface matching registration. The following options are available:

• Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to isolate common surfaces between the input images. Note, if common surfaces are not segmentable via thresholding 

the input data will need to be segmented prior to registration. 

 · Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

Registration Controls > 2D
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Registration Controls > 2D (continued)

2-D > Surface Alignment > Threshold (continued):

 · Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

• Show Thresholds: When enabled displays a filled preview of the minimum/maximum threshold value set for base and match input data.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

• Load: Load a matrix file (*.mat file) for the match data set.

• Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

• Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the value 

of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four available 

interpolation options.

• Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale intensity 

based on the distance of neighboring voxels from the interpolated voxel.

• Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

• Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.
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Slices: This option is only available when a single 3D volume is selected for input for 2D registration. The slices sliders allow users to 

navigate through the base and match inputs. 

• Base: The base slider controls the display of the base slice. This will also be the 2D slice used for registration. 

• Match: The match slider controls the display of the match slice. This will be the slice registered to the base for single Matrix and Single 

Reference registration. See Process and Registration mode for information on other registration options. 

Process: The process controls allow users to register and save registration result, the following options are available.  

• Save Registered: Allows users to save the transformed match image, the fused image, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

• Register: Initiates the slice-to-slice registration. 

• Register Pairs: Only available when a single 3D volume is loaded. The register pairs option registered the current match slice to the 

current base slice. To adjust the select of the base or match slice input use the Slices sliders.

• Match Range: Only available when a single 3D volume is loaded. The match range slider allows users to specify a range of 2D match 

images to be registered to the base image.

Register Mode: Only available when a single 3D volume is loaded. The registration mode allows users to select from the following options: 

• Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match data 

set to the displayed base data to the range of match images selected using the match range slider. All images in the match range are 

transformed to the same single matrix.

Registration Controls > 2D (continued)
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Register Mode > Single Matrix (continued):

• Single Reference: The single reference option registers each of the match images specified in the match range, individually to the base 

image.

Registration Controls > 2D (continued)
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Register Mode (continued):

• Sequential: Performs a sequential match image to base image registration within the specified match range. For example, match image 

2 to base image 1, then match image 3 to based image 2, etc.

• Register Sequence: Only available for the single reference and sequential register modes. When selected initiates registration. 

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Registration Controls > 2D (continued)
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Mutual Information enables mutual information-based registration. The following options are available:

• Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to consider for registration. The use of thresholding with mutual information-based registration is normally to remove 

background noise, artifact from implants, or other ranges of greyscale values from the data that could interfere with registration. 

 · Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

 · Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

• Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input 

data.

Match Sample Region: The match sample region slides allow users to increase or decrease the sampling density in the X, Y, and Z (if 

applicable).

• Minimum X Sample Extent: Use the slider to specify the x sampling density. Decreasing the x minimum value and increasing the x 

maximum value will increase the minimum x sample range [1]. Increasing the x minimum value and decreasing the x maximum value will 

decrease the minimum x sample range [2].

Registration Controls > 2D (continued)
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Match Sample Region (continued):

The minimum and maximum values can also be 

adjusted to select a specific x region or exclude a 

region that could interfere with registration [3].

• Y Sample Extent: As with the minimum X 

sample extent, users can use the minimum 

Y sample extent slider to specify the 

minimum y sampling density. Decreasing 

the y minimum value and increasing the y 

maximum value will increase the minimum y 

sample range [4]. Increasing the y minimum 

value and decreasing the y maximum value 

will decrease the minimum y sample range 

[5]. The minimum and maximum values can 

also be adjusted to select a specific y region 

or exclude a region that could interfere with 

registration.

• Z Sample Extent: Use the slider to specify 

the z sampling density.

• Show Region: Enables the display of the 

sample extent on the match image, showing 

the region as a purple and white dashed box.

Registration Controls > 2D (continued)
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DOF Search Ranges: The Degrees Of Freedom (DOF) search range allows users to adjust the default parameters set for registration.

• X Search: Allows users to adjust the maximum expected horizontal displacement (in either direction) of the match image in pixels.

• Y Search: Allows users to adjust the maximum expected vertical displacement (in either direction) of the match image in pixels.

• Z Rotation Search: Allows users to adjust the maximum expected rotation of the match image in degrees.

• Affine Register: Allows users to enable affine registration providing access to X and Y scale and shear search options:

 · X Scale Search: Adjust the maximum expected horizontal scaling difference between the match and base images

 · Y Scale Search: Adjust the maximum expected vertical scaling difference between the match and base images

 · X Shear in Y Search: Adjust the level of x shear in the y search.

 · Y Shear in X Search: Adjust the level of y shear in the x search.

• Bounded Search: Limits the total number of search steps.  The registration algorithm, while robust in most cases, can fail to converge 

in extremely low-information situations. This option avoids program hang-up in those situations, and seldom significantly affects typical 

solutions.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

 · Load: Load a matrix file (*.mat file) for the match data set.

 · Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

 · Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

Registration Controls > 2D (continued)
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Transformation Interpolation (continued):

 · Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.

 · Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

 · Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Slices: This option is only available when a single 3D volume is selected for input for 2D registration. The slices sliders allow users to 

navigate through the base and match inputs. 

 · Base: The base slider controls the display of the base slice. This will also be the 2D slice used for registration. 

 · Match: The match slider controls the display of the match slice. This will be the slice registered to the base for single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options. 

Process: The process controls allow users to register and save registration result, the following options are available.  

 · Save Registered: Allows users to save the transformed match image, the fused image, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

 · Register: Initiates the slice-to-slice registration. 

 · Register Pairs: Only available when a single 3D volume is loaded. The register pairs option registered the current match slice to the 

current base slice. To adjust the select of the base or match slice input use the Slices sliders.

 · Match Range: Only available when a single 3D volume is loaded. The match range slider allows users to specify a range of 2D match 

images to be registered to the base image.

Register Mode: Only available when a single 3D volume is loaded. The registration mode allows users to select from the following options: 

 · Single Matrix: Applies the transformation matrix created when registering the displayed match data set to the displayed base data to 

the images selected using the match range slider. All images in the match range are transformed to the same single matrix.

Registration Controls > 2D (continued)
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Register Mode (continued):

 · Single Reference: This option registers each of the match images specified in the match range, individually to the base image. 

 · Sequential: Performs a sequential match image to base image registration within the specified match range. For example, match 

image 2 to base image 1, then match image 3 to based image 2, etc. 

 · Register Sequence: Only available for the single reference and sequential register modes. When selected initiates registration.

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action.

Registration Controls > 3D
The 3-D dimension mode is enabled when two 3D volumes or one or more multivolumes (4D data sets) are loaded into Register.

Surface Alignment: Enables 3D surface matching registration. The following options are available:

• Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to isolate common surfaces between the input images. Note, if common surfaces are not segmentable via thresholding 

the input data will need to be segmented prior to registration. 

 · Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

 · Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input data.

Registration Controls > 2D (continued)
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Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

 · Load: Load a matrix file (*.mat file) for the match data set.

 · Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

 · Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

 · Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.

 · Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

 · Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Process: The process controls allow users to register and save registration result, the following options are available.  

 · Save Registered: Allows users to save the transformed match volume, fused volume, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

 · Register: Initiates the 3D registration. 

 · Register Pair: Only available when the register mode is set to Single Reference or Sequential. Will initiate the registration of the 

current match volume to the current base volume. 

 · Match Range: Only available when one or more 4D multivolumes are loaded. The match range slider allows users to specify a range 

of 3D volumes in the 4D match multivolume to be registered to the base volume.

Registration Controls > 3D (continued)
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Register Mode: Only available when a single 4D volume is loaded. The registration mode allows users to select from the following options: 

 · Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match 

data set to the displayed base data to the range of match data sets selected using the match range slider. All volumes in the match 

range are transformed to the same single matrix.

 · Single Reference: The single reference option registers each of the match volumes specified in the match range, individually to the 

base volume.

 · Sequential: Performs a sequential match volume to base volume registration within the specified match range. For example, match 

volume 2 to base volume 1, then match volume 3 to based volume 2, etc. 

 · Register Sequence: Only available for the single reference and sequential register modes. When selected initiates sequential 

registration. 

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Volumes: This option is only available when one or more 4D multivolumes are selected for input for 3D registration. The Volume sliders 

allow users to navigate through the volumes in the match and/or base input multivolumes. 

 · Base: The base slider controls the display of the base volume. This will be the volume used for single matrix and single reference 

registration.

 · Match: The match slider controls the display of the match volume. This will be the volume registered to the base for Single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options.

Mutual Information: Enables 3D mutual information-based registration. The following options are available:

• Threshold: The Threshold double-ended slider bars for both Base and Match data allows specifification of a range of threshold values 

to consider for registration. The use of thresholding with mutual information-based registration is normally to remove background noise, 

artifact from implants, or other ranges of greyscale values from the data that could interfere with registration.

Registration Controls > 3D (continued)
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Mutual Information > Threshold (continued): Enables 3D mutual information-based registration. The following options are available:

 · Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

 · Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

• Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input 

data.

Match Sample Region: The match sample region slides allow users to increase or decrease the sampling density in the X, Y, and Z.

 · X Sample Extent: Use the slider to specify the x sampling density. [1]

 · Y Sample Extent: Use the slider to specify the Y sampling density. [2]

 · Z Sample Extent: Use the slider to specify the Z sampling density. [3] 

 · Show Region: Enables the display of the sample extent on the match  

image. The region will be shown as a purple and white dashed box.

Registration Controls > 3D (continued)

DOF Search Ranges: The Degrees Of Freedom (DOF) search range allows users to adjust the 

default parameters set for registration.

 · X Search: Allows users to adjust the x translation search step.

 · Y Search: Allows users to adjust the y translation search step.

 · Z Search: Allows users to adjust the z translation search step.

 · X Rotation Search: Allows users to adjust the rotation about the x search step. 

 · Y Rotation Search: Allows users to adjust the rotation about the y search step. 

 · Z Rotation Search: Allows users to adjust the rotation about the z search step. 

 · Affine Register: Allows users to enable affine registration providing access to X, Y, and Z 

scale and shear search options:
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Registration Controls > 3D (continued)

DOF Search Ranges > Affine Register (continued):

 · X Scale Search: Allows users to adjust the X scaling search parameter.

 · Y Scale Search: Allows users to adjust the Y scaling search parameter.

 · Z Scale Search: Allows users to adjust the Z scaling search parameter.

 · X Shear in Z Search: Allows users to adjust the level of x shear in the z search.

 · Y Shear in Z Search: Allows users to adjust the level of y shear in the z search.

 · X Shear in Y Search: Allows users to adjust the level of x shear in the y search.

 · Z Shear in Y Search: Allows users to adjust the level of z shear in the y search.

 · Y Shear in X Search: Allows users to adjust the level of y shear in the x search.

 · Z Shear in X Search: Allows users to adjust the level of z shear in the x search.

• Bounded Search: Limits the total number of search steps.  The registration algorithm, while robust in most cases, can fail to converge 

in extremely low-information situations. This option avoids program hang-up in those situations, and seldom significantly affects typical 

solutions.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

 · Load: Load a matrix file (*.mat file) for the match data set.

 · Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

 · Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

 · Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.
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Registration Controls > 3D (continued)

Transformation Interpolation (continued):

 · Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

 · Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Process: The process controls allow users to register and save registration result, the following options are available.  

 · Save Registered: Allows users to save the transformed match volume, fused volume, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

 · Register: Initiates the 3D registration. 

 · Register Pair: Only available when the register mode is set to Single Reference or Sequential. Will initiate the registration of the 

current match volume to the current base volume. 

 · Match Range: Only available when one or more 4D multivolumes are loaded. The match range slider allows users to specify a range 

of 3D volumes in the 4D match multivolume to be registered to the base volume. 

Register Mode: Only available when a single 4D volume is loaded. The registration mode allows users to select from the following options: 

 · Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match 

data set to the displayed base data to the range of match data sets selected using the match range slider. All volumes in the match 

range are transformed to the same single matrix.   

 · Single Reference: The single reference option registers each of the match volumes specified in the match range, individually to the 

base volume. 

 · Sequential: Performs a sequential match volume to base volume registration within the specified match range. For example, match 

volume 2 to base volume 1, then match volume 3 to based volume 2, etc. 

 · Register Sequence: Only available for the single reference and sequential register modes. When selected initiates sequential 

registration. 
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Registration Controls > 3D (continued)

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Volumes: This option is only available when one or more 4D multivolumes are selected for input for 3D registration. The Volume sliders 

allow users to navigate through the volumes in the match and/or base input multivolumes. 

• Base: The base slider controls the display of the base volume. This will be the volume used for single matrix and single reference 

registration.

• Match: The match slider controls the display of the match volume. This will be the volume registered to the base for Single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options.
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Surface alignment is used to register image data that does not have enough or any mutual information, for example a functional SPECT 

scan and structural MRI scan. This exercise will provide the steps necessary to correctly register a SPECT scan and an MRI scan of the brain. 

However, first we will observe what happens when we try to register the image data set using Mutual Information.

To follow along, download data sets SISCOM_MRI.avw and SISCOM_Ictal_SPECT.avw from analyzedirect.com/data

• Open Input/Output and load both the SISCOM_MRI.avw and SISCOM_Ictal_SPECT.avw data sets into Analyze.

• Once loaded select the SISCOM_MRI data set then press and hold the Ctrl button on your keyboard and select the SISCOM_Ictal_

SPECT data set and open Register. Note the order in which the data is selected is important. The first data set selected will be loaded

3D Registration - Surface Alignment

 · as the base data set, in this 

example the MRI [1], while 

the second data set will be 

the match data set, in this 

example the SPECT [2].

• Set the Register Type to 

Mutual Information [3] and 

then click Register [4].
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Due to the lack of mutual information between 

these two modalities the registration will fail. Note 

the incorrectly positioned SPECT [5] with respect 

to the MRI.

In order to facilitate successful registration of 

the MRI and SPECT data we need to establish 

surfaces for common objects in both data sets, 

this means the explicit segmentation of the brain 

from the MRI and SPECT data sets.

• Close the Register module. 

• From the main Analyze window select 

the SISCOM_MRI data set and then open 

Segment. 

• From the Semi-Automatic tab [6] select 

Object Extractor [7].

• On Coronal slice 115 click in the white matter 

to set a seed point [8]. Adjust the threshold 

range [9] to define the brain, a minimum value 

of 21 and a maximum value of 47 works well 

for this data set.

• Click Extract Object [10].

3D Registration - Surface Alignment (continued)
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• After segmentation is complete 

notice that the brain object contains 

some minor holes. To correct for 

these holes, choose Fill Holes [11], set 

the Fill Type to 3-Pass [12],  click on 

the brain object [13] to initiate the fill 

process.

• Once the fill process is complete the 

brain will no longer contain any holes. 

Right-click on the brain object in 

the object list and then choose Save 

Grayscale from the menu [14].

3D Registration - Surface Alignment (continued)

• In the Save Grayscale window retuned change the name of the output file to SISCOM_MRI_Brain [15] and click Save Grayscale [16]. A 

grayscale version of the segmented brain object will be saved to the workspace, this will provide the surface of the brain for surface 

alignment with the SPECT data set.

• Close Segment. 

• As the brain surface in this SPECT data set can be easily isolated via thresholding in Register there is no need to segment the data 

set using Segment. However, if the SPECT image data contained extracranial signal that prevented a clear representation of the 

brain surface via thresholding the data set could be segmented to isolate the brain using Segment prior to use in Register.
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• Select the SISCOM_MRI_Brain data 

set then press and hold the Ctrl 

button on your keyboard now select 

the SISCOM_Ictal_SPECT data set 

and open Register.

• Set the Register Type to Surface 

Alignment [17].

• If desired modify the blend type 

[18].

• Next click the Show Threshold check 

box [19].

3D Registration - Surface Alignment (continued)

• Note that all voxels for both the base and match data sets are currently selected. To exclude the background voxels from the base 

volume set the Base minimum threshold level to 1 [20] by entering the value in the text field or by adjusting the slider. Note the 

update on the base display [21], only the voxels within the red mask will be considered for registration. 

• Adjust the threshold range for the match data set to remove the background voxels and all non-brain voxels. Set the minimum 

threshold value to 20 [22] by entering the value in the text field or by adjusting the slider. Note the update on the match display [23], 

the voxels within the red mask represent the brain and will provide the match surface to facilitate a successful registration.
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• Uncheck the Show Threshold option 

[24].

• To register the data click Register 

[25].

• After the registration is complete 

visually review the transformed and 

fused image data [26].

• Click Save Registered to save 

the Transformed SPECT data to 

the workspace and then close 

Register.

3D Registration - Surface Alignment (continued)
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The goal of this exercise is to demonstrate how to apply mutual information to registration of image data from two different modalities, MRI 

and PET. The MRI data set is sagittal acquisition anisotropic (non-cubic) data set, while the PET data set is an axial acquisition with isotropic 

voxels, so not only are the image data sets different modalities they also have different volume and voxel dimensions and were acquired 

in different orientations. To view this information right-click on the data once loaded into Analyze and then choose Info, review the volume 

metadata in the tab at the bottom of the Analyze window.  To follow along, download data sets MRI_Head.avw and PET_Head.avw from 

analyzedirect.com/data. Open Input/Output and load both the MRI_Head.avw and PET_ Head.avw data sets into Analyze.

• Select the MRI_Head data set and while holding down the Ctrl key, select the PET_Head data set and then open Register.

• Select File > Input/Output Ports to view the input and output ports at the bottom of the Register window. Make sure that MRI_Head is 

the base volume, and PET_Head is the match volume. If the data was loaded incorrectly, click the Swap Inputs button to correct.

• The base MRI data set will display in the first column while the match PET data will display in the last column. 

3D Registration - Mutual Information

• At this point no registration has taken 

place, but the match data set has been 

correctly scaled to the base data set, 

displayed isotropically.

• The crosshair (linked cursor) [1] in each 

of the image display panes can be used 

to move through the volumes. When the 

crosshair is moved in any of the panes, the 

other panes automatically update. Note 

that the base and match coordinates are 

reported at the bottom of the window [2].

• Click the Register button [3].
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• After registration is complete, you will see that the PET volume has been scaled, rotated and translated to match the sagittal MRI [4].

• If desired right-click the Blend Type yellow text in the fused axial image (middle upper panel) [5] and change the blend type. 

• To evaluate the registration, move the crosshair in any of the panes. Note, if moving the crosshair in fused or match data you can 

unintentionally translate the data. If you do this click Undo to reverse the last action. To prevent this from happening again either right-

click in a fused or match image and uncheck the ‘Left Drag to Translate’ option or simply control the crosshair maneuvers from the base 

volume only. 

• If the registration is not satisfactory, you can choose to undo the last action using the Undo button at the bottom of the left tool bar. 

• If you want to reset the data back to the original matrix, use the Reset button in the top right of the register window [6].

3D Registration - Mutual Information (continued)

• To view the current transformation matrix, 

select the Registration Matrix box [7] on 

the left tool bar. This gives the option 

to save the current matrix as an ASCII 

floating-point file or load a previously 

saved matrix.

• To save a copy of the transformed PET 

data set or fused MRI/PET data set, 

click Save Registered [8]. Select the 

Transformed Save Type, Workspace, File 

and then select Save Transformed.

• When finished close Register.
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Sometime image registration will fail, fortunately the Register module provides several tools to help optimize conditions to achieve 

registration. Common problems include:

 · • Not enough overlapping information between input data sets

 · • Background or artifact noise

 · • Adjusting the sample region to include/exclude regions in the match data

Not enough overlapping information between input data sets

• Download data sets Register_MRI_Base.avw and Register_MRI_Match.avw from analyzedirect.com/data to follow along.

• Use Input/Output to load the two data sets into Analyze. Select the Register_MRI_Base data set and while holding down the Ctrl key, 

select the Register_MRI_Match data set and then open Register.

Troubleshooting Registration Problems

• Select File > Input/Output Ports to view 

the input and output ports at the bottom 

of the Register window. Confirm that the 

Register_MRI_Base data set is assigned 

as the ‘Base Volume’ and Register_MRI_

Match data set is assigned as the ‘Match 

Volume’. If the data is loaded incorrectly 

use the Swap Inputs option to correct.

• Use the Blend Type [1] to set a Red-Green 

blend for the fused image. The blend 

will help with visual assessment of the 

registration result as both the base and 

match data sets are grayscale.

• Press the Register button [2].
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• Examine the Fused image data in the 

center column [3]. It is clear to see that the 

registration process failed. These image 

inputs do not have enough overlapping 

mutual information to facilitate a successful 

registration, however, the resolution to 

this issue is quite simple, the match data 

set needs to be manually adjusted so it 

has a new starting point closer to the base 

image.

• Since the registration is not acceptable 

click the Reset Matrix button [4].

Not enough overlapping information between input data sets

• Left click on the coronal fused or match image and drag the data down slightly [5]. Release the mouse when the ventricles are aligned 

closer [6].

• Alternatively, use the down translation arrow [7] to move the coronal match  

image down 5 voxels.
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• Press the Register button. 

• This time the image data will register 

correctly. Notice that the fused image 

will appear yellow [8] when aligned 

correctly. Use the Save Register [9] to 

save the transformed image data to 

the workspace. 

• Note that when troubleshooting data 

you are experiencing problems with 

may need to make larger adjustments 

that could also include rotations and 

manipulations in all three orientations.

• Close Register.

Not enough overlapping information between input data sets (continued)
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Noise in the background of the image 

or from artifact in the image can prevent 

successful registration of image data. 

In this example, registration of a post-

operative CT to a pre-operative MRI fails 

due to the artifact from the electrodes in 

the CT data set [1].

However, simply setting a threshold 

range to exclude the voxels in the match 

data set that represent the electrodes, 

by decreasing the maximum threshold 

value [2], and the streak artifact from the 

electrodes, by increasing the minimum 

threshold value [3], allows for a successful 

registration [4].

Background or artifact noise
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Registration can fail if not enough of 

the match data is considered for the 

registration. Registration can also fail 

if the match region considered for 

registration contains a region of large 

morphological change from the base 

data set, such as an implant in a post-

implant data set. The match sample 

region allows users to adjust to match 

region considered for the registration, 

increasing or decreasing the match region 

as necessary. 

The match sample region provides 

X, Y and Z sample extent sliders that 

define a specific spatial region used for 

registration. A dotted boundary line will 

appear on the right match image column 

[1] when the option is enabled.

In this example registration between 

a pre-procedure and post-procedure 

Cone Beam CT (CBCT) scans fails as the 

CBCT scans were acquired from different 

scanners with different parameters [2].

Adjusting the sample region to include or exclude regions in the match data
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Adjustment of the match sample 

region to increase the X sample 

range [3] remedied the problem and 

allowed for successful registration of 

the image data [4].

Adjusting the sample region to include or exclude regions in the match data (continued)
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The Analyze Measure module provides access to an array of measurement tools that allow users to sample their image data.  

1D measurement tools are available for sampling and logging 3D positions of points, making line intensity and distances measures, or 

making angle measurements. 2D measurements tools allow users to interactively defined rectilinear or elliptical regions, sample freehanded 

traces of regions of interest, or sample regions or objects on images. Finally, 3D measurements tools allow users to sample loaded object 

maps to return spatial size measures, signal intensity information, or 3D shape characteristics.

Introduction
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The measure module is divided into several areas: 1) the menu, 2) measurement tools, 3) stats display, 4) stats log,  5) the object control 

window, 6) display controls, 7) tools, 8) orthogonal image display, and 9) the rendering window. Each of these areas are now described.

Measure Module Interface
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The Menu provides access to the File, Options and Help menus. 

File: The File menu allows users to load and save object maps for the loaded data set. The File options include:

• Input/Output Ports: Displays a Volume area at the bottom of the Segment module window. This area facilitates the dragging and 

dropping of image data into the module and the loading of a related image data set, see Dual Input Segmentation for additional 

information.

• Load Object Map: When selected opens a Load Object Map window allowing users to navigate to, select and load an object map file. 

The following options are available:

 · Current Directory: Takes user to the current directory, the current directory is set by right-clicking in the main Analyze 15.0 window 

and then choosing Current Directory from the menu. See section 1. Analyze Basics for additional information. 

 · Workspace Directory: Takes user to the current Workspace directory.

 · Home Directory: Takes user to the user’s Home directory. 

 · Cancel Load: Cancels the load of the object map.

• Unload Object Map: Unloads the current object map

• Exit: Closes the module

Menu
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Other: The other menu provides access to additional module options and configuration of the tools area. 

• Options: When selected opens the Options menu providing access to Module configuration options, including:

 · Intensities Linked: Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity 

display will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually.  

 · Fast Object Rendering: Enables/Disabled Fast Object Rendering.

 · Show Cursor Coordinates: Allows users to Enable/Disable the display of the linked cursor coordinates and voxel grayscale value 

displayed in the lower left-hand corner of the display window. 

 · Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

 · Auto Cursor Link: Allows the Auto Cursor Link option to be enabled or disabled. 

 · Remember Layout: When enabled the module will remember changes made to the layout and will open with this layout in the future. 

When disabled the module will open with the default layout. 

 · Decimal Places: The Decimal Places options allows users to set the number of decimal places reported for measurements. By default 

the number of decimal places is set to 2.

 · Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads 

is set to the number of processors on the system.

• PowerBar Editor: When selected opens the PowerBar editor allowing users to add additional shortcut buttons to the tools area of the 

Measure window. Add or remove the following shortcut buttons form the tools area: 1) Exit, 2) Options, 3) Input/Output, 4) Load Object 

Map, 5) PowerBar Editor, 6) Set Note Stat, 7) Toggle Cursor Link, 8) Toggle Region Display, and 9) Unload Object Map.

• Help: The Help menu provides users with quick access to help resources including:

 · About: View version, system and environment information.

 · Users Guide: Opens the Analyze 15.0 User’s Guide.

 · Get Help: Opens the AnalyzeDirect Support Page.

Menu (continued)
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The measurement tools options are grouped into three tabs under Sample Type. These are:

1-D: The 1-D tab provides access to the following measurement tools:

 · Sample Point(s)

 · Sample Line(s)

 · Sample Trace(s)

 · Sample Border(s)

 · Sample Angle(s)

 · Sample Two Lines

 · Sample Perpendicular Lines

3-D: The 3-D tab provides access to the following measurement options:

 · Box

 · Selected Objects

 · Enabled Objects

 · Entire Volume

 · Stereology

These three tabs provide access to all of the measurement tools in Measure. The measurement tools within each tab will be discussed in the 

Measurement Tools section of this guide.

Measurement Tools

2-D: The 2-D tab provides access to the following 

sampling options:

 · Sample 2-D Rectangle

 · Sample 2-D Oval

 · Sample 2-D Closed Trace

 · Selected Region

 · Selected Object

 · Enabled Object

 · Entire Image
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Stats Display

The stats display area reports the select measurements. Measurements cannot be saved from this area (see Stats Log for saving out 

measurements), however, measurements can be copied and pasted from this area.

Stats Log

When the Auto Log Stats option is checked the Stats Log reporting the selected measurements will be displayed below the main image 

display area. The following right mouse menu options are available:

• Save Log: Allows users to save the log file as a .csv file.

• Clear Log: Clears all measurements from the current log file. 

• Dismiss Log: Closes the log file.

• Remove Last Entry: Allows users to delete the last entry in the stats log. 

Object Control Window

The Measure object controls window allows users to enable and disable the display of objects within the current object map. It also allows 

users to edit object properties including name, color, and opacity.

Display Controls

The Display Control tools allow users to control and customize the layout of the Measure display area. For further information on these tools 

please refer to the Image Display, Controls and Customization section of this User’s Guide.

Other Measure Module Interface Areas
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Tools

The Tools options provide access to the Toggle Cursor Link, Toggle Region Display and the Set Note State tools. For further information on 

these tools please refer to the Image Display, Controls and Customization section of this User’s Guide. 

Orthogonal Image Display

The orthogonal slice display windows provide an interactive 2D review tool of the slice data in the axial, coronal and sagittal planes. For 

more information about the slice display windows, refer to the Display section of this User’s Guide.

The Rendering Window

The render window provides an interactive 3D display of the segmented image data. For more information about the render window, refer 

to the Display section of this User’s Guide.

Other Measure Module Interface Areas (continued)
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1D measurements include points, lines, trace, angles, borders distances, intersecting lines, and perpendicular lines. Coordinates, signal 

values, linear distances, line profiles and angles can all be generated using Measure. Full Width Half Max (FWHM) parameters can also be 

set to control sampling. Note 1-D measurements (apart from Sample Border(s)) can be made on image data with or without a loaded object 

map. The 1-D tab provides access to the following measurement tools:

 · Sample Point(s)

 · Sample Line(s)

 · Sample Trace(s)

Sample Point(s) 
 
The Sample Point(s) tool allows users to select points on the 2D image data or 3D rendering. The tool will report the coordinates and 

intensity value of the selected point. The following options are available: 

 

Sample Options: Provides users with access to the following point sampling options:

 · Name: Allows users to assign a name to the selected point when reported to the log file.

 · Persistent: When selected prevents previously selected points for being cleared from the image.

 · Clear: Clears all points from the image.

Stats to View: The stats to view area allows users to enable and disable measurements and information reported to the stats log. 

• General: Allows users to report information about the image data set including:

 · Data File Name: Reports the data set name to the stats log.

 · Object Map Name: Reports the object map name to the stats file.

 · Voxel Width: Reports the voxel width to the stats file.

 · Voxel Height: Reports the voxel height to the stats file.

 · Voxel Depth: Reports the voxel depth to the stats file.

1-D Measurement Tools

 · Sample Border(s)

 · Sample Angles

 · Sample Two Lines

 · Sample Perpendicular Lines
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Stats to View > General (continued):
 · Time Stamp: Reports the date and time of sampling to the stats file.

 · Analyst: Reports the current user logged into the system to the stats file.

• DICOM Info: Only applicable for DICOM image data, allows users to report:

 · Patient Name: Reports the patient name to the stats log.

 · Patient ID: Reports the patient ID to the stats log.

 · Birth Date: Reports the patient’s date of birth to the stats log.

 · Gender: Reports the patient’s gender to the stats log.

 · Weight: Reports the patient’s weight to the stats log.

 · Study ID: Reports the study ID to the stats log.

 · Study Date: Reports the study date name to the stats log.

 · Study Time: Reports the study time to the stats log.

 · Study Description: Reports the study description to the stats log.

 · Series Number: Reports the series number to the stats log.

 · Series Description: Reports the series description to the stats log.

 · Accession Number: Reports the accession number to the stats log.

 · Modality: Reports the modality to the stats log.

• Points: Provides users with the option to report the following point related information and measurements:

 · Orient: Reports the orientation the point was logged in. Options include; Axial, Coronal, Sagittal, Rendering, and Oblique. 

 · Name: Reports the name.

 · Object: Reports the object the point was logged on (if an object map is loaded).

 · Point Location: Reports the X, Y, Z location of the point.

 · Intensity Value: Reports the greyscale intensity value of the point.

Sample Point(s) (continued)
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The Sample Point(s) tool can be 

used to sample landmarks for 

morphological applications.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

To sample points, do the following:

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze.

• Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Maps 

and load MRI_3D_Head.obj.

• Select the 1D Sample Type [1 and 

choose Points [2].

• Click on the brain in the axial 

orientation [3] to set a point.

Note that the coordinates and 

intensity of the point will be reported 

in the Stats review area [4].

Sampling Points using Sample Point(s)
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• Check the Auto Log Stats option 

[5]. Each point selected will now 

be saved to a measurement log.

• Check the Persistent checkbox [6].

This will prevent points from being 

cleared from the display when a 

new point is selected.

• Set a new point in the axial 

orientation [7] and set another 

point in the coronal orientation [8]. 

The current point will display as 

green, while previous points will 

change to red.

• The coordinates and intensity 

values will be reported in the log 

[9].

Sampling Points using Sample Point(s) (continued)
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• Set several new points in the 

sagittal orientation [10] and on the 

rendering [11].

• Right click on the log to save as a 

.CSV file [12].

Note that point sampling does not 

require an object map to be loaded 

[13].

Sampling Points using Sample Point(s) (continued)
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The Sample Line(s) tool allows users to define a line on a 2D image or a 3D rendering. The tool will report 

distance measurements, line intensity profile and the coordinates of the line end points. The following 

configuration options are available: 

Sample Options: Provides users with access to the following line sampling options: 

 · Name: Allows users to assign a name to the defined lines when reported to the log file. 

 · Persistent: When selected prevents previously defined lines for being cleared from the image. 

 · Clear: Clears all lines from the image. 

Sample Line(s)

Full Width Half Max: The 

Full Width Half Max (FWHM) 

option can be enabled [1] 

for the Sample Line(s) and 

Sample Trace(s) tool [2].

Once enabled, Measure will 

automatically log FWHM 

distance measurements 

[3] for defined lines [4] and 

traces.
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Full Width Half Max (continued):

• Base Value: Allows users to specify the value used in the 

FWHM calculation.

• Auto: When enabled, the base value is automatically 

calculated by computing the mean of the nine-point 

neighborhoods around each endpoint of the line or trace

• Search from: Allows users to specify the search mode for 

FWHM measurement. The following options are available:

 · Outside: Specifies that search begins at the ends of the 

profiles. 

 · Maximum: Specifies that search begins at the maximum 

value and proceeds to both the left and right for the two 

half max values.

Sample Line(s) Options (continued)

The Full Width Half Max 

To find the FWHM of the line profile [5] (the calculation of 

pixel intensities along straight lines and freehand traces on 

the images), the ‘Half Max’ value is first computed using the 

formula: 

Half Max = ((Maximum Value – Base Value)/2 + Base Value)
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Full Width Half Max (continued):

The ‘Maximum Value’ is the maximum intensity value of the line profile. The 

‘Base Value’ is defined under the Full Width Half Max options [6]. The Base Value 

can be set to a specified value, or it can be set dynamically using the ‘Auto’ 

option. When the Auto option is selected, the Base Value is set to the mean 

intensity value of the nine-point neighborhoods surrounding each endpoint of 

the line. Once the Half Max value is known, Measure will search the line profile 

to see where that value is first crossed over on either side of the line maximum. 

The direction from which the module searches the line profile for the Half Max is 

determined by the ‘Search From’ option in under the Full Width Half Max options 

[7].

If the Search From option is set to ‘Outside’, then Measure will search for where 

the line intensity values cross over the Half Max value beginning at the outside 

of the profile and moving inwards. In this example, the FWHM will be defined 

by the closest voxel to either endpoint of the line with an intensity value greater 

than the Half Max value [8].

If Search From is set to ‘Maximum’, then Measure will search for where the line 

intensity values cross over the Half Max value beginning at the profile Maximum 

and moving outwards (to the right and left). In this example, the FWHM ends up 

being defined by the voxels closest to the line Maximum that have an intensity 

value less than the Half Max [9]. Once the FWHM of the line has been defined, 

Measure will compute the FWHM distance by taking the distance between the 

voxels on either side of the FWHM weighted by their relative value to the true 

Half Max value. 

Sample Line(s) Options (continued)
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Stats to View

General: Allows reporting of general data parameters in the stats log file. See Sample Point(s) > Stats to View > General for full description.

DICOM Info: Allows reporting of DICOM tag information. See Sample Point(s) > Stats to View > DICOM Info for full description.

Line Traces:
 · Orient: Reports the orientation the line was defined in. Options include; Axial, Coronal, Sagittal, Rendering, and Oblique. 

 · Name: Reports the name.

 · End Point Locations: Reports the X, Y, Z location of each line end point (A and B).

 · Maximum: Reports the maximum voxel intensity value along the line.

 · Minimum: Reports the minimum voxel intensity value along the line.

 · Mean: Reports the mean intensity value for the voxels along the line. 

 · Standard Deviation: Reports the standard deviation.

 · Endpoint Distance: The Endpoint Distance (or Distance as reports in the stats display) reports the linear distance from end point A to 

end point B. Note, even if this option is unchecked it will still be reported to the stats display area and stats log. 

 · Curved Distance: Reports the curvilinear distance between the endpoints. The curvilinear distance is an approximation based on the 

distance between the two 3-D surface endpoints.

 · Surface Distance: The Surface Distance is only available for lines defined on the rendering. This option reports the surface distance 

of the line. The defined line is projected onto surface of the rendering and measured.

 · Profile: Displays the line profile plot.

FWHM:
 · Half Max: Reports the half max intensity value.

 · Half Max Location: Reports the X, Y, Z location of both half max locations.

 · Maximum: Reports the maximum voxel intensity value along the line.

 · Base Value: Reports the Base Value.

 · Distance: Reports the FWHM distance. 

Sample Line(s) Options (continued)
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Here we use the Sample Line(s) tool 

to make line measurements.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

To make a line measurement, do the 

following:

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze.

• Select MRI_3D_Head and open 

Measure.

• Switch the display of the 

Rendering off [1] and set the 

primary display to Sagittal [2].

Making Line Measurements using Sample Line(s)

• Select the 1D Sample Type [3] and choose the Line tool [4].

• If checked (enabled), uncheck Full Width Half Max [5].

• Define a line on a sagittal slice. [6] To draw a line position the cursor on the image and press the left mouse button to begin drawing. 

Release the button to end the line.

• The coordinates for the line endpoints (A and B) and the line distance are reported in the Stats review area [7].
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• Press Clear [8] to reset.

• Check the Persistent [9] and Auto 

Log Stats checkboxes [10].

• Define several lines on the sagittal 

slice [11].

• The coordinates for the line 

endpoints (A and B) and the line 

distances are reported in the log 

[12]. Right click to save the log as a 

.CSV file.

Making Line Measurements using Sample Line(s) (continued)



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

547MEASURE > MEASUREMENT TOOLS > 1-D MEASUREMENTS

The Sample Line(s) tool allows users 

to sample and plot pixel intensity 

values for a defined line.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze.

• Select MRI_3D_Head and open 

Measure.

• Switch the display of the 

Rendering off [1] and toggle the 

display of all orientations off [2].

Generating Line Profiles using Sample Line(s)

• Use the Orient option to switch to Sagittal [3].

• Select the 1D Sample Type [4]. Choose the Line tool [5].

• If enabled (checked), uncheck Full Width Half Max [6].

• Check the Profile option [7] and the Auto Log Stats checkbox [8]. 

• Define a line on a sagittal slice to measure the posterior to anterior distance of the corpus callosum [9].
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• The coordinates for the line 

endpoints (A and B) and the line 

distance are reported in the Stats 

review area [10] and in the Lines 

tab [11].

• The intensity profile of the defined 

line is logged [12] and plotted [13] 

in the Line Profile tab [14].

Generating Line Profiles using Sample Line(s) (continued)
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The Sample Line(s) tool allows for 

measurement of FWHM (Full-Width, 

Half-Max) distance on a line that 

crosses a structure of sufficient 

contrast to produce edges which 

cross the half-max value, which 

represents half the difference 

between the minimum and maximum 

intensity values along the line. FWHM 

measurements can be useful when 

trying to make exact measurements 

on a structure when placing the end 

points accurately is difficult.

Download the VH_Abdomen.avw 

data set from analyzedirect.com/data 

to follow along.

Making FWHM Line Measurements using Sample Line(s)

• Open Input/Output and load VH_Abdomen.avw into Analyze. Select VH_Abdomen and open Measure.

• Select the Sample Line(s) tool [1] from 1-D Sample Type. 

• Define a line in the axial orientation to measure the distance from the right side of the vertebral body to the left side [2].

• Note the distance [3].
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• Placing the endpoints, point A 

and point B, exactly in the correct 

location to obtain an accurate 

measurement can be difficult.

• Click Clear [4] to reset the line. 

• Check the Full Width Half Max 

checkbox [5] and check the Auto 

option to have the tool calculate 

the FWHM Base Value. 

• Select the FWHM Stats to View 

tab [6] and make sure Distance 

[7] is selected, this will report 

the FWHM Distance in the stats 

display. 

Making FWHM Line Measurements using Sample Line(s) (continued)

• In the axial orientation, define a line across the vertebral body, however, this time do not place the endpoints of the line exactly on each 

side of the vertebral body [8]. Note that the FWHM is overlaid in red on the line.

• Note the distance measurement in the stats display [9]. Even if the same distance measurements as before were obtained, FWHM is a 

quicker and easier method than trying to accurately place endpoints. 
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Like the Sample Points tool, the 

Sample Line(s) tool can also be used 

to make measurements on the 3D 

rendering.

Download the EG_CT.avw data set 

from analyzedirect.com/data to follow 

along.

• Open Input/Output and load 

EG_CT.avw into Analyze. Select 

EG_CT and open Measure.

• Select the Sample Line(s) tool [1] 

from 1-D Sample Type.

• From Stats to View select the Line 

Traces tab [2].

Making Line Measurements on the 3D Rendering using Sample Line(s)

• Ensure that both the Endpoint Distance and Surface Distance options are selected [3] and check Auto Log Stats [4].

• Use the Display control tools [5] to enable the display of the rendered image and switch off the display of the slice data.

• To view the skull, double-click on the yellow Thresh text in the lower left-hand corner and set the minimum value to 500 [6]. The skull will 

be displayed. Define a line on the skull [7].

• Note that both the straight line and surface distance have been reported to the stats log [8]. Note the difference in the measurements. 

Right-click to save the log.
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The Sample Trace(s) tool provides all the functionality of the Sample Line(s) tool, while allowing 

 the user to define a freehand trace. Available options are as follows:

Sample Options: Provides users with access to the following trace sampling options: 

 · Name: Allows users to assign a name to the defined trace when reported to the log file. 

 · Persistent: When selected prevents previously defined traces for being cleared from the image. 

 · Clear: Clears all traces from the image. 

Full Width Half Max: The Full Width Half Max (FWHM) option can be enabled for the Sample Line(s) and  

Sample Trace(s) tool. For additional information refer to the FWHM description under Sample Line(s) tool.

 · Base Value: Allows users to specify the value used in the FWHM calculation.

 · Auto: When enabled, the base value is automatically calculated by computing the mean of the nine-point neighborhoods around each 

endpoint of the line or trace

 · Search from: Allows users to specify the search mode for FWHM measurement. The following options are available:

 ·  Outside: Specifies that search begins at the ends of the profiles. 

 ·  Maximum: Specifies that search begins at the maximum value and proceeds to the left and right for the two half max values.

Stats to View

• General: Allows users to report general image data parameters in the stats log file. See General under Sample Point(s) > Stats to View for 

a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See the DICOM Info under Sample Point(s) 

> Stats to View above for a full description of available options.

• Lines Traces: Allows users to report an array of information about the trace. See Lines Trace under Sample Lines(s) > Stats to View above 

for a full description of available options.

• FWHM: Allows report an array of information for Full Width Half Max measurements. See FWHM under Sample Lines(s) > Stats to View 

above for a full description of available options.

Sample Trace(s)
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Here we use the Sample Trace(s) 

tool to make freehand trace 

measurements.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select the 1-D Sample Type [1] 

and choose Sample Trace(s) [2].

• Check any of the measurements 

required from the Lines Traces tab 

[3].

Making Freehand Trace Measurements using Sample Trace(s)

• Define a freehand trace on the data [4].

• The measurements selected will be returned to the Stats review area [5] once tracing is completed.

• If the Auto Log Stats [6] checkbox is selected, the measurements will be added to the Lines log [7] which can be saved as a .CSV file.
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The Sample Border(s) tool enables the measurement of a portion of an object’s border.  

Note that an object map must be loaded in order to utilize this tool. The following user  

configuration options are available:

Sample Options: Provides users with access to the following border sampling option: 

 · Name: Allows users to assign a name to the region of the border being measured 

 when reported to the log file. 

Full Width Half Max: The Full Width Half Max option can be enabled for Sample Border(s), Sample Line(s) 

 and Sample Trace(s) tool. For additional information refer to the FWHM description under Sample Line(s).

 · Base Value: Allows users to specify the value used in the FWHM calculation.

 · Auto: When enabled, the base value is automatically calculated by computing the mean of the nine-point neighborhoods around each 

endpoint of the line or trace

 · Search from: Allows users to specify the search mode for FWHM measurement. The following options are available:

 ·  Outside: Specifies that search begins at the ends of the profiles. 

 ·  Maximum: Specifies that search begins at the maximum value and proceeds to the left and right for the two half max values.

Stats to View

• General: Allows users to report general image data parameters in the stats log file. See General under Sample Point(s) > Stats to View for 

a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See the DICOM Info under Sample Point(s) 

> Stats to View above for a full description of available options.

• Lines Traces: Allows users to report an array of information about the trace. See Lines Trace under Sample Lines(s) > Stats to View above 

for a full description of available options.

• FWHM: Allows report an array of information for Full Width Half Max measurements. See FWHM under Sample Lines(s) > Stats to View 

above for a full description of available options.

Sample Border(s)
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Here we use the Sample Border(s) 

tool to make border measurements.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the Sample Border(s) tool 

[1] from 1-D Sample Type.

Making Border Measurements using Sample Border(s)

• To measure a length of an object border, move the cursor over the border and click to set the starting point [2] move the cursor to the 

where you wish to measure and click to set the end point [3].

• The distance measurement along the border will be reported in the stats display [4].
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• To enable FWHM check the Full 

Width Half Max checkbox [5].

• Note that the FWHM is overlaid in 

red on the image display [6].

• The FWHM Distance will be 

reported in the stats display area 

[7]. If the FWHM distance is not 

displayed select the FWHM tab 

from Stats to View and select 

check the Distance option.

Making Border Measurements using Sample Border(s) (continued)
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The Sample Angle(s) tool allows users to make distance measurements between points and angle  

measurements between defined lines. The following options are available: 

Sample Options: Provides users with access to the following angle sampling options: 

 · Name: Allows users to assign a name to the defined angle when reported to the log file.

 · Persistent: When selected prevents previously defined angles for being cleared from the image. 

 · Clear: Clears all angles from the image. 

Stats to View

• General: Allows users to report general image data parameters in the stats log file. See General under Sample Point(s) > Stats to View for 

a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See the DICOM Info under Sample Point(s) 

> Stats to View above for a full description of available options.

Angles: The following angle measurement options are available:

• Points: Provides users with the option to report the following point related information and measurements:

 · Name: Reports the name entered in the Sample Options area for the angle measurement.

 · A: Reports the X, Y, Z coordinate location for point A of the angle measurement.

 · B: Reports the X, Y, Z coordinate location for point B of the angle measurement.

 · C: Reports the X, Y, Z coordinate location for point B of the angle measurement.

• Distances: Provides users with the option to report the following distance measurements:

 · AB: Reports the distance between point A and point B.

 · BC: Reports the distance between point B and point C.

• Angles: Provides users with the option to report the following angle measurements:

 · ABC 2-D: Reports the 2D angle measurement.

 · ABC 3-D: Reports the 3D angle measurement.

Sample Angle(s)
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Here we use the Sample Angle(s) tool 

to make angle measurements.

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the 1D Sample Type [1]. 

Choose the Angles tool [2].

Making Angle Measurements using Sample Angle(s)

• Check the Points, Distances, and Angles to be reported [3].

• Define the angles on any of the 2D slices or the 3D rendering [4].

• The selected measurements will be reported in the Stats review area [5].



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

559MEASURE > MEASUREMENT TOOLS > 1-D MEASUREMENTS

The Sample Two Lines tool provides users with an interactive tool for making point, distance, and angle  

measurements. The tool is useful for applications such as measuring midline shift in stroke CT images.

Sample Options: Provides users with access to the following sampling options: 

 · Name: Assigns a name to the defined set of two-line measurements when reported to the log file.

 · Persistent: Prevents previously defined two-line measurements for being cleared from the image.

 · Clear: Clears all measurements from the image.

Stats to View
 · General: Allows reporting of general data parameters in the stats log file. See General under Sample Point(s) > Stats to View.

 · DICOM Info: Allows users to report DICOM tag information. See the DICOM Info under Sample Point(s) > Stats to View.

Two Lines:

• Points: Provides users with the option to report the following point related information and measurements:

 · Name: Reports the name entered in the Sample Options area for the two lines measurement.

 · A: Reports the X, Y, Z coordinate location for point A of the two line(s) tool.

 · B: Reports the X, Y, Z coordinate location for point B of the two line(s) tool.

 · C: Reports the X, Y, Z coordinate location for point C of the two line(s) tool.

 · D: Reports the X, Y, Z coordinate location for point D of the two line(s) tool.

 · E: Reports the X, Y, Z coordinate location for point E of the two line(s) tool.

• Distances: Provides users with the option to report the following distance measurements:

 · AB: Reports the distance between point A and point B.

 · CD: Reports the distance between point C and point D.

 · AE: Reports the distance between point A and point E.

• Angles: Provides users with the option to report the following angle measurements:

 · AEC: Reports the 2D angle measurement for points A-E-C.

 · CEB: Reports the 2D angle measurement for points C-E-B.

Sample Two Lines

 · BED: Reports the 2D angle measurement for points B-E-D.

 · DEA: Reports the 2D angle measurement for points D-E-A.

 · BE: Reports the distance between point B and point E.

 · CE: Reports the distance between point C and point E.

 · DE: Reports the distance between point D and point E.
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Download the ICH_CT.avw data set 

from analyzedirect.com/data to follow 

along.

• Open Input/Output and load 

ICH_CT.avw into Analyze. Select 

ICH_CT and open Measure.

• Use the display configuration tools 

to display the 3 ortho sections 

making axial view the primary [1].

• Right click on the Max/Min option 

and select CT > Brain. This will 

provide a better display of the 

brain structure in the CT data [2]. 

Select the 1D [3] Sample Type and 

choose Sample Two Lines [4].

Making Measurements using Sample Two Lines

• To measure the displacement of the septum pellucidum from the midline at the level of the foramen of Monro, find a suitable axial slice 

to make the measurement on. [5] 

• Click on the image to set the first point, A, and drag the end point of the first line, B, to the desired location. This is the midline [6]. Once 

the midline is set, the next line will automatically appear. To define the second line, move point D perpendicular to the midline of the 

septum pellucidum. [7] Point C may need adjusting to make the second line perpendicular to the first. 

• Check the Points, Distances, and any Angles you want to measure. [8] In this example, the midline shift measurement is between point D 

and point E. Reviewing angle DEA will confirm whether the second line is perpendicular to the first line. The angle should be 90 degrees. 

• Measurements will be reported in the Stats review area. [9]
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The Sample Perpendicular Lines tools allows users to make point and distance measurements  

perpendicular to a defined line (points A and B). 

Sample Options: Provides users with access to the following sampling options: 

 · Name: Assigns a name to the perpendicular line measurements when reported to the log file.

 · Persistent: Prevents previously defined perpendicular line measurements for being cleared.

 · Clear: Clears all perpendicular line measurements from the image.

Stats to View

• General: Allows users to report general image data parameters in the stats log file. See General under Sample Point(s) > Stats to View for 

a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See the DICOM Info under Sample Point(s) 

> Stats to View above for a full description of available options.

Perp Lines:

• Points: Provides users with the option to report the following point related information and measurements:

 · Name: Reports the name entered in the Sample Options area for the perpendicular line measurement.

 · A: Reports the X, Y, Z coordinate location for point A of the perpendicular line tool.

 · B: Reports the X, Y, Z coordinate location for point B of the perpendicular line tool.

 · C: Reports the X, Y, Z coordinate location for point C of the perpendicular line tool.

 · D: Reports the X, Y, Z coordinate location for point D of the perpendicular line tool.

• Distances: Provides users with the option to report the following distance measurements:

 · AB: Reports the distance between point A and point B.

 · AC: Reports the distance between point A and point C.

 · CD: Reports the distance between point C and point D.

Sample Perpendicular Lines
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The sample perpendicular lines tool is useful when 

making measurement perpendicular to specific 

landmarks in a data set.  Download the CBCT.avw data 

set from analyzedirect.com/data to follow along.

• Open Input/Output and load CBCT.avw into 

Analyze. Select CBCT and open Measure. Select 

the Sample Perpendicular Lines tool [1] from the 1-D 

Sample Type tab. Set the measure display so that 

all three orthogonal views are displayed with the 

Sagittal as the primary display [2].

• Adjust the Cursor Link tool in the axial [3] or 

coronal view to select a sagittal slice close to the 

mid-sagittal point. Toggle off the Cursor Link 

tool [4]. Enable all required Point and Distance 

measurements [5].

• Click on an area at the base of the skull [6] to set the 

first point (A) for the tool. Drag the second point B) 

to an area in the nasal bone [7]. The perpendicular 

line (points C and D) will appear halfway between 

points A and B. Drag point D to the mandible [8].

• The selected measurements will be reported to the 

stats display area [9]. Click Log Stats to log these 

measurements to a stats file that can be saved to 

disk.

Making Perpendicular Line Measurements using Sample Perpendicular Lines
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The 2D sampling options in Measure allow users to derive measurements from interactively defined rectilinear or elliptical regions or 

from objects that exist on a specific slice. Measurement options available include spatial context measurements as well as signal value 

measurements, including Max/Min, mean, standard deviation, area, volume, 2D shape characteristics and more.

2D measurements include measurements tools that can be used with or without object maps, these include; rectangular region of interest 

sampling, oval region of interest sampling, free trace region of interest sampling, and entire image sampling. The remaining three 2-D 

sampling options can only be used with an object map, these are; selected regions, selected object, and enabled object.

The 2-D tab provides access to the following measurement tools:

 · Sample 2-D Rectangle

 · Sample 2-D Oval

 · Sample 2-D Closed Trace

Sample 2-D Rectangle 
 
The Sample 2-D Rectangle tool enables the drawing of a rectangle on the displayed image to define a region. To define a rectangular region 

left click on the image and then drag the cursor until the desired size and shape rectangle has been define. The following sampling options 

are available. 

 

Sample Options: Provides users with access to the following 2-D Rectangle sampling options:

 · Name: Allows users to assign a name to the selected rectangle when reported to the log file.

 · Persistent: When selected prevents previously defined rectangles for being cleared from the image.

 · Clear: Clears all rectangles from the image.

Stats to View: The stats to view area allows users to enable and disable measurements and information reported to the stats log.

2-D Measurement Tools

 · Selected Region

 · Selected Object

 · Enabled Object

 · Entire Image
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Stats to View (continued):

• General: Allows users to report general image data parameters in the stats log file. See  

General under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM  

format. See DICOM Info under Sample Point(s) > Stats to View above for a full description.

• Size Intensity: Allows users to report an array of size intensity information and  

measurements. The following options are available:

 · Orient: Reports the orientation the region was defined in. 

 · Name: Reports the name entered in the Sample Options area for the region.

 · Slice: Reports the slice the region was defined on. 

 · Maximum: Reports the maximum voxel intensity in the region.

 · Max Location: Reports the location of the voxel with the maximum intensity value.

 · Minimum: Reports the minimum voxel intensity in the region.

 · Min Location: Reports the location of the voxel with the minimum intensity value.

 · Number of Voxels: Reports the number of voxels in the defined region.

 · Area: Reports the area of the region using the formula: Area = number of voxels x voxel width x voxel height

 · Volume: Reports the volume of the region using the formula: Volume = number of voxels x voxel width x voxel height x voxel 

depth

 · Mean: Reports the mean intensity value of the voxels sampled in the region. 

 · St. Dev: Reports the standard deviation of the sampled voxels.

 · Sum: Reports the sum of the intensity values of the sampled voxels. 

 · Entropy: Reports the Shannon entropy of the sampled voxels.

Sample 2-D Rectangle Options (continued)
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Stats to View > Size Intensity (continued):
 · Histogram: The histogram option reports plots the histogram of the region (intensities vs. occurrence) and reports relevant histogram 

information including:

 ·  Orient: Reports the orientation the region was defined in.

 ·  Slice: Reports the slice number the region was defined on. 

 ·  Object: Reports the object or region name. 

 ·  Intensity: Reports all intensity values in the region.

 ·  Count: Reports the count of the intensity in the region

 ·  Histogram Mode: Reports the Histogram Mode value.

 ·  Histogram Median: Reports the Histogram Median value.

Sample 2-D Rectangle Options (continued)
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Stats to View > Size Intensity (continued):
 · Boundary Coordinates: Reports the boundary (perimeter) coordinates of the 

region. Measurements include the following:

 ·  Index: Boundary pixel reference number.

 ·  X: Reports the X position of the boundary coordinate.

 ·  Y: Reports the Y position of the boundary coordinate.

 ·  Slice: Reports the slice position of the boundary coordinate.

 ·  Orient: Reports the orientation the sampled region is defined in.

 ·  Value: Reports the greyscale value of the boundary coordinate. 

 ·  Object: Reports selected or enabled object when an object map is loaded.

 ·  Border: Reports border thickness when an object map is loaded. 

 · Region Pixels: Reports information on all pixels that make up the defined region, 

measurements include:

 ·  Index: Region pixel reference number.

 ·  X: Reports the X position of the pixel.

 ·  Y: Reports the Y position of the pixel.

 ·  Slice: Reports the slice position of the pixel.

 ·  Orient: Reports the orientation the sampled region is defined in.

 ·  Value: Reports the greyscale value of the pixel. 

 ·  Object: Reports selected or enabled object when an object map is loaded.

Sample 2-D Rectangle Options (continued)
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Stats to View (continued):

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and maximum intensity range. The 

following options are available.

 · Sample Range Slider: The sample range slider allows users to define a minimum and maximum sample range based on the image 

histogram. Only voxels that meet the specified criteria will be sampled.

 ·  Range Min: Set the minimum for the sampling range.

 ·  Range Max: Set the maximum for the sampling range.

 · < Sample Min: Reports the number of voxels with an intensity value less than the specified minimum range value. 

 · > Sample Max: Reports the number of voxels with an intensity value greater than the specified maximum range value.

 · >= SMin & <= SMax: Reports the number of voxels with an intensity value equal to or greater than the sample minimum and equal to 

or less than the sample maximum. 

 · Mean in Range: Reports the mean intensity value of the voxels within the specified minimum and maximum sampling range. 

 · STD in Range: Reports the standard deviation of the sampled voxels. 

 · Sum in Range: Reports the sum of the intensity values of the sampled voxels within the defined range. 

 · Area in Range: Reports the area of the sampled voxels within the defined range. 

 · Volume in Range: Reports the volume of the sampled voxels within the defined range.

 · Brightness Area Product: Reports the Brightness Area Product for the sampled voxels. The value is calculated from the formula: 

(Mean in Range - Min) * No. Pixels In Range. 

• 2-D Shape: All 2-D shape measurements assume the input image data will have square pixels and are in units of linear pixel-sides or 

square pixels as appropriate. The following options are available.

 · MER Angle Resolution: MER (Minimum Enclosing Rectangle) specifies the angle resolution to be used when searching for the 

Minimum Enclosing Rectangle.

 · Perimeter: Reports the perimeter of the region in pixel-sides and in calibrated voxel units.

Sample 2-D Rectangle Options (continued)
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Stats to View > 2-D Shape (continued):
 · MER Angle: Reports the angle of rotation in one-degree increments, at which the sides of the minimum enclosing Rectangle is 

parallel to the X and Y axes. 

 · MER Area: Reports the minimum enclosing rectangle. 

 · MER Aspect Ratio: Reports the short side of the minimum enclosing rectangle to the long side. 

 · MER Coordinates: Reports the coordinates of the four corners of the MER.

 · Rectangular Fit Factor: Reports the ratio of the area of the region to the area of the minimum enclosing rectangle.

 · Circularity: Reports the ratio of the perimeter squared of the region to the area of the region, (P²/A). This parameter takes on a 

minimum value of 4 pi for a circle.

 · Circ./(4*Pi): Reports the circularity value divided by 4*Pi. This value should be 1 for a perfect circle. 

 · Centroid: Reports the center gravity for the region.

 · Surface Voxels: For use with the rendered image only. Reports the total number of voxels counted on the surface of the defined 

region.

 · Surface Faces: For use with the rendered image only. Reports the total number of exposed faces for all surface voxels.

 · Planar Area: For use with the rendered image only. Reports the count of 2-D pixels in the user defined area.

 · Surface Area: For use with the rendered image only. Reports an estimate of the structures surface area within the defined region, 

computed by examining each surface voxel found via the tracking algorithm and assigning a surface area component for each voxel 

based on its non-surface neighbors.

Sample 2-D Rectangle Options (continued)
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.

obj file. Select the 2D Sample 

Type [1] and choose Sample 2-D 

Rectangle(s) [2]. 

• In the Stats to View area check all 

required measurements [3] in the 

stats review area.

Making 2D Rectangular Measurements using Sample 2-D Rectangle

• Define a rectangle on the current axial slice [4].

• Selected measurements will be reported for the region in the stats review 

area [5]. Click Log Stats to return the stats to a log file that can be saved 

out of Analyze as a .csv file. 

• Note, to move the rectangle, place the cursor in the center of the 

rectangle. When the cursor updates its shape [6] move the rectangle up, 

down, left, or right.
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The Sample 2-D Oval tools enabled the drawing of an oval on the displayed image to define  

a region for sampling. To define an oval region left click on the image and then drag the cursor 

 until the desired size and shape oval has been define. The following sampling options are available:

Sample Options: Provides users with access to the following 2-D oval sampling options: 

 · Name: Allows users to assign a name to the selected oval when reported to the log file.

 · Persistent: Prevents previously defined ovals for being cleared from the image.

 · Clear: Clears all ovals from the image.

Stats to View: The stats to view area allows users to enable and disable measurements 

and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file. See  

General under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See DICOM Info under Sample Point(s) > 

Stats to View above for a full description of available options.

• Size Intensity: Allows users to report an array of size intensity information and measurements. Refer to the size Intensity description for 

Sample 2-D Rectangle for a description of all available options.

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and maximum intensity range. Refer to the 

Sample Range description for Sample 2-D Rectangle for a description of all available options. 

• 2-D Shape: Allows users to report 2-D shape measurements for the defined region. Refer to the 2-D Shape description for Sample 2-D 

Rectangle for a description of all available options.

Sample 2-D Oval
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Download the MRI_3D_Head.avw data 

set from analyzedirect.com/data to 

follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map and 

load the MRI_3D_Head.obj file. 

Select the 2D Sample Type [1] and 

choose Sample 2-D Oval(s) [2].  In 

the Stats to View area check all 

required measurements [3] in the 

stats review area. Define a oval on 

the current coronal slice [4].

Making 2D Oval Measurements using Sample 2-D Oval

• Selected measurements will be reported for 

the region in the stats review area [5]. Click Log 

Stats to return the stats to a log file that can 

be saved out of Analyze as a .csv file. Note, to 

move the oval, place the cursor in the center of 

the oval. When the cursor updates its shape [6] 

move the oval up, down, left, or right. The oval 

can also be rotated using the either of the two 

larger green control points [7].
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The Sample 2-D Closed Trace tools enable the drawing of a trace to define a region to sample on an 

 image. When selected, position the cursor on the displayed slice, press and hold the left mouse button 

 to draw a trace, release the mouse button to end the trace. The last point of the trace drawn is  

automatically connected to the first point of the trace. The following sampling options are available:

Sample Options: Provides users with access to the following 2-D closed trace sampling options: 

 · Name: Assigns a name to the selected closed trace when reported to the log file.

 · Persistent: Prevents previously defined closed traces for being cleared from the image.

 · Clear: Clears all closed traces from the image.

Stats to View: The stats to view area allows users to enable and disable measurements and  

information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file. See  

General under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format. See DICOM Info under Sample Point(s) > 

Stats to View above for a full description of available options.

• Size Intensity: Allows users to report an array of size intensity information and measurements. Refer to the size Intensity description for 

Sample 2-D Rectangle for a description of all available options.

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and maximum intensity range. Refer to the 

Sample Range description for Sample 2-D Rectangle for a description of all available options. 

• 2-D Shape: Allows users to report 2-D shape measurements for the defined region. Refer to the 2-D Shape description for Sample 2-D 

Rectangle for a description of all available options.

Sample 2-D Closed Trace
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the 2D Sample Type [1] and 

choose Sample 2-D Closed Trace 

[2].

• In the Stats to View area check all 

required measurements [3] in the 

stats review area.

• On the current sagittal slice 

define a trace around the corpus 

callosum [4].

• Selected measurements will be 

reported for the region in the 

stats review area [5].

Making 2D Closed Trace Measurements using Sample 2-D Closed Trace
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The Selected Region option allows users to sample a region of an object on a 2D slice. An object map 

must be loaded for this sampling option to be available.

Sample Options: Provides users with access to the following selected region options:

 · Name: Allows users to assign a name for the selected region when reported to the log file. 

Stats to View: The stats to view area allows users to enable and disable measurements and 

information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file. See General 

under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM format.  

See DICOM Info under Sample Point(s) > Stats to View above for a full description of  

available options.

• Size Intensity: Allows users to report an array of size intensity information and measurements. Refer to the size Intensity description for 

Sample 2-D Rectangle for a description of all available options.

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and maximum intensity range. Refer to the 

Sample Range description for Sample 2-D Rectangle for a description of all available options. 

• 2-D Shape: Allows users to report 2-D shape measurements for the defined region. Refer to the 2-D Shape description for Sample 2-D 

Rectangle for a description of all available options.

Selected Region
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the 2D Sample Type [1] and 

choose Selected Region [2].

• In the Stats to View area check all 

required measurements [3] in the 

stats review area.

• Move to axial slice 136 [4]. Click 

in the ventricle object on the left 

side to sample [5].

• Selected measurements will be 

reported for the region in the 

stats review area [6].

Making Measurements using Selected Region

To sample all of the ventricle on this slice please refer to 

the Selected Object sampling type on the following pages.
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The Selected Object option allows users to sample an object on a 2D slice. An object map  

must be loaded for this sampling option to be available.

Stats to View: The stats to view area allows users to enable and disable measurements 

and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file.  

See General under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM  

format. See DICOM Info under Sample Point(s) > Stats to View above for a full description  

of available options.

• Size Intensity: Allows users to report an array of size intensity information and measurements.  

Refer to the size Intensity description for Sample 2-D Rectangle for a description of all available 

options.

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and maximum intensity range. Refer to the 

Sample Range description for Sample 2-D Rectangle for a description of all available options. 

• 2-D Shape: Allows users to report 2-D shape measurements for the defined region. Refer to the 2-D Shape description for Sample 2-D 

Rectangle for a description of all available options.

Selected Object
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the 2D Sample Type [1] and 

choose Selected Object [2].

• In the Stats to View area check all 

required measurements [3] in the 

stats review area.

Making Measurements using Selected Object

• Move to axial slice 136 [4]. Click in the ventricle object on either the left or right side to sample [5]. Note that even though the two 

regions of the ventricle on this slice are spatially disconnected both are sampled as the sample type, selected object, will sample all 

voxels assigned to the selected object on the current 2D slice.

• Selected measurements will be reported for the region in the stats review area [6].



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

578MEASURE > MEASUREMENT TOOLS > 2-D MEASUREMENTS

The Enabled Objects option allows sampling of all enabled objects (currently displayed) for the current  

slice, all slices, or a range of slices. An object map must be loaded for this option to be available.

Sample Options: Provides users the following sampling controls:

• Orient: Select the orientation to sample enabled objects in.

 · Axial: Sets the sampling orientation to axial.

 · Coronal: Sets the sampling orientation to coronal.

 · Sagittal: Sets the sampling orientation to sagittal.

• Slices: Allows users to specify the slices sampled. 

 · Current Slice: Samples the current displayed slice for the selected orientation. 

 · All Slices: Samples all slices in the selected orientation.

 · Slice Range: Samples the range of samples specified using the start and end slice fields for the selected orientation. 

 ·  Start Slice: Allows users to set the starting slice for sampling. Slices before the start slice will not be sampled.

 ·  End Slice: Allows users to set the ending slice for sampling. Slices after the end slice will not be sampled.

 · Combine Objects: Allows users to sum the measurements of the individually sampled objects. 

 ·  Name: Allows users to specify a name for the combined object measurements when reported to the stats log. 

• Sample Enabled Objects: Initiates the sampling process.

Stats to View: The stats to view area allows users to enable and disable measurements and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file (see General under Sample Point(s) > Stats to View.)

• DICOM Info: Allows users to report DICOM tag information (see DICOM Info under Sample Point(s) > Stats to View.)

• Size Intensity: Reports an array of size intensity information and measurements (see Size Intensity description for Sample 2-D Rectangle.)

• Sample Range: Samples voxels within a defined region based on a min/max intensity range (see Sample 2-D Rectangle > Sample Range.)

• 2-D Shape: Reports 2-D shape measurements for the defined region (see Sample 2-D Rectangle > 2-D Shape.)

Enabled Objects
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj 

file.

• Select the 2D Sample Type [1] and 

choose Enabled Objects [2].

Sampling the Current Slice

To sample all enabled objects for 

the current slice in a particular 

orientation, do the following:

Sampling Objects using Enabled Objects

• Leave Orient set to Axial and Slice(s) set to Current [3]. This will sample the current axial slice when Sample Enabled Objects is selected. 

Change the axial slice to 136 [4].

• In the Stats to View area check all the measurements [5] to be reported. Check the Auto Log option [6].

• Click the Sampled Enabled Object button [7].

• All objects currently displayed [8] will be sampled. The sampled objects are displayed for the current slice in the current orientation [9].

• The selected measurements will be returned to the stats log for the current slice [10].



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

580MEASURE > MEASUREMENT TOOLS > 2-D MEASUREMENTS

Combining Objects for the Current 
Slice

To return summed measurements for 

the enabled objects, do the following: 

To return summed measurements for 

the enabled objects, do the following:

• Check the Combine Enabled 

Objects check box [11]. Leave the 

Name set to Combined. 

• Click the Sampled Enabled Object 

button [12].

• All objects currently displayed will 

be sampled. The sampled objects 

are displayed in red in the current 

orientation. Measurements will be 

summed for the enabled objects 

(skin + brain + ventricles) and 

returned in a new row in the stats 

log [13].

Sampling Objects using Enabled Objects (continued)
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Sampling All Slices

To sample all enabled objects for all 

slices in a particular orientation, do 

the following:

• Dismiss the stats log by clicking 

the x in the upper right-hand 

corner of the stats log.

• Set the Orient to Coronal [14] 

and set Slice(s) set to All Slices 

[15], these settings will allow 

you to sample all slices in the 

coronal orientation when Sampled 

Enabled Object is selected.

• Click the Sampled Enabled Object 

button [16]. 

• All objects currently displayed will 

be sampled. The sampled objects 

are displayed in red in the current 

orientation [17].

• Measurements will be returned to 

the stats log for the current slice 

[18].

Sampling Objects using Enabled Objects (continued)
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Combining Objects when sampling 
All Slices

To return the individual object 

measurements summed in a single 

line entry in the stats log, do the 

following:

• Dismiss the stats log by clicking 

the x in the upper right-hand 

corner of the stats log.

• Check the Combine Enabled 

Objects check box [19].

• Leave the Name set to Combined 

[20].

• Click the Sampled Enabled Object 

button [21]. 

• All objects currently displayed will 

be sampled. The sampled objects 

are displayed in red in the current 

orientation. Measurements will be 

summed for the enabled objects 

and returned to the stats log for 

the current slice [22].

Sampling Objects using Enabled Objects (continued)
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Sampling a Range of Slices

To sample a range of slices for 

all enabled objects in a specific 

orientation, do the following:

• Dismiss the previous stats log by 

clicking the x in the upper right-

hand corner of the stats log.

• Next, uncheck the Combine 

Enabled Objects.

• Set the Orient to Sagittal [23] and 

set Slice(s) set to Slice Range [24].

• Set the Start Slice to 50 and 

the End Slice to 150 [25]. These 

settings will allow you to sample 

a range of slices, slice 50 to 150, 

in the sagittal orientation when 

Sampled Enabled Object is 

selected.

Sampling Objects using Enabled Objects (continued)

• Click the Sampled Enabled Object button [26].

• All objects currently displayed will be sampled. The sampled objects are displayed in red in the current orientation [27].

• Measurements will be returned to the stats log for the enabled objects within the specified range of slices [28].
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Combining Objects when Sampling 
a Range of Slices

To sum the object measurements in a 

single line entry in the stats log for a 

range of slices, do the following:

• Dismiss the stats log by clicking 

the x in the upper right-hand 

corner of the stats log.

• Check the Combine Enabled 

Objects check box [29].

• Leave the Name set to Combined 

[30].

• Click the Sampled Enabled Object 

button [31]. 

• All objects currently displayed will 

be sampled for the range of slices 

specified. The sampled objects 

are displayed in red in the current 

orientation. Measurements are 

summed for the enabled objects 

and returned to the stats log [32].

Sampling Objects using Enabled Objects (continued)
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The Entire Image option allows users to sample measurements for the entire slice for  

the current slice, all slices, or a range of slices. 

Sample Options: Provides users the following sampling controls:

• Orient: Select the orientation to sample enabled objects in.

 · Axial: Sets the sampling orientation to axial.

 · Coronal: Sets the sampling orientation to coronal.

 · Sagittal: Sets the sampling orientation to sagittal.

• Slices: Allows users to specify the slices sampled. 

 · Current Slice: Samples the current displayed slice for the selected orientation. 

 · All Slices: Samples all slices in the selected orientation.

 · Slice Range: Samples the range of samples specified using the start and end slice fields  

for the selected orientation. 

 ·  Start Slice: Allows users to set the starting slice for sampling. Slices before the start slice will not be sampled.

 ·  End Slice: Allows users to set the ending slice for sampling. Slices after the end slice will not be sampled.

• Sample Entire Image: Initiates the sampling process.

Stats to View: The stats to view area allows users to enable and disable measurements and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file (see General under Sample Point(s) > Stats to View.)

• DICOM Info: Allows users to report DICOM tag information (see DICOM Info under Sample Point(s) > Stats to View.)

• Size Intensity: Reports an array of size intensity information and measurements (see Size Intensity description for Sample 2-D Rectangle.)

• Sample Range: Samples voxels within a defined region based on a min/max intensity range (see Sample 2-D Rectangle > Sample Range.)

• 2-D Shape: Reports 2-D shape measurements for the defined region (see Sample 2-D Rectangle > 2-D Shape.)

Entire Image



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

586MEASURE > MEASUREMENT TOOLS > 2-D MEASUREMENTS

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select the 2D Sample Type [1] and 

choose Entire Image [2].

Sampling the Entire Current Slice

To sample the entire current slice, do 

the following:

• Leave Orient set to Axial and 

Slice(s) set to Current Slice [3]. This 

will sample the current axial slice 

when Sample Entire Image(s) is 

selected.

Sampling the Entire Image

• In the Stats to View area check all the measurements [4] you would like returned.

• Click the Sample Entire Image(s) button [5].

• The current axial image will be sampled [6].

• The selected measurements will be returned to the stats review area [7].
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Sampling the Entire Slice for All 
Slices

To sample the entire slice for all slices 

in the selected orientation, do the 

following:

• Set Orient to Coronal and then set 

Slice(s) to All Slices [8]. 

• Check the Auto Log Stats check 

box [9].

• Click the Sample Entire Image(s) 

button [10].

• All slices in the current orientation 

will be sampled [11].

• Measurements for each slice will 

be returned to the stats log [12].

Sampling the Entire Image (continued)
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Sampling the Entire Slice for a 
Range of Slices

To sample the entire slice for a range 

of slices in the selected orientation, 

do the following:

• Dismiss the previous stats log by 

clicking the x in the upper right-

hand corner of the stats log.

• Next, set Orient to Sagittal and 

then set Slice(s) to Slice Range 

[13].

• Set the Start Slice to 50 and 

the End Slice to 150 [14]. These 

settings will allow you to sample a 

range of slices, slice 50 to 150, in 

the sagittal orientation.

• Click the Sample Entire Image(s) 

button [15].

• Only slices in the current range 

for the selected orientation will be 

sampled [16].

• Measurements will be returned to 

the stats log [17].

Sampling the Entire Image (continued)
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3D measurements are derived from the loaded object map for the data set. Spatial size, signal intensity information and 3D shape 

characteristics can be derived from an object or collection of objects. These options include; selected object and enabled object. The 

remaining three measurement options do not require an object map, these include; box, entire volume, and stereology.

The 3-D tab provides access to the following measurement tools:

 · Box

 · Selected Objects

Box 
 
The Box tool enables users to interactively define and then sample a 3D box region of interest in the volume image data. The following 

sampling options are available.  

 

Sample Options: Provides users with access to the following 3D Box sampling options:

 · Name: Allows users to assign a name to the selected box when reported to the log file.

 · Sample Enabled Objects: This option is only available when an object map is loaded. When disabled (default) all voxels within the 

box will be sampled [1]. When enabled only voxels that form part of enabled objects within the box will be sampled [2].

3-D Measurement Tools

 · Enabled Objects

 · Entire Volume

 · Stereology
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Stats to View: The stats to view area allows users to enable and disable measurements  

and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file. See  

General under Sample Point(s) > Stats to View for a full description of available options.

• DICOM Info: Allows users to report DICOM tag information if the data is in the DICOM 

 format. See DICOM Info under Sample Point(s) > Stats to View above for a full description 

 of available options.

• Size Intensity: Allows users to report an array of size intensity information and  

measurements. Refer to the size Intensity description for Sample 2-D Rectangle  

for a description of all available options.

• Sample Range: Allows users to sample voxels within the defined region based on a minimum and 

 maximum intensity range. Refer to the Sample Range description for Sample 2-D Rectangle for a description of all available options.

• 3-D Shape: Allow users to measure the following 3-D shape measurements:

 · MEB Angle Resolution: MEB (Minimum Enclosing Brick) specifies the angle resolution to be used when searching for the Minimum 

Enclosing Brick.

 · Surface Area: The surface area option reports the estimated surface area for the sampled object. 

 · MEB Angles: The MEB Angles option reports the orientation angles of the minimum enclosing brick around the object. The angle 

resolution is specified in the MEB Angle Resolution option.

 · MEB Volume: Reports the volume of the minimum enclosing brick.

 · MEB Coordinates: Reports the coordinates of the eight corners of the MEB.

 · Sphere Fit Factor: Reports the ratio: SA3 /(9V2 *4Pi) where 1 equals a perfect sphere.

 · Bick Fit Factor: Reports the ratio: ObjectVolume/MEB_Volume where 1 equals a brick shaped object.

 · Centroid: Reports the center gravity for the object.

Box Options (continued)
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Download the MRI_3D_Head.avw data set from 

analyzedirect.com/data to follow along.

• Open Input/Output and load MRI_3D_Head.

avw into Analyze. Select MRI_3D_Head and 

open Measure.

• Select File > Load Object Map and load the 

MRI_3D_Head.obj.

• Select the 3D Sample Type [1] and choose Box 

[2].

• To define a box first draw a rectangular region 

on one of the slices, in any orientation [3].

• In either of the other two orientations left click 

on a corner and then drag the cursor until the 

desired size and shape box is define [4].

• Selected measurements will be reported for 

the region in the stats review area [5]. Click Log 

Stats to return the stats to a log file that can be 

saved out of Analyze as a .csv file.

Making Measurements using Box
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Making Box Measurements for 
Enabled Objects

• To sample only enabled objects 

within the box check the Sample 

Only Enabled Objects option [6].

• Only objects in the object list that 

are displayed [7] will be sampled 

[8].

• The stats review area will 

automatically update [9].

Making Measurements using Box (continued)
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The Selected Object option allows users to sample an object within the 3D volume. 

 An object map must be loaded for this sampling option to be available. The following 

 sampling options are available:

Stats to View: The stats to view area allows users to enable and disable measurements  

and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file  

(see General under Sample Point(s) > Stats to View.)

• DICOM Info: Allows users to report DICOM tag information (see DICOM Info under  

Sample Point(s) > Stats to View.)

• Size Intensity: Reports an array of size intensity information and measurements (see  

Size Intensity description for Sample 2-D Rectangle.)

• Sample Range: Samples voxels within a defined region based on a min/max intensity  

range (see Sample 2-D Rectangle > Sample Range.)

• 3-D Shape: Allow users to sample different 3-D shape-based measurement, see the  

3-D Shape description under 3-D > Box for details on each of the 3-D shape  

measurements available.

Selected Object
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj.

• Select the 3D Sample Type [1] and 

choose Selected Object [2].

• In the Stats to View area check the 

required measurements [3] to be 

sampled.

• Check Auto Log Stats [4].

• Click on the brain object in any of 

the three orthogonal slices [5].

• Selected measurements will be 

reported for the region in the 

stats log [6]. Right click to save the 

log to disk as a .csv file.

Making Measurements using Selected Object
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Generating Histograms with 
Selected Object

• Check the Histogram checkbox 

[7].

• To generate the histogram 

statistics (intensity and count 

information) [8] click on the brain 

[9].

• The histogram for the sampled 

objects will be displayed below 

the display area [10] in a new 

Histogram tab [11] in front of the 

other statistics tabs.

• Note that objects with the view 

disabled can accidently be 

selected and sampled when using 

the Selected Object tool. Be 

aware when selecting an object to 

sample.

• The histogram information can 

be saved as a .CSV file by right-

clicking and selecting Save Log.

Making Measurements using Selected Object (continued)
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The Enabled Object option allows users to sample all enabled objects (objects currently  

displayed) in the volume. An object map must be loaded for this sampling option to be  

available.

Sample Options: Provides users the following sampling controls:

• Combine Objects: Allows users to sum the measurements of the individually  

sampled objects. 

 · Name: Allows users to specify a name for the combined object measurements 

when reported to the stats log. 

• Sample Enabled Objects: Initiates the sampling process.

Stats to View: The stats to view area allows users to enable and disable measurements and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file (see General under Sample Point(s) > Stats to View.)

• DICOM Info: Allows users to report DICOM tag information (see DICOM Info under Sample Point(s) > Stats to View.)

• Size Intensity: Reports an array of size intensity information and measurements (see Size Intensity description for Sample 2-D Rectangle.)

• Sample Range: Samples voxels within a defined region based on a min/max intensity range (see Sample 2-D Rectangle > Sample Range.)

• 3-D Shape: Allow users to sample different 3-D shape-based measurement, see the 3-D Shape description under 3-D > Box for details on 

each of the 3-D shape measurements available.

Enabled Object
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Sampling Enabled Objects

Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj.

• Select the 3D Sample Type [1] and 

choose Enabled Object [2].

• Select Size Intensity [3] and make 

sure that Name, Volume, and 

Mean are checked. Uncheck Area 

[4].

Making Measurements using Enabled Object

• Switch the display of the Skin object off [5] by clicking on the monitor icon next to the object in the object list. 

• Switching the display of an object off disables the object so it won’t be sampled. Switch on the Lenticular and Caudate objects. 

• Click Sample Enabled Objects [6]. The selected measurements for the enabled objects will be reported to the stats review area [7].
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Sampling Enabled Objects 
(continued)

• To report the selected 

measurements to a log file that 

can be saved from Measure, click 

the Log Stats button [8]. When 

clicked the button will become 

grayed out. 

• The selected measurements 

for the enabled objects will be 

reported to a file below the image 

display area [9].

• To save the measurements log file, 

right-click in this area and select 

Save Log [10]. The log file will be 

saved as a .CSV file.

Making Measurements using Enabled Object (continued)
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Using Enabled Objects to make Combined 
Measurements

• Check the Auto Log Stats checkbox [11].

• Next, check the Combine Enabled Objects 

checkbox [12].

• Name the combined result or leave the default 

name as Combined [13].

• Click Sample Enabled Objects [14].

• The combined measurements will be reported 

in the stats review area [15] and added to the 

log file.

• Checking additional measurement options [16] 

will automatically update in the stats review 

area with the selected measurement for the 

combined object [17].

• The measurements for the individual and 

combined objects will automatically update in 

the log [18].

Making Measurements using Enabled Object (continued)
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Using Enabled Object to Generate 
a Combined Object Histogram

• Check the Histogram check box 

[18] and select Sample Enabled 

Objects [19].

• The histogram measurements 

will be reported [20] and the 

histogram plotted [21] in a new 

tab. Right-click to save the 

histogram log.

Making Measurements using Enabled Object (continued)
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The Entire Volume option allows users to sample measurements for the entire data set.  

The entire volume measurement option does not require an object map.

Sample Options: Provides users the following sampling controls:

• Name: Allows users to specify a name for the combined object measurements  

when reported to the stats log.

Stats to View: The stats to view area allows users to enable and disable measurements  

and information reported to the stats log.

• General: Allows users to report general image data parameters in the stats log file  

(see General under Sample Point(s) > Stats to View.)

• DICOM Info: Allows users to report DICOM tag information (see DICOM Info under Sample Point(s) > Stats to View.)

• Size Intensity: Reports an array of size intensity information and measurements (see Size Intensity description for Sample 2-D Rectangle.)

• Sample Range: Samples voxels within a defined region based on a min/max intensity range (see Sample 2-D Rectangle > Sample Range.)

• 3-D Shape: Allow users to sample different 3-D shape-based measurement, see the 3-D Shape description under 3-D > Box for details on 

each of the 3-D shape measurements available.

Entire Volume
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Download the MRI_3D_Head.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

MRI_3D_Head.avw into Analyze. 

Select MRI_3D_Head and open 

Measure.

• Select File > Load Object Map 

and load the MRI_3D_Head.obj.

• Select the 3D Sample Type [1] and 

choose Entire Volume [2].

• Select Size Intensity [3] and make 

sure that Name, Volume and 

Mean are checked. Uncheck Area. 

• Check Auto Log Stats [4] and click 

Sample Entire Volume [5].

• The selected stats for the entire 

volume will be reported in the 

Stats review area [6] and log file.

Sampling the Entire Data Set using Entire Volume
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The Stereology tool estimates volume and surface area using the stereological method of point  

counting. This method consists of overlaying images entirely with a randomly positioned and  

oriented systematic array of test points and counting the number of occasions on which a point  

lies within the feature of interest.

Stereology Options:

• Estimate: Choose from the following to determine the type of estimation to conduct:

 · Volume Only: Specifies that only volume estimations will be made.

 · Volume & Surface Area: Specifies that both volume and surface area estimations will be made.

• Orient: Allows users to select the orientation to create the sampling grid in. 

Slice:
 · Start: Specifies the initial slice to be used for the grid. Enter the desired slice number in the text entry box.

 · Incr: Specifies the interval of the slices used when generating the grid. Enter the desired increment in the text entry box.

 · Number: Specifies the number of slices to be used for the grid. Enter the desired number in the text entry box.

• Spacing:
 · X: Allows users to the distance (in pixels) between grid elements in X.

 · Y: Allows users to the distance (in pixels) between grid elements in Y.

• Start Position: Choose from Random and Specified to specify whether the starting position is randomly selected or specified by the 

following options. When Random is selected the X Start Position, Y Start Position, and Angle text entry fields are disabled.

• Random: Generates a random grid. 

• Specified:
 · Start X: Specifies the x position of the first grid element.

 · Start Y: Specifies the y position of the first grid element.

 · Angle: Specifies the angle used to position the grid on the image.

Stereology
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Stereology Options (continued):

• B/sqrt(A): Specifies the value used in correcting the estimation of surface area. This value is determined during the estimation of the 

volume.

• Generate Grid: Generates the grid based on the parameters entered above.

Stats to View

• Stereology
 · Volume:
 ·   Points: Reports the number of points selected.

 ·   Volume: Displays the current estimation of the specified volume.

 ·   Coefficient of Error: Specifies the current estimation of the error coefficient.

 ·   Elliptical Error: More accurate error estimate for objects which are unusually regular, close to an ellipsoidal shape.

 · Surface Area
 ·   X Intersection
 ·   Y Intersection
 ·   Z Intersection
 ·   Surface Area: Displays the current surface area estimation (in Surface Area mode only).

 ·   B/sqrt(A): Specifies the mean boundary length divided by the square root of the mean area of the sampled object on all the 

  slices. This is computed in Surface Area Mode and improves Coefficient of Error Estimates.

Right click options: 

 · Copy Grid Forward: Copies the current grid forward to the next grid slice. If points have been selected (green points) there selected 

state will be copied forward also. 

 · Middle Button Action: Allows users to set the action of the middle mouse button. See the Image Display, Controls and Customization 

section for a full description of this option.

Stereology Options (continued)
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Right Click Options (continued):
 · Mouse Wheel Action: Allows users to set the action of the middle mouse wheel. See the Image Display, Controls and Customization 

section for a full description of this option.

 · Copy to Clipboard: Copies the current slice display to memory.

 · Isotropic: Active only for anisotropic data. Allows users to toggle between an isotropic or anisotropic display of the data.

 · Show Active Slices Only: Allow users to automatically skip non-grid slices using the + or – keys or the mouse scroll wheel.  

 

 

 · Show Grid: Toggles the display of the volume estimation grid when surface area is selected.

 · Show X Lines: Toggles the display of the x lines for surface estimation when estimating surface area is active.

 · Show Y Lines: Toggles the display of the y lines for surface estimation when estimating surface area is active.

Stereology Options (continued)



Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.

606MEASURE > MEASUREMENT TOOLS > 3-D MEASUREMENTS

Right Click Options (continued):
 · Toggle with ‘s’ key: When enabled allows users to toggle between Grid, X Lines, and Y Lines. 

 · Stereology Cursor: Allows users to change the shape of the cursor for selecting grid points. Users can choose from; Crosshair [1], 

Rectangle [2], or Oval [3].

 

 · Additional Cursor options: Additional options are available for the Rectangle and Oval cursors:

 ·   Rectangle Shape: Choose from Square, Wide, or Tall. 

 ·   Rectangle Size: Tiny, Small, Medium, Large, Extra Large

 ·   Oval Shape: Choose from Circular, Wide, or Tall. 

 ·   Oval Size: Tiny, Small, Medium, Large, Extra Large

 · Keyboard Shortcuts: The following keyboard shortcuts are available:

 ·   S: Toggle through the cursor options. 

 ·   X: Toggle though cursor shape options.

 ·   Z: Toggle through the cursor size options. 

Axis Label: Allows users to enable or disable the display of the axis labels on the perimeter of the slice display window.

Border Ruler: Enables/Disables the boarder ruler tool.

Reset: Resets all options to default.

Stereology Options (continued)
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In this example we will use Stereology 

to estimate the volume of the heart in 

a CT data set.

Download the Canine_Chest_CT.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

Canine_Chest_CT.avw into 

Analyze. Select Canine_Chest_CT 

and open Measure.

• Select the 3D Sample Type [1] and 

choose Stereology [2].

Estimating Volume using Stereology

• Use the Display tools to configure the image display so that the rendering is disabled and only one orthogonal slice is displayed [3].

• Ensure the orientation is set to Axial and then move to slice 42 [4]. This is the first axial slice that the heart can be seen on.

• From Stereology Options set Estimate to Volume & Surface Area [5]. Notice that the surface area related measurement options become 

available in the Stats to View area [6].

• The heart first appears around axial slice 42 and remains visible until slice 94. To create a sampling grid that will encompass the heart set 

the Start Slice to 42. Using Stereology, it is not necessary to sample every slice, set the Grid Slide Increment to 3 and Number of Grid 

Slices to 17 [7].

• Click Generate Grid [8] to generate the sampling grid on the image.
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• The grid will be overlaid on the image data.[9].

• The stereology options to generate the grid will no 

longer be visible, however, if you need to modify or 

recreate the grid click the Regenerate Grid button 

[10] and all options will be displayed. 

• Move the cursor over to the image and click on any 

point that falls on the heart [11]. When completed 

press the + key on your keyboard to move to the 

next grid slice and repeat.

• As you continue to move through the data 

selecting points [12] the stats review area [13] will 

update with the measurements selected. 

• When sampling is complete select Log Stats to log 

the measurements to a stats log that can be saved 

to disk as a .csv file. 

Note: If Stereology is to be used for research study, it is necessary 

to validate the process for the study application. To validate a 

stereologic-based estimate of volume, segmentations of the 

structure of interest need to be established as gold standard 

volume measurements to which the stereologic estimates can be 

compared. These gold standard test volumes also provide the 

opportunity to establish best grid parameters to be used for the 

study.

Estimating Volume using Stereology (continued)
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Measure can sample 4D image data. 

When 4D image data is loaded into 

Measure a volume slider is available 

allowing users to selected different 

volumes.

Download the 4D_Cardiac_CT.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

4D_Cardiac_CT.avw into Analyze. 

Select 4D_Cardiac_CT and open 

Measure.

• Select File > Load Object Map 

and load 4D_Cardiac_CT.obj.

Sampling 4D Multivolumes using 3D Tools

• Select the 3D Sample Type [1] and choose Enabled Objects [2].

• Select Size Intensity [3] and check Name, Volume and Mean, and uncheck Area.

• Check Auto Log Stats [4] and check Sample All Volumes [5].

• Click Sample Enabled Objects [6].

• The total volume of the blood pool for each of the 18 3D volumes in the 4D multivolume will be reported in the 3D log [7]. Right click to 

save the log as a .CSV file.
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Measure can also generate 4D 

histograms from 4D image data. 

When 4D image data is loaded into 

Measure a volume slider is available 

allowing users to selected different 

volumes.

Download the 4D_Cardiac_CT.avw 

data set from analyzedirect.com/data 

to follow along.

• Open Input/Output and load 

4D_Cardiac_CT.avw into Analyze. 

Select 4D_Cardiac_CT and open 

Measure.

• Select File > Load Object Map 

and load 4D_Cardiac_CT.obj 

Sampling 4D Multivolumes using 3D Tools (continued)

• Select the 3D Sample Type [1] and choose Enabled Objects [2].

• Select Size Intensity [3] and ensure that Name, Volume and Mean, and Histogram are checked [4].

• Check Auto Log Stats [5] and check Sample All Volumes [6]. Click Sample Enabled Objects [7].

• The histogram measurements will be reported [8] and the histogram plotted [9] in a new tab.

• The volume slider [10] beneath the histogram stats allows review of histograms for all 3D volumes in the 4D multivolume.


	Analyze15Basics
	Analyze15Controls
	Analyze15InputOutput
	Analyze15Display
	Analyze15Process
	Analyze15Transform
	Analyze15Segment
	Analyze15Register
	Analyze15Measure

